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Введение

В далеком 1984 году, 24 января, когда многие из читателей еще ходи-
ли пешком под стол, а некоторые и вовсе даже не родились, увидела 
свет первая версия операционной системы Mac OS, называвшаяся тог-
да Mac System Software. Она была предустановлена на компьютерах 
Macintosh 128K, поступивших в розничную продажу по цене $2500. По 
сравнению с современными операционными системами и возможно-
стями нынешних компьютеров характеристики Macintosh 128K, равно 
как и требования Mac System Software, были смешны — 8 МГц процес-
сор и 128 Кб оперативной памяти. На рис. 1 и 2 представлен интерфейс 
операционной системы Mac System Software 1.0.

� Примечание. Подробно хронологию развития компьютеров 
компании Apple вы можете изучить на сайте macoblog.ru/classic-
macintosh/. А история развития операционных систем компании 
Apple опубликована тут: appleinsider.ru/istoriya-apple/istoriya-
operacionnyx-sistem-apple-chast-9.html.

Вплоть до версии System 7.5.5 для пользовательской операционной 
системы Apple применялось название System, а с релизом версии 7.6 
в 1997 году на экране компьютеров Mac появилась графическая застав-
ка с названием Mac OS. Началась эра «классической» операционной 
системы Macintosh, продлившаяся вплоть до выпуска версии 9 (и ми-
норных обновлений) в октябре 2003 года. А уже 24 марта 2001 года 
Стив Джобс, в то время CEO компании Apple, представил операцион-
ную систему Mac OS X 10.0 с кодовым названием «Гепард». За ней по-
следовали другие представители семейства кошачьих: «Пума» (10.1), 
«Ягуар» (10.2), «Пантера» (10.3), «Тигр» (10.4), «Леопард» (10.5), «Снеж-
ный барс» (10.6), «Лев» (10.7) и, наконец, «Горный лев» (10.8). К сло-
ву, в 2007 году название операционной системы Mac OS X потеряло 
приставку «Mac» (начиная с версии 10.5). Это случилось потому, что 
в то же время стала позиционироваться операционная система OS X 
для смартфонов iPhone . 
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Рис. 1. Интерфейс операционной системы Mac System Software 1.0

Рис. 2. Приложения в операционной системе Mac System Software 1.0

Таким образом, компания дала понять, что теперь нет просто Mac OS X, 
а есть платформа OS X, на которую можно перевести как компьютеры, 
так и другие устройства. А в 2013 году компания Apple решила сменить 
политику присвоения названий своей операционной системе, и от-
ныне версии OS X обретают имена в честь различных мест штата, где 
располагается головной офис компании Apple. Поэтому версия 10.9 
носит название «Mavericks», как и популярный калифорнийский пляж 
(рис. 3).

Вы можете загрузить и установить операционную систему OS X Mave-
ricks в любое время, посетив онлайн-магазин App Store, на сегодняш-
ний день дистрибутив предоставляется бесплатно1, а размер инсталля-
ционного файла составляет около 5,3 Гб.

1 В качестве обновления для пользователей операционной системы OS X версии Snow 
Leopard (10.6.8), Lion (10.7) или Mountain Lion (10.8). Пользователям более ранних версий 
понадобится сначала обновить систему до версии Snow Leopard.
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Рис. 3. Приложения в операционной системе OS X 10.9

Операционная система OS X Mavericks существенно отличается от сво-
их предшественниц: на официальном сайте компании Apple вы найде-
те описание более 200 различных усовершенствований и доработок 
(www.apple.com/ru/osx/). Разработчики внесли улучшения в различ-
ные элементы системы OS X Mavericks, начиная с новой технологии эко-
номии энергии без потери производительности и заканчивая возмож-
ностью работать с предустановленными приложениями iBooks и Карты 
(Maps), знакомыми пользователям мобильных устройств фирмы Apple.

Сотрудники компании при разработке системы OS X Mavericks продол-
жили придерживаться курса на сближение с мобильной платформой 
iOS, которая используется для управления планшетами iPad, смартфо-
нами iPhone  и плеерами iPod. На данный момент обе системы остаются 
обособленными, но лучшие возможности iOS уже перенесены в OS X 
Mavericks.

Новые возможности операционной 
системы OS Х Mavericks

Новая операционная система OS X Mavericks имеет множество отличий 
от своей предшественницы — системы Mountain Lion. Не все из них за-
метны с первого взгляда, но в процессе работы вы сможете оценить, 
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насколько большой труд был проделан. К сожалению, формат книги не 
позволяет рассмотреть каждую из 200 новых функций, но мы непре-
менно остановимся на самых важных и значимых доработках системы. 
Итак…

• iBooks. Отныне все книги, которые вы загрузили на свой iPad, iPhone  
или iPod touch, автоматически появятся в приложении iBooks на ва-
шем компьютере. Все элементы управления доступны в новой опера-
ционной системе OS X Mavericks, в том числе и управление жестами. 
Благодаря сервису iCloud, закончив чтение книги на определенной 
странице на своем планшете iPad, вы сможете продолжить с того же 
места, запустив приложение iBooks на компьютере Mac.

• Карты (Maps). Приложение Карты (Maps) прекрасно подойдет для 
просмотра мест будущих путешествий или командировок, состав-
ления маршрутов, а также ознакомления с ситуацией на дорогах. 
Доступны три режима просмотра карты: стандартный (схема), вид 
со спутника и гибридный, совмещающий преимущества обоих.

• Календарь (Calendar). Обновился интерфейс приложения Кален-
дарь (Calendar), и были реализованы новые функции. Непрерывная 
прокрутка позволяет просматривать даты с большим комфортом, 
упростился процесс создания и редактирования событий, стали до-
ступны возможности просмотра места на карте, вычисления време-
ни в пути и изучения прогноза погоды.

• Браузер Safari получил ряд новых функций и улучшений. Благода-
ря функции Общие ссылки (Shared Links) вы всегда будете в курсе, 
чем хотят поделиться с вами друзья в социальных сетях LinkedIn, 
Facebook и Twitter. Обновилось боковое меню и режим Top Sites 
для размещения закладок на ваши любимые сайты. Благодаря тех-
нологическим улучшениям ускорен отклик и открытие веб-страниц, 
а на ноутбуках MacBook используется новый режим энергосбере-
жения, позволяющий экономить заряд аккумуляторной батареи.

• Связка ключей iCloud. Данная функция разработана, чтобы сохра-
нить все ваши логины и пароли к веб-сайтам на каждом из ваших 
устройств под управлением операционных систем OS X и iOS. Все со-
храненные имена и пароли защищены с помощью 256-разрядного 
шифрования AES. Новый генератор паролей создает уникальные 
и трудные для подбора пароли. Функция также поддерживает со-
хранение платежных реквизитов, позволяя мгновенно оплачивать 
покупки с помощью банковской карты.
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• Улучшена поддержка нескольких мониторов, подключенных 
к вашему Mac. Теперь на каждом из них вы видите отдельный рабо-
чий стол и можете запускать разные приложения.

• Обновлен Центр уведомлений (Notification Center). Теперь на уве-
домления приложений Mail, Сообщения (Messages) и FaceTime мож-
но отвечать, не запуская соответствующую программу. Если вам 
потребуется отойти от компьютера, вы увидите все пропущенные 
уведомления, как только вернетесь.

• Обновлено приложение Finder. Теперь в нем используются вклад-
ки, позволяющие объединить несколько окон Finder в одно. Что-
бы перемещать/копировать файлы между вкладками, достаточно 
просто перетаскивать их. Также в приложении Finder используются 
цветовые теги, позволяющие с легкостью сортировать и находить 
нужные файлы.

• Теги, используемые в приложении Finder, теперь поддерживаются 
множеством программ, таких как TextEdit и другие, а также и облач-
ным сервисом iCloud. Каждому файлу можно назначить один или 
несколько цветовых тегов.

Мы рассмотрели основные нововведения и улучшения, которые раз-
работчики внесли в операционную систему OS X Mavericks. Оценить 
полный набор усовершенствований и нововведений вы можете на 
официальном сайте компании Apple (www.apple.com/ru/osx/).

Системные требования операционной системы 
OS Х Mavericks

Системные требования OS X 10.9 Mavericks к железу довольно скром-
ны: 64-битный процессор Intel, 2 Гб оперативной памяти и 8 Гб про-
странства на жестком диске. Поддерживаются процессоры компании 
Intel: Core 2 Duo, Core i3, Core i5, Core i7 и Xeon.

� Примечание. В настоящее время OS X Mavericks распространяется 
исключительно через онлайн-магазин App Store. Вы можете перей-
ти на новую версию, если на вашем компьютере установлена опе-
рационная система OS X версии не ниже Snow Leopard 10.6.
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Установка OS X Mavericks возможна на следующие модели компьюте-
ров компании Apple:

• iMac (середина 2007 года или новее);

• Mac Mini (начало 2009 года или новее);

• Mac Pro (начало 2008 года или новее);

• MacBook (13-дюймовый алюминиевый, конец 2008 года, 13- дюймо-
вый начало, 2009 года или новее);

• MacBook Air (конец 2008 года или новее);

• MacBook Pro (13-дюймовый, середина 2009 года или новее, 15- дюй-
мовый, середина/конец 2007 года или новее, 17-дюймовый, конец 
2007 года или новее);

• Xserve (начало 2009 года).

� Примечание. Операционная система OS X Mavericks успешно уста-
навливается и запускается в виртуальных средах, например в про-
грамме VMware Player, и на компьютерах сторонних производителей 
(так называемый Хакинтош), но важно помнить, что это противоре-
чит условиям лицензионного соглашения компании Apple.

Перед тем как устанавливать операционную систему OS X Mavericks 
на свой компьютер, убедитесь, что его характеристики соответствуют 
системным требованиям, заявленным разработчиками. Возможно, вам 
потребуется компьютер с более высокими характеристиками.

Учитывайте, что для того, чтобы использовать специфические возмож-
ности операционной системы OS X, вам потребуются дополнительные 
устройства и оснащение. Рассмотрим основные дополнения:

• если вы переживаете за сохранность своих данных и используете 
приложение Time Machine, придется купить еще один жесткий диск 
или специальное устройство AirPort Time Capsule (www.apple.com/
ru/airport-time-capsule/);

• чтобы полноценно использовать многие функции операционной 
системы, своевременно получать обновления и чувствовать себя 
уверенно при работе в Сети, вам потребуется широкополосное (вы-
сокоскоростное) соединение с Интернетом;
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• если вы собираетесь часто просматривать DVD-диски, то для каче-
ственного воспроизведения видеозаписей нужен процессор с так-
товой частотой не менее 1,6 ГГц. Иначе вы можете столкнуться с не-
приятными эффектами: несоответствием звуковой дорожки или 
«прерывистым» воспроизведением;

• для запуска современных игр потребуется компьютер с производи-
тельной видеокартой компании NVIDIA.

Также не забывайте о сенсорных возможностях управления операци-
онной системой. Если вы хотите в полной мере насладиться жестами 
Multi-Touch, либо потребуется ноутбук (они оснащаются трекпадом 
по умолчанию), либо придется приобрести мышь Magic Mouse с под-
держкой Multi-Touch или трекпад Magic Trackpad (или же комплект 
MagicWand) для компьютеров Mac.

Цель этой книги

В этой книге рассказывается о новой операционной системе из семей-
ства Mac OS X — OS X Mavericks, которая предлагает своим пользо-
вателям удобный и понятный интерфейс, огромный выбор практич-
ных инструментов и возможность персональной настройки рабочей 
среды .

Вы узнаете о возможностях операционной системы OS X Mavericks 
и получите необходимую информацию, которая позволит сделать ра-
боту за компьютером Mac максимально комфортной и удобной как для 
опытных пользователей, так и для тех, кто только начинает знакомство 
с операционными системами компании Apple.

Если вы раньше работали с подобными системами, то легко разбере-
тесь в назначении новых элементов пользовательского интерфейса 
системы OS X Mavericks. Новичкам же будет несколько сложнее, хотя 
эта книга, несомненно, сделает изучение операционной системы OS X 
более легким и приятным. Материалы, представленные на страницах 
книги, будут полезны и опытным пользователям, так как помогут сэко-
номить время и быстрее разобраться с нововведениями, которыми 
разработчики щедро одарили систему OS X Mavericks.

Так как в России большинство пользователей переходят на компьютеры 
Mac, уже имея некоторый опыт работы с компьютерами под управле-
нием операционной системы Windows, мы будем использовать в книге 
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ряд аналогий, которые помогут понять назначение тех или иных эле-
ментов. Также предполагается, что вы обладаете некоторыми навы-
ками работы на компьютере и знаете, как выполнить двойной щелчок 
мышью, работать с меню, имеете представление о назначении стан-
дартных элементов управления, таких как кнопки, флажки, переключа-
тели и т. д. Если вы раньше никогда не работали за компьютером, не 
переживайте — вы все равно сможете разобраться с тем, как работать 
в системе OS X, ведь здесь приведено много примеров и иллюстраций, 
на которых показано, с какими именно элементами следует работать 
в данный момент. Кроме того, в книге понятным и доступным даже для 
новичка языком подробно объясняются базовые принципы работы 
с операционной системой.

Из материалов этого издания вы также узнаете о назначении всех при-
ложений и служебных программ, которые входят в состав операцион-
ной системы OS X Mavericks (доступны на панели Dock и папке Про-
граммы (Application)).

Книга содержит 11 глав и 2 приложения, читая которые вы постепенно 
познакомитесь с различными приемами работы, призванными помочь 
при изучении операционной системы Mac OS X.

Глава 1 посвящена выбору компьютера Mac. Из нее вы узнаете о том, 
какие компьютеры выпускает компания Apple в настоящее время, а так-
же получите дополнительные знания, на базе которых сможете сделать 
выбор, какой же все-таки Mac вам подходит для решения поставлен-
ных задач: MacBook Air, MacBook Pro, Mac mini, iMac или Mac Pro.

В главе 2 вы познакомитесь с основными элементами операцион-
ной системы OS X: рабочим столом, приложением Finder и панелью 
Dock, а также узнаете, в чем состоит ценность таких нововведений, 
как вкладки приложения Finder и теги. Еще в этой главе мы расскажем 
о том, как управлять окнами, какие сочетания клавиш использовать, 
каково предназначение всплывающих подсказок и визуальных ори-
ентиров, а также о правилах работы со справочной системой в сре-
де OS X.

Из главы 3 вы узнаете о структуре каталогов операционной системы 
OS X и о том, как работать с папками и файлами. Изучив материалы 
главы, вы узнаете, как использовать контекстные меню, познакоми-
тесь со смарт-папками, а также научитесь копировать, перемещать, 
удалять и восстанавливать файлы и папки. Особое внимание уделе-
но правилам работы с папкой Корзина (Trash), так как правильное ис-
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пользование ее функциональных возможностей пригодится вам в бу-
дущем. А также здесь подробно объяснено, как использовать жесты 
Multi-Touch.

В главе 4 указаны подробные сведения о назначении приложений , ко-
торые входят в состав операционной системы OS X Mavericks, и прин-
ципах работы с ними. Вы узнаете, для чего нужна каждая программа 
из папки Программы (Application), и поймете назначение всех утилит, 
которые хранятся в папке Утилиты (Utilities).

В главе 5 мы расскажем о том, как можно использовать мультимедий-
ное приложение iTunes для воспроизведения аудио- и видеофайлов. 
Вы найдете подробные инструкции по настройке приложения iTunes 
и созданию медиатеки, получите информацию о различных способах 
добавления музыкальных файлов, видеороликов, фильмов, телешоу, 
подкастов и т. д. в базу приложения. Кроме того, вы узнаете, как с по-
мощью приложения iTunes покупать и воспроизводить музыкальные 
композиции, брать напрокат и смотреть фильмы, настраивать интер-
нет- радио, воспроизводить подкасты и обучающие материалы, а также 
о том, как создать собственные плейлисты.

В главе 6 рассказано о возможностях приложений iPhoto (редактиро-
вание и управление фотографиями и другими изображениями), iMovie 
(создание и обработка видеоматериалов), GarageBand (домашняя сту-
дия звукозаписи), Pages (текстовый редактор), Numbers (электронные 
таблицы) и Keynote (создание презентаций).

В главе 7 мы рассмотрим правила настройки локальной сети и подклю-
чения к Интернету. Здесь вы узнаете, с какими системами подключения 
может работать ваш компьютер и как настроить каждую из них. Прочи-
тав главу, вы легко разберетесь с сетями Ethernet, AirPort или FireWire, 
сможете подключить свой компьютер к Интернету и обеспечить доступ 
во Всемирную паутину другим компьютерам в вашей локальной сети. 
Кроме того, научитесь настраивать совместный доступ к файлам, кото-
рые хранятся на вашем компьютере, узнаете, что представляет собой 
функция AirDrop и как создавать гибридные сети.

Глава 8 описывает взаимодействие с веб-браузером Safari. Вы позна-
комитесь с интерфейсом программы, научитесь работать с вкладками, 
закладками, списками для чтения, со списком Top sites, боковым меню, 
общими ссылками и историей просмотра, сможете скачивать файлы 
на свой компьютер, отправлять веб-страницы по почте, сохранять их 
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или выводить на печать. Тем читателям, чьи дети уже умеют работать 
на компьютере, будет интересно узнать о средствах родительского 
контроля, которые помогут оградить ребенка от нежелательных веб-
ресурсов.

В главе 9 рассматриваются возможности почтовой программы Mail. 
Сначала вы научитесь создавать и настраивать собственную учетную 
запись, а потом узнаете, как проверить почту, создать и отправить 
собственное сообщение и ответить на входящее письмо. Вы сможете 
использовать бланки оформления и смарт-ящики, управлять вложе-
ниями и разговорами, сортировать электронную почту, настраивать 
фильтрацию входящих сообщений, просматривать контактные данные 
и адреса в приложении Карты (Maps), а также настраивать интерфейс 
приложения Mail.

В главе 10 рассказано, как можно защитить операционную систему 
OS X и свои личные данные от несанкционированного доступа. Вы 
узнаете о связках ключей и о системе шифрования данных FileVault. 
Часть этой главы посвящена полезному и ценному приложению 
Time Machine, с помощью которого вы будете создавать резервные 
копии и локальные моментальные снимки своих данных. Вы узнаете, 
как настроить Time Machine и восстановить файлы и папки в случае 
необходимости. Кроме резервного копирования, мы рассмотрим 
процедуру переустановки системы с помощью функции восстанов-
ления.

Глава 11 научит вас правильно использовать параметры настройки 
операционной системы OS X и эффективно применять внутренние эле-
менты управления. Прочитав главу, вы без труда настроите рабочий 
стол, панель Dock и приложение Finder по своему усмотрению, смо-
жете создать оптимальную рабочую среду: обеспечить универсальный 
доступ, настроить параметры монитора и других устройств (мыши, кла-
виатуры, трекпада, принтера), организовать общий доступ к файлам, 
принтерам, сканерам, Интернету и многое другое.

В приложении 1 мы расскажем о том, как самостоятельно устранить 
типичные проблемы, с которыми вы можете столкнуться во время ра-
боты с операционной системой OS X Mavericks.

В приложении 2 содержится описание самых интересных приемов 
и хитростей, зная о которых вы сможете быстрее добиться желаемого 
результата от операционной системы OS X.
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� Примечание. Обозначения клавиш в книге указаны с помощью 
символов, принятых в операционной системе OS X:

Клавиша Символ в книге

Command �

Option (Alt) ⌥

Control ⌃

Shift �

Delete ⌫

Caps Lock �

Tab �

Escape �

Клавиши с изображением стрелок ↑, ↓, ←, →

Ввод (Enter) �

Мы постарались создать книгу, где не просто рассматриваются осо-
бенности новой операционной системы OS X Mavericks, а постепенно 
создается целостная структура, благодаря которой вы сможете изучить 
и реализовать весь потенциал, заложенный разработчиками в этот по-
пулярный и надежный программный продукт.



Глава 1
Выбор компьютера Mac

Если у вас возникнет желание приобрести компьютер Mac, стоит за-
думаться, для каких задач он вам нужен, а также посетить магазин 
и взглянуть на «будущих кандидатов». После этого останется опреде-
лить, какой же компьютер Mac  подойдет вам лучше всего. В первую 
очередь нужно выбрать: ноутбук или настольный компьютер. Если вы 
заранее знаете, что у вас нет необходимости всегда держать компью-
тер под рукой и вы будете использовать его, только сидя за рабочим 
столом, тогда, разумеется, покупайте настольный компьютер. Если же 
вам необходима мобильность — стоит выбрать ноутбук, так вы полу-
чите надежного помощника, который станет одновременно и рабочей 
машиной, и центром развлечений. Кроме того, любой ноутбук фирмы 
Apple легко превратить в настольный компьютер, подключив к нему 
внешний монитор, клавиатуру, мышку или даже внешний жесткий диск. 
В этом случае ноутбук возьмет на себя функции обычного системного 
блока, как, например, Mac mini. При использовании дополнительного 
монитора вы будете видеть изображение и на экране ноутбука, и на 
внешнем мониторе, в результате чего получите сразу два рабочих дис-
плея. Чтобы было проще определиться с нужной вам моделью, посе-
тите официальный сайт компании Apple, где представлен подробный 
обзор всех компьютеров, представленных в настоящее время на рынке 
(store.apple.com/ru/mac/compare).

Независимо от того, какую модель вы решите приобрести, у всех ком-
пьютеров Mac есть общие черты. Во-первых, их собирают на базе мощ-
ных процессоров компании Intel и оснащают оперативной памятью 
не менее 4 Гб. Этого вполне достаточно для корпоративного или до-
машнего использования: создания документов, работы во Всемирной 
паутине, управления электронной почтой, воспроизведения музыки 
и просмотра фильмов или фотографий, запуска игр и т. д. Во-вторых, все 
компьютеры Mac можно подключить к внешнему дисплею или телеви-
зору, у них есть адаптеры Bluetooth и Wi-Fi, также они оснащены встро-
енными веб-камерами и микрофонами (кроме Mac mini и Mac Pro).

У всех компьютеров Mac есть приятное дополнение: не важно, какую 
модель компьютера вы решите купить, вместе с ним вы получите годо-
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вую гарантию и 90 дней бесплатной технической поддержки от специа-
листов компании Apple. С помощью услуги AppleCare Protection Plan вы 
сможете увеличить срок сервисного обслуживания до трех лет со дня 
покупки компьютера (store.apple.com/ru/browse/home/applecare).

Типы компьютеров Apple

Итак, вы решили приобрести компьютер фирмы Apple. Среди тех, кото-
рые в настоящее время предлагает компания, на рынке представлены 
следующие.

• MacBook Air. Эти ноутбуки очень функциональны и удобны в ис-
пользовании. Среди достоинств моделей MacBook Air следует отме-
тить полноразмерную клавиатуру, алюминиевый корпус и неболь-
шой вес. MacBook Air станет отличным решением для тех, кто часто 
находится в дороге, но при этом хочет иметь под рукой мобильный 
и мощный компьютер. Среди недостатков можно отметить отсут-
ствие дискретной (отдельной) видеокарты.

• MacBook Pro. Эти компьютеры прежде всего отличаются большими 
качественными экранами, дискретными видеокартами и высокой 
мощностью. Среди ноутбуков фирмы Apple модели MacBook Pro 
справедливо считаются самыми функциональными и производи-
тельными, поэтому станут прекрасным выбором для специалистов 
в области дизайна и геймеров.

• Mac mini. Эти компьютеры представляют собой самый миниатюр-
ный и относительно недорогой вариант. Среди недостатков можно 
отметить отсутствие дискретной (отдельной) видеокарты и сравни-
тельно невысокую производительность. Такое устройство является 
оптимальным вариантом для пользователей, которые хотят оце-
нить работу компьютеров Mac за небольшие деньги. При наличии 
хорошего монитора компьютер Mac mini можно превратить в до-
статочно серьезный центр аудио- и видеоразвлечений.

• iMac. Эти компьютеры со встроенным дисплеем подойдут боль-
шинству пользователей, которые предпочитают работать дома или 
в офисе.

• Mac Pro. Это самые мощные и надежные модели стационарных 
компьютеров среди всех, что производит компания Apple. Един-
ственный недостаток этих моделей — довольно высокая стоимость. 
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Компьютер Mac Pro справится с любыми сложными задачами: про-
фессиональной обработкой видео, аудио, 3D-моделированием 
и самыми современными играми.

Компьютеры Mac Pro, iMac и Mac mini — это стационарные компьюте-
ры, а MacBook Pro и MacBook Air — ноутбуки. Если вы не собираетесь 
профессионально заниматься обработкой видео или играть в ультра-
современные игры, вам вполне подойдет ноутбук MacBook Air или ста-
ционарный Mac mini. Если нужен универсальный и функциональный 
компьютер, тогда лучше взять ноутбук MacBook Pro или настольный 
компьютер iMac, так как ультратонкий ноутбук MacBook Air, хотя и спра-
вится с большинством возложенных на него задач, особой производи-
тельностью не отличается. И наконец, стационарный гигант Mac Pro — 
очень мощный и самый дорогой из всех компьютеров, выпускаемых 
фирмой Apple, который стоит покупать в том случае, когда вы точно 
знаете, зачем вам понадобились его мощности. А теперь рассмотрим 
внимательнее каждое семейство компьютеров Mac.

Ноутбук MacBook Air

Компьютеры MacBook Air  называют суперлегкими ноутбуками, и это 
верно, так как 11-дюймовый MacBook Air весит всего 1,08 кг, а 13- дюй-
мовый — всего 1,35 кг. Благодаря прочному корпусу, технологии Multi-
Touch, мощному аккумулятору и SSD-накопителям модели MacBook Air 
при толщине менее двух сантиметров остаются производительными 
и функциональными. Именно использование SSD-накопителей помог-
ло разработчикам добиться того, что модели MacBook Air вошли в раз-
ряд самых тонких и легких ноутбуков среди всех моделей разных про-
изводителей, представленных на рынке (рис. 1.1).

Рис. 1.1. Внешний вид ноутбука MacBook Air
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Компания Apple выпускает ноутбуки MacBook Air в алюминиевом кор-
пусе, который обеспечивает легкость, минимальную толщину и необ-
ходимую прочность.

Рассмотрим подробно различия в спецификациях и ценах1 на ноут-
буки MacBook Air. В табл. 1.1а представлены 11-дюймовые модели, 
а в табл. 1.1б — 13-дюймовые.

Табл. 1.1а. 11-дюймовые модели MacBook Air (различия)

Модель 11-дюймовый MacBook Air
SSD 128 Гб

11-дюймовый MacBook Air
SSD 256–512 Гб

Цена* 41 990 руб. 49 990 руб.

Процессор 
(двухъядер-
ный)

• Intel Core i5 с тактовой часто-
той 1,3 ГГц

• Intel Core i7 с тактовой часто-
той 1,7 ГГц (+5970 руб.)

• Intel Core i5 с тактовой часто-
той 1,3 ГГц

• Intel Core i7 с тактовой часто-
той 1,7 ГГц (+5970 руб.)

Оператив-
ная память

• 4 Гб DDR3 1600 МГц
• 8 Гб DDR3 1600 МГц 

(+4380 руб.)

• 4 Гб DDR3 1600 МГц
• 8 Гб DDR3 1600 МГц 

(+4380 руб.)

SSD-
накопитель

• 128 Гб • 256 Гб
• 512 Гб (+11 940 руб.)

* За базовую минимальную конфигурацию.

Таким образом, в максимальной конфигурации 11-дюймовый MacBook 
Air с 128 Гб SSD-накопителем обойдется в 52 340 руб., а модель с 512 Гб 
SSD-накопителем — в 72 280 руб.

Табл. 1.1б. 13-дюймовые модели MacBook Air (различия)

Модель 13-дюймовый MacBook Air
SSD 128 Гб

13-дюймовый MacBook Air
SSD 256–512 Гб

Цена* 45 990 руб. 53 990 руб.

Процессор 
(двухъядер-
ный)

• Intel Core i5 с тактовой частотой 
1,3 ГГц

• Intel Core i7 с тактовой частотой 
1,7 ГГц (+5970 руб.)

• Intel Core i5 с тактовой часто-
той 1,3 ГГц

• Intel Core i7 с тактовой часто-
той 1,7 ГГц (+5970 руб.)

Оператив-
ная память

• 4 Гб DDR3 1600 МГц
• 8 Гб DDR3 1600 МГц 

(+4380 руб.)

• 4 Гб DDR3 1600 МГц
• 8 Гб DDR3 1600 МГц 

(+4380 руб.)

SSD-
накопитель

• 128 Гб • 256 Гб
• 512 Гб (+11 940 руб.)

* За базовую минимальную конфигурацию.

1 Цены указаны по состоянию на конец 2013 года.
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Таким образом, в максимальной конфигурации 13-дюймовый MacBook 
Air с 128 Гб SSD-накопителем обойдется в 56 340 руб., а модель с 512 Гб 
SSD-накопителем — в 76 280 руб.

Помимо перечисленного, ноутбуки MacBook Air оборудованы интегри-
рованным графическим процессором Intel HD Graphics 5000 со встро-
енным модулем обработки видео, который обеспечивает плавное, чет-
кое и реалистичное воспроизведение при просмотре видео или при 
видеозвонках с использованием встроенной HD-камеры FaceTime. При 
производстве ноутбуков MacBook Air используются только SSD- нако-
пители, они в два раза быстрее обычных жестких дисков и позволяют 
создать ультратонкий корпус, так как занимают меньше места.

Бесспорным преимуществом компьютеров MacBook Air является глян-
цевый широкоформатный экран с подсветкой LED, который гарантирует 
высокое качество изображения и цветопередачи. Разрешение экрана 
ноутбуков значительно выше, чем у похожих моделей других произво-
дителей: для 11-дюймовых моделей оно составляет 1366×768 пиксе-
лов, а для 13-дюймовых — 1440×900 пикселов.

Ноутбуки MacBook Air выпускаются со встроенными адаптерами Wi-Fi 
и Bluetooth, с помощью которых вы сможете выйти в Интернет и про-
должить работу, где бы ни находились.

Благодаря технологии Thunderbolt к ноутбуку MacBook Air можно под-
ключить любые периферийные устройства. Кроме порта Thunderbolt 
ноутбуки MacBook Air оснащены двумя портами USB 3.0, разъемом пи-
тания MagSafe 2, разъемом для подключения наушников, разъемом для 
карты SDXC (в 13-дюймовой модели), а также встроенной HD-камерой 
FaceTime, стереодинамиками и микрофоном.

В ноутбуки MacBook Air устанавливаются мощные аккумуляторы, 
благодаря которым 11-дюймовые модели могут работать без подза-
рядки около 9 часов, а 13-дюймовые модели — около 12 часов. Но-
утбук MacBook Air очень быстро переходит в спящий режим (около 
2 секунд), если же вы оставите его в режиме сна более чем на час, 
он автоматически перейдет в режим ожидания. По словам разработ-
чиков, режим ожидания позволяет экономить заряд аккумуляторов, 
и вы сможете вернуться к работе через день, через неделю или даже 
через месяц.

Толщина корпуса составляет 1,7 см, длина — 30 см (32,5 см у 13- дюй-
мовой модели), ширина — 19,2 см (22,7 см у 13-дюймовой модели), 
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а вес — 1,08 кг (1,35 кг у 13-дюймовой модели). Несмотря на компакт-
ные размеры, MacBook Air выпускается с полноразмерной клавиатурой 
с подсветкой и специальным датчиком, автоматически регулирующим 
яркость экрана и клавиатуры в зависимости от уровня освещения.

Если вам нравится использовать в работе основные жесты и жесты 
Multi-Touch, вы по достоинству оцените трекпад ноутбука MacBook Air, 
так как он превосходно подходит для выполнения любых жестов.

Подробнее о возможностях и преимуществах компьютера MacBook 
Air вы можете прочитать на официальном сайте компании Apple 
(www.apple.com/ru/macbook-air/).

Ноутбук MacBook Pro

Ноутбуки MacBook Pro  предназначены для профессионального исполь-
зования и способны заменить стационарный компьютер. В настоящее 
время на рынке представлены ноутбуки MacBook Pro с диагональю 
экрана 13 и 15 дюймов (рис. 1.2).

Рис. 1.2. Внешний вид ноутбука MacBook Pro

Рассмотрим подробно различия в спецификациях и ценах на ноут-
буки MacBook Pro. В табл. 1.2а представлены 13-дюймовые модели, 
а в табл. 1.2б — 15-дюймовые.

Таким образом, в максимальной конфигурации 13-дюймовый MacBook 
Pro с 128 Гб SSD-накопителем обойдется в 79 270 руб., модель с 256 Гб 
SSD-накопителем — в 83 890 руб., а модель с 1024 Гб SSD-накопителем — 
в 113 410 руб.

В максимальной конфигурации как 15-дюймовый MacBook Pro с дис-
кретной видеокартой, так и модель без нее обойдется в 136 650 руб.
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Табл. 1.2а. 13-дюймовые модели MacBook Pro с дисплеем Retina (различия)

Модель 13-дюймовый 
MacBook  Pro
SSD 128 Гб

13-дюймовый 
MacBook  Pro
SSD 256 Гб

13-дюймовый 
MacBook Pro
SSD 512–1024 Гб

Цена* 52 990 руб. 61 990 руб. 73 990 руб.

Процессор 
(двухъядер-
ный)

• Intel Core i5 с такто-
вой частотой 2,4 ГГц

• Intel Core i5 с такто-
вой частотой 2,6 ГГц 
(+4380 руб.)

• Intel Core i7 с такто-
вой частотой 2,8 ГГц 
(+13 140 руб.)

• Intel Core i5 с такто-
вой частотой 2,4 ГГц

• Intel Core i5 с такто-
вой частотой 2,6 ГГц 
(+4380 руб.)

• Intel Core i7 с такто-
вой частотой 2,8 ГГц 
(+13 140 руб.)

• Intel Core i5 
с тактовой 
частотой 2,6 ГГц

• Intel Core i7 
с тактовой 
частотой 2,8 ГГц 
(+8760 руб.)

Оператив-
ная память

• 4 Гб DDR3 1600 МГц
• 8 Гб DDR3 1600 МГц 

(+4380 руб.)
• 16 Гб DDR3 1600 

МГц (+13 140 руб.)

• 8 Гб DDR3 1600 МГц
• 16 Гб DDR3 1600 

МГц (+8760 руб.)

• 8 Гб DDR3 
1600 МГц

• 16 Гб DDR3 
1600 МГц 
(+8760 руб.)

SSD- накопи-
тель

• 128 Гб • 256 Гб • 512 Гб
• 1024 Гб 

(+21 900 руб.)

* За базовую минимальную конфигурацию.

Табл. 1.2б. 15-дюймовые модели MacBook Pro с дисплеем Retina (различия)

Модель 15-дюймовый MacBook Pro 15-дюймовый MacBook Pro 
(с дискретной видеокартой)

Цена* 79 990 руб. 105 990 руб.

Процессор 
(четы-
рехъядер-
ный)

• Intel Core i7 с тактовой часто-
той 2,0 ГГц

• Intel Core i7 с тактовой часто-
той 2,3 ГГц (+4100 руб.)

• Intel Core i7 с тактовой часто-
той 2,6 ГГц (+12 860 руб.)

• Intel Core i7 с тактовой часто-
той 2,3 ГГц

• Intel Core i7 с тактовой часто-
той 2,6 ГГц (+8760 руб.)

Оперативная 
память

• 8 Гб DDR3 1600 МГц
• 16 Гб DDR3 1600 МГц 

(+8760 руб.)

• 16 Гб DDR3 1600 МГц

SSD- накопи-
тель

• 256 Гб
• 512 Гб (+13 140 руб.)
• 1024 Гб (+35 040 руб.)

• 512 Гб
• 1024 Гб (+21 900 руб.)

* За базовую минимальную конфигурацию.

У ноутбуков MacBook Pro более тонкий корпус, чем у похожих ноутбу-
ков других производителей, соответственно, они более легкие. В то же 
время ноутбуки MacBook Pro остается мощными, надежными и долго-
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вечными. Во всех MacBook Pro используются экраны с технологией Re-
tina, которая обеспечивает более качественное и яркое изображение. 
Экраны с технологией Retina отличаются крайне высокой плотностью 
пикселов, и человеческий глаз не способен заметить, что изображение 
состоит из них.

Встроенный мощный аккумулятор обеспечивает 13- и 15-дюймовым 
моделям 8–9 часов автономной работы.

Все ноутбуки MacBook Pro оснащаются современными процессорами: 
13-дюймовые модели — двухъядерными процессорами Intel Core i5 
с тактовой частотой 2,4–2,6 ГГц или процессорами Intel Core i7 с такто-
вой частотой 2,8 ГГц, а на 15-дюймовые модели устанавливаются четы-
рехъядерные процессоры Intel Core i7 с тактовой частотой 2,0–2,6 ГГц. 
Благодаря технологии Turbo Boost вы можете рассчитывать на увели-
чение в 1,5 раза тактовой частоты процессора при работе с ресурсо-
емкими приложениями, а интерфейс Thunderbolt обеспечит быстрое 
подключение высокоскоростных периферийных устройств.

Справиться со сложными задачами вам поможет графический процес-
сор Intel Iris Pro Graphics, который поддерживает высочайшее качество 
изображения при просмотре HD-фильмов в приложении iTunes и при 
видеозвонках с использованием HD-камеры FaceTime, позволяет мон-
тировать и конвертировать HD-видео и играть в современные игры. 
Вы можете подключить до двух внешних мониторов и объединить 
их для получения одного изображения с высочайшим разрешением. 
А 15- дюймовая модель MacBook Pro с дискретной видеокартой под-
держивает две графические системы, помимо Intel Iris Pro Graphics на 
этой ней установлен графический процессор NVIDIA GeForce GT 750M 
с 2 Гб памяти GDDR5, что существенно увеличивает производитель-
ность видеосистемы компьютера.

Разумеется, ноутбуки MacBook Pro оборудованы портом Thunderbolt 2, 
с помощью которого можно последовательно подключить несколько 
высокопроизводительных устройств, в том числе монитор высокого 
разрешения. Также компьютер оснащен двумя портами USB 3.0 и пор-
том HDMI для подключения мультимедийной аппаратуры. Кроме того, 
на корпусе вы обнаружите слот для карт памяти SDXC, разъем для на-
ушников и разъем питания MagSafe 2. Компьютеры MacBook Pro выпу-
скаются со встроенными адаптерами Wi-Fi и Bluetooth 4.0, с помощью 
которых вы сможете выйти в Интернет и продолжить работу, где бы ни 
находились.
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При создании аккумуляторных батарей для ноутбуков MacBook Pro ис-
пользуются передовые технологии, благодаря которым компьютеры 
могут работать без подзарядки около 8–9 часов.

Толщина корпуса составляет 1,8 см, длина — 31,4 см (35,9 см у 15- дюй-
мовой модели), ширина — 21,9 см (24,7 см у 15-дюймовой модели), 
а вес — 1,57 кг (2,02 кг у 15-дюймовой модели). Несмотря на компакт-
ные размеры, MacBook Pro выпускается с полноразмерной клавиатурой 
с подсветкой и специальным датчиком, автоматически регулирующим 
яркость экрана и клавиатуры в зависимости от уровня освещения.

Если вам нравится использовать в работе основные жесты и жесты 
Multi-Touch, вы по достоинству оцените трекпад ноутбука MacBook Pro, 
так как он превосходно подходит для выполнения любых жестов.

Подробнее о возможностях и преимуществах компьютера MacBook 
Pro вы можете прочитать на официальном сайте компании Apple 
(www.apple.com/ru/macbook-pro/).

Стационарный компьютер Mac mini

Компьютеры Mac mini  не зря называют миниатюрными, на момент на-
писания книги его длина/ширина составляла 19,7 см, а высота — всего 
3,6 см. Несмотря на столь скромные размеры, эти «малыши» способны 
вас удивить, так как оснащены современными процессорами, каче-
ственными графическими системами и современными интерфейсами 
передачи данных (рис. 1.3).

Рис. 1.3. Внешний вид компьютера Mac mini

Рассмотрим подробно различия в спецификациях и ценах на компью-
теры Mac mini  (табл. 1.3).

В максимальной конфигурации Mac mini i5 обойдется в 39 130 руб., мо-
дель Mac mini i7 — в 60 070 руб., а модель Mac mini i7 под управлением 
операционной системы OS X Server — в 84 990 руб.
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Табл. 1.3. Модели Mac mini (различия)

Модель Mac mini i5 Mac mini i7 Mac mini i7 OS X Server

Цена* 25 990 руб. 34 990 руб. 43 990 руб.

Процессор 
(двухъядерный 
для модели Mac 
mini i5; осталь-
ные — четы-
рехъядерный)

• Intel Core i5 
с тактовой 
частотой 2,5 ГГц

• Intel Core i7 с так-
товой частотой 
2,3 ГГц

• Intel Core i7 
с тактовой 
частотой 2,6 ГГц 
(+3980 руб.)

• Intel Core i7 с такто-
вой частотой 2,3 ГГц

• Intel Core i7 с такто-
вой частотой 2,6 ГГц 
(+3980 руб.)

Оперативная 
память

• 4 Гб DDR3 
1600 МГц

• 8 Гб DDR3 
1600 МГц 
(+4380 руб.)

• 16 Гб DDR3 
1600 МГц 
(+13 140 руб.)

• 4 Гб DDR3 
1600 МГц

• 8 Гб DDR3 
1600 МГц 
(+4380 руб.)

• 16 Гб DDR3 
1600 МГц 
(+13 140 руб.)

• 4 Гб DDR3 1600 МГц
• 8 Гб DDR3 1600 МГц 

(+4380 руб.)
• 16 Гб DDR3 1600 МГц 

(+13 140 руб.)

HDD/SSD- нако-
питель

• HDD 512 Гб • HDD 1024 Гб
• Fusion Drive 

1024 Гб 
(+7960 руб.)

• SSD 256 Гб 
(+7960 руб.)

• 2 HDD общим 
объемом 2048 Гб

• SSD 256 Гб 
(+7960 руб.)

• 2 SSD общим 
объемом 512 Гб 
(+23 880 руб.)

* За базовую минимальную конфигурацию

На компьютеры Mac mini фирма Apple устанавливает современные 
двухъядерные процессоры Intel Core i5 с тактовой частотой 2 2,5 ГГц или 
более мощные четырехъядерные процессоры Intel Core i7 с частотой 
2,3 и 2,6 ГГц. В качестве графической подсистемы Mac mini оснащены 
процессором Intel HD Graphics 4000, благодаря чему работа с ресурсо-
емкими графическими приложениями и играми выполняется макси-
мально быстро. Объем жесткого диска Mac mini i5 составляет 512 Гб 
(HDD), на Mac mini i7 по умолчанию установлен HDD-диск объемом 
1024 Гб, который вы вправе заменить на диск Fusion Drive1 объемом 
1024 Гб или даже SSD-диск объемом 256 Гб. В случае с Mac mini i7 OS X 
Server под корпусом скрываются два HDD, каждый объемом 1024 Гб, 
которые можно заменить на один или два SSD-диска объемом 256 Гб. 
На все компьютеры Mac mini устанавливается память DDR3 с частотой 
1600 МГц объемом 4, 8 или 16 Гб. Каждый Mac mini «знаком» с новейшей 
беспроводной технологией подключения к Интернету — AirPort, под-
держивает подключение к сетям через Wi-Fi и Ethernet-интерфейсы, 
а также позволяет устанавливать Bluetooth-соединение, посредством 

1 Технология объединения HDD- и SSD-дисков.
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которого вы сможете подключить внешние устройства, такие как бес-
проводная клавиатура и мышь.

В новых моделях Mac mini есть встроенный блок питания, а для их под-
ключения требуется меньше кабелей, благодаря технологии Thunderbolt, 
когда к одному порту одновременно подключается несколько внешних 
устройств. Также вы легко подключите свой Mac mini к внешнему мони-
тору или даже HD-телевизору (понадобится HDMI-кабель) через HDMI-
интерфейс. Кроме перечисленных разъемов, компьютеры Mac mini 
оснащены четырьмя портами USB 3.0, разъемом питания для подклю-
чения сетевого шнура, разъемом для карт памяти, а также интерфейсом 
FireWire 800, гнездами для подключения наушников и микрофона.

Компьютеры Mac mini не оснащаются приводами оптических дисков, 
и если он вам необходим, например, чтобы записывать диски, понадо-
бится приобрести внешний дисковод, подключаемый к компьютеру че-
рез USB-интерфейс, Apple USB SuperDrive.

Подробнее о возможностях и преимуществах компьютера Mac 
mini вы можете прочитать на официальном сайте компании Apple 
(www.apple.com/ru/mac-mini/).

Стационарный компьютер iMac

Компьютеры iMac  выпускаются с четырехъядерными процессорами, 
современными графическими системами, HD-камерой FaceTime и осна-
щены портами Thunderbolt. Компьютеры iMac созданы так, что в одном 
корпусе вы получаете монитор и системный блок (рис. 1.4).

Рис. 1.4. Внешний вид компьютера iMac
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Компания Apple выпускает компьютеры iMac  в алюминиевом корпусе, 
который обеспечивает легкость, компактность и необходимую проч-
ность.

Рассмотрим подробно различия в спецификациях и ценах на ком-
пьютеры iMac . В табл. 1.4а представлены 21,5-дюймовые модели, 
а в табл. 1.4б — 27-дюймовые. Таким образом, в максимальной конфи-
гурации 21,5-дюймовый iMac обойдется в 86 650 руб., а модель с дис-
кретной видеокартой — в 104 610 руб.

Табл. 1.4а. 21,5-дюймовые модели iMac (различия)

Модель 21,5-дюймовый iMac 21,5-дюймовый iMac (с дис-
кретной видеокартой)

Цена* 57 990 руб. 67 990 руб.

Процессор 
(четырехъядер-
ный)

• Intel Core i5 с тактовой 
частотой 2,7 ГГц

• Intel Core i5 с тактовой часто-
той 2,7 ГГц

• Intel Core i7 с тактовой часто-
той 3,1 ГГц (+7960 руб.)

Оперативная 
память

• 8 ГБ DDR3 1600 МГц
• 16 ГБ DDR3 1600 МГц 

(+8 760 руб.)

• 8 ГБ DDR3 1600 МГц
• 16 ГБ DDR3 1600 МГц 

(+8760 руб.)

HDD/SSD-
накопитель

• HDD 1024 Гб
• Fusion Drive 1024 Гб 

(+7960 руб.)
• SSD 256 Гб (+7960 руб.)
• SSD 512 Гб (+19 900 руб.)

• HDD 1024 Гб
• Fusion Drive 1024 Гб 

(+7960 руб.)
• SSD 256 Гб (+7960 руб.)
• SSD 512 Гб (+19 900 руб.)

* За базовую минимальную конфигурацию.

Таким образом, в максимальной конфигурации 27-дюймовый iMac 
обойдется в 147 070 руб., а его игровая версия с более мощной видео-
картой — в 170 000 руб.

На задней панели корпуса iMac вы найдете необходимые разъемы 
и гнездо для подключения сетевого шнура. Компьютеры iMac продают-
ся в комплекте с беспроводной клавиатурой и мышью Magic Mouse или 
трекпадом Magic Trackpad (на выбор). И мышь Magic Mouse, и трекпад 
Magic Trackpad предназначены для управления компьютером при по-
мощи жестов: основных или разработанных на базе технологии Multi-
Touch. Если вы серьезно настроены на изучение жестов Multi-Touch, 
лучше выбрать трекпад Magic Trackpad, так как с ним у вас будет боль-
ше пространства для выполнения жестов. При покупке iMac вам не 
придется тратить деньги на колонки, так как у компьютера есть встро-
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енные динамики, которые обеспечивают качественный звук и мини-
мально искажают звучание.

Табл. 1.4б. 27-дюймовые модели iMac (различия)

Модель 27-дюймовый iMac 27-дюймовый iMac
(игровой)

Цена* 80 990 руб. 89 990 руб.

Процессор 
(четырехъядер-
ный)

• Intel Core i5 с тактовой 
частотой 3,2 ГГц

• Intel Core i5 с тактовой ча-
стотой 3,4 ГГц

• Intel Core i7 с тактовой ча-
стотой 3,5 ГГц (+7960 руб.)

Оперативная 
память

• 8 Гб DDR3 1600 МГц
• 16 Гб DDR3 1600 МГц 

(+8760 руб.)
• 32 Гб DDR3 1600 МГц 

(+26 280 руб.)

• 8 Гб DDR3 1600 МГц
• 16 Гб DDR3 1600 МГц 

(+8760 руб.)
• 32 Гб DDR3 1600 МГц 

(+26 280 руб.)

HDD/SSD-
накопитель

• HDD 1024 Гб
• HDD 3072 Гб (+5970 руб.)
• Fusion Drive 1024 Гб 

(+7960 руб.)
• Fusion Drive 3072 Гб 

(+13 930 руб.)
• SSD 256 Гб (+7960 руб.)
• SSD 512 Гб (+19 900 руб.)
• SSD1024 Гб (+39 800 руб.)

• HDD 1024 Гб
• HDD 3072 Гб (+5970 руб.)
• Fusion Drive 1024 Гб 

(+7960 руб.)
• Fusion Drive 3072 Гб 

(+13 930 руб.)
• SSD 256 Гб (+7960 руб.)
• SSD 512 Гб (+19 900 руб.)
• SSD1024 Гб (+39 800 руб.)

Видеокарта • NVIDIA GeForce GT 755M 
с 1024 Мб памяти GDDR5

• NVIDIA GeForce GT 775M 
с 2048 Мб памяти GDDR5

• NVIDIA GeForce GT 780M 
с 4096 Мб памяти GDDR5

* За базовую минимальную конфигурацию.

Компьютеры iMac выпускаются с большими широкоформатными 
21,5- или 27-дюймовыми экранами со сплошным стеклянным покры-
тием. На моделях iMac экран занимает практически всю переднюю 
панель корпуса. Для 21,5-дюймовых экранов разрешение составля-
ет 1920×1080 пикселов, а для 27-дюймовых используется технология, 
которая позволяет поддерживать разрешение 2560×1440 пикселов. 
Экраны компьютеров iMac оснащены LED-подсветкой, гарантирующей 
непревзойденную четкость и яркость изображения. А благодаря тех-
нологии IPS обеспечивается качественное изображение при взгляде 
на экран сбоку (угол обзора составляет 178°).

Все модели компьютеров iMac выпускаются с четырехъядерными про-
цессорами Intel Core i5 (предусмотрена возможность установки че-
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тырехъядерного процессора Intel Core i7). Объем жесткого диска по 
умолчанию составляет 1024 Гб, а количество памяти DDR3 — 8 Гб. В по-
следнем случае вы можете увеличить объем оперативной памяти до 
16 Гб (в 21,5-дюймовой модели) или до 32 Гб (в 27-дюймовой модели).

Графическая подсистема достойна отдельного восхищения. 21,5 дюй-
мовые модели оснащаются или новейшим встроенным графическим 
процессором Intel Iris Pro Graphics, или дискретной видеокартой по-
следнего поколения NVIDIA GeForce GT 750M с 1024 Мб графической 
памяти стандарта GDDR5. На 27-дюймовые модели устанавливаются 
дискретные видеокарты NVIDIA GeForce GT 755M с 1024 Мб графиче-
ской памяти стандарта GDDR5. Игровая же версия 27-дюймовой мо-
дели предлагает выбор между видеокартой NVIDIA GeForce GTX 775M 
(2048 Мб памяти GDDR5) и NVIDIA GeForce GTX 780M (уже с 4096 Мб 
памяти GDDR5). Модель NVIDIA GeForce GTX 780M являлась самой мощ-
ной видеокартой на момент написания книги.

Компьютеры iMac оснащены самыми современными интерфейсами 
передачи данных. Используя интерфейс Thunderbolt, вы можете под-
ключать высокопроизводительные периферийные устройства. Корпу-
сы iMac оборудованы сразу двумя портами Thunderbolt.

Кроме того, компьютеры iMac также оснащены четырьмя портами 
USB 3.0 и одним портом Gigabit Ethernet. Этого вполне достаточно, что-
бы подсоединить любые периферийные устройства: iPad, iPod, iPhone , 
цифровую камеру, мобильный телефон, внешний жесткий диск и дру-
гие устройства, а также подключиться к сети. В дополнение к этому на 
компьютерах iMac есть встроенный разъем SDXC, который позволяет 
работать с картами памяти. Теперь, чтобы перенести фотографии или 
видеозаписи с камеры на компьютер iMac, достаточно вставить карту 
памяти в разъем SDXC и импортировать данные в базу приложения 
iPhoto . Также на корпусе вы найдете разъем для подключения наушни-
ков и встроенный микрофон.

Как и Mac mini, компьютер iMac поддерживает беспроводную техноло-
гию AirPort для подключения к Интернету, позволяет подсоединяться 
к Wi-Fi-сетям и устанавливать Bluetooth-соединение.

Компьютеры iMac выпускаются с HD-камерой FaceTime, которая обе-
спечивает отличное качество изображения. Вы сможете легко устано-
вить видеосвязь с другими компьютерами Mac, а также пользователя-
ми устройств под управлением операционной системы iOS: iPad, iPhone  
или iPod touch.
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Подробнее о возможностях и преимуществах компьютера iMac вы мо-
жете прочитать на официальном сайте компании Apple (www.apple.
com/ru/imac/).

Стационарный компьютер Mac Pro

Mac Pro  по праву считается самым мощным стационарным компью-
тером из серии Mac. Это профессиональный компьютер, который по-
строен на базе производительного четырех- или шестиядерного про-
цессора Intel Xeon E5 с тактовой частотой до 3,7 ГГц, двух графических 
процессоров AMD FirePro D300 или D500 с видеопамятью объемом до 
6 Гб, SSD-накопителя емкостью 256 Гб и оперативной памяти объемом 
12-16 Гб. Разумеется, комплектующие могут быть заменены на более 
производительные. Дизайн нового Mac Pro уникален и безупречен 
(рис. 1.5).

Рис. 1.5. Внешний вид компьютера Mac Pro

Рассмотрим различия в спецификациях на компьютеры Mac Pro 
(табл. 1.5).

Таким образом, в максимальной конфигурации обе модели iMac Pro 
обойдутся в 413 270 руб.

Несмотря на свою мощность, такой компьютер полностью соответству-
ет требованиям экономичности и энергопотребления. Кроме того, но-
вые модели Mac Pro полностью собираются в США.

Подробнее о возможностях и преимуществах компьютера Mac 
Pro вы можете прочитать на официальном сайте компании Apple 
(www.apple.com/ru/macpro).
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Табл. 1.5. Модели Mac Pro (различия)

Модель Mac Pro четырехъядерный 
процессор

Mac Pro шестиядерный 
процессор

Цена* 124 990 руб. 167 990 руб.

Процессор • Intel Xeon E5 с тактовой частотой 
3,7 ГГц (4 ядра)

• Intel Xeon E5 с тактовой частотой 
3,5 ГГц (6 ядер) (+21 000 руб.)

• Intel Xeon E5 с тактовой частотой 
3,0 ГГц (8 ядер) (+86 800 руб.)

• Intel Xeon E5 с тактовой частотой 
2,7 ГГц (12 ядер) (+152 500 руб.)

• Intel Xeon E5 с тактовой 
частотой 3,5 ГГц (6 ядер)

• Intel Xeon E5 с тактовой 
частотой 3,0 ГГц (8 ядер) 
(+65 700 руб.)

• Intel Xeon E5 с тактовой 
частотой 2,7 ГГц (12 ядер) 
(+131 400 руб.)

Оператив-
ная память

• 12 ГБ DDR3 1866 МГц
• 16 ГБ DDR3 1866 МГц (+4380 руб.)
• 32 ГБ DDR3 1866 МГц (+21 900 руб.)
• 64 ГБ DDR3 1866 МГц (+56 940 руб.)

• 16 ГБ DDR3 1866 МГц
• 32 ГБ DDR3 1866 МГц 

(+17 520 руб.)
• 64 ГБ DDR3 1866 МГц 

(+52 560 руб.)

HDD/SSD-
накопитель

• SSD 256 Гб
• SSD 512 Гб (+13 140 руб.)
• SSD 1024 Гб (+35 040 руб.)

• SSD 256 Гб
• SSD 512 Гб (+13 140 руб.)
• SSD 1024 Гб (+35 040 руб.)

Видеокарта • AMD FirePro D300 2048 Мб памяти 
GDDR5 (2 карты)

• AMD FirePro D500 3072 Мб памяти 
GDDR5 (2 карты) (+17 520 руб.)

• AMD FirePro D700 6144 Мб памяти 
GDDR5 (2 карты) (+43 800 руб.)

• AMD FirePro D500 3072 Мб 
памяти GDDR5 (2 карты)

• AMD FirePro D700 6144 Мб 
памяти GDDR5 (2 карты) 
(+26 280 руб.)

* За базовую минимальную конфигурацию.

Подготовка к установке Mac OS X 10.9 Mavericks

С помощью этой небольшой инструкции вы сможете подготовить свой 
компьютер Mac к переходу на новую операционную систему. Итак…

• Первое, что нужно сделать перед установкой любого программного 
обеспечения, — это проверить свой компьютер на совместимость. 
Для просмотра системных требований обратитесь к введению дан-
ной книги.

• Затем рекомендуется установить все обновления операционной 
системы OS X. Для этого достаточно подключиться к Интернету, вы-
полнить команду меню  ⇒ Обновление ПО (  ⇒ Software Up-
date) либо щелкнуть мышью по значку  на панели Dock и перей-
ти на вкладку Обновления (Updates). Вы увидите все доступные на 
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данный момент обновления. Чтобы установить их, нажмите кнопку 
Обновить все (Update All).

• При установке глобального обновления существует риск потерять 
ценную информацию, хранящуюся в памяти компьютера. Поэтому 
перед установкой OS X Mavericks рекомендуется сделать резерв-
ную копию системы. Проще всего для этого использовать приложе-
ние Time Machine, как описано в главе 10 данной книги.

• Рекомендуется проверить системный раздел на наличие ошибок. 
Это можно сделать с помощью программы Дисковая утилита (Disk 
Utility), как описано в приложении 1.

Теперь можно приступать к установке и попутно знакомиться с новой 
операционной системой OS X Mavericks, читая эту книгу.



Глава 2
Обзор операционной 
системы OS X Mavericks

Первое, чему вам следует научиться, приступая к работе с операци-
онной системой OS X, — это использовать функциональные возмож-
ности вашего компьютера. Именно поэтому работу следует начать со 
знакомства с рабочим столом и программой Finder. Если вы работали 
с другими операционными системами, например Windows, тогда у вас 
есть основные навыки работы на компьютере: вы отличаете ярлыки 
программ и документов друг от друга, знаете, что такое папки, умее-
те пользоваться мышью и выполнять несложные действия (открывать 
папки и файлы, запускать файлы программы и т. д.). В операционной 
системе OS X многие из них выполняются аналогично.

Итак, изучив эту главу, вы узнаете, что представляет собой рабочий 
стол системы OS X, научитесь взаимодействовать с приложением Fin-
der и панелью Dock, узнаете основные сочетания клавиш. Кроме того, 
сможете пользоваться всплывающими подсказками и визуальными 
ориентирами, а также работать со справочными материалами опера-
ционной системы OS X.

Первый запуск

После первого включения компьютера под управлением операцион-
ной системы OS X Mavericks вы увидите экран авторизации, на котором 
вам нужно представиться системе: указать данные своей учетной за-
писи Apple ID (рис. 2.1).

� Примечание. Если вы еще не создали учетную запись Apple ID, то 
можете сделать это прямо на экране авторизации, щелкнув мышью 
по ссылке Создать новый Apple ID (Create Apple ID), и, следуя ин-
струкциям на экране, зарегистрировать новый аккаунт.
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Рис. 2.1. Экран авторизации с Apple ID

1. Указав адрес электронной почты и пароль своей учетной записи 
Apple ID, нажмите кнопку Продолжить (Next).

2. Нажмите кнопку Разрешить (Allow), чтобы разрешить поиск дан-
ного компьютера с помощью функции Найти Mac (Find Mac). В про-
тивном случае нажмите кнопку Не сейчас (Not now).

3. Прочитайте условия лицензионного соглашения, и нажмите кноп-
ку Принять (Accept) и подтвердите свое решение в открывшемся 
окне, нажав кнопку Принимаю (Accept).

Система идентифицирует вас как пользователя и предоставит права 
доступа, заданные соответствующими настройками. При каждом сле-
дующем включении компьютера вместо экрана авторизации будет по-
являться экран входа в систему (рис. 2.2).

� Примечание. В нижней части окна экрана входа в систему рас-
положены следующие кнопки: Режим сна (Sleep), Перезагрузить 
(Restart), Выключить (Shut Down). Если вы нажмете кнопку Режим 
сна (Sleep), компьютер перейдет в спящий режим, нажатие кнопки 
Перезагрузить (Restart) приведет к перезагрузке, а кнопка Вы-
ключить (Shut Down) — выключит компьютер.
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Рис. 2.2. Экран входа в систему

Чтобы войти в систему, сделайте следующее: на экране входа щелкните 
мышью по имени своей учетной записи, введите пароль и нажмите на 
клавиатуре клавишу �.

� Примечание. Если вы — единственный пользователь компьютера 
и при этом не установили пароль для защиты своей учетной записи, 
экран входа в систему не появится, и вы увидите сразу экран опе-
рационной системы. Однако не рекомендуется столь халатно отно-
ситься к личной информации, лучше всегда использовать пароль, 
так как вы не сможете постоянно контролировать свой компьютер.

Если вы ошиблись и выбрали чужую учетную запись, еще раз щелкните 
по ее имени или аватару (изображению), чтобы вернуться в окно входа 
в систему.

При вводе пароля обратите внимание на следующие моменты.

• Прежде всего, вы не увидите символы, которые будете вводить, си-
стема заменяет каждый из них знаком * (звездочка). Так делается 
для того, чтобы никто из посторонних не смог подсмотреть пароль, 
когда вы его вводите.
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• При создании учетной записи всегда заполняйте поле подсказки, 
так как она поможет вспомнить пароль, если вы его забудете.

• Если система не принимает пароль, но вы уверены, что вводите его 
правильно, посмотрите, не нажата ли клавиша �, и верна ли теку-
щая раскладка клавиатуры: возможно, вы набираете пароль в ки-
риллической раскладке.

После того как введете свой пароль и нажмете клавишу �, вы увидите 
рабочий стол. Теперь можно смело переходить к изучению возможно-
стей и особенностей новой операционной системы компании Apple — 
OS X Mavericks.

Важно отметить, что если за вашим компьютером работают несколь-
ко человек, желательно создать отдельную учетную запись для каждо-
го пользователя. Это, прежде всего, продиктовано структурой папок, 
которая используется в операционной системе, а также поможет рас-
пределить права доступа к настройкам и инструментам системы в со-
ответствии с уровнем каждого пользователя (новичок, опытный поль-
зователь или администратор). Когда вы создадите несколько учетных 
записей, все они будут отображаться в окне входа в систему при за-
грузке компьютера. Для каждой учетной записи система будет отобра-
жать имя и аватар (небольшое изображение), которые вы присвоите 
пользователю при добавлении.

Рабочий стол

Рабочий стол  представляет собой объемный интерфейс, фоном кото-
рого в операционной системе OS X Mavericks является изображение 
волны (по умолчанию). Здесь размещаются различные объекты, кото-
рые вы будете использовать в процессе работы (рис. 2.3).

Рассмотрим структуру рабочего стола.

В верхней его части находится строка меню, а на ней ряд элементов: 
, Finder, Файл (File), Правка (Edit), Вид (View), Переход (Go), Окно 

(Window) и Справка (Help). Внешний вид строки меню меняется в за-
висимости от того, какое приложение активно на данный момент. В ее 
правой части находятся системные элементы управления.

Если у вас еще нет опыта работы с операционной системой OS X, их на-
значение может быть непонятно с первого взгляда. 



42 Глава 2

Рис. 2.3. Рабочий стол операционной системы OS X Mavericks

Прежде всего, нужно запомнить, что в строке меню в раскрывающихся 
списках находятся важнейшие команды, которыми вы будете пользо-
ваться постоянно. Рассмотрим подробно каждый элемент.

• Меню , оформленное фирменным логотипом , содержит систем-
ные команды, при помощи которых вы можете управлять своим 
компьютером. Например, Режим сна (Sleep), Перезагрузить (Re-
start) и Выключить (Shut Down). Эти команды доступны всегда не-
зависимо от того, с какой именно программой вы работаете.

• Меню Finder  отображает команды, относящиеся к программе, ко-
торую вы используете в настоящий момент. Обычно оно содержит: 
пункт О программе (About), при помощи которого вы можете бы-
стро определить, какая версия программы используется, пункт 
Настройки (Preferences), открывающий окно, в котором вы смо-
жете изменить настройки активного приложения, а также коман-
ды Скрыть остальные (Hide Others) или Показать все (Show All), 
которые помогают управлять окнами на рабочем столе. Имя меню 
Finder меняется при запуске приложений, но его содержание оста-
ется приблизительно одинаковым.

• Меню Файл (File)  заключает в себе команды, при помощи которых 
можно открыть, сохранить, просмотреть, закрыть папки и файлы 
и выполнить с ними другие операции.
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• В меню Правка (Edit)  доступны команды отмены и повторения по-
следнего действия, Вырезать (Cut), Копирование (Copy), Вставить 
(Paste), а также функции просмотра содержимого буфера обмена 
и вставки специальных символов.

• В меню Вид (View)  находятся команды, которые позволяют управ-
лять внешним видом окон. Например, для приложения Finder вы 
сможете выбрать режимы просмотра в виде значков (Icon View), 
списка (List View), колонок (Column View) или Cover Flow .

• Меню Переход (Go)  содержит команды, которые позволяют быстро 
перемещаться по папкам на компьютере. Например, выбрав пункт 
Недавно использованные папки (Recent Folders), вы сможете сра-
зу перейти к папкам, с содержимым которых работали накануне,.

• В меню Окно (Window)  находятся команды, которые дают возмож-
ность сворачивать окна, изменять их размер или использовать дру-
гие функции управления открытыми окнами.

• Меню Справка (Help)  предназначено для поиска справочных све-
дений о том, как работать с операционной системой OS X. Все от-
веты можно получить, используя окно Справочный центр (Help 
Center).

• Системные значки  в правой части строки меню также часто назы-
вают расширениями меню (Menu Extras). Каждый из них одновре-
менно является и индикатором, и меню, которое обеспечивает пря-
мой доступ к элементам настройки. Например, значок  позволяет 
управлять громкостью звука и т. д.

При желании вы можете перемещаться по пунктам в строке меню, ис-
пользуя только клавиатуру. Чтобы получить доступ к любому меню, до-
статочно нажать сочетание клавиш ⌃+F2, и система выделит первый 
пункт в строке (меню ). В ноутбуках для перехода к строке меню ис-
пользуется сочетание клавиш fn+⌃+F2. Для перемещения по пунктам 
меню вам понадобятся клавиши → и ← или клавиша �, чтобы открыть 
следующий пункт, а также сочетание клавиш �+�, чтобы вернуться 
в предыдущее меню. Выбрав нужный пункт, нажмите клавишу �, чтобы 
увидеть список доступных команд, и используйте клавиши ↑ и ↓, чтобы 
выбрать нужную. Если вы хотите быстро перейти к искомой команде, 
нажмите на клавиатуре клавишу, которая соответствует первой букве 
в названии нужной команды меню. Когда вы выберете одну из команд, 
система выделит ее подсветкой. Активируйте выбранную команду, на-
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жав клавишу �. Чтобы выйти из меню, используйте сочетание клавиш 
�+. или клавишу �.

В правом верхнем углу рабочего стола вы увидите значки жесткого дис-
ка и любых других накопителей, подключенных к компьютеру.

� Примечание. Если вы хотите скрыть на рабочем столе значок, на-
пример жесткого диска, выполните команду меню Finder ⇒ На-
стройки (Finder ⇒ Preferences) и в окне Настройки Finder (Pre-
ferences Finder) на вкладке Основные (General) сбросьте флажки 
напротив тех объектов, которые не хотите видеть: жесткие диски, 
внешние диски и т. д. Теперь вы сможете найти их значки на боко-
вой панели окна Finder или если выполните команду меню Пере-
ход ⇒ Компьютер (Go ⇒ Computer).

В нижней части рабочего стола располагается панель Doc k, а на ней — 
значки приложений и различных папок, включая Корзина (Trash). Па-
нель Dock нужна для быстрого запуска программ, с которыми вы часто 
работаете, а также для управления файлами, папками и дисками, актив-
ными в данный момент.

Приложение Finder

Операционная система OS X предлагает широкий выбор приложений, 
с которыми вы можете работать, но чаще всего будет востребовано 
приложение Finder , автоматически загружаемое при запуске опера-
ционной системы, так как оно позволяет просматривать ваши папки 
и файлы. Если щелкнуть мышью по значку  на панели Dock, откроет-
ся окно Finder. Чтобы убедиться, что это приложение в данный момент 
активно, посмотрите на строку меню: там должно отображаться слово 
Finder.

Окно Finder содержит ряд элементов, с назначением которых вам нуж-
но познакомиться (рис. 2.4).

Изучим основные элементы окна Finder.

В самом верху находится заголовок Finder, который поможет быстро 
определить, в какой папке вы находитесь в данный момент, просто 
взглянув на него. Ниже расположена панель инструментов, на которой 
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размещены полезные и важные кнопки и элементы. Если вы нажмете 
кнопку , окно Finder (впрочем, как и любое другое) закроется; кнопку 

 — оно свернется (минимизируется) в панель Dock, а если нажмете 
 — окно изменится в размерах. 

Рис. 2.4. Окно Finder и его элементы

Эти кнопки выполняют такие же функции в окнах любых других прило-
жений. Используя кнопки , вы сможете быстро перемещаться впе-
ред и назад по просмотренным ранее папкам. Кнопки выбора режима 
просмотра позволяют изменить представление данных в окне Finder: 
если нажать кнопку , файлы и папки будут отображаться в виде 
значков, кнопку  — в виде списка, кнопку  — в виде колонок, 
а если нажать кнопку  — в графическом виде CoverFlow . Кнопка  
позволяет выбрать режим сортировки объектов в окне, например по 
имени, по типу, по ассоциации с программой, по дате изменения и т. п. 
Кнопка  предоставляет доступ к контекстному меню или, как его 
принято называть, меню быстрого доступа , в котором представлены 
основные команды, доступные для выбранного объекта. Принципы ис-
пользования контекстных меню мы рассмотрим в главе 3. Кнопка  
предназначена для отправки выбранного файла (или файлов) в тексто-
вом сообщении или по электронной почте. Для файлов разного форма-
та в этом меню отображаются различные команды, например, помимо 
перечисленных двух команд для изображений возможна публикация 
в социальных сетях Facebook, Twitter и Flickr. Кнопка  служит для 
быстрого присваивания выбранным объектам цветовых тегов. Они 
служат для быстрой фильтрации файлов. Правее на панели инструмен-



46 Глава 2

тов окна Finder расположено поле поиска, которое позволяет быстро 
найти нужные файлы и папки в окне Finder.

Ниже панели инструментов расположены вкладки окон программы 
Finder. Режим вкладок активируется выбором команды меню Вид ⇒ По-
казать панель вкладок (View ⇒ Show Tab Bar).

В левой части окна Finder находится боковая панель , на которой вы 
найдете значки дисков и основных папок, в том числе и общего доступа 
(появляются при наличии подключения к сети), необходимых вам в про-
цессе работы. Кроме того, на боковой панели отображен список цвето-
вых тегов, с помощью которых удобно отфильтровывать файлы в окне 
программы Finder. Подробнее о тегах рассказывается чуть позже .

Перетаскивая границу боковой панели, вы сможете изменить ее разме-
ры так, как вам удобно. Кроме того, разрешается скрыть панель инстру-
ментов и боковую панель окна Finder, выполнив следующие действия.

• Нажав и удерживая клавишу ⌃, щелкните мышью по панели ин-
струментов и выберите команду меню Скрыть панель инструмен-
тов (Hide toolbar).

• Чтобы вернуть окно Finder в первоначальное состояние, следует, 
нажав и удерживая клавишу ⌃, щелкнуть мышью по заголовку окна 
и выбрать команду меню Показать панель инструментов (Show 
toolbar).

Вы можете изменять размеры окна Finder. Для этого достаточно уста-
новить указатель мыши на любой край или угол окна и, нажав и удер-
живая кнопку мыши, переместить последнюю в нужном направлении. 
А если навести указатель мыши на панель инструментов, а затем, нажав 
и удерживая кнопку мыши, передвинуть последнюю, можно поместить 
окно в любую позицию на рабочем столе.

При желании вы можете настроить управляющие элементы окна Fin-
der. О том, как это сделать, рассказывается в главе 11.

Боковая панель

В верхней части боковой панели находится группа Избранное (Favo-
rites) со значками папок на вашем компьютере, а в некоторых случаях 
и значок домашней папки (с именем вашей учетной записи на англий-
ском языке).
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� Примечание. Если вы хотите отобразить значок домашней папки 
в окне приложения Finder, выполните команду меню Finder ⇒ На-
стройки (Finder ⇒ Preferences) и на вкладке Боковое меню (Side-
bar) открывшегося окна установите флажок напротив имени вашей 
домашней папки со значком . После этого значок с именем учет-
ной записи появится на боковой панели окна Finder.

Ниже находится группа Общий доступ (Shared) со значками других 
компьютеров или жестких дисков, к которым вы можете подключать-
ся через локальную сеть. Если вы не настраивали локальную сеть или 
ваш компьютер к ней не подключен, тогда этого раздела на боковой 
панели не будет. Основы создания локальной сети мы рассмотрим 
в главе 7.

Под группой Общий Доступ (Shared) вы можете увидеть раздел 
Устройства (Devices), который содержит значки накопителей: жестких 
дисков, сетевых устройств, приводов CD или DVD, а также других съем-
ных накопителей (например, iPod). Чтобы просмотреть содержимое 
накопителя, щелкните мышью по соответствующему значку. Если на-
против значка накопителя вы увидите значок , значит, этот носитель 
является съемным. Другими словами, это может быть CD/DVD-привод, 
iPod, внешний жесткий диск или даже другой компьютер, подключен-
ный по локальной сети. Если вы щелкнете мышью по этому значку, си-
стема извлечет CD/DVD-диск, отключит внешнее устройство или разо-
рвет связь с другим компьютером.

Вы можете изменить содержимое боковой панели окна Finder в любое 
время по своему усмотрению: добавить или удалить папки и докумен-
ты. Под этой возможностью подразумевается, что вы можете разме-
стить на боковой панели любые объекты, и это значительно упростит 
вам доступ к нужным файлам, папкам и приложениям, которые вы ак-
тивно используете. При изменении боковой панели помните, что все 
элементы, которые вы добавите на боковую панель, являются псев-
донимами (аналогами ярлыков в операционной системе Windows) 
и только ссылаются на реальные файлы. Каждый псевдоним, который 
вы поместили на боковую панель или который находится там по умол-
чанию, может указывать на файл, физически находящийся в любом 
месте на диске вашего компьютера. Если вы удалите значок с боковой 
панели, то всего лишь удалите псевдоним, а реальный файл останется 
на прежнем месте.



48 Глава 2

Чтобы изменить содержимое боковой панели, выполните следующие 
действия:

• чтобы добавить папку (файл) на боковую панель, перетащите его 
мышью в область панели;

• чтобы добавить на боковую панель значок устройства или папки, 
откройте окно Настройки Finder (Finder preferences) и установите 
флажки напротив тех элементов, которые вы хотите видеть на бо-
ковой панели окна Finder. Более подробно о способах настройки 
окна Finder вы узнаете в главе 11;

• чтобы удалить значок из боковой панели, перетащите его в любую 
позицию за ее пределы, например на рабочий стол.

Прежде чем заняться изменением содержимого боковой панели, сна-
чала следует поближе познакомиться с операционной системой OS X, 
разобраться с основными папками и устройствами, а затем выбрать те, 
которые вам необходимы.

Режимы просмотра файлов и папок

Помимо режима отображения объектов в окне Finder доступна функ-
ция предварительного просмотра любого файла (и даже нескольких 
файлов) — текстового документа, графического изображения и т. д. — 
без запуска соответствующего приложения. Для этого выделите один 
или несколько файлов, а затем нажмите клавишу Пробел, чтобы по 
очереди увидеть выбранные файлы в режиме предварительного про-
смотра (рис. 2.5).

В операционной системе OS X предусмотрено несколько режимов ото-
бражения элементов в окне Finder: в виде значков (Icon View), в виде 
списка (List View), в виде колонок (Column View) или в режиме Cover-
Flow . Эта возможность удобна еще и тем, что переключаться между ре-
жимами вы можете нажатием нужной кнопки на панели инструментов 
окна Finder.

� Совет. Независимо от того, какой режим отображения вы выбра-
ли, всегда можно открыть папку в отдельном окне. Для этого, нажав 
и удерживая клавишу �, дважды щелкните мышью по нужной папке .
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Рис. 2.5. Работа в режиме быстрого предварительного просмотра

• Чтобы отобразить содержание окна Finder в режиме значков, нуж-
но нажать кнопку  на панели инструментов. Если вы выберете 
этот режим, операционная система отобразит все файлы и папки 
в виде миниатюр (рис. 2.6).

Рис. 2.6. Просмотр содержимого окна Finder в режиме значков
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• При выборе режима просмотра в виде списка (кнопка ) вы смо-
жете также удобно сортировать файлы: в алфавитном порядке (по 
именам), по дате последнего изменения, по типу и т. д.

Режим просмотра в виде списка удобен еще и тем, что в нем вы можете 
одновременно просматривать содержимое вложенных папок (рис. 2.7).

Рис. 2.7. Просмотр содержимого окна Finder в режиме списка

По умолчанию файлы сортируются по алфавиту (по возрастанию), при 
этом заголовок колонки Имя (Name) выделен голубым цветом. Если вы 
хотите изменить порядок сортировки, щелкните мышью по заголовку 
соответствующей колонки. Если нужная колонка не видна, увеличьте 
размеры окна или переместите вправо бегунок полосы прокрутки, ко-
торая находится внизу.

� Совет. Также по умолчанию файлы сортируются по возрастанию. 
Если вы хотите изменить тип сортировки, вам нужно еще раз щелк-
нуть мышью по заголовку выбранной колонки. Если треугольник 
направлен вершиной вверх, значит, выбрана сортировка по воз-
растанию, а если вершиной вниз — по убыванию.

При работе в этом режиме просмотра вам нужно помнить, что, дважды 
щелкнув мышью по значку папки, вы откроете ее содержимое в том же 
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окне Finder. А чтобы просмотреть содержимое вложенных папок в окне 
Finder, щелкните мышью по треугольнику слева от нужной папки .

• При выборе режима просмотра содержимого окна Finder в виде ко-
лонок (кнопка ) вы будете не только просматривать выбранную 
папку или жесткий диск, но и отслеживать местоположение каждо-
го файла. Этот режим просмотра считается самым информативным 
и наглядным: вы сможете просматривать другие папки, не покидая 
текущей, а при выборе конкретного файла сразу увидите основные 
данные о нем: тип, размер и т. д. (рис. 2.8).

Рис. 2.8. Просмотр содержимого окна Finder в режиме колонок

Этот режим удобнее всего использовать, если вы хотите просмотреть 
содержимое папок, в которых находятся фотографии и графические 
файлы, так как в нем доступна функция предварительного просмотра 
для выбранного элемента. Также в области предварительного просмо-
тра можно воспроизвести небольшой видеоролик или увидеть доку-
менты определенного формата.

Если вы хотите воспользоваться этой возможностью, откройте нужную 
папку и щелкните мышью по конкретному файлу. После этих действий 
появится область предварительного просмотра, в которой вы увидите 
содержимое и подробную информацию о просматриваемом файле.

• При выборе режима просмотра CoverFlow   (кнопка ) ваши файлы 
будут отображаться в графическом виде (рис. 2.9).
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Рис. 2.9. Просмотр содержимого Finder в режиме CoverFlow 

Просматривать файлы вы можете несколькими способами: щелкая мы-
шью по названиям файлов в списке, который находится в нижней части 
окна Finder, или по миниатюрам в области просмотра, а также переме-
щая мышью ползунок, расположенный под областью просмотра. Если 
вы хотите изменить порядок сортировки файлов, это можно сделать, 
щелкая мышью по заголовкам колонок.

Чтобы открыть документ или запустить приложение, в режиме Cover-
Flow  нужно дважды щелкнуть мышью по имени файла в списке или его 
изображению в области просмотра.

Вкладки

Вкладки, впервые появившиеся в версии OS X Mavericks, в окне про-
граммы Finder упрощают управление файлами и папками, объединяя 
несколько окон Finder в одно. Например, открыв на одной вкладке 
папку с документами, а на другой — содержимое Flash-накопителя 
коллеги, вы с легкостью можете скопировать нужные файлы, используя 
одно окно Finder.

1. Чтобы использовать режим вкладок, выберите команду меню 
Вид ⇒ Показать панель вкладок (View ⇒ Show Tab Bar) или на-
жмите сочетание клавиш �+�+T. Вы увидите вкладку с именем ак-
тивной папки.
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� Примечание. Повторное нажатие сочетания клавиш �+�+T или 
выбор команды меню Вид ⇒ Скрыть панель вкладок (View ⇒ Hide 
Tab Bar) отключает режим вкладок. Данное действие доступно толь-
ко при единственной открытой вкладке.

2. Щелкните мышью по кнопке с символом +, расположенной справа 
от вкладки с именем активной папки. Будет открыта новая вкладка 
с содержимым папки Мои файлы (All my files) (рис. 2.10).

Рис. 2.10. Режим вкладок в окне Finder

Вы можете переключаться между вкладками, открывать на них любые 
папки, менять порядок их расположения, перетаскивая мышью, и, ко-
нечно закрывать, щелкая мышью по кнопке  в левой части вкладки.

3. Чтобы переместить файл (файлы) или папку (папкии) между вклад-
ками, выделите объекты в окне и, нажав и удерживая кнопку мыши, 
перетащите на нужную вкладку. Через пару секунд в окне Finder от-
кроется содержимое целевой папки.

� Примечание. Подробнее о приемах выделения, копирования и пе-
ремещения файлов вы узнаете из главы 3.
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4. Отпустите кнопку мыши. Объекты будут перемещены.

Важно отметить, что на каждой вкладке в окне программы Finder вы 
можете использовать режимы отображения папок и файлов независи-
мо друг от друга.

Цветовые теги

Цветовые теги также впервые появились в операционной системе 
OS X версии Mavericks. Они предоставляют новый способ организации 
и фильтрации папок и файлов. Пометив тегом одного цвета файлы и/или 
папки, которые вы хотите сгруппировать вместе, вы с легкостью найде-
те их позднее, выбрав тег соответствующего цвета на боковой панели 
окна Finder или введя его текстовое название в поле поиска (рис. 2.11).

Рис. 2.11. Цветовые теги в окне Finder

Любой файл/папку можно пометить одним или несколькими тегами, 
а сами теги переименовать, используя вместо названий цветов нужные 
значения, например «Важно» или «Спорт».

� Примечание. Подробнее о приемах работы с тегами вы узнаете из 
главы 3.
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Используя теги, вы можете отобразить в одном окне файлы и папки, 
хранящиеся в различных папках на компьютере.

Панель Dock

Панель Dock  — это панель, которая находится в нижней части рабоче-
го стола и содержит значки приложений, папок, дисков и документов. 
В процессе работы с операционной системой OS X вы будете часто об-
ращаться к этой панели, чтобы запускать программы, открывать фай-
лы и папки и управлять программами, запущенными в данный момент. 
Значки приложений находятся слева от разделительной линии, а спра-
ва от нее — значки открытых приложений, документов, папок, дисков 
и папки Корзина (Trash) (рис. 2.12).

Рис. 2.12. Панель Dock в операционной системе OS X Mavericks

Для тех, кто раньше никогда не работал с панелью Dock, приведем список 
приложений, которые находятся на ней по умолчанию (слева направо).

 — значок приложения Finder, при помощи которого можно управ-
лять папками и файлами, хранящимися на диске компьютера.

 — значок приложения Launchpad, выводящего полноэкранный пе-
речень установленных на компьютере программ.

 — значок браузера Safari, с помощью которого можно просматри-
вать веб-страницы во Всемирной паутине и загружать файлы.

 — значок приложения Mail, с помощью которого можно отправлять 
и принимать электронную почту.

 — значок приложения Контакты (Contacts), с помощью которого 
можно создать базу данных своих знакомых или клиентов, с их имена-
ми, физическими адресами, адресами электронной почты, номерами 
телефонов и другой полезной информацией.

� Примечание. Подробнее возможности приложений в составе опе-
рационной системы OS X рассматриваются в главе 4.
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 — значок приложения Календарь (Calendar), позволяющего не 
только вести календарь и создавать списки дел на каждый день, но 
и следить за приближающимися важными событиями при помощи на-
поминаний.

� Примечание. Значок приложения Календарь (Calendar) на панели 
Dock интерактивен — он отображает текущую дату: число и назва-
ние месяца.

 — значок приложения Заметки (Notes), предназначенного для соз-
дания и хранения заметок.

 — значок приложения Карты (Maps), с помощью которого мож-
но просматривать населенные пункты в режиме карты и со спутника, 
а также прокладывать маршруты.

 — значок приложения Сообщения (Messages), с помощью которого 
можно обмениваться сообщениями между пользователями устройств 
под управлением операционной системы iOS версии не ниже 5 и OS X 
версии не ниже 10.8 (Mountain Lion).

 — значок приложения FaceTime, которое позволяет общаться со 
своими коллегами и знакомыми, друзьями и близкими по всему миру: 
обмениваться текстовыми сообщениями, проводить аудиочаты и ви-
деоконференции.

 — значок приложения Photo Booth, которое позволяет с помощью 
веб-камеры создавать фотографии и видеозаписи и применять к ним 
различные визуальные эффекты.

 — значок приложения iTunes, которое позволяет приобретать, 
брать напрокат, импортировать и воспроизводить аудиофайлы и филь-
мы, создавать плейлисты, в том числе и интеллектуальные (с помощью 
функции Genius), прослушивать интернет-радиостанции и многое 
другое .

 — значок приложения iBooks, предназначенного для загрузки 
и просмотра электронных книг.

 — значок приложения App Store, предназначенного для покупки 
и загрузки новых программ и игр, а также поиска и установки обнов-
лений.
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� Примечание. Стоит отметить, что на вашем компьютере некоторые 
значки в панели Dock могут отсутствовать или же присутствовать 
другие — в зависимости от настроек и установленных программ. 
Вы можете легко изменять содержимое панели Dock: добавлять но-
вые значки, менять их местами и удалять.

 — значок приложения Системные настройки (System Preferences). 
При помощи этого приложения вы сможете изменять предопределен-
ные настройки операционной системы, управлять устройствами, под-
ключенными к вашему компьютеру, настраивать локальную сеть или 
подключение к Интернету и т. д.

 — значок папки Загрузки (Downloads), предоставляющей возмож-
ность управлять файлами, которые вы загрузили на жесткий диск из 
Всемирной паутины.

 — значок папки Корзина (Trash). Используя эту папку, вы сможете 
управлять удаленными файлами: безвозвратно удалять их с диска ком-
пьютера, просматривать или восстанавливать.

Для запуска приложения достаточно дважды щелкнуть мышью по его 
значку на панели Dock, после этого под значком появится светящая-
ся черта, которая означает, что программа запущена. Если вы свора-
чиваете окно какой-либо программы или документа, минимизирован-
ное окно будет отображаться в виде небольшой миниатюры на панели 
Dock, справа от разделительной полосы. Когда вам вновь понадобится 
открыть свернутое окно, щелкните мышью по его миниатюре на пане-
ли Dock.

Чтобы изменить содержимое панели Dock, вы можете выполнить сле-
дующие действия.

• Для перемещения, нажав и удерживая кнопку мыши на значке, пе-
ретаскивайте его вправо или влево, пока он не окажется в нужном 
месте, а затем отпустите кнопку мыши. Соседние значки будут сме-
щаться автоматически.

• Если вам нужно добавить на панель Dock новый значок приложе-
ния, откройте папку Программы (Applications) в окне Finder, а за-
тем перетащите значок нужной программы в левую часть панели 
Dock.
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• Чтобы удалить значок с панели Dock, нажав и удерживая кнопку 
мыши на значке, переместите его за пределы панели, а затем отпу-
стите кнопку мыши.

• Чтобы добавить на панель Dock папку или документ, перетащите 
соответствующий элемент из открытого окна Finder или рабочего 
стола в правую часть панели Dock.

• Чтобы добавить на панель веб-страницу и обеспечить к ней бы-
стрый доступ, сначала нужно открыть ее в браузере Safari. Затем 
следует перетащить небольшую пиктограмму, расположенную 
слева от веб-адреса, в правую часть панели Dock. Добавление веб-
страницы на панель Dock поможет вам сэкономить время, если вы 
часто работаете с определенной веб-страницей (почтовым серви-
сом, сайтом компании и т. д.).

Панель Dock является одним из важнейших элементов, поэтому в опе-
рационной системе OS X предусмотрена возможность самостоятель-
ной настройки пользователем ее внешнего вида. Вы можете изменять 
не только состав элементов на панели, но и ее размеры, включать ре-
жим увеличения значков, размещать ее на разных краях экрана, скры-
вать и т. д. Подробнее о настройке панели Dock рассказано в главе 11.

Приложение Launchpad
Приложение Launchpad  разработано с целью ускорить поиск и запуск 
приложений. Чтобы увидеть его в действии, щелкните мышью по знач-
ку  на панели Dock. Все открытые окна исчезнут с экрана, фоновое 
изображение станет размытым, а поверх него вы увидите значки про-
грамм, которые установлены в системе (рис. 2.13).

Повторный щелчок мышью по значку  закроет Launchpad и вернет 
обычный рабочий стол. По сути, приложение Launchpad представля-
ет собой развернутую версию панели Dock. Если значки приложений 
не помещаются на одной странице, программа размещает их на не-
скольких. Количество страниц вы можете определить по числу точек 
в нижней части окна (над панелью Dock). Точка, которая соответствует 
странице приложения Launchpad, открытой в данный момент, — под-
свечена. Если вы не устанавливали никаких программ, Launchpad будет 
содержать одну страницу, которой вполне хватает, чтобы поместились 
значки всех стандартных приложений. Для перемещения по страни-
цам приложения Launchpad достаточно щелкнуть мышью по точке, со-
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ответствующей странице, или использовать колесико мыши. Также вы 
можете управлять программой с помощью специальных жестов, о ко-
торых мы расскажем подробнее в главе 3.

Рис. 2.13. Вид рабочего стола при запуске приложения Launchpad

Чтобы использовать возможности приложения Launchpad, вы можете 
выполнить следующие действия.

• Запустите приложение Launchpad и щелкните мышью по значку лю-
бой программы, чтобы открыть ее.

• Чтобы найти то или иное приложение, начните вводить буквы 
его названия в поле поиска в верхней части экрана приложения 
Launchpad. Содержимое экрана будет автоматически фильтровать-
ся по мере ввода, отображая только те приложения, названия кото-
рых соответствуют поисковому запросу.

• Если вы хотите изменить местоположение значка, перетащите его 
в нужную позицию, нажав и удерживая на нем кнопку мыши. Значки 
остальных программ автоматически сместятся, чтобы освободить 
пространство.
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• Если вы решите удалить какую-то программу из окна приложения 
Launchpad, помните, что удаление значка из приложения Launch-
pad равносильно ее удалению из системы. В операционной систе-
ме OS X не все программы, установленные по умолчанию, можно 
удалить. При необходимости, нажав и удерживая кнопку мыши на 
значке приложения, дождитесь, пока значки не начнут дрожать. За-
тем щелкните мышью по символу × в левом верхнем углу значка 
приложения, которое необходимо удалить.

• Если вам сложно ориентироваться в большом количестве значков, 
их можно сгруппировать в папки. Чтобы сгруппировать приложе-
ния, перетащите значок одного приложения на значок другого, по-
сле чего операционная система автоматически создаст группу, при-
своив ей имя на основании типа входящих в нее приложений.

• Если нужно отредактировать имя группы, щелкните по нему мы-
шью, введите новое имя и нажмите клавишу �, чтобы сохранить 
изменения.

• Чтобы увидеть содержимое группы, достаточно щелкнуть мышью 
по значку группы. Система отобразит значки этой группы на темно-
сером фоне, так вам будет легче ориентироваться при выборе 
нужной программы, и вы будете знать, что открыта именно группа. 
Группировка упрощает работу с приложением Launchpad и ускоря-
ет поиск нужного приложения.

Приложение Mission Control
Приложение Mission Control  позволяет легко узнавать, какие приложения 
открыты в данный момент, использовать виртуальные экраны и управ-
лять виджетами. Иногда для работы достаточно открыть одно-два окна, 
но чаще всего вам придется открывать множество окон одновременно. 
Чтобы помочь вам организовать окна приложений и сделать работу 
в системе OS X максимально комфортной, компания Apple объединила 
в приложении Mission Control разрозненные инструменты управления 
окнами, содержавшиея в предыдущих версиях операционной системы.

Запустить приложение Mission Control можно несколькими спосо бами:

• нажав сочетание клавиш ⌃+↑;

• на трекпаде или мыши Magic Mouse смахнув тремя пальцами вверх 
или дважды нажав двумя пальцами;
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• на клавиатуре Apple, нажав клавишу F3 или сочетание клавиш fn+F9;

• щелкнув мышью по значку  в панели Dock и на появившемся 
экране выбрав значок ;

• щелкнув мышью по значку  в окне папки Программы (Applica-
tions);

• владельцы новой клавиатуры компании Apple могут нажать клави-
шу Dashboard.

Каким бы способом вы ни запустили приложение Mission Control, ре-
зультат будет одним и тем же — на экране появятся миниатюры откры-
тых приложений (рис. 2.14).

Рис. 2.14. Экран программы Mission Control

Прежде всего рассмотрим интерфейс приложения Mission Control.

В верхней части экрана расположены миниатюры виртуальных (рабо-
чих) столов и приложения Dashboard. Вы можете перемещаться между 
ними при помощи мыши или жестов смахивания. Чтобы запустить при-
ложение Dashboard, достаточно щелкнуть мышью по его миниатюре.
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� Примечание. Если вы часто пользуетесь виджетами, тогда будет 
удобнее перенести значок приложения Dashboard ( ) на панель 
Dock. О возможностях приложения Dashboard вы можете узнать из 
главы 11.

В центре экрана Mission Control расположены окна открытых в данный 
момент приложений, при этом схожие окна объединены в стеки и ото-
бражаются как одно окно. В нижней части каждого окна открытого при-
ложения вы увидите его значок. Нужно щелкнуть мышью по миниатюре 
окна, чтобы перейти в выбранное приложение и закрыть окно прило-
жения Mission Control.

Благодаря приложению Mission Control удобно работать с полноэкран-
ными приложениями, так как для перемещения между такими прило-
жениями не нужно их минимизировать или сворачивать. Достаточно 
запустить приложение Mission Control и щелкнуть мышью по миниатю-
ре такого приложения или использовать специальный жест. Миниатю-
ры всех полноэкранных программ отображаются в верхней части окна 
приложения Mission Control наряду с миниатюрами рабочих столов 
и приложения Dashboard.

Управление виртуальными рабочими столами

Программа Mission Control позволяет не только упорядочивать окна 
открытых приложений, она также является удобным и практичным 
инструментом управления окнами — с ее помощью можно создать до 
пятнадцати виртуальных полноразмерных рабочих столов (экранов). 
Несмотря на то что одновременно вы сможете работать только с одним 
виртуальным монитором, приложение Mission Control позволяет пере-
ключаться между несколькими при помощи клавиатуры или мыши.

Вы можете создать отдельные виртуальные рабочие столы для каждой 
программы или группы программ, с которыми работаете. Например, на 
одном виртуальном столе можно открыть электронную почту и чат, на вто-
ром — графический или текстовый редактор, а на третьем — веб-браузер 
и работать во Всемирной паутине. Если существует необходимость, мож-
но открыть на разных рабочих столах документы и проекты, созданные 
в одном приложении. Каждый виртуальный рабочий стол абсолютно не-
зависим, но с одним ограничением — вы не сможете изменять настройки 
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визуализации, то есть назначить разным столам свои фоновые рисунки, 
менять положение и размер панели Dock и т. д. Сколько бы виртуальных 
столов вы ни создали, все они будут выглядеть одинаково.

� Совет. Использование виртуальных рабочих столов особенно 
удобно, если вам необходимо работать с полноэкранными прило-
жениями: на каждом столе вы можете открыть по одному приложе-
нию, развернуть его на весь экран и перемещаться от приложения 
к приложению не поиском их на одном рабочем столе, а сменой 
виртуального стола.

Чтобы воспользоваться возможностями приложения Mission Control, 
выполните следующие действия.

1. Чтобы создать виртуальный монитор, запустите приложение Mis-
sion Control и установите указатель мыши в правый верхний угол 
экрана.

2. Подождите, пока появится панель с изображением знака «плюс», 
и щелкните мышью по этой панели. Система создаст дополнитель-
ный рабочий стол (рис. 2.15).

� Примечание. Вы можете создать до 15 дополнительных рабочих 
столов, каждый из которых будет иметь порядковый номер в фор-
мате: Рабочий стол 1 (Desktop 1), Рабочий стол 2 (Desktop 2) и т. д.

3. Чтобы перейти на другой рабочий стол, щелкните мышью по его 
миниатюре на экране приложения Mission Control. Приложение 
Mission Control закроется, и вы увидите выбранный рабочий стол.

� Совет. Если вы не хотите переходить на рабочий стол, а собирае-
тесь только взглянуть на него, чтобы, например, проверить, не за-
грузился ли файл, используйте сочетание клавиш ⌃+→ или ⌃+←. 
Нажимая эти сочетания клавиш, вы будете циклично перемещаться 
между рабочими столами без перехода на них, а содержимое этих 
столов будет отображаться в нижней части экрана Mission Control.
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Рис. 2.15. Создание виртуального рабочего стола

4. Чтобы переместить окно открытого приложения с одного вирту-
ального стола на другой, перетащите его миниатюру мышью.

Если виртуальный рабочий стол вам больше не нужен, его можно уда-
лить.

5. Для этого запустите приложение Mission Control и установите указа-
тель мыши на миниатюре удаляемого рабочего стола. Когда в левом 
верхнем углу миниатюры появится кнопка ×, щелкните по ней мышью. 
Система удалит указанный виртуальный монитор, а все окна открытых 
приложений автоматически переместятся на другой рабочий стол.

� Примечание. Вы сможете удалить все дополнительные рабочие 
столы, кроме основного.

При необходимости вы можете указать, какие приложения должны за-
пускаться на каком из виртуальных рабочих столов. Такой подход по-
зволит сэкономить время, так как независимо от того, на каком вирту-
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альном столе вы работаете в данный момент, приложение запустится 
на своем рабочем столе. Чтобы присвоить приложению рабочий стол, 
щелкните мышью при нажатой клавише ⌃ по значку выбранного при-
ложения на панели Dock и выберите в контекстном меню:

• пункт Параметры ⇒ Этот Рабочий стол (Options ⇒ This Desktop), 
если хотите, чтобы приложение было привязано к активному рабо-
чему столу;

• пункт Параметры ⇒ Все Рабочие столы (Options ⇒ All Desktops), 
если хотите, чтобы приложение было привязано ко всем рабочим 
столам, которые вы создали;

• пункт Параметры ⇒ Нет (Options ⇒ None), если хотите отменить 
привязку приложения к рабочему столу.

Если значок приложения не отображается в панели Dock, добавьте его 
туда, запустив Launchpad и переместив на панель мышью. Если в даль-
нейшем этот значок не нужен вам в панели Dock, то его можно удалить 
после того, как вы привяжете приложение, перетащив мышью за грани-
цы панели. При этом привязка к виртуальному монитору сохранится.

Приложение Mission Control обладает еще одной особенностью: если к ва-
шему компьютеру подключены два монитора, то вы можете использовать 
приложение Mission Control для каждого монитора отдельно, то есть соз-
дать не 16, а 32 рабочих стола. Стоит отметить, что каждый монитор полно-
стью независим, поэтому вы не сможете перемещать окна открытых при-
ложений с рабочего стола одного монитора на рабочий стол второго.

Центр уведомлений
Центр уведомлений (Notification center) — приложение, впервые по-
явившееся в операционной системе OS X версии Mountain Lion, которое 
уведомляет вас о событиях в таких программах, как Mail, Календарь (Ca-
lendar), FaceTime, Game Center, Сообщения (Messages), Напоминания (Re-
minders), Safari, Карты (Maps), iTunes, и обновлениях из социальных сетей, 
таких как Facebook и Twitter. Доступ к Центру уведомлений можно полу-
чить в любое время и из любой программы, включая полно экранные.

Приложение Центр уведомлений (Notification center) отображает 
в верхнем правом углу экрана напоминания и различные системные 
уведомления, не мешая при этом работе пользователя. Также вы може-
те просмотреть весь список актуальных и предстоящих уведомлений, 
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отобразив панель данного приложения. Для этого выполните одно из 
следующих действий.

• Нажмите кнопку , расположенную в правом верхнем углу строки 
меню.

• Смахните двумя пальцами влево от правого края трекпада.

Вы увидите панель приложения Центр уведомлений (Notification cen-
ter) в правой части экрана (рис. 2.16).

Рис. 2.16. Центр уведомлений

Щелкнув мышью по уведомлению, вы перейдете в связанное с ним 
приложение. При этом уведомление будет считаться «прочитанным» 
и будет удалено с панели Центра уведомлений (Notification center).

� Примечание. Уведомления о событиях в приложениях Календарь 
(Calendar) и Напоминания (Reminders) не скрываются после щелчка 
мышью по ним. Они отображаются до момента наступления собы-
тия, а затем скрываются автоматически.
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Нажав кнопку × в правой части панели с названием приложения, уве-
домления которого отображаются на панели программы Центр уве-
домлений (Notification center), вы удалите все уведомления, связанные 
с данным приложением.

� Совет. Смахните (прокрутите) панель приложения Центр уведомле-
ний (Notification center) вниз, чтобы отобразить переключатель Не 
беспокоить (Do not disturb), позволяющий быстро приостановить 
отображение уведомлений.

При авторизации в социальных сетях на панели приложения Центр 
уведомлений (Notification center) отображаются кнопки для быстрой 
публикации поста в соответствующей сети. Например, после автори-
зации в сети Twitter в верхней части панели появляется кнопка Twitter. 
Нажав ее, вы отобразите небольшое поле, предназначенное для ввода 
текста сообщения (твита) и его публикации (рис. 2.17).

Рис. 2.17. Поле для ввода текста сообщения в сети Twitter

Помимо отображения на панели приложения Центр уведомлений (No-
tification center), уведомления о событиях появляются в виде наклеек, 
баннеров и предупреждений в правом верхнем углу экрана (рис. 2.18).

Рис. 2.18. Наклейка на значке (слева), предупреждение (в центре) и баннер (справа) 
уведомления

� Примечание. Баннеры отличаются от предупреждений тем, что по-
являются на несколько секунд и автоматически скрываются, а пре-
дупреждения необходимо закрывать нажатием кнопки.
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Красная наклейка с числом, отображаемая в правом верхнем углу знач-
ка программы на панели Dock, показывает, сколько новых элементов 
доступно для программы.

Баннеры отображаются в правом верхнем углу экрана компьютера 
в течение короткого периода времени. Щелкнув мышью по баннеру, 
вы сможете перейти в связанное с ним приложение.

Предупреждения — это важные уведомления, которые отображаются 
так же, как баннеры, но остаются на экране, пока пользователь не на-
жмет кнопку Закрыть (Close) или Позже (Later). В последнем случае 
предупреждение вновь появится через некоторое время.

Управление окнами приложений

В окнах  всех приложений операционной системы OS X есть удобные 
элементы, призванные помочь в управлении и упростить работу. Так, 
на панели инструментов любого окна вы найдете кнопки ,  и .

Кнопка закрытия  сворачивает окно в значок на панель Dock. Дей-
ствию этой кнопки соответствует сочетание клавиш �+W, с помощью 
которого легко закрыть несколько окон подряд, поскольку вам не по-
надобится целиться в каждую следующую кнопку закрытия. Некоторые 
приложения позволяют закрыть все открытые окна, для этого достаточ-
но удерживать клавишу ⌥ при нажатии кнопки  или нажать сочетание 
клавиш ⌥+�+W.

Кнопка минимизации  используется, когда нужно свернуть окно 
приложения в панель Dock. Кнопке  соответствует сочетание кла-
виш �+M. Сворачивание позволяет освободить рабочий стол. Чтобы 
вернуть окно, щелкните мышью по значку свернутого окна на панели 
Dock. Кнопка минимизации таит в себе одну полезную особенность: 
если щелкнуть по ней мышью при нажатой клавише ⌥ или нажать со-
четание клавиш ⌥+�+M, тогда все открытые окна текущей программы 
свернутся одновременно.

Щелчок мыши по кнопке увеличения  приведет к тому, что любое 
окно на рабочем столе увеличится до размеров, позволяющих увидеть 
все его элементы управления и содержимое. Повторное нажатие кноп-
ки  восстановит прежний размер окна. Также для изменения размера 
окна можно использовать команду меню Окно ⇒ Изменить масштаб 
(Window ⇒ Zoom).
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� Совет. Вы также можете свернуть все окна, нажав клавишу F11 или 
сочетание клавиш Fn+F11. Чтобы вернуть окна, еще раз нажмите 
клавишу F11 или сочетание клавиш Fn+F11. Такой способ особен-
но удобен, когда нужно найти файл или значок на рабочем столе: 
вам не придется перемещать и сворачивать окна по одному, чтобы 
открыть нужную часть рабочего стола.

Кроме кнопок управления, окно любой программы имеет заголовок, 
у которого есть несколько назначений. Прежде всего, внешний вид 
заголовка поможет вам определить, какое именно окно активно: его 
заголовок более темный, в то время как у неактивных окон заголовки 
более тусклые и бесцветные. Также, используя заголовок, можно при 
помощи мыши перемещать окно по рабочему столу. Каждый заголовок 
окна в приложении Finder содержит маленький значок, информирую-
щий о том, какая папка открыта. Перетаскивая значок, вы можете пере-
местить или скопировать открытую папку в другую папку, на другой 
диск, на панель Dock или в корзину, не закрывая окно.

� Совет. Чтобы увидеть иерархию папок в окне приложения Finder, 
нажав и удерживая клавишу ⌃, щелкните мышью по заголовку окна 
Finder.

Вы легко найдете все открытые окна одного приложения, используя со-
четание клавиш ⌃+↓. Как только вы нажмете это сочетание клавиш, ра-
бочий стол потускнеет, и операционная система выделит все окна при-
ложения, активного в данный момент. Если вы работаете с программой, 
которая использует большое количество окон, эта функция операци-
онной системы OS X может оказаться полезной. Чтобы перемещаться 
по открытым окнам или приложениям, вы можете использовать мышь 
или клавишу �. Когда вы захотите снова вернуться к рабочему столу, 
нажмите сочетание клавиш ⌃+↓ еще раз.

Обозначения и сочетания клавиш 
в операционной системе OS X

Когда вы освоитесь в системе OS X, вам захочется, чтобы часто повто-
ряющиеся операции выполнялись быстрее. Ускорить работу можно, ис-
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пользуя сочетания клавиш . Чаще всего они предоставляют не только бо-
лее быстрый, но и более удобный способ получить нужный ре зультат.

Сочетания клавиш, которые соответствуют основным командам, вы 
легко найдете возле соответствующих названий пунктов меню. Напри-
мер, сочетания клавиш, которые соответствуют командам навигации 
по папкам в приложении Finder, вы можете просмотреть, открыв меню 
Переход (Go). Здесь, как и в остальных меню, сочетания клавиш при-
ведены справа от соответствующих им команд (рис. 2.19).

Рис. 2.19. Сочетания клавиш в меню Переход

Сочетания клавиш особенно удобны при работе в текстовых редакто-
рах, они позволяют вызвать определенные команды, не отрывая рук от 
клавиатуры.

Существует два типа клавиш, которые вы можете использовать в со-
четаниях при работе с операционной системой OS X: модификаторы 
и функциональные.

Сами сочетания клавиш могут содержать одну или несколько клавиш-
модификаторов, а также одну буквенно-цифровую, или функциональ-
ную, клавишу.

Сначала разберемся с клавишами-модификаторами . Так называются 
клавиши, которые сами по себе не выполняют никаких конкретных дей-
ствий, если их не использовать в сочетании с другими. Например, если 
вы нажмете клавишу �, ничего не произойдет, но если нажать ее в со-
четании с другой клавишей, она произведет модифицирующий эффект.

Каждой клавише-модификатору назначен определенный символ, ко-
торый отображается в пунктах меню и помогает определить, какую 
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именно клавишу следует использовать (табл. 2.1). Кроме того, в табли-
це указаны обозначения функциональных клавиш, принятые в этой 
книге.

Табл. 2.1. Обозначения клавиш

Клавиша-модификатор Символ в меню

Command �

Option (Alt) ⌥

Control ⌃

Shift �

Delete ⌫

Caps Lock �

Tab �

Escape �

Клавиши с изображением стрелок ↑, ↓, ←, →

Ввод (Enter) �

Теперь вы знаете, что если в пункте меню напротив команды указано 
сочетание клавиш �Z, это значит, что для вызова этой команды с кла-
виатуры вам нужно нажать сочетание клавиш �+Z.

Функциональными  называют клавиши, которые находятся в верхнем 
ряду клавиатуры и отмечены буквой «F» в сочетании с цифрой, на-
пример F2, F10. На ноутбуках присутствует дополнительная функцио-
нальная клавиша Fn, которая обычно размещена в левом нижнем углу 
клавиатуры. С ее помощью вы можете назначать индивидуальным кла-
вишам не одну, а несколько функций.

Чтобы правильно воспользоваться сочетанием клавиш, вам нужно на-
жать на клавиатуре управляющую клавишу (или клавиши) и, удерживая 
их в нажатом положении, один раз быстро нажать нужную алфавитно-
цифровую или функциональную клавишу. Например, вы хотите закрыть 
окно при помощи сочетания клавиш �+W. Тогда вам следует нажать 
клавишу � и, удерживая ее в этом состоянии, нажать алфавитную кла-
вишу W. Если вы хотите закрыть несколько окон, тогда, удерживая кла-
вишу � в нажатом положении, нажмите клавишу W соответствующее 
количество раз.

Некоторые команды можно использовать в любой момент — это ак-
тивные команды, другие же потребуют от вас предварительных дей-
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ствий — неактивные команды. Активные команды отображаются 
в пунктах меню черным цветом, а неактивные — серым. Используя эту 
визуальную подсказку, вы всегда сможете отличить активные команды 
от неактивных, то есть недоступных в данный момент. Чтобы лучше ра-
зобраться в этом, раскройте меню Finder, и вы увидите, что довольно 
большое количество команд затенено серым цветом. Их вы не сможете 
применить, чаще всего это связано с тем, что вы не совершили какие-
то действия над объектом. Например, у вас не получится выполнить 
команду закрытия окна, если вы предварительно не выберете нужное 
окно щелчком мыши. Тогда как активную команду можно выполнить, 
выбрав ее в меню или нажав на клавиатуре соответствующее сочета-
ние клавиш.

Всплывающие подсказки

Разработчики OS X позаботились о том, чтобы вы были обеспечены 
дополнительной информацией о работе с ней. Если вы только начи-
наете знакомиться с операционной системой, вам помогут во всем 
разобраться такие встроенные элементы, как всплывающие под-
сказки  .

В большинстве программ и окон есть всплывающие подсказки, кото-
рые содержат краткую информацию о выбранном элементе, в основ-
ном о предназначении того или иного элемента управления. Всплыва-
ющие подсказки появляются в тот момент, когда вы наводите указатель 
мыши на элемент окна (рис. 2.20).

Рис. 2.20. Всплывающая подсказка в окне приложения TextEdit

Вы будете видеть всплывающие подсказки всякий раз, когда наведете 
указатель мыши на какой-либо элемент панели инструментов любого 
окна. В операционной системе OS X всплывающие подсказки существу-
ют для большинства управляющих элементов, достаточно навести на 
них указатель мыши.
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Визуальные ориентиры

Кроме всплывающих подсказок операционная система OS X содер-
жит множество визуальных ориентиров , которые помогают быстро 
определить варианты возможных действий и узнать, какое приложе-
ние или функция активны в данный момент. Если вы раньше работали 
с другой операционной системой (например, Windows), то уже знаете, 
как могут выглядеть визуальные ориентиры. Например, вам известно, 
что при просмотре веб-страниц в браузере текст, отформатирован-
ный подчеркиванием и синим цветом, сообщает посетителю о том, 
что это ссылка, щелчок мышью по которой перенаправит на другую 
веб-страницу. Если вы работали в текстовом редакторе MS Word, то 
знаете: если какое-либо слово подчеркнуто красной линией, значит, 
в этом слове допущена орфографическая ошибка. Операционная си-
стема OS X также оснащена визуальными ориентирами, которые часто 
бывают очень полезны.

Например, если вы установите указатель мыши на край окна запущен-
ного приложения, он примет вид двунаправленной стрелки — � . Она 
сообщает о том, что вы можете перетащить край окна и изменить его 
размер. Если вы щелкнете мышью в поле поиска, операционная систе-
ма выделит его рамкой голубого цвета, внутри которой будет мигать 
текстовый курсор, — так вы узнаете о том, что поле поиска активно 
и можно ввести в него нужную информацию.

Важным визуальным ориентиром, который помогает разобраться 
в большом количестве открытых окон, является меню Окно (Window) 
в верхней части экрана. 

Откройте несколько окон и разверните меню Окно (Window) — актив-
ное окно система отметит флажком, свернутое — ромбом, а неактив-
ное оставит без отметки (рис. 2.21).

Рис. 2.21. Визуальные подсказки в меню Окно
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Информационные окна также содержат визуальные ориентиры. Напри-
мер, когда вы закрываете документ, система показывает окно с предло-
жением выбрать один из вариантов: выйти из приложения без сохране-
ния документа, отказаться от закрытия окна или сохранить документ.

В таком окне наиболее подходящая кнопка подсвечивается. Если вас 
устраивает этот вариант, можете подтвердить действие, нажав на кла-
виатуре клавишу � вместо нажатия кнопки.

Когда приступите к работе с некоторыми приложениями и начнете соз-
давать свои документы, вам придется периодически обращаться к двум 
основным визуальным ориентирам. Один из них — темная точка в цен-
тре кнопки  — сообщает о том, что в этом документе не сохранены по-
следние изменения. После того как вы успешно сохраните измененный 
документ, темная точка исчезнет (рис. 2.22).

Рис. 2.22. Визуальный ориентир на панели окна

Другой важный визуальный ориентир — меню Окно (Window), которое 
помогает разобраться в большом количестве открытых окон. Откройте 
несколько документов и выберите пункт Окно (Window): активный до-
кумент будет отмечен флажком, а документы, в которых вы не сохрани-
ли последние изменения, — черной точкой.

Поиск при помощи функции Spotlight

Функция Spotlight  станет для вас незаменимым помощником при поиске 
нужной информации. Она работает быстро, эффективно и оснащена ря-
дом полезных преимуществ. Так, результаты поиска по повторяющимся 
запросам система хранит в смарт-папках. Файлы, которые соответству-
ют заданным вами атрибутам поиска, будут автоматически добавляться 
в эти папки, а содержимое самих смарт-папок — автоматически обнов-
ляться. Подробнее о смарт-папках мы расскажем в главе  3.

Функцию Spotlight можно использовать несколькими способами, каж-
дый из которых будет удобен в различных обстоятельствах: через меню 
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Spotlight, поиск в окне Finder, выбрав быстрый поиск с помощью бо-
ковой панели или поиск в приложениях. Чтобы освоиться с возможно-
стями функции Spotlight, попробуйте ее в действии.

• Чтобы открыть меню Spotlight, щелкните мышью по значку , ко-
торый находится в правом верхнем углу строки меню, или нажмите 
сочетание клавиш �+Пробел. Меню Spotlight особенно удобно 
использовать для быстрого поиска любой информации (рис. 2.23).

Рис. 2.23. Поиск с помощью меню Spotlight

Введите запрос в поле поиска, и функция Spotlight сразу начнет отобра-
жать результаты. В процессе ввода диапазон поиска будет постепенно 
сужаться, а результаты — становиться более конкретными. Меню Spot-
light можно открывать в любой момент, независимо от того, в каком 
приложении вы работаете.

• Чтобы отобразить результаты поиска в окне приложения Finder, 
введите запрос и выберите в меню пункт Показать все в Finder 
(Show All in Finder) в верхней части меню Spotlight (рис. 2.24).

• Кроме того, чтобы организовать поиск в приложении Finder, вы 
можете ввести ключевое слово в поле поиска в правом верхнем 
углу окна. Результаты отобразятся в том же окне Finder. При этом 
их будет меньше, чем при выборе команды Показать все в Finder 
(Show All in Finder) в меню Spotlight, например, поиск не будет вы-
полняться в системных настройках.

Если необходимо определить диапазон поиска, нужно щелкнуть мы-
шью по соответствующему значку на боковой панели. Например, если 
выделить определенную папку перед началом поиска, тогда он будет 
выполняться только в ней.



76 Глава 2

Рис. 2.24. Просмотр результатов поиска в окне Finder

Вы можете задать поиск не только по текстовым запросам, но и по типу 
файлов. Например, аудиофайлы, видеоролики, графические изображе-
ния, текстовые документы, файлы в формате PDF и т. д. Нужно нажать 
кнопку , которая появляется при выполнении поиска в левой части 
панели окна Finder. Теперь следует указать атрибуты в раскрывающих-
ся списках (рис. 2.25).

Рис. 2.25. Использование атрибутов поиска
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Так же можно задать поиск, например, по дате создания или послед-
него редактирования, имени, содержимому и прочим атрибутам. В по-
следнем случае нужно выбрать пункт Другое (Other) в раскрываю-
щемся списке и определиться с атрибутами, согласно которым следует 
осуществлять поиск (рис. 2.26).

Рис. 2.26. Расширенные атрибуты поиска

Поиск с помощью функции Spotlight поддерживается в большинстве 
приложений системы OS X. Например, вы сможете найти сообщения 
в электронной почте: по содержимому, по имени отправителя, по кон-
тактной информации, по графическим файлам, по календарям и храня-
щимся в них спискам мероприятий и задач, принятых к исполнению. 
Кроме того, поиск может производиться по содержимому на страницах 
текстового редактора TextEdit и даже в журналах сообщений, если вы 
заранее решили протоколировать свои переговоры в чате.

Справочная система

С каким бы приложением вы ни работали, в любой момент можно об-
ратиться к справочной системе , выбрав меню Справка (Help) в строке, 
расположенной в верхней части экрана.

Чтобы найти нужные материалы, надо выполнить следующие дей-
ствия.
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1. Разверните меню Справка (Help), чтобы открыть окно поиска.

2. Введите в поле поиска ключевые слова, по которым вам нужно по-
лучить дополнительную информацию. Откроются доступные раз-
делы справки по заданному запросу (рис. 2.27).

Рис. 2.27. Список разделов справочной системы

В данном случае можно просмотреть информацию из двух разделов: 
Пункты меню (Menu Items) или в разделе Статьи Справки (Help To-
pics).

• Если вы установите указатель мыши на любой пункт в разделе Пун-
кты меню (Menu Items), операционная система укажет, в каком 
именно меню находится данная команда (рис. 2.28).

Рис. 2.28. Использование раздела справки Пункты меню

Используя раздел Пункты меню (Menu Items), вы быстро найдете нуж-
ную команду в любом меню, но при этом справочная система не предо-
ставит разъясняющую информацию о назначении команды.

• Чтобы ознакомиться с подробной информацией об искомом эле-
менте (команде), щелкните мышью по соответствующему пункту 
в разделе Статьи Справки (Help Topics). Откроется окно Справоч-
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ный центр (Help Center), в котором вы можете просмотреть темати-
ческие статьи с разъяснениями (рис. 2.29).

Рис. 2.29. Окно Справочный центр

Если информации, которую вы нашли в справочной системе, недо-
статочно, можете поискать нужные сведения на официальном сайте 
компании Apple по адресу www.apple.com/ru/support/mac/ или обра-
титься в службу технической поддержки www.apple.com/ru/support. 
На официальном сайте компании Apple вы найдете много полезной 
информации, предназначенной помочь вам быстрее освоиться с опе-
рационной системой OS X и больше узнать о ее преимуществах.

На сайте размещены практические руководства по работе с системой 
и приложениями, которые можно просмотреть онлайн или сохранить 
на диске (www.apple.com/ru/findouthow/mac). Также на сайте вы 
сможете ознакомиться с мнениями и советами других пользователей, 
которые работают в операционной системе OS X, а также с ответами 
службы технической поддержки на часто задаваемые вопросы.



Глава 3
Работа с файлами и папками

Вы уже познакомились с рабочим столом и возможностями окна Fin-
der. Теперь пора переходить к более конкретным действиям и учиться 
работать с файлами и папками.

Прочитав эту главу, вы научитесь создавать, переименовывать и пере-
мещать собственные папки, удалять и восстанавливать любые катало-
ги, а также защищать их от незапланированного удаления. Кроме того, 
вы познакомитесь со структурой папок на своем компьютере и узнаете 
о преимуществах контекстных меню.

Структура папок в операционной системе OS X

Структура папок в операционной системе OS X существенно отлича-
ется от принятой в операционной системе Windows. Главным образом 
это связано с тем, что операционная система OS X относится к UNIX-
системам, а Windows сохраняет определенную преемственность с DOS. 
Также стоит отметить, что операционная система OS X на пользователь-
ском уровне сильно отличается от стандарта FHS (Filesystem Hierarchy 
Standard), а такие корневые папки, как /bin и прочие (BSD-окружение), 
в приложении Finder и других прикладных программах скрываются от 
пользователя.

В операционной системе OS X корневой файловой системой является 
та, которая соответствует загрузочному разделу. Все остальные раз-
делы, в том числе находящиеся на сменных носителях, монтируют-
ся в /Volumes под собственным именем, которое в случае файловых 
систем FAT и NTFS (для системы Windows) задается меткой диска (С:\ 
и т. д.). Такой подход гарантирует межмашинную унификацию, то есть, 
к какому бы компьютеру вы ни подключили свой сменный носитель 
(или другой накопитель), путь в структуре папок файловой систе-
мы будет одним и тем же. Такой подход заметно упрощает создание 
переносимого рабочего окружения, которое содержит программы, 
настройки и файлы пользователя. Также в случае операционной си-
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стемы OS Х стираются различия между реальными разделами и об-
разами дисков, прикладные программы работают с образами дисков 
в обычном режиме, в результате чего пользователю не нужно заду-
мываться о том, сколько носителей или образов подключено к его 
компьютеру.

В отличие от операционной системы OS X, в системе Windows исполь-
зуется методика обозначения разделов буквами латинского алфавита. 
Так, загрузочный раздел получает букву «C» независимо от того, осна-
щен ли компьютер приводами, за которыми резервируются буквы «A» 
и «B». Каждому новому носителю, который пользователь подключит 
к компьютеру, система присвоит первую свободную букву (не обяза-
тельно в строгом порядке). Поэтому в свойствах файлов и папок можно 
увидеть точную информацию об их размещении на диске — путь, на-
пример, С:\Program Files\. Использование букв диска при подключении 
сменного носителя к разным компьютерам приводит к тому, что они 
получают разное наименование разделов (разные буквы). В результате, 
если вы создали рабочее окружение и хотите перенести его на другой 
компьютер под управлением Windows, вам придется либо использовать 
специальные программы, либо специализированные адаптированные 
версии. Кроме того, использование букв для наименования дисков со-
пряжено с недостатками в процессе работы с виртуальными привода-
ми. Так, виртуальный привод в конкретный момент времени ограничен 
одним подключенным образом, то есть, чтобы использовать два вир-
туальных привода одновременно, придется инсталлировать еще один 
эмулятор или попеременно монтировать то один образ, то другой.

В операционной системе OS X вы будете работать со следующими пап-
ками в корневом каталоге: Программы (Applications) — установленные 
программы, Система (System) — файлы операционной системы, Библи-
отеки (Library) — дополнительные файлы системы и установленных 
приложений и Пользователи (Users) — cобрание домашних папок всех 
пользователей, которые зарегистрированы в системе. Такой способ 
распределения позволяет четко разграничить права пользователей 
и управлять доступом к отдельным объектам файловой системы. На-
пример, приложение не сможет сохранить файл со своими настройка-
ми вне папки Библиотеки (Library) текущего пользователя (исключение 
составляет учетная запись администратора), а пользовательские до-
кументы — вне его домашней папки. Естественно, при желании и на-
личии прав вы сможете поместить программу, например, на рабочий 
стол, но при этом структура папок останется логичной и хорошо сба-



82 Глава 3

лансированной, чтобы поддерживать разграничения доступа на осно-
ве стандартной UNIX-схемы.

Структура папок  в каталоге Пользователи (Users) операционной систе-
мы OS X показана на рис. 3.1.

Рис. 3.1. Пример структуры папок в операционной системе OS X

На первом уровне расположены папки Библиотеки (Library), Пользо-
ватели (Users), Программы (Applications) и Система (System). Ваша до-
машняя папка находится в каталоге Пользователи (Users), а папки, в ко-
торых будут храниться ваши документы, — в вашей домашней папке. 
Такая организация обусловлена тем, что изначально операционная 
система OS X рассчитана на нескольких пользователей. И чтобы они 
не путались, кто какие документы создал, для каждого из них отведе-
но собственное «пространство». Если вы единовластный хозяин своего 
компьютера, тогда в каталоге Пользователи (Users) будет присутство-
вать только одна домашняя папка с именем, которое вы укажете при 
первом запуске системы. Несмотря на количество пользователей, са-
мой важной для вас при работе с операционной системой OS X будет 
ваша домашняя папка.

В операционной системе OS X существует несколько способов быстро 
открыть домашнюю папку:
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• выполнить команду меню Переход ⇒ Личное (Go ⇒ Home);

• нажать сочетание клавиш �+�+H;

• выполнить команду меню Файл ⇒ Новое окно Finder (File ⇒ New 
Finder Window), щелкнуть по значку  на панели Dock или исполь-
зовать сочетание клавиш �+N. Затем щелкнуть мышью по значку 

 на боковой панели окна Finder.

Хотя негласно и разрешается создавать свои папки везде, кроме папок 
Библиотеки (Library) и Система (System), сначала вам может показать-
ся, что в OS X установлены слишком жесткие ограничения на структу-
ру папок — все документы система автоматически сохраняет в вашей 
домашней папке. Но у такого способа организации есть неоспоримые 
преимущества. Поддерживая жесткий контроль над размещением фай-
лов, операционная система OS X сохраняет свое быстродействие и вы-
сокую надежность. Более того, хранение личных материалов в одной 
папке заметно упростит для вас процесс резервного копирования 
и обеспечит стабильное и быстрое соединение с другими компьютера-
ми по локальной сети или доступ к Интернету.

Кроме домашней папки вам также понадобится папка Программы (Ap-
plications), в которой хранятся все приложения, которые установлены 
на ваш компьютер в текущий момент. 

Более подробно о содержимом папки Программы (Applications) мы рас-
скажем в главе 4.

Операции с файлами и папками
Каждое приложение, папка, файл или документ, которые хранятся на 
диске вашего компьютера, представлены отдельным значком — не-
большим цветным изображением. Значки вы можете копировать, пе-
реименовывать, перемещать по рабочему столу и запускать с их помо-
щью различные приложения или открывать документы.

Когда вы создаете свои файлы или папки, важно знать, как правильно 
присваивать им имена.

• В операционной системе OS X имена папок и файлов могут содер-
жать не более 255 символов.

• В именах файлов можно применять буквы, числа, знаки пунктуации 
и т. д. Допускается использовать в качестве имен практически лю-
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бой символ, кроме двоеточия (:), которое участвует в отображении 
структуры расположения папок, и точки в начале имени (.).

• Приложение Finder при сортировке файлов и папок считает, что 
пробел приоритетнее буквы A. Поэтому, если вы хотите переме-
стить какой-либо объект в верхнюю часть списка при просмотре 
в окне Finder, введите пробел в начале его имени.

• Если в начале имени файла указана цифра, система будет сортиро-
вать файлы и папки по возрастанию. Например, I квартал, II квар-
тал, 10-я неделя, 30-й день и т. д.

• Кроме букв и цифр, система также сортирует папки и файлы по спе-
циальным символам, которые вы указали в имени объекта. Итак, 
в операционной системе OS X специальные символы сортируются 
в следующем порядке: `, ^, _, -, пробел, короткое (–) и длинное (—) 
тире, запятая (,), точка с запятой (;), !, ?, ‘, ", набор символов ( и ), на-
бор символов [ и ], набор символов { и }, @, *, /, &, #, %, +, <, =, =/, 
>, |, ~ и $. Уже после специальных символов следуют цифры, потом 
буквы и замыкают ряд символов: μ (⌥+M); π (⌥+P); Ω (⌥+Z) и  
(�+⌥+K).

• Вы можете назначать файлам и папкам одинаковые имена при усло-
вии, что они находятся в разных папках на диске вашего компьюте-
ра или имеют разное расширение. Например, вы можете создать 
сколько угодно файлов с именем Мое резюме.doc, если сохраните 
их в разных папках, а файлы с именами Мое резюме.doc и Мое резю-
ме.xls можно хранить в одной.

Создание новых папок

В процессе работы вам рано или поздно придется создать собственные 
папки , так как хранить все файлы в каталоге Документы (Documents) — 
это все равно, что свалить все свои документы в одну кучу на столе, 
а потом пытаться найти нужный. Целесообразно создать отдельные 
папки для хранения финансовых документов, текстов, видеороликов, 
фотографий, а также других типов файлов.

Чтобы управлять собственными папками, нужно знать, как их создавать 
и именовать.

1. Чтобы создать новую папку, в окне Finder выполните команду 
меню Файл ⇒ Новая папка (File ⇒ New Folder). Также, чтобы соз-
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дать новую папку можно использовать контекстное меню, нажав 
кнопку  и выбрав в нем пункт Новая папка (New Folder).

2. Введите имя папки (рис. 3.2). Чтобы сохранить новое имя, нажмите 
на клавиатуре клавишу �.

Рис. 3.2. Создание и именование папки в операционной системе OS X

� Совет. Рекомендуется присваивать папкам содержательные имена, 
которые будут соответствовать типу документов в ней. Это значи-
тельно упростит поиск нужных файлов и папок.

Переименование файлов и папок

Для переименования файла или папки выполните следующие дей-
ствия.

1. Щелкните мышью по значку файла (или папки), а затем — по имени 
файла (или папки) или же нажмите на клавиатуре клавишу �. Теку-
щее имя будет выделено.

2. Введите новое имя с клавиатуры.

3. Если вам нужно только добавить символ в существующее имя фай-
ла, используйте клавиши ← и →, чтобы переместить курсор в соот-
ветствующую позицию.

4. Нажмите на клавиатуре клавишу �, чтобы присвоить папке или 
файлу новое имя и сохранить внесенные изменения.

Если необходимо присвоить нескольким объектам схожие имена, вы 
можете использовать команды Вырезать (Cut), Копировать (Copy) 
и Вставить (Paste) из меню Правка (Edit).

Выделение файлов и папок

Перед тем как выполнять операции с файлами и папками — переме-
щать, вырезать, копировать, вставлять или удалять, — их следует вы-
делить. Как выделить один объект, вы уже знаете, достаточно щелкнуть 
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по нему мышью. Теперь рассмотрим вариант выделения группы объ-
ектов. Это можно осуществить несколькими способами: при помощи 
мыши и клавиатуры.

Чтобы выделить несколько объектов , выполните следующие действия.

• Если вы хотите выделить все объекты в открытом окне, выполните 
команду меню Правка ⇒ Выбрать все (Edit ⇒ Select All) или на-
жмите на клавиатуре сочетание клавиш �+A.

• Выделить несколько объектов в окне можно, перетащив указатель 
мыши по диагонали, поверх группы объектов. Сделать это очень 
просто: нажав и удерживая кнопку мыши в области окна, перета-
щите указатель мыши по диагонали, заключив в область выделения 
нужные объекты. В процессе перетаскивания указателя мыши объ-
екты будут постепенно попадать внутрь серого прямоугольника. 
После того как вы отпустите кнопку мыши, объекты останутся вы-
деленными (рис. 3.3).

Рис. 3.3. Выделение нескольких объектов

• Если по ошибке в выделенную группу попал ненужный объект, на-
жав и удерживая клавишу �, щелкните по случайно выделенному 
объекту, чтобы удалить его из группы.

• Если вы с первого раза не смогли выделить все нужные объекты, на-
жав и удерживая клавишу � или �, повторите выделение перетаски-
ванием; при этом объекты, выбранные ранее, сохранят выделение.
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• Если в окне используется режим просмотра в виде списка или ко-
лонок, вы можете перетаскивать указатель мыши не по диагонали, 
а вертикально через имена файлов и папок, чтобы выделить группу 
последовательных объектов. Более быстрый способ сделать это — 
щелкнуть мышью по первому объекту в группе, а затем, нажав 
и удерживая клавишу �, щелкнуть по последнему из них.

� Совет. Если вам потребуется выделить группу произвольно распо-
ложенных объектов, щелкайте по ним мышью, нажав и удерживая 
клавишу �.

• Также вы можете выделять объекты при помощи клавиатуры. Для 
этого нажмите клавишу, соответствующую первой букве имени 
(или нескольким буквам) объекта, который требуется выделить. 
Например, нажмите клавишу И, чтобы выделить папку с именем 
Изображения. Если у вас есть несколько папок, в названиях кото-
рых совпадают первые буквы, нажмите клавишу �, чтобы выделить 
следующий объект, имя которого начинается с той же буквы, напри-
мер папку с именем Иллюстрации. Чтобы выделить предыдущий 
объект, воспользуйтесь сочетанием клавиш �+�. Перемещаться 
между объекта ми также можно при помощи клавиш ←, ↑, ↓ и →.

� Примечание. Клавишу � можно использовать только в режиме 
просмотра в виде значков, в виде списка и в режиме CoverFlow . 
В режиме просмотра в виде колонок, чтобы выделить соседние ко-
лонки, нужно использовать клавиши ←, ↑, ↓ и →.

Когда вы выделите группу объектов, то сможете манипулировать ими 
как одним объектом. Например, переместить их в другую папку, скопи-
ровать, вырезать или удалить. Кроме того, выделение нескольких объ-
ектов значительно упрощает процесс резервного копирования, когда 
требуется переместить группу файлов на другой диск.

� Примечание. Если вы выделили несколько объектов, такие коман-
ды как Дублировать (Duplicate), Открыть (Open), Создать псевдо-
ним (Make Alias), и некоторые другие также будут действовать на 
все объекты одновременно.
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Теги

Начиная с версии Mavericks операционной системы OS X, для улучше-
ния организации документов и быстрого поиска нужного файла опре-
деленной тематики можно использовать теги — метки, прикрепляемые 
к файлам. Например, все, что относится к спортивной тематике, вы мо-
жете пометить тегом «спорт». Разрешается создавать неограниченное 
количество тегов и применять несколько к одному и тому же файлу.

В левой части окна приложения Finder приведен список тегов. Щелкнув 
по любому из них, вы увидите, как в окне отобразятся файлы, которым 
он ранее был назначен. Тег отмечается именем и цветовым маркером. 
По умолчанию доступно семь тегов различных цветов, которым по 
умолчанию присвоены названия соответствующих цветов в качестве 
имен. Теги также отображаются в контекстном меню файлов.

Для удобства вы можете сразу же переименовать теги на свой выбор. 
Для этого выполните следующие действия.

1. Откройте окно Finder. В боковом меню, в левой части окна, будет 
отображаться список тегов.

2. Щелкните мышью, удерживая клавишу ⌃, по имени тега, который 
вы хотите переименовать.

3. В появившемся контекстном меню выберите пункт Переимено-
вать (Rename). Если тега нет в списке, выберите пункт Все теги (All 
tags), чтобы развернуть список всех тегов (рис. 3.4).

4. Введите новое имя тега и нажмите клавишу �.

Чтобы добавить тег к файлу, выполните следующие действия.

1. Удерживая клавишу ⌃, щелкните мышью по файлу или группе из 
нескольких выделенных файлов (если к ним ко всем требуется на-
значить один и тот же тег). Появится контекстное меню.

� Совет. Вы можете присваивать несколько цветовых тегов каждому 
объекту, благодаря чему способы сортировки файлов и папок ста-
новятся практически безграничны.

2. В группе элементов управления Теги (Tags) выберите имя (цвет) 
тега, который вы хотите присвоить файлу.
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3. Щелкните по свободной от объектов части окна, чтобы закрыть 
контекстное меню. Цветовые теги присвоены.

Рис. 3.4. Список тегов в окне Finder

Теперь вы можете фильтровать файлы согласно присвоенным им тегам, 
щелкая мышью по именам тегов в боковом меню (см. рис. 3.5).

Рис. 3.5. Файлы с цветовыми тегами
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Чтобы отобразить все файлы, просто откройте любую другую папку. 
Чтобы удалить тег из файла, повторите действия по присвоению те-
гов — теперь выбор уже назначенного тега удалит его из файла.

� Совет. Для удобства вы можете щелкнуть мышью по файлу, удер-
живая клавишу ⌃, и выбрать в контекстном меню пункт Теги (Tags). 
Появится всплывающая панель, с помощью элементов управления 
которой удобно назначать/удалять несколько цветовых тегов сразу .

Чтобы удалить тег из списка в боковом меню окна Finder, выполните 
следующие действия.

1. Удерживая клавишу ⌃, щелкните мышью по имени тега, который вы 
хотите удалить.

2. В появившемся контекстном меню выберите пункт Удалить из бо-
кового меню (Remove from Sidebar). Тег будет удален из бокового 
меню, но останется в списке всех тегов.

3. Чтобы полностью удалить тег, выберите пункт Удалить тег (Delete 
Tag) и в появившемся всплывающем окне подтвердите удаление. 
В этом случае данный цветовой тег будет сброшен со всех файлов, 
которым он был присвоен.

Кроме того, для поиска файлов с тегами вы можете воспользоваться 
полем поиска в правом верхнем углу окна программы Finder. Укажите 
в качестве поискового запроса имя тега и выберите его затем в списке 
результатов поиска.

Теги можно сразу же назначать при сохранении нового файла. Когда вы 
сохраняете файл, появляется панель сохранения файла. На ней доступ-
но поле ввода Теги (Tags). Если щелкнуть по нему мышью, отобразится 
список ранее применявшихся тегов. Вы можете выбрать какой-либо из 
существующих или ввести имя нового.

Копирование и перемещение объектов

Допустимо копировать и перемещать файлы из одной папки в другую, 
с одного диска на другой и т. д. несколькими способами: перетаскивая 
мышью, используя сочетания клавиш или команды меню.
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При перетаскивании в одних случаях файлы могут копироваться, 
а в других — перемещаться.

• При перетаскивании объектов из одной папки в другую на том же 
самом диске операционная система перемещает  их в выбранную 
папку, то есть из исходного расположения объекты удаляются.

• При перетаскивании с одного диска на другой объекты копируют-
ся , то есть в новом расположении создаются их дубликаты, а исход-
ные объекты остаются в первоначальном расположении.

• Если при перетаскивании удерживать клавишу ⌥, объекты копи-
руются, независимо от того, используется тот же диск или разные. 
Если выполнить подобное действие в одной и той же папке, опера-
ционная система создаст дубликат файла.

• Если при перетаскивании объектов удерживать клавишу �, систе-
ма переместит их и удалит из исходного местоположения.

С одной стороны, копировать и перемещать объекты путем перетаски-
вания удобно, так как вы наглядно можете видеть, как они перемеща-
ются в новое расположение. Но, с другой стороны, если открыто мно-
го окон, файл может по ошибке оказаться не в той папке. Чтобы быть 
уверенным, что копирование (перемещение) пройдет без проблем, 
используйте вкладки в окне приложения Finder или команды Копиро-
вать (Copy) и Вставить (Paste).

� Примечание. Команды Копировать (Copy) и Вставить (Paste) 
в операционной системе OS X работают так же, как и в системе Win-
dows, за одним исключением — объекты можно скопировать, но не 
получится вырезать.

• Чтобы скопировать или переместить файл или каталог перетаски-
ванием, предварительно откройте на вкладках исходную и целевую 
папки. Затем, нажав и удерживая кнопку мыши на объекте (группе 
объектов), подлежащем копированию, перетащите его на целевую 
вкладку. Спустя некоторое время целевая папка откроется, и вы 
увидите новую позицию копируемого (перемещаемого) объекта 
(объектов) (рис. 3.6). Отпустите кнопку мыши, чтобы завершить опе-
рацию.
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Рис. 3.6. Перетаскивание объекта на другую вкладку окна Finder

� Примечание. Чтобы использовать режим вкладок, выберите ко-
манду меню Вид ⇒ Показать панель вкладок (View ⇒ Show Tab 
Bar) или нажмите сочетание клавиш �+�+T. Кроме того, вы можете 
щелкнуть по папке мышью, нажав и удерживая клавишу ⌃, а затем 
выбрать пункт Открыть в новой вкладке (Open in New Tab) в кон-
текстном меню.

• Чтобы скопировать объект при помощи команд меню, щелкните по 
нему мышью и выполните команду меню Правка ⇒ Копировать 
(Edit ⇒ Copy) или нажмите на клавиатуре сочетание клавиш �+C. 
Также вы можете воспользоваться командой Копировать (Copy) 
из контекстного меню. Откройте окно, в которое вы хотите поме-
стить скопированные объекты, и выполните команду меню Прав-
ка ⇒ Вставить (Edit ⇒ Paste) или нажмите на клавиатуре сочетание 
клавиш �+V. Также вы можете воспользоваться соответствующей 
командой из контекстного меню.

� Совет. Если требуется прервать копирование (перемещение) объек-
тов, нажмите на клавиатуре сочетание клавиш �+. или клавишу �.
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При копировании или перемещении файла в папку, где уже есть файл 
с точно таким же именем (включая расширение), появится запрос, по-
казанный на рис. 3.7.

Рис. 3.7. Окно с запросом

Выберите нужный вариант и закройте окно с запросом.

• Нажмите кнопку Оставить оба (Keep Both), чтобы завершить опе-
рацию и сохранить как перемещаемый, так и существующий файлы. 
При этом к имени скопированного (перемещенного) файла будет 
добавлено слово Копия.

• Нажмите кнопку Остановить (Stop), чтобы прервать операцию.

• Нажмите кнопку Заменить (Replace), чтобы заменить существую-
щий файл копируемым (перемещаемым).

� Совет. Если вы ошибочно переместили или скопировали объект не 
в ту папку, нажмите на клавиатуре сочетание клавиш �+Z или вы-
полните команду меню Правка ⇒ Отменить (Edit ⇒ Undo), чтобы 
вернуть файл или папку в исходное место на жестком диске.

При использовании нескольких вложенных папок в одном окне, вы 
можете воспользоваться такой функцией операционной системы OS X, 
как самораскрывающиеся папки . Принцип ее работы прост: вы пере-
таскиваете объект на папку и не отпускаете кнопку мыши. Через пару 
секунд автоматически откроется окно папки, а указатель мыши окажет-
ся в его центре. Как будет отображаться содержимое папки, зависит от 
выбранного режима просмотра:

• в режиме просмотра в виде значков содержимое нового окна за-
мещает содержимое исходного;
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• в режиме просмотра колонок появится новая колонка с содержи-
мым вложенной папки;

• в режиме просмотра в виде списка и в режиме CoverFlow  откроется 
новое окно с содержимым вложенной папки.

Защита файлов от удаления

Чтобы защитить файлы от случайного удаления, надо выполнить сле-
дующие шаги.

1. Щелкните мышью по значку выбранного файла или папки и выпол-
ните команду меню Файл ⇒ Свойства (File ⇒ Get Info). Откроется 
окно с именем Свойства имя объекта (Get Info).

2. Установите флажок Защита (Locked) и нажмите кнопку . В левом 
нижнем углу значка файла или папки появится изображение за-
мочка.

Операционная система OS X не позволит вам переместить защищенный 
файл в папку Корзина (Trash) или другую папку и при попытке удалить 
такой объект откроет информационное окно с предупреждением.

Создание защищенного файла не обеспечивает полной безопасности 
от действий других пользователей, а только помогает избежать оши-
бочного перемещения нужного файла в корзину.

3. Нажмите кнопку Остановить (Stop), чтобы прекратить удаление, 
или нажмите кнопку Продолжить (Continue), чтобы перенести за-
щищенную папку в корзину. Когда вы попытаетесь очистить корзи-
ну, в которой есть защищенные файлы, система откроет информа-
ционное окно с предупреждением об их удалении.

4. Выберите нужный вариант и закройте информационное окно.

Чтобы убрать защиту с файла, вам потребуется снять флажок Защита 
(Locked) в окне Свойства имя объекта (Get Info).

Удаление и восстановление объектов

В папке Корзина (Trash), значок которой доступен на панели Dock, хра-
нятся объекты, которые вы удалили в процессе работы. От большин-
ства объектов можно избавиться, просто перетащив их на значок пап-
ки Корзина (Trash).
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Для наглядности, когда вы удаляете файлы, значок пустой корзины за-
меняется изображением корзины, заполненной смятой бумагой.

Чтобы использовать корзину, вам нужно знать, как выполняются сле-
дующие операции.

1. Чтобы поместить ненужный файл (папку) в папку Корзина (Trash), 
нажав и удерживая на нем кнопку мыши, перетащите выбранный 
объект на значок Корзина (Trash) на панели Dock.

� Совет. Вы можете ускорить процедуру удаления файлов, для чего 
достаточно щелкнуть мышью по удаляемому файлу и нажать на кла-
виатуре сочетание клавиш �+⌫.

 После того как указатель мыши коснется значка папки Корзина 
(Trash), отпустите кнопку мыши, и объект будет удален (рис. 3.8).

Рис. 3.8. Значки пустой (слева) и полной (справа) папки Корзина

� Примечание. При перемещении файлов в папку Корзина (Trash) 
важно помнить, что изображения корзины должен коснуться имен-
но указатель мыши, а не значок перетаскиваемого объекта.

2. Чтобы восстановить ошибочно удаленные объекты, щелкните мы-
шью по значку папки Корзина (Trash) на панели Dock и отобразите 
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ее содержимое. Выделив восстанавливаемые объекты, щелкните 
по ним мышью, нажав и удерживая клавишу ⌃, и выберите в кон-
текстном меню пункт Возвратить (Put back). Этот же пункт досту-
пен в контекстном меню и меню Файл (File) (рис. 3.9).

Рис. 3.9. Восстановление объектов из папки Корзина (Trash)

� Совет. Вы можете ускорить процедуру восстановления файлов, 
для чего достаточно щелкнуть мышью по удаленному файлу в окне 
папки Корзина (Trash) и нажать на клавиатуре сочетание кла-
виш �+⌫.

� Совет. Если удаление файла было вашим последним действием, мож-
но быстро восстановить его, нажав на клавиатуре сочетание клавиш 
�+Z. Удаленный файл будет восстановлен в исходную папку .

3. Чтобы очистить папку Корзина (Trash), откройте ее и нажмите на 
клавиатуре сочетание клавиш �+�+⌫. Или, нажав и удерживая 
клавишу ⌃, щелкните мышью по значку папки Корзина (Trash), рас-
положенному на панели Dock. В открывшемся контекстном меню 
выберите пункт Очистить корзину (Empty Trash). Откроется инфор-
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мационное окно с запросом подтвердить ваши намерения удалить 
объекты. Нажмите кнопку Очистить Корзину (Empty Trash), чтобы 
удалить файлы из папки Корзина (Trash). После этого все объекты 
будут удалены.

Стоит отметить, что удаленные данные по-прежнему находятся на 
жестком диске вашего компьютера, только пространство, которое они 
занимали, система OS X пометила как свободное и позднее запишет 
туда новые файлы. Поэтому файлы, удаленные из папки Корзина (Trash) 
таким способом, можно легко и быстро восстановить, если восполь-
зоваться специальными программами или услугами компьютерной 
фирмы.

Если вы хотите, чтобы файлы были удалены без возможности восстано-
вить их, воспользуйтесь командой Finder ⇒ Очистить корзину необ-
ратимо (Finder ⇒ Secure Empty Trash), после чего откроется окно с за-
просом подтвердить намерения (рис. 3.10).

� Примечание. Если в папке Корзина (Trash) есть защищенные фай-
лы, система не позволит восстановить их, пока не будет снята за-
щита в окнах свойств удаляемых файлов.

Рис. 3.10. Окно с запросом подтвердить необратимую очистку корзины

Нажмите кнопку Очистить Корзину необратимо (Secure Empty Trash). 
В этом случае система OS X не просто сотрет запись о том, где находи-
лись файлы или папки, но и запишет на это место новые данные в виде 
случайной последовательности нулей и единиц. Хотя такая процеду-
ра удаления и выполняется существенно дольше, чем простая очистка 
папки Корзина (Trash), восстановить файлы будет практически невоз-
можно без сложного оборудования и высококлассных специалистов.
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Контекстные меню

Контекстные меню помогут вам выполнять практически любые доступ-
ные операции над папками и файлами. Они представляют собой не-
большие списки, которые появляются, когда вы щелкаете по объектам 
мышью при нажатой клавише ⌃, и содержат перечень команд, доступ-
ных в данный момент.

Вызвать контекстные меню можно несколькими способами: щелкнуть 
мышью по объекту в окне или на рабочем столе, по ссылке в веб-
браузере, выделенному фрагменту в текстовом редакторе и т. д. В ре-
зультате появится список доступных команд. Чтобы выбрать интере-
сующую, нужно щелкнуть по ней мышью.

В операционной системе OS X вы найдете еще один способ доступа 
к контекстным меню — на панели инструментов окна Finder располо-
жена кнопка . Если вы щелкнете мышью по этой кнопке, откроется 
контекстное меню, которое также называют меню быстрого доступа 
(рис. 3.11).

Рис. 3.11. Контекстное меню

Контекстным такое меню  называют в связи с тем, что список доступ-
ных в нем команд зависит от того, по какому объекту вы щелкаете мы-
шью. Для разных объектов содержимое контекстного меню различно.
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Например, если вы вызовете контекстное меню, щелкнув мышью по 
свободному от элементов пространству рабочего стола, то увидите 
список команд, при помощи которых можно управлять внешним видом 
рабочего стола (рис. 3.12).

Рис. 3.12. Контекстное меню рабочего стола

При вызове контекстного меню щелчком мыши по панели инструмен-
тов окна Finder вы увидите команды, которые можно использовать для 
управления интерфейсом приложения Finder (рис. 3.13).

Рис. 3.13. Контекстное меню панели окна Finder

Как правило, команды контекстных меню дублируются в строке меню, 
расположенной в верхней части экрана.

Домашняя папка пользователя

Имя домашней папки  соответствует имени пользователя, которое вы 
указали при первом запуске компьютера, а слева от него будет на-
ходиться значок . Когда открыта домашняя папка, в заголовке окна 
Finder также отображается имя пользователя.

Чтобы просмотреть содержимое домашней папки, нужно выполнить 
следующие действия.
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1. Щелкните мышью по значку  на панели Dock, чтобы открыть 
окно Finder.

� Примечание. По умолчанию значок домашней папки в окне при-
ложения Finder скрыт. Если вы хотите отобразить его, выполните ко-
манду меню Finder ⇒ Настройки (Finder ⇒ Preferences) и на вклад-
ке Боковое меню (Sidebar) открывшегося окна установите флажок 
напротив имени вашей домашней папки со значком . После этого 
значок с именем учетной записи появится на боковой панели окна 
Finder.

2. На боковой панели окна Finder щелкните мышью по папке с именем 
вашей учетной записи, слева от которого указан значок . В приме-
ре домашняя папка носит имя mikhailrightman (рис. 3.14).

Рис. 3.14. Содержимое домашней папки

По умолчанию в домашней папке расположено несколько специализи-
рованных папок.

• В папке Документы (Documents) сохраняются любые документы, ко-
торые вы создали в процессе работы.
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• В папке Загрузки (Downloads) находятся файлы, которые вы загрузи-
ли при помощи различных приложений из Интернета или получи-
ли по электронной почте. На эту же папку ссылается одноименный 
значок, расположенный на панели Dock.

• В папке Изображения (Pictures) сохраняются файлы, используемые 
программой iPhoto и другими графическими приложениями, на-
пример ваши фотографии и альбомы.

• Папка Музыка (Music) содержит файлы, используемые приложени-
ем iTunes, то есть аудиозаписи и плейлисты.

• Папку Общие (Public) вы будете использовать для совместного до-
ступа к файлам, которые создадут другие пользователи, когда будут 
работать за вашим компьютером.

• В папке Рабочий стол (Desktop) содержатся объекты, которые на-
ходятся непосредственно на рабочем столе компьютера.

• В папке Фильмы (Movies) сохраняются файлы, которые использует 
приложение iMovie, когда вы монтируете видеоролики.

� Примечание. Если за компьютером работает несколько человек, 
система создаст домашнюю папку для каждого пользователя со-
гласно их учетным записям.

Если нет особой необходимости и вы не уверены в своих действиях, не 
стоит самостоятельно переименовывать или удалять папки, назначе-
ние которых вам непонятно, так как это может привести к неправиль-
ной работе операционной системы OS X.

Смарт-папки

Используя смарт-папки, которые расположены на боковой панели окна 
Finder, вы просматриваете только те папки и файлы, которые система 
поместила туда автоматически. Если вам этого недостаточно, можете 
создать пользовательские смарт-папки, задав для них нужные атрибу-
ты. Пользовательские смарт-папки выполняют те же функции: при ра-
боте с файлами, попадающими под заданные атрибуты, их содержимое 
автоматически обновляется. Так же как и в системных смарт-папках, 
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в пользовательских хранятся не сами файлы, а только ссылки на них. 
Но при этом пользовательские смарт-папки обладают одним преиму-
ществом — вы можете самостоятельно задавать и менять атрибуты, по 
которым система будет отбирать новые файлы. Для примера, создадим 
смарт-папку, которая будет отслеживать скопированные из других ис-
точников изображения в формате JPEG.

Чтобы создать смарт-папку, вам нужно выполнить следующие дей-
ствия.

1. В строке меню приложения Finder выберите команду меню Найти 
(Find) или нажмите сочетание клавиш �+F.

2. В качестве атрибутов поиска укажите в раскрывающихся списках 
значения Тип (Kind), Изображение (Image) и JPEG соответственно 
(рис. 3.15).

Рис. 3.15. Выбор атрибутов пользовательской смарт-папки

3. Нажмите кнопку Сохранить (Save), расположенную в правой части 
окна. Раскроется панель, в полях ввода которой вам нужно ука-
зать имя новой смарт-папки и путь к ней. В приведенном примере 
смарт-папка с именем Фотографии сохраняется в папке Докумен-
ты (Documents) (рис. 3.16).

Если требуется, чтобы созданная смарт-папка отображалась на бо-
ковой панели окна Finder, установите флажок Добавить в боковое 
меню (Add To Sidebar).
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Рис. 3.16. Сохранение смарт-папки

4. Чтобы сохранить новую папку, нажмите кнопку Сохранить (Save).

После того как вы создали смарт-папку, для просмотра ее содержимого 
достаточно щелкнуть по ней мышью (рис. 3.17).

Рис. 3.17. Новая смарт-папка на боковой панели окна Finder

Атрибуты, заданные для смарт-папки, можно изменить в любой мо-
мент. Для этого дважды щелкните по ней в окне Finder, укажите но-
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вые атрибуты поиска и сохраните изменения. Операционная система 
автоматически обновит папки в соответствии с новыми параметрами 
поиска.

Управление компьютером с помощью жестов

Благодаря жестам Multi-Touch,  в операционной системе OS X вы можете 
управлять приложениями на своем компьютере Mac без помощи мыши 
или клавиатуры. Жесты Multi-Touch удобны и интуитивно понятны, вы 
быстро научитесь ими пользоваться и запомните назначение каждого 
из них. Естественно, вы сможете использовать жесты Multi-Touch, толь-
ко если ваш компьютер оснащен соответствующими сенсорными обла-
стями: трекпадом (для ноутбуков), мышью Magic Mouse с поддержкой 
Multi-Touch или трекпадом Magic Trackpad.

Приобретя внешний сенсорный экран, вы можете заметно упростить 
работу с компьютером при помощи жестов. Использовать их очень 
просто, механизм заключается в простых движениях пальцами, кото-
рые выполняются на сенсорной области компьютера. 

Преимущество жестов заключается в том, что с их помощью можно бы-
стрее выполнить поставленную задачу, нежели используя традицион-
ные клавиатуру и мышь.

Конечно, чтобы привыкнуть к жестам, потребуется определенное вре-
мя, возможно, некоторые из них так и останутся вне вашего внимания. 
Рассмотрим основные.

• Жест касания. Чтобы выполнить его, однократно коснитесь сен-
сорной области.

• Жест поворота. Для его выполнения поверните два пальца в сен-
сорной области, как показано на рис. 3.18, слева. Жест удобен для 
поворота, например, изображений.

• Жест прокрутки. Чтобы выполнить его, следует коснуться сенсор-
ной области (трекпада) двумя пальцами и сделать движение вниз, 
если вы хотите прокрутить содержимое открытого документа вниз, 
или движение вправо, когда надо прокрутить документ вправо. 
Если в конце этого жеста вы сделаете резкое движение, тогда про-
крутка продолжится по инерции (рис. 3.18, справа). На мыши Magic 
Mouse жест прокрутки выполняется одним пальцем.
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Рис. 3.18. Жест поворота (слева) и прокрутки (справа)

• Жест смарт-масштабирования позволяет увеличить определен-
ную область экрана, например колонку страницы в браузере Safari. 
Чтобы выполнить этот жест, нужно дважды коснуться двумя паль-
цами сенсорной области. Повторное использование жеста вер-
нет изображение к исходному размеру (рис. 3.19, слева). На мыши 
Magic Mouse жест смарт-масштабирования выполняется одним 
пальцем.

• Жест масштабирования позволяет регулировать размер изо-
бражения. Если вы хотите увеличить масштаб, разведите пальцы 
в разные стороны, не отрывая их от сенсорной области, если нужно 
уменьшить изображение — сведите пальцы вместе в одной точке 
(рис. 3.19, справа).

Рис. 3.19. Жесты смарт-масштабирования (слева) и масштабирования (справа)

• Жест навигации смахиванием. Для просмотра больших докумен-
тов или веб-страниц можно использовать навигацию смахиванием. 
Чтобы выполнить этот жест, смахните в сенсорной области тремя 
пальцами, словно вы перелистываете страницы книги, журнала 
или другого печатного издания. Если выполнить жест смахивания 
вправо, вы переместитесь к следующей странице, чтобы вернуть-
ся к предыдущей, выполните жест смахивания влево (рис. 3.20). На 
мыши Magic Mouse жест навигации смахиванием выполняется дву-
мя пальцами.
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Рис. 3.20. Жест навигации смахиванием

� Примечание. В случае, когда у вас не получается разобраться 
с каким-то жестом, а также для получения дополнительной инфор-
мации о них вы можете посетить соответствующий раздел справки 
по адресу www.apple.com/ru/support/.

Каждый современный ноутбук компания Apple оснащает трекпадом 
Multi-Touch, который поддерживает полный набор представленных 
жестов. На стационарных компьютерах вы можете использовать мышь 
Magic Mouse с поддержкой Multi-Touch или трекпад Magic Trackpad. 
Каждое из этих устройств легко подключить к компьютеру Mac.



Глава 4
Программы в составе OS X Mavericks

В состав операционной системы OS X Mavericks входит 48 бесплатных 
приложений самого разного назначения. С их помощью можно отправ-
лять и принимать сообщения по электронной почте, создавать тексто-
вые и другие документы, просматривать видеоролики и фотографии, 
слушать музыку, выполнять математические расчеты, планировать свое 
время, делать заметки и многое другое. Часть приложений существова-
ла и в более ранних версиях операционной системы, их обновили для 
поддержки OS X Mavericks. Кроме того, специально для системы OS X 
Mavericks были разработаны совершенно новые программы, которые 
позволяют решать широкий круг задач без покупки дополнительного 
программного обеспечения, например Карты (Maps).

Все программы и приложения, которые установлены на ваш компью-
тер в текущий момент, вы найдете в папке Программы (Applications), от-
крыв ее в окне Finder. В этом каталоге присутствует папка Утилиты 
(Utilities), где находятся еще два десятка полезных утилит — служебных 
программ, при помощи которых можно быстро настроить подключе-
ния к принтерам и факсам, создать сетевые соединения, решить про-
блемы с жестким диском и отслеживать незаметные для пользователя 
процессы, которые выполняет система при запуске приложений и ра-
боте с ними.

В этой главе мы кратко рассмотрим приложения в составе OS X Mave-
ricks.

Первое, что следует отметить, приложения операционной системы 
OS X отличаются простотой и удобством в работе. Все навыки, которые 
вы получите, изучая одно из них, можно применить и к остальным уста-
новленным программам. Так происходит потому, что все приложения 
содержат схожие инструменты и элементы управления.

Если вы щелкнете мышью по пункту Программы (Applications) на боко-
вой панели открытого окна Finder, то увидите содержимое одноимен-
ной папки (рис. 4.1).
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Рис. 4.1. Содержимое папки Программы

� Совет. Чтобы ускорить запуск программ, рекомендуется поместить 
на панель Dock значки тех приложений, с которыми вы работаете 
чаще всего, тогда вы будете иметь к ним доступ независимо от того, 
какая программа активна в данный момент. Если позже вам пона-
добятся программы, чьи значки вы убрали с панели Dock, вы всегда 
можете вернуть их, зайдя в папку Программы (Applications) и пере-
тащив нужный значок на панель.

В случае если впоследствии вы установите дополнительные приложе-
ния, система автоматически создаст для них собственные подпапки 
в каталоге Программы (Applications).

Приложения

App Store

С помощью приложения App Store  вы можете приобретать, устанавли-
вать и обновлять программное обеспечение. Основное предназначе-
ние приложения App Store — обеспечить вас актуальными версиями 
программного обеспечения и сэкономить время, которое вам при-
шлось бы потратить на поиск обновлений или новых программ на раз-
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личных сайтах во Всемирной паутине. Стоит отметить, что не все про-
граммы, представленные в приложении, платные. Вы найдете много 
интересных и полезных программ, которые можно загрузить и устано-
вить абсолютно безвозмездно.

Чтобы приобрести программу в интернет-магазине App Store, снача-
ла нужно создать учетную запись Apple ID. Сделать это можно в са-
мом приложении App Store. Также желательно заранее авторизовать 
вашу учетную запись Apple ID. Ее вы сможете использовать не только 
в интернет-магазине App Store, но и в других приложениях.

Чтобы запустить программу App Store, выполните следующие действия.

1. Выполните команду меню  ⇒ Apple Store или щелкните мышью 
по значку  на панели Dock. Подождите, пока откроется основное 
окно приложения App Store и система загрузит необходимые дан-
ные о товарах (рис. 4.2).

Рис. 4.2. Окно приложения App Store

 Сделать поиск программ в магазине App Store более комфортным 
можно, используя следующие вкладки в верхней части окна при-
ложения:

• в разделе Подборка (Featured) вам будут предложены рекомен-
дуемые приложения;
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� Примечание. Вы можете просмотреть приложения и игры, но, чтобы 
совершить покупку, нужно авторизоваться в приложении со своей 
учетной записью Apple ID, выбрав ссылку Войти (Sigh In) в группе Бы-
стрые ссылки (Quick Links) и указав свои данные на открывшейся па-
нели. Если у вас нет учетной записи Apple ID, нажмите кнопку Создать 
Apple ID (Create Apple ID) и следуйте инструкциям, которые будут по-
являться на экране. Теперь, чтобы войти в магазин, укажите в поле 
Apple ID адрес электронной почты своей учетной записи, пароль на 
вход в поле Пароль (Password) и нажмите кнопку Войти (Sigh In). По-
сле успешной авторизации вам нужно будет указать данные банков-
ской карты и некоторые другие сведения (если они не были указаны 
ранее), чтобы успешно завершить процедуру привязки аккаунта.

• в разделе Топ-чарты (Top Charts) — наиболее популярные про-
граммные продукты из различных категорий;

• в разделе Категории (Categories) приложение сортирует про-
граммы по категориям. Например, справочники, игры и т. д.;

• если вы захотите просмотреть список приложений, купленных 
в магазине App Store, войдите под своей учетной записью Apple 
ID и откройте вкладку Покупки (Purchased);

• также вы можете проверить наличие обновлений установлен-
ных программ, нажав кнопку Обновления (Updates).

� Совет. Вы можете воспользоваться встроенным поиском по мага-
зину App Store, указав запрос в поле в правом верхнем углу окна 
программы и нажав клавишу �.

2. Чтобы загрузить программу, которая вас заинтересовала, нажмите 
кнопку с ценой продукта для платных приложений или по кнопке 
Бесплатно (Free) для тех программ, которые распространяются 
свободно.

Если вы выбрали платную программу, появится кнопка Купить (Buy 
App), если бесплатную — Установить (Install App).

3. Нажмите данную кнопку.
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4. Введите пароль к учетной записи Apple ID, чтобы подтвердить по-
купку/загрузку. Система загрузит и установит приложение.

Как только закончится установка программы, вы увидите ее значок 
в окне приложения Launchpad. Теперь новая программа готова к ис-
пользованию.

5. Щелкните мышью по значку нового приложения, чтобы запу-
стить его.

Все программы, которые вы приобрели в интернет-магазине App Store, 
находятся в папке Программы (Application).

Если вы удалили приложение, купленное в магазине App Store, есть воз-
можность загрузить его снова. Войдите в магазин под своей учетной за-
писью Apple ID и повторите те же действия, в этот раз уже бесплатно. 
Это справедливо и для приложений, которые были куплены на других 
устройствах, авторизованных с вашей учетной записью Apple ID.

Automator

Работая с OS X, вы обнаружите, что часто приходится выполнять 
одни и те же действия. Однако разработчики снабдили систему заме-
чательным инструментом, который способен решить этот вопрос, — 
приложением Automator . Данная программа поможет вам шаг за 
шагом объяснить своему компьютеру, что он должен сделать, а ис-
пользовать для этого вы будете последовательность визуальных кон-
структивных элементов, которые называют действиями. Достаточно 
запустить приложение, перетащить действия, расположить их в нуж-
ном порядке и нажать кнопку Запустить (Run), чтобы ваша система 
послушно в заданном порядке выполнила все указанные операции. 
Создавая такие последовательности, вы сможете управлять систе-
мой и ее приложениями при помощи готовых шаблонов действий, 
при этом не нужно учить язык программирования и самостоятельно 
разрабатывать программы. Результатом вашей работы с приложе-
нием Automator станут маленькие «программные роботы», которые 
называют процессами, способные быстро выполнять за вас массу ру-
тинных операций.

Выбор действий, которые вы можете задать, достаточно широк, но все-
таки ограничен. С помощью приложения Automator вы не сможете за-
программировать разработку сложных многоэлементных объектов. 
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Например, нельзя автоматизировать разработку целого сайта с помо-
щью одного лишь приложения Automator.

Самой привлекательной и простой в управлении функцией приложе-
ния Automator можно назвать режим записи действий. Используя его, 
вы можете показать программе, чему хотите ее научить, и приложение 
Automator начнет наблюдать и запоминать все ваши действия: нажатие 
клавиш, щелчки мышью и выбор пунктов меню. В дальнейшем прило-
жение Automator сможет правильно воспроизвести все ваши действия, 
как программа записи макросов.

Чтобы использовать возможности приложения Automator, выполните 
следующие шаги.

1. Запустите приложение, открыв в программе Finder папку Програм-
мы (Applications) и дважды щелкнув мышью по значку . Откроется 
основное окно приложения (рис. 4.3).

Рис. 4.3. Основное окно приложения Automator

2. Выберите тип документа на появившейся панели, например Про-
цесс (Process), и нажмите кнопку Выбрать (Choose).
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3. В области Библиотеки (Library) выберите программу, которой со-
бираетесь управлять.

� Примечание. Если вы захотите скрыть область Библиотеки (Li-
brary), нажмите кнопку Скрыть библиотеки (Hide Library) на пане-
ли инструментов. Это удобно при работе с большими процессами 
одной программы, когда для области процессов требуется много 
пространства на экране.

4. Выберите действие в области правее Библиотеки (Library) и пере-
тащите его в область процесса (крайняя правая область окна).

� Примечание. Вы можете перемещать объекты в область процессов 
не только с помощью приложения Automator или медиа-браузера. 
Допускается перетаскивать текстовые документы, папки, файлы 
и т. д. прямо из окна приложения Finder, что значительно упрощает 
работу и избавляет от поиска в программе Automator.

5. Чтобы обозначить начало последовательности действий, которую 
приложение должно запомнить, нажмите кнопку Запись (Record). 
В свою очередь кнопки Запустить (Run) и Остановить (Stop) по-
зволяют управлять процессом.

6. Завершите запись нажатием кнопки остановки.

7. После того как вы создадите процесс, не забудьте сохранить его, 
выполнив команду меню Файл ⇒ Сохранить (File ⇒ Save) или на-
жав сочетание клавиш �+S.

Вы можете сохранить процесс в виде обычного приложения, запускае-
мого двойным щелчком мыши, выполнив команду меню Файл ⇒ Со-
хранить (File ⇒ Save), а затем выбрав в раскрывающемся списке Фор-
мат файла (File Format) пункт Программа (Application).

При сохранении процессов в формате приложения они занимают 
больше пространства на жестком диске, но и получают все преимуще-
ства программ системы OS X. Вы сможете запускать процессы двойным 
щелчком по соответствующему значку в окне Finder, поместить значок 
процесса на панель Dock или рабочий стол и т. п.
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Приложение Automator способно избавить вас от выполнения трудоем-
ких и регулярно повторяющихся задач. В нем вы найдете сотни шабло-
нов, так что самому показывать порядок действий придется не так уж 
и часто. Дополнительную информацию о возможностях приложения Au-
tomator и примеры построения процессов вы можете получить на сайте 
support.apple.com/kb/HT2488?viewlocale=ru_RU&locale=ru_RU.

Dashboard

Кроме программ, файлов и документов в операционной системе OS X 
вы найдете еще одну категорию объектов — виджеты. Виджетами  на-
зывают небольшие приложения, встроенные в операционную систе-
му, обеспечивающие быстрое решение определенного круга задач. 
Если нажмете клавишу F12, все виджеты, установленные в системе 
по умолчанию, появятся на вашем рабочем столе поверх других окон 
(рис. 4.4).

Рис. 4.4. Виджеты на рабочем столе

Управлять виджетами вы можете при помощи приложения Dashboard . 
Оно позволяет настроить быстрый доступ к информации, нужной 
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именно вам. Панель виджетов по умолчанию содержит простой каль-
кулятор, сводку погоды, календарь и часы.

� Примечание. Подробнее о возможностях Dashboard см. в прило-
жении 1.

DVD-плеер

Программа DVD-плеер (DVD-player)  позволяет смотреть любые видео-
записи. Ее возможности обеспечат хороший звук и качественное изо-
бражение, а простой и понятный интерфейс позволит легко управлять 
просмотром. Приложение запоминает, на каком моменте вы остано-
вились, и в следующий раз предлагает продолжить с этой позиции, 
а элементы управления дают возможность остановить/запустить вос-
произведение, перемотать запись вперед/назад, изменить уровень 
громкости и многое другое.

1. Вставьте в дисковод DVD-диск с фильмом. Если вы не меняли на-
стройки распознавания дисков, заданные в системе по умолчанию, 
то компьютер автоматически определит, что в дисководе находится 
диск с видеозаписью, и сам запустит приложение DVD-плеер (DVD-
player). Откроется основное окно приложения (рис. 4.5).

Рис. 4.5. Интерфейс приложения DVD-плеер
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2. Чтобы начать воспроизведение, нажмите кнопку  или клавишу 
Пробел. Повторное нажатие приостановит его.

3. Чтобы перемотать видеозапись вперед или назад, нажмите кнопку 
 (сочетание клавиш �+�+→) или  (сочетание клавиш �+�+←) 

соответственно.

Воспроизведение фильмов в программе DVD-плеер (DVD-player) начи-
нается в полноэкранном режиме, при этом исчезает даже строка меню. 
Если вам понадобится получить доступ к строке меню, переместите 
указатель мыши к верхнему краю экрана, и она появится.

Возможности приложения DVD-плеер (DVD-player) позволяют отметить 
избранные эпизоды фильма и при желании вернуться к их просмотру. 
Чтобы отметить эпизоды, нужно создать закладку, нажав сочетание 
клавиш �+= или выполнив команду меню Управление ⇒ Новая за-
кладка (Controls ⇒ New Bookmark). Для перемещения по закладкам ис-
пользуйте команду меню Переход ⇒ Закладки (Go ⇒ Bookmarks).

� Примечание. Если операционная система не запускает приложе-
ние DVD-плеер (DVD-player) при помещении DVD-диска в дисковод, 
это легко исправить. Выполните команду меню  ⇒ Системные 
настройки (  ⇒ System Preferences), затем щелкните мышью по 
значку  CD и DVD (CDs & DVDs) и в открывшемся одноименном 
окне укажите, как должна поступать операционная система, если 
в дисководе находится DVD-диск. Больше информации о возмож-
ностях настройки системы при работе с CD/DVD-дисками вы найде-
те в приложении 1.

FaceTime

Приложение FaceTime предназначено для осуществления видеосвязи 
с собеседниками, которые используют компьютеры Mac, оснащенные 
веб-камерами, а также устройства iPod, iPad и iPhone .

1. Чтобы запустить приложение FaceTime , щелкните мышью по значку 
 на панели Dock и укажите данные своей учетной записи Apple 

ID в окне входа. Если у вас еще нет учетной записи Apple ID, вы мо-
жете создать ее в этом окне, нажав кнопку Создать новую учетную 
запись (Create new Account) и следуя инструкциям на экране.
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2. Нажмите кнопку Войти (Sign In). После подтверждения адреса 
электронной почты произойдет вход в программу и отобразит-
ся список контактов, импортированных из приложения Контакты 
(Contacts).

3. Чтобы добавить новый контакт, нажмите кнопку , введите инфор-
мацию о контакте и нажмите кнопку Готово (Finish).

4. Нажмите кнопку Контакты (Contacts) и выберите собеседника.

5. Щелкните мышью по номеру телефона, чтобы позвонить на iPhone , 
или по адресу электронной почты, чтобы позвонить на iPad, iPod 
Touch или другой компьютер с операционной системой OS X. Будет 
осуществлен звонок абоненту.

 На рис. 4.6 приведен снимок программы во время разговора.

Рис. 4.6. Видеоразговор двух абонентов в программе FaceTime

6. Чтобы завершить разговор, нажмите кнопку Отбой (End).

В приложении FaceTime к одному контакту могут быть привязаны не-
сколько «номеров» вызова. 

Например, если ваш собеседник выходит в чат или с домашнего ком-
пьютера Mac, или с телефона iPhone , приложение FaceTime может 
хранить оба «номера». В этом случае, перед тем как начать видеовы-
зов, вам нужно указать, на какое устройство вы собираетесь дозво-
ниться.
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Game Center

Приложение Game Center предлагает возможность совместной игры 
с друзьями, у которых есть iPhone , iPad, iPod Touch или компьютер 
с Mac OS X Mountain Lion или Maverick. Приложение Game Center объ-
единяет пользователей устройств Apple, позволяя играть между собой 
в онлайн-игры, обмениваться сообщениями и делиться своими игро-
выми рекордами (рис. 4.7).

Рис. 4.7. Интерфейс приложения Game Center

Чтобы воспользоваться приложением Game Center, выполните следую-
щие шаги.

1. Запустите приложение Game Center. При необходимости автори-
зуйтесь с учетной записью Apple ID.

2. После авторизации в приложении Game Center настройте свою 
учетную запись и добавьте друзей.

• В главном окне приложения Game Center рядом с вашим именем 
отображается ваша фотография. Чтобы добавить или изменить 
фотографию, щелкните мышью по ней и в появившемся меню 
выберите одно из стандартных изображений или добавьте свою 
фотографию, после чего нажмите кнопку Готово (Done).
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• Вы можете указать статус, который увидят ваши друзья и сопер-
ники. Статус — это небольшое сообщение, отображающее ваше 
настроение. Чтобы добавить или изменить статус, введите его 
текст в поле ввода Статус (Status) и нажмите клавишу �.

• Чтобы добавить друзей, перейдите на вкладку Друзья (Friends) 
и нажмите кнопку Добавить друзей (Add Friends). В поле вво-
да Кому (To) впишите адрес электронной почты вашего друга 
или его псевдоним в сервисе Game Center, после чего нажмите 
кнопку Отправить (Send).

Для загрузки и установки игр используется приложение App Store.

3. Чтобы выбрать и загрузить игры, в приложении Game Center от-
кройте вкладку Игры (Game) и нажмите кнопку Найти игры в App 
Store (Find Game Center Games). Появится окно приложения App 
Store, в котором будет открыт раздел с играми.

4. После загрузки и установки игр на компьютер они появятся на 
вкладке Игры (Game) приложения Game Center. Щелкните мышью 
по названию игры для просмотра статистики — своей, друзей и всех 
игроков.

5. Чтобы начать играть, выберите игру и нажмите кнопку Играть 
в игру (Play Game).

После завершения игры все ваши рекорды и достижения будут ото-
бражаться в вашей учетной записи Game Center. Если игра поддержи-
вает сетевой режим, вы можете играть через Интернет, как со своими 
друзьями, так и с незнакомыми людьми. На вкладке Игры (Games) есть 
раздел Достижения (Achievements), в котором отображается список 
достижений, получаемых в игре. Они представляют собой некоторые 
особые задания, выполняемые в процессе игры. Часть из них легкие 
или осуществляются по мере прохождения сюжетной части игры, 
а часть — сложные. Выполнив достижение, вы вольны выбрать его 
и поделиться своим успехом с друзьями. Можете приглашать друзей 
побить ваш рекорд и принимать вызовы от них на соответствующих 
вкладках окна программы.

iBooks

Приложение iBooks, которое впервые стало штатным в операционной 
системе OS X, начиная с версии Mavericks, предназначено для чтения 



120 Глава 4

и загрузки новых книг с помощью сервиса iBooks Store. Оно поддержи-
вает синхронизацию с другими устройствами Apple, что позволит вам 
читать загруженные книги на iPad, iPhone  и iPod Touch.

� Примечание. В некоторых книгах могут содержаться интерактив-
ные мультимедийные объекты — видеоролики, аудиоклипы, 3D-
объекты, галереи и слайд-шоу. Все это вы можете просматривать 
в приложении iBooks.

Чтобы воспользоваться приложением iBooks, выполните следующие 
шаги.

1. Чтобы запустить приложение, щелкните мышью по значку ( ) на 
панели Dock. При первом запуске появится окно приветствия.

2. Для входа в программу нажмите кнопку Начать работу (Start).

3. Чтобы покупать книги в iBooks Store, синхронизировать закладки, 
выделенные фрагменты в книгах и заметки с другими устройствами 
Apple, необходимо авторизоваться в приложении, используя учет-
ную запись Apple ID. Панель авторизации появится автоматически.

4. В поле ввода Apple ID введите свой адрес электронной почты Ap-
ple ID.

5. В поле ввода Пароль (Password) введите пароль от своей учетной 
записи.

6. После ввода логина и пароля нажмите кнопку Войти (Sign Up), что-
бы подтвердить правильность введенной информации и выпол-
нить авторизацию в приложении iBooks.

7. После выполнения авторизации в окне приложения появятся все 
книги, загруженные вами на других компьютерах и устройствах под 
управлением операционной системы iOS вашей учетной записи 
Apple ID (рис. 4.8).

� Примечание. О том, что книга загружена с помощью другого 
устройства, сообщает значок в виде облака в правом верхнем углу 
миниатюры обложки книги. Это ваши покупки и загрузки, хранящие-
ся в облачном сервисе iCloud.
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Рис. 4.8. Интерфейс приложения iBooks с загрузками, доступными в iCloud

8. Если в вашем приложении книги еще не загружались, нажмите 
кнопку iBooks Store, расположенную в левом верхнем углу окна 
программы. Вы перейдете в магазин iBooks Store, интерфейс кото-
рого схож с приложением App Store, за тем лишь исключением, что 
здесь доступны только книги.

Чтобы загрузить книгу, выберите нужную из списка или воспользуйтесь 
поиском, после чего нажмите кнопку Бесплатно (Free). После того как 
книга будет загружена, она отобразится в вашей библиотеке.

� Примечание. Все книги доступны бесплатно. Однако на русском 
языке их практически нет.

9. Чтобы перейти к загруженным книгам, нажмите кнопку Библиотека 
(Library), расположенную в левом верхнем углу окна программы.

10. Дважды щелкните мышью по обложке книги, чтобы начать чтение 
(рис. 4.9).

Работа с книгами в приложении iBooks осуществляется следующим об-
разом. 
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Рис. 4.9. Интерфейс приложения iBooks в режиме чтения

По левому и правому краям страниц книги расположены кнопки пе-
рехода на предыдущую ( ) и следующую ( ) страницу, скрываемые, 
пока на них не наведен указатель мыши. Для быстрого перехода к нуж-
ной странице в нижней части книги расположена полоса прокрутки 
с ползунком, также автоматически скрываемая.

� Совет. Для перехода по страницам на сенсорных устройствах вы 
можете использовать жесты, а также нажатие клавиш ← или → на 
клавиатуре.

1. Чтобы открыть оглавление книги, нажмите кнопку , расположен-
ную в верхней части окна программы в режиме чтения.

2. Чтобы сделать закладку на странице книги, нажмите кнопку . 
Если она отображается красным цветом, то на открытой странице 
уже используется закладка.

3. Чтобы удалить закладку, откройте всплывающее меню Закладки 
(Bookmarks) и нажмите кнопку удаления, расположенную справа от 
названия закладки.
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В книге также можно делать заметки. Для этого выполните следующие 
действия.

� Примечание. Вы можете открывать в приложении iBooks PDF-
файлы, выполнив команду меню Файл ⇒ Добавить в библиотеку 
(File ⇒ Add to Library) или нажав сочетание клавиш �+�+O.

1. Чтобы создать заметку, выделите фрагмент текста в книге и щелкни-
те по нему мышью, удерживая клавишу ⌃.

2. В появившемся контекстном меню (рис. 4.10) выберите цветной 
индикатор для выделения текста цветом или пункт Добавить за-
метку (Add Note). В последнем случае появится заметка, в которую 
можно будет ввести любой текст.

Рис. 4.10. Добавление заметки

3. После ввода текста щелкните по странице книги, чтобы закрыть за-
метку. Заметки отображаются в правой части страницы в виде цвет-
ных квадратиков, щелкая по которым можно открывать полные тек-
сты заметок.

4. Чтобы просмотреть все заметки в книге, нажмите кнопку , после 
чего в левой части окна программы появится их список.

Справа от каждой заметки в нем располагается ссылка для перехода на 
соответствующую страницу.

5. Чтобы удалить заметку, удерживая клавишу ⌃, щелкните мышью по 
фрагменту текста, к которому привязана заметка, и в появившем-
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ся контекстном меню выберите пункт Удалить заметку (Remove 
Note).

� Совет. Чтобы изменить режим отображения страниц, выполните 
команду меню Вид ⇒ Одна страница (View ⇒ Single Pages) или 
Вид ⇒ Две страницы (View ⇒ Two Pages). Чтобы изменить шрифт 
текста и оформление страниц книги, нажмите кнопку , располо-
женную в верхней части окна чтения, и в появившемся всплываю-
щем меню выберите шрифт, размер текста или один из вариантов 
оформления страниц книги.

Нажав кнопку , вы вернетесь в библиотеку. Она состоит из несколь-
ких вкладок, на каждой из которых книги отображаются с определен-
ной сортировкой. На вкладке Коллекции (Collections) можно группи-
ровать книги в коллекции, создавая их.

iTunes

Приложение iTunes  в составе операционной системы OS X использу-
ется для воспроизведения и проката цифровых музыкальных файлов, 
подкастов и видеозаписей, прослушивания радиостанций во Всемир-
ной паутине и синхронизации файлов с такими портативными устрой-
ствами, как iPhone , iPad и iPod. Если вы хотите обзавестись новой му-
зыкой, посетите онлайн-магазин iTunes Store. В нем можно прослушать 
и приобрести записи песен различных исполнителей и видеоклипы, 
взять напрокат или приобрести фильмы, подписаться на подкасты или 
загрузить приложения для портативных устройств под управлением 
операционной системы iOS.

� Примечание. Более подробно о возможностях приложения iTunes 
см. в главе 5.

Launchpad

Благодаря приложению Launchpad  вам больше не требуется тратить 
время на поиск нужного приложения в папке Программы (Application): 
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достаточно щелкнуть мышью по значку  на панели Dock, и вы уви-
дите на экране перечень установленных приложений. Щелкнув мы-
шью по значку, вы запустите соответствующую программу. С помощью 
Launchpad также можно управлять приложениями. Например, объеди-
нить схожие приложения в одну папку, перетащив их значки. Все про-
граммы, которые вы приобретете с помощью App Store, система авто-
матически добавит в приложение Launchpad.

� Примечание. О возможностях приложения Launchpad  см. в главе  2.

Mail

Приложение Mail  представляет собой удобный и практичный инстру-
мент для управления электронной почтой. С его помощью вы можете 
просматривать и читать входящую почту, писать сообщения, управлять 
вложениями, использовать бланки, а также сортировать почту и приме-
нять встроенные фильтры. Возможности приложения Mail позволяют 
работать с несколькими почтовыми ящиками одновременно, а элемен-
ты управления параметрами помогут установить периодичность про-
верки новой почты, настроить интерфейс приложения и справиться со 
спамом. По всем параметрам приложение Mail является полноценным 
многофункциональным программным продуктом, который эффектив-
но справляется с возложенными на него задачами.

� Примечание. Подробнее о возможностях приложения Mail расска-
зывается в главе 9.

Mission Control

Основная задача приложения Mission Control  заключается в управ-
лении большим количеством запущенных приложений и виджетами. 
С помощью Mission Control вы сможете просмотреть, какие приложе-
ния открыты в данный момент, временно скрыть все окна запущенных 
приложений на рабочем столе, создать несколько виртуальных рабо-
чих столов и привязать к ним приложения, которые вы используете 
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чаще всего. Благодаря удобному и простому интерфейсу Mission Con-
trol легко перемещаться между открытыми приложениями и виртуаль-
ными рабочими столами.

� Примечание. О возможностях приложения Mission Control см. 
в главе 2.

Photo Booth

При помощи приложения Photo Booth  можно делать снимки, приме-
нять различные визуальные эффекты к изображениям с веб-камеры 
и даже записывать небольшие видеоролики.

Разумеется, пользоваться им можно только в том случае, если ваш ком-
пьютер оснащен веб- или видеокамерой. Вкратце идея приложения 
Photo Booth заключается в эмуляции кабинки для фотоснимков.

Чтобы использовать возможности приложения Photo Booth, выполни-
те следующие шаги.

1. Запустите приложение, щелкнув мышью по значку  на панели 
Dock. Откроется основное окно Photo Booth.

2. Если камера подключена, вы сразу увидите свое изображение 
(рис. 4.11).

3. Нажмите кнопку  или воспользуйтесь сочетанием клавиш �+�, 
чтобы сделать фотоснимок. Спустя некоторое время (вы увидите 
три поочередно загорающихся элемента в нижней части окна про-
граммы) произойдет характерный щелчок затвора, и в нижней ча-
сти окна программы появится миниатюра снимка.

4. Нажмите кнопку Эффекты (Effects), чтобы просмотреть доступные 
эффекты.

Одни искажают изображение, другие изменяют его цветопередачу 
(делают черно-белым или дают эффект рисунка), третьи позволяют 
выбрать фон. Всего приложение Photo Booth содержит пять стра-
ниц визуальных эффектов, на каждой из которых вы найдете девять 
вариантов обработки (включая изображение без эффекта). Чтобы 
увидеть все доступные возможности, используйте стрелки, распо-
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ложенные слева и справа от кнопки Эффекты (Effects), или сочета-
ние клавиш �+→/�+←. Для некоторых эффектов вы можете задать 
настройки, перемещая соответствующие ползунки на панели инст-
рументов.

Рис. 4.11. Приложение Photo Booth в полноэкранном режиме

Приложение может сделать не только один снимок (кнопка  в левом 
нижнем углу окна программы) за одно нажатие, но и четыре последо-
вательных, как в фотокиосках. Для этого нажмите кнопку , а затем — 

. Программа сделает четыре последовательных снимка с интерва-
лом в две секунды.

Если при работе с приложением Photo Booth вы заметите, что фотогра-
фия отображается зеркально, щелкните мышью по миниатюре снимка 
в нижней части окна программы и выполните команду меню Прав-
ка ⇒ Отобразить фотографию зеркально (Edit ⇒ Flip Photo).

� Совет. Этот эффект можно установить по умолчанию. Выполните 
команду меню Правка ⇒ Отображать новые объекты зеркаль-
но (Edit ⇒ Auto Flip New Photos), после чего приложение будет пе-
реворачивать все снимки, которые вы сделаете.
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Если хотите записать видеоклип, в том числе с применением визуаль-
ных эффектов, нажмите кнопку , а затем — . Приложение будет 
записывать видеоролик (со звуком), пока вы не нажмете кнопку  или 
не закончится свободное пространство на диске вашего компьютера. 
После того как вы остановите съемку, в группе фотографий появится 
значок нового видеоролика, который можно просмотреть, переме-
стить в любой каталог на диске или отправить друзьям по электронной 
почте. Файлы, созданные в Photo Booth, находятся в папке Мои файлы 
(All My Files). Там вы обнаружите один файл в формате *.JPEG для каждо-
го снимка, четыре файла в формате *.JPEG для фото из четырех снимков 
и файл в формате *.MOV для записанных видеороликов.

QuickTime Player

Фильмом в формате QuickTime может быть видеозапись, которую вы 
храните на жестком диске своего компьютера, на CD/DVD-дисках или 
просматриваете во Всемирной паутине. Как и любая видеозапись, та-
кой фильм состоит из отдельных кадров, которые воспроизводятся 
с большой скоростью и синхронизированы со звуковой дорожкой. 
Запускать и проигрывать фильмы в формате QuickTime могут многие 
приложения, но в качестве основной программы для их воспроизве-
дения в операционной системе OS X выступает проигрыватель Quick-
Time Player, который вы найдете в папке Программы (Applications). Он  
не только воспроизводит фильмы в формате QuickTime, но также мо-
жет работать с графикой, звуковыми файлами, и другими форматами 
видеозаписей. При помощи приложения QuickTime Player можно про-
сматривать потоковое видео или слушать радиостанции, вещающие во 
Всемирной паутине.

� Примечание. Кроме того, приложение QuickTime Player позволяет 
записывать видеоролики на камеру компьютера, речь на микро-
фон, а также происходящее на экране компьютера. Для записи 
видеоролика выберите команду меню Файл ⇒ Новая видеоза-
пись (File ⇒ New Movie Recording) или нажмите сочетание клавиш 
⌥+�+N; для записи звука — команду Файл ⇒ Новая аудиозапись 
(File ⇒ New Audio Recording) или сочетание клавиш ⌃+⌥+�+N; 
а для записи происходящего на экране компьютера — команду 
Файл ⇒ Новая запись изображения на экране (File ⇒ New Screen 
Recording) или сочетание клавиш ⌃+�+N.
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Приложение QuickTime Player отличается простым и удобным интер-
фейсом, при этом вы можете скрыть элементы управления, если в дан-
ный момент они не нужны. Также при помощи приложения QuickTime 
Player несложно обрабатывать видеоролики: вырезать, копировать 
и вставлять видеофрагменты, достаточно просто указать программе, 
какой именно вам нужен.

Чтобы просмотреть видеозапись при помощи приложения QuickTime 
Player, выполните следующие шаги.

1. Откройте окно Finder, перейдите в папку Программы (Applications) 
и запустите приложение QuickTime Player.

2. Выполните команду меню Файл ⇒ Открыть файл (File ⇒ Open file) 
или сочетание клавиш �+O. Откроется окно для выбора файла.

3. Выберите видеофайл и нажмите кнопку Открыть (Open), чтобы от-
крыть его в приложении QuickTime Player. Также вы можете дважды 
щелкнуть мышью по значку видеофайла в окне приложения Finder 
или на рабочем столе. Выбранный файл откроется в окне прило-
жения.

4. Нажмите кнопку , чтобы начать воспроизведение (рис. 4.12).

Рис. 4.12. Просмотр видеофайла в приложении QuickTime Player

5. Чтобы перейти в полноэкранный режим, нажмите кнопку  в пра-
вом верхнем углу окна программы или сочетание клавиш ⌃+�+F. 
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При изменении размера окна приложение QuickTime Player стара-
ется сохранить пропорции изображения (соотношение размеров) 
исходного кадра и избежать случайного искажения.

6. Если потребуется изменить громкость звука, перетащите пол-
зунковый регулятор  или воспользуйтесь клавишами ↓ (тише) 
и ↑ (громче ).

� Совет. Чтобы полностью выключить звук, используйте сочетание 
клавиш ⌥+↓, в свою очередь сочетание клавиш ⌥+↑ установит 
уровень звука на максимум.

Чтобы просмотреть потоковое видео или прослушать аудио во Все-
мирной паутине, следует найти на веб-странице ссылку вида «Щелкни-
те здесь, чтобы просмотреть (прослушать) запись» и скопировать ее. 
В приложении QuickTime Player необходимо выбрать команду меню 
Файл ⇒ Открыть адрес (File ⇒ Open Location) или сочетание клавиш 
�+L и вставить скопированный адрес в открывшееся окно. После на-
жатия кнопки Открыть (Open) приложение начнет воспроизведение 
потокового файла.

Safari

Safari  — это веб-браузер в составе операционной системы OS X. С по-
мощью программы Safari вы можете управлять открытыми веб- страни-
цами, организовать свою работу во Всемирной паутине при помощи 
списка чтения, вкладок и закладок, сохранять, распечатывать и отправ-
лять по почте содержимое веб-страниц и ограничивать доступ детей 
к нежелательным веб-ресурсам (средствами родительского контроля).

� Примечание. Подробнее о возможностях веб-браузера Safari 
см. в главе 8.

TextEdit

Используя текстовый редактор TextEdit, вы можете создавать заметки, 
письма, вести дневники, составлять списки, заполнять таблицы, а так-
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же редактировать различные текстовые документы. TextEdit предоста-
вит вам ряд возможностей для форматирования текста, обработки ил-
люстраций, а также поиска и замены фрагментов в документах. В этом 
разделе мы кратко рассмотрим основные возможности приложения 
TextEdit: создание и сохранение текстовых файлов, использование 
стилей форматирования, создание таблиц и вывод документов на пе-
чать. Если вам приходится работать с документами, созданными в при-
ложении Microsoft Word, редактор TextEdit предоставит возможность 
открывать и обрабатывать такие файлы, а также сохранять их в том 
же формате (*.DOC). Некоторые сложные функции форматирования 
останутся недоступны, но для редактирования элементарных тексто-
вых документов, содержащих простые таблицы и маркированные или 
нумерованные списки, имеющихся возможностей будет вполне доста-
точно. Если на вашем компьютере не установлена программа Microsoft 
Word, операционная система автоматически будет ассоциировать все 
файлы с расширением doc с приложением TextEdit. Кратко познако-
мимся с приемами работы в программе.

1. Чтобы запустить приложение, откройте окно Finder, перейдите 
в папку Программы (Applications) и дважды щелкните мышью по 
значку приложения TextEdit. Откроется окно TextEdit (рис. 4.13).

Рис. 4.13. Окно TextEdit

Аналогичные окна вы можете встретить и у других приложений в опе-
рационной системе OS X. Конкретно это предназначено для выбора 
документа, который следует открыть. В левом верхнем углу окна вы 
увидите две вкладки: iCloud отображает документы, хранящиеся на 
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сервере облачного сервиса iCloud, а вкладка На моем Mac (On My 
Mac) открывает доступ к содержимому вашего компьютера. В правом 
верхнем углу расположено поле ввода, предназначенное для поиска 
файлов. В левом нижнем углу находится кнопка для создания нового 
документа, кнопки  и  для выбора режима отображения фай-
лов — в виде значков и списка соответственно, кнопка  для отправки 
файла по электронной почте или в сообщении, а также кнопка  для 
управления цветовыми тегами документов. В правом нижнем углу рас-
положена кнопка Готово (Done) для закрытия окна и кнопка Открыть 
(Open) для открытия выбранного документа.

2. Выберите документ и дважды щелкните по нему мышью или нажми-
те кнопку Открыть (Open), расположенную в правом нижнем углу. 
Откроется окно документа (рис. 4.14), а в панели Dock появится зна-
чок приложения TextEdit — .

Рис. 4.14. Окно документа в приложении TextEdit

3. Чтобы добавить текст, достаточно щелкнуть мышью по свободной 
области в окне документа и напечатать, что нужно, при помощи 
клавиатуры.

Панель инструментов приложения TextEdit позволяет управлять табу-
ляцией, задавать междустрочные интервалы и выравнивать абзацы. 
Раскрывающийся список  Стили (Style) позволяет выбрать вариант 
начертания шрифта. Чтобы изменить отступы между строками, исполь-
зуйте раскрывающийся список  Интервалы (Spacing), а для созда-
ния списков (нумерованных или маркированных) — раскрывающийся 
список  Списки (Lists). Шкалу (линейку) под панелью управления 
можно отобразить/скрыть при помощи сочетания клавиш �+R.
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Чтобы добавить в документ таблицу, выполните следующие действия.

1. Установите текстовый курсор в позицию, где вы хотите вставить та-
блицу, а затем выполните команду меню Формат ⇒ Таблица (For-
mat ⇒ Table). Откроется окно Таблица (Table), в котором нужно ука-
зать, какая именно таблица нужна.

2. В поле ввода Строки (Rows) отметьте, сколько строк должно быть 
в таблице, а в поле Колонки (Columns) — число столбцов. Также вы 
можете выбрать способ выравнивания текста в ячейках, толщину 
и цвет рамки таблицы или цвет заливки ячеек.

3. Нажмите кнопку Вставить таблицу (Nest Table). Таблица появится 
в документе.

4. Чтобы заполнить ее, установите курсор в ячейку и введите текст. По 
мере появления символов ячейка таблицы будет постепенно уве-
личиваться по вертикали — так, чтобы было видно все введенное.

Если нужно отформатировать текст в таблице, действуйте так же, как 
при обработке обычного текста: выделите нужный фрагмент и выбери-
те параметры форматирования из строки меню или панели инструмен-
тов приложения TextEdit. Если вы хотите изменить размер строк или 
столбцов, просто перетащите границу ячейки при помощи мыши.

Чтобы сохранить документ, выполните следующие действия.

1. Щелкните мышью по заголовку окна документа. Появится панель, 
в которой нужно указать имя файла и место хранения, а также, по 
желанию, присвоить теги и установить защиту (рис. 4.15).

Рис. 4.15. Панель сохранения текстового документа
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2. В поле Имя (Name) укажите имя файла.

3. При необходимости присвойте файлу цветовые теги, используя 
поле Теги (Tags).

4. В раскрывающемся списке Где (Where) выберите, где должен быть 
сохранен файл — в облачном хранилище iCloud или на компьюте-
ре, указав папку.

5. Для защиты файла от случайного изменения или удаления устано-
вите флажок Установлена защита (Locked).

6. Щелкните мышью вне панели. Документ сохранен.

� Совет. Если вы хотите распечатать созданный документ, выполните 
команду меню Файл ⇒ Напечатать (File ⇒ Print) или нажмите со-
четание клавиш �+P.

Редактор TextEdit позволяет открывать и сохранять документы в форма-
те *.DOC (приложение Microsoft Word). Когда вы откроете в приложении 
TextEdit документ, созданный в редакторе Microsoft Word, бóльшая часть 
форматирования будет сохранена: начертание шрифтов, цвета, между-
строчные интервалы, выравнивание и т. д. Приложение TextEdit также 
способно отобразить простые таблицы, правда с измененной шириной 
столбцов. Но не все форматирование программы Microsoft Word пере-
носится в приложение TextEdit. В основном проблемы могут возникнуть 
с рамками, стилями, сносками, маркированными и нумерованными 
списками. Также редактор TextEdit не воспринимает комментарии и ис-
правления, которые программа Microsoft Word создает, когда над одним 
документом совместно работают несколько пользователей.

Time Machine

Утилита Time Machine  предназначена для создания резервной копии 
данных вашего компьютера. После простой настройки приложение 
Time Machine будет автоматически создавать резервную копию си-
стемы, настроек и другого содержимого жесткого диска: приложений, 
учетных записей, персональных настроек системы и программ, доку-
ментов, музыкальных файлов, видеороликов, фотографий и т. д. При 
этом программа копирует только те файлы, которые вы изменили с мо-
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мента создания последней копии. Резервное копирование выполня-
ется в фоновом режиме, поэтому вы сможете работать на компьютере 
как обычно, не отвлекаясь на управление приложением Time Machine. 
Процесс восстановления потерянных или поврежденных данных с по-
мощью утилиты Time Machine прост и не требует каких-то специальных 
знаний или навыков. При необходимости вы можете вернуть систему 
к состоянию на определенный день.

� Примечание. О возможностях приложения Time Machine и прин-
ципах работы с ним вы узнаете в главе 10.

Заметки

С помощью приложения Заметки (Notes) вы можете записывать форма-
тированный текст и фотографии. Заметки могут быть синхронизирова-
ны с учетной записью iCloud и отправлены по электронной почте, что 
позволит вам получать доступ к ним, где бы вы ни находились. Чтобы 
ваши заметки синхронизировались, учетная запись Apple ID должна 
быть подключена к учетной записи iCloud. Кратко рассмотрим приемы 
работы с приложением Заметки (Notes).

1. Чтобы запустить программу, щелкните мышью по ее значку ( ) на 
панели Dock. Откроется окно приложения (рис. 4.16). На рисунке 
также показаны дополнительные окна, не появляющиеся в момент 
запуска приложения!

Основное окно приложения Заметки (Notes) имеет три области: в ле-
вой части можно увидеть список расположений заметок (в случае, если 
подключена учетная запись iCloud), в центре отображается список за-
меток указанного расположения, и в правой части показано содержи-
мое выбранной заметки.

Вы можете сортировать свои заметки по папкам. Чтобы создать новый 
каталог, выполните следующие действия.

1. Удерживая клавишу ⌃, щелкните мышью по области расположений 
и в появившемся контекстном меню выберите пункт Новая папка 
(New Folder).

2. Введите имя папки и нажмите клавишу �.
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Рис. 4.16. Окно приложения Заметки с дополнительными окнами

Вы можете помещать сюда существующие заметки, перетаскивая их, 
или создавать новые внутри папки.

� Совет. Если, удерживая клавишу ⌥, перетащить заметку в другой 
каталог, она будет скопирована.

Чтобы удалить папку, выполните следующие действия.

1. Удерживая клавишу ⌃, щелкните мышью по имени папки, которую 
хотите удалить, и в появившемся контекстном меню выберите пункт 
Удалить папку (Delete Folder).

2. Подтвердите удаление, нажав кнопку Удалить папку (Delete 
Folder ).

Будьте внимательны, при удалении папки удаляются все содержащиеся 
в ней заметки!
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Чтобы создать новую заметку, выполните следующие действия.

1. Выберите папку, в которой должна быть создана заметка, и нажми-
те кнопку  в нижней части окна программы.

2. Введите текст заметки.

� Совет. Чтобы удалить заметку, щелкните по ней мышью, удерживая 
клавишу ⌃, и в появившемся контекстном меню выберите пункт 
Удалить (Delete).

Изменение форматирования осуществляется с помощью команд 
меню Формат (Format) и дополнительных окон, показанных на 
рис. 4.16.

� Совет. Если дважды щелкнуть мышью по названию заметки, она от-
кроется в новом окне, которое можно будет разместить на рабочем 
столе отдельно от основного окна программы.

3. Нажмите сочетание клавиш �+T, чтобы открыть окно Шрифты 
(Fonts). В нем вы можете выбрать шрифт, его размер, цвет (открыва-
ется окно Цвета (Colors), показанное на рис. 4.16), а также подчер-
кивание/зачеркивание.

� Совет. Нажав кнопку  в окне Шрифты (Fonts), вы получите до-
ступ к дополнительным командам, таким как Символы (Symbols), 
которые позволяют вставлять в заметки интересные и смешные 
значки, как показано на рис. 4.16.

Чтобы добавить изображение в заметку, достаточно перетащить в нее 
графический файл.

Над списком заметок расположено поле ввода Поиск (Search). Введя 
туда слово или другую информацию, вы сможете найти нужную замет-
ку среди прочих.
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Чтобы отправить заметку по электронной почте или в сообщении, не-
обходимо открыть ее и нажать кнопку  в правом нижнем углу окна 
программы. Также вы можете экспортировать заметку в PDF-файл, вы-
полнив команду меню Файл ⇒ Экспортировать в PDF (File ⇒ Export 
as PDF).

Записки

Программа Записки (Stickies)  хранит отдельные записки прямо на ра-
бочем столе, словно это офисные стикеры. В таком приложении очень 
удобно создавать напоминания, составлять списки и хранить другую 
важную информацию. Несмотря на кажущуюся простоту, программа 
Записки (Stickies)  поддерживает размещение изображений и импорт/
экспорт текстовых документов. При желании вы можете изменить 
внешний вид данных в приложении: цвет, стиль, размер шрифта и т. д. 
Приложение призвано заменить бумажные липучки, которыми мно-
гие пользователи обклеивают свои мониторы. При помощи програм-
мы вы можете создавать короткие текстовые записки о планируемых 
делах, хранить электронные адреса или телефонные номера, к кото-
рым приходится часто обращаться. Но нужно помнить, что записки 
будут отображаться на рабочем столе, только если приложение за-
пущено.

Чтобы создать новую записку, выполните следующие шаги.

1. Откройте окно Finder, перейдите в папку Программы (Applications) 
и запустите приложение Записки (Stickies). При первом запуске 
приложения автоматически появятся несколько образцов записок, 
которые должны познакомить вас с возможностями программы 
(рис. 4.17).

2. Закройте записки-образцы, выполнив команду меню Файл ⇒ За-
крыть (File ⇒ Close) или нажав сочетание клавиш �+W, и подтвер-
дите операцию в появившемся окне.

3. Чтобы создать новую записку, выберите команду меню Файл ⇒ Но-
вая заметка (File ⇒ New Note) или нажмите сочетание клавиш �+N.

4. В открывшемся окне новой записки введите текст.

Кроме того, допустимо перетаскивать в окно записки текстовые фраг-
менты из другого приложения: TextEdit, Pages или Microsoft Word, 
а также изображения. Приложение Записки (Stickies) позволяет до-
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бавлять в записки даже аудиофайлы и небольшие видеоролики. При 
желании вы можете импортировать в окно записки любые текстовые 
файлы, выполнив команду меню Файл ⇒ Импорт текста (File ⇒ Im-
port).

Рис. 4.17. Вид записок на рабочем столе

5. Если записка очень важна и вы хотите, чтобы она была видна по-
верх окон других приложений, выполните команду меню Замет-
ка ⇒ Всегда на переднем плане (Note ⇒ Floating Window) или на-
жмите сочетание клавиш ⌥+�+F.

6. Если нужно, чтобы сквозь окно записки были видны окна других 
открытых приложений, выполните команду меню Заметка ⇒ По-
лупрозрачное окно (Note ⇒ Translucent Window) или нажмите со-
четание клавиш ⌥+�+T.

Также вы можете настроить персональный вид оформления записки, 
изменив способ отображения текста и цвет окна:

• чтобы изменить цвет окна записки, выберите в меню Цвет (Color) 
понравившийся оттенок;

• чтобы изменить шрифт текста записки, выполните команду меню 
Шрифт ⇒ Показать шрифты (Font ⇒ Show Fronts). Откроется окно 
Шрифты (Font), в котором вы можете выбрать тип шрифта, цвет 
и размер.
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� Совет. Когда вы оформите записку, выбрав для нее желаемый цвет, 
стиль текста и размер шрифта, можете закрепить этот дизайн за 
всеми новыми записками, которые будут созданы впоследствии, 
выполнив команду меню Заметка ⇒ Использовать по умолча-
нию (Note ⇒ Use as Default).

Размер записки легко изменить, нажав и удерживая на нижнем левом 
углу ее окна кнопку мыши и перетаскивая указателя мыши в нужном 
направлении.

Вы можете сворачивать и разворачивать записки, выполнив следую-
щие действия.

1. Чтобы свернуть записку, дважды щелкните мышью по темной по-
лосе в верхней части окна записки или выполните команду меню 
Окно ⇒ Свернуть (Window ⇒ Miniaturize).

 Когда окно записки находится в свернутом виде, первая строка тек-
ста отображается мелким шрифтом, это поможет понять содержи-
мое, не разворачивая окно.

2. Чтобы развернуть его, дважды щелкните мышью по темной по-
лосе в верхней части окна записки или выполните команду меню 
Окно ⇒ Развернуть (Window ⇒ Maximize).

Чтобы сохранить текст записки, выполните следующие действия.

1. Выберите команду меню Файл ⇒ Экспорт текста (File ⇒ Export 
Text). Откроется окно Экспорт (Export).

2. В поле ввода Сохранить как (Save as) укажите название записки.

3. В раскрывающемся списке Формат (Format) выберите тип файла, 
в котором приложение должно сохранить записку:

• Простой текст (Plain Text) позволит сохранить записку в обыч-
ном текстовом файле, без форматирования и графики;

• формат RTF сохранит основное форматирование, включая 
шрифт, стиль и цвет;

• формат RTFD создаст документ расширенного текстового форма-
та с вложениями (графическими файлами и другими объектами ).
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4. Нажмите кнопку Сохранить (Save), чтобы сохранить записку с за-
данными параметрами.

Все созданные вами записки приложение по умолчанию сохраняет 
в вашей домашней папке, но при желании несложно выбрать для них 
другое место. Сохраненными записками можно управлять, как и дру-
гими файлами: перемещать, копировать, пересылать по электронной 
почте или удалять.

Захват изображений

Небольшая программа Захват изображений (Image Capture)  предна-
значена для загрузки изображений с цифровых устройств на жесткий 
диск компьютера с целью их хранения и последующей обработки. 
Кроме того, программа позволяет выполнять операции сканирования 
и фотографирования прямо из приложения.

1. Подключите фотоаппарат или сканер к вашему компьютеру и (при 
необходимости) включите его.

2. Откройте окно Finder, перейдите в папку Программы (Applications) 
и запустите приложение Захват изображений (Image Capture). От-
кроется основное окно приложения (рис. 4.18).

Рис. 4.18. Окно приложения Захват изображений
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3. С помощью первого раскрывающегося списка в нижней части окна 
программы укажите, в какую папку на жестком диске следует ско-
пировать объекты. Когда приложение загрузит все изображения, 
система автоматически откроет указанную папку.

Вы можете повернуть изображение, нажав кнопку  нужное количе-
ство раз. А также удалить ее, нажав кнопку .

4. Установите флажок Удалить после импорта (Delete after capture), 
чтобы удалить фотографии с карты памяти после импорта.

� Совет. Вы можете настроить программу Захват изображений (Ima-
ge Capture) так, чтобы она автоматически открывалась при под-
ключении фотокамеры через USB-порт. Для этого выберите пункт 
Захват изображений (Image Capture)  в раскрывающемся списке 
Камера: при подключении открывается (Connecting this camera 
opens).

5. Нажмите кнопку Импортировать все (Import All). Приложение ско-
пирует все изображения с камеры на жесткий диск.

 Если нужно загрузить только некоторые изображения, выберите их 
и нажмите кнопку Импортировать (Import).

Также в приложении Захват изображений (Image Capture) вы можете 
делать снимки с помощью подключенного устройства, например фото-
аппарата. Для этого выполните следующие действия.

1. Подключите фотоаппарат к компьютеру и (при необходимости) 
включите его.

2. Выберите команду меню Файл ⇒ Сфотографировать (File ⇒ Take 
Picture). Откроется окно Сделать снимок (Take Picture) (рис. 4.19).

3. Установите переключатель в положение Вручную (Manual) (съемка 
осуществляется нажатием клавиши Пробел или �) или Автомати-
чески (Automatic). 

 В последнем случае укажите промежуток времени между кадрами 
с помощью элементов управления, расположенных ниже, и нажми-
те кнопку Начать (Start). Чтобы прекратить съемку, нажмите кнопку 
Остановить (Stop).
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Рис. 4.19. Окно Сделать снимок

По умолчанию снятые кадры записываются на карту памяти фотоаппа-
рата, но вы можете также отправлять их на жесткий диск компьютера, 
установив флажок Загрузить новые изображения в (Download new 
images to) и выбрав папку в раскрывшемся списке. А если установлен 
флажок Удалить после загрузки (Delete after downloading), после ко-
пирования на жесткий диск фотографии будут удалены с карты памяти 
фотоаппарата.

Календарь

Приложение Календарь (Calendar)  — удобный инструмент, который 
поможет вам запоминать даты важных мероприятий и создавать спи-
ски дел на каждый день. Календари, которые вы наполните событиями 
в этом приложении, можно синхронизировать с сервисом iCloud и ис-
пользовать на всех устройствах, авторизованных с вашим Apple ID.

Чтобы изучить возможности приложения Календарь (Calendar), выпол-
ните следующие шаги.

1. Запустите приложение, щелкнув мышью по значку  на панели 
Dock. Откроется основное окно приложения (рис. 4.20).
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Рис. 4.20. Окно приложения Календарь

 По умолчанию основное окно имеет привычный формат календа-
ря. Под заголовком, на панели инструментов, находятся кнопки, 
при помощи которых можно менять режимы просмотра календа-
ря: День (Day), Неделя (Week), Месяц (Month) и Год (Year). Чтобы 
перей ти в нужный режим, нужно щелкнуть мышью по соответству-
ющей кнопке.

2. Если вы хотите создать новый календарь, выберите команду меню 
Файл ⇒ Новый календарь ⇒ iCloud (File ⇒ New Calendar ⇒ iCloud). 
В левой части окна появится всплывающая группа элементов управ-
ления для создания нового календаря.

3. Присвойте ему название и нажмите клавишу �, чтобы сохранить.

 Приложение Календарь (Calendar) может работать с любым количе-
ством календарей. Каждый из них помечен определенным цветом. 
Это сделано для того, чтобы в случае, когда события из разных ка-
лендарей накладываются друг на друга, было легче ориентировать-
ся в записях.

4. Чтобы изменить цвет календаря, нажмите кнопку Календари (Calen-
dars), а затем, удерживая клавишу ⌃, щелкните мышью по нужному 
календарю и выберите пункт Информация (Info) в контекстном 
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меню. Появится панель, с помощью элементов управления которой 
можно изменить цвет календаря и указать дополнительную инфор-
мацию.

5. После внесения изменений в настройки календаря нажмите кноп-
ку OK.

Создавать события, приуроченные к определенной дате (но не привя-
занные по времени), удобнее всего в режиме Месяц (Month). Для этого 
выполните следующие действия.

1. Измените режим просмотра календаря, нажав кнопку Месяц 
(Month) в верхней части окна программы.

2. Дважды щелкните мышью по ячейке с нужной датой. Появится па-
нель, где можно задать параметры события.

3. Введите название события, укажите место и уточните время, если 
требуется (рис. 4.21).

Рис. 4.21. Создание события в календаре

4. Щелкните мышью в любом месте экрана или нажмите клавишу �, 
чтобы сохранить событие.

Для событий, которые не только привязаны к определенному числу, но 
и распланированы по времени, удобнее использовать режим просмо-
тра по неделям или по дням.

1. Измените режим просмотра календаря, нажав кнопку Неделя 
(Week) или День (Day) в верхней части окна программы.
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2. Дважды щелкните мышью по нужной дате/времени и создайте со-
бытие.

3. Чтобы скорректировать период проведения мероприятия, уста-
новите указатель мыши на нижний край события. Когда указатель 
мыши примет вид двунаправленной стрелки, перетаскивайте мышь, 
пока событие не растянется на нужное количество часов (рис. 4.22).

� Совет. Аналогичным образом вы можете «растянуть» событие на 
несколько дней.

Рис. 4.22. Создание события в режиме День

С программой Календарь (Calendar) активно взаимодействуют прило-
жения Контакты (Contacts) и Mail. При создании событий вы можете до-
бавлять приглашения на планируемые в вашем календаре мероприя-
тия близким и друзьям.

Калькулятор

Приложение Калькулятор (Calculator)  позволяет выполнять различные 
расчеты: простые арифметические вычисления, сложные математиче-
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ские и логические операции, а также переводить основные единицы 
измерения площади, длины, объема и пересчитывать суммы в разной 
валюте. При необходимости вы можете посмотреть и распечатать про-
цесс вычислений.

� Примечание. В приложении Dashboard имеется простой кальку-
лятор, который входит в данную группу виджетов. Но, хотя он и от-
крывается быстрее, здесь вы сможете провести только простые ма-
тематические вычисления. Подробнее о виджетах см. в главе 11.

Чтобы познакомиться с программой Калькулятор, вам нужно выпол-
нить следующие действия.

1. Откройте окно Finder, перейдите в папку Программы (Applica-
tions) и запустите приложение Калькулятор. Откроется основное 
окно Калькулятор программы в режиме Стандартный (Basic) 
(рис. 4.23).

Рис. 4.23. Окно программы Калькулятор в режиме Стандартный (Basic)

Всего в приложении Калькулятор (Calculator) доступны три режима: 
Стандартный (Basic), Инженерный (Advanced) и Для программиста 
(Programmer). Вы можете выбрать любой из них. В режиме Стандарт-
ный (Basic) выполняются четыре основных арифметических действия: 
сложение, вычитание, умножение и деление, в режиме Инженерный 
(Advanced) — ряд научных вычислений, а в режиме Для программи-
ста (Programmer) ведется работа с шестнадцатеричными, восьмерич-
ными, десятичными и двоичными системами счисления.
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2. Чтобы перейти в режим Инженерный (Advanced), нажмите сочета-
ние клавиш �+2 или выполните команду меню Вид ⇒ Инженер-
ный (View ⇒ Advanced).

3. Чтобы перейти в режим Для программиста (Programmer), нажмите 
сочетание клавиш �+3 или выполните команду меню Вид ⇒ Для 
программиста (View ⇒ Programmer) (рис. 4.24).

Рис. 4.24. Программа Калькулятор в режимах Инженерный (слева) 
и Для программиста (справа)

4. Чтобы вернуться в режим Стандартный (Basic), нажмите сочетание 
клавиш �+1 или выполните команду меню Вид ⇒ Стандартный 
(View ⇒ Basic).

Краткие приемы работы с программой Калькулятор:

• чтобы выполнить расчеты, вы можете щелкать мышью по соответ-
ствующим кнопкам с числами и операторами, но гораздо удобнее 
использовать соответствующие цифровые клавиши на клавиатуре;

• чтобы очистить дисплей калькулятора, нажмите кнопку ;

• если вам нужно скопировать результаты вычислений, выполните 
команду меню Правка ⇒ Скопировать (Edit ⇒ Copy) или нажми-
те сочетание клавиш �+C, а затем вставьте результат вычислений 
в другое приложение;

• если вы проводите расчеты и хотите использовать обратную поль-
скую нотацию, которая позволяет обходиться без скобок, выполни-
те команду меню Вид ⇒ Режим ОПН (View ⇒ RPN).
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Вы также можете преобразовывать единицы измерения. Для этого вы-
полните следующие шаги.

1. Введите начальное значение. Например, вам нужно преобразовать 
значение в долларах США в российские рубли.

2. В меню Конвертация (Convert) выберите тип преобразования. На-
пример, Валюта (Currency). Вы увидите панель с группой элементов 
управления (рис. 4.25).

Рис. 4.25. Панель для настройки преобразования

3. Укажите исходную и расчетную единицы измерения при помощи 
раскрывающихся списков.

4. Нажмите кнопку Конвертировать (Convert), программа выведет 
результат.

� Примечание. Приложение Калькулятор запоминает, какие типы 
конвертации вы используете, и в следующий раз, когда вам потре-
буется преобразовать денежные единицы, этот тип преобразова-
ния найдется в подменю Конвертация ⇒ Последние конверта-
ции (Convert ⇒ Recent Conversions).

При необходимости вы можете сохранить процедуру расчета, выпол-
нив команду меню Файл ⇒ Сохранить расчеты как (View ⇒ Save Tape 
as). Откроется окно Лента расчетов (Paper Tape), в котором показан 
порядок вычислений. Сразу же автоматически откроется панель, на ко-
торой нужно выбрать тип файла и папку, где будут сохранены расчеты, 
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и, при желании, присвоить файлу цветовые теги. При необходимости 
вы можете распечатать расчеты, выполнив команду меню Файл ⇒ На-
печатать ленту расчетов (File ⇒ Print Tape).

Карты

С помощью приложения Карты (Maps), впервые появившегося в опе-
рационной системе OS X версии Mavericks, вы можете найти нужное 
место на карте, проложить маршрут до точки назначения и посмотреть 
информацию о движении на дорогах.

1. Чтобы запустить приложение, щелкните мышью по значку  на 
панели Dock.

2. По умолчанию карты отображаются в виде обычной схемы, но вы 
можете переключиться на другой режим, нажав кнопку Спутник 
(Satellite) для просмотра фотографий со спутника, кнопку Гибрид 
(Hybrid) для одновременного просмотра фотографий со спутника 
и схемы карты или кнопку Стандарт (Standard) для возврата в обыч-
ный режим (рис. 4.26).

Рис. 4.26. Просмотр карты в режиме Спутник
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3. Некоторые города на карте можно просматривать в трехмерном ото-
бражении. Чтобы перейти к нему, нажмите кнопку  (рис. 4.27).

Рис. 4.27. Просмотр карты в 3D-режиме

Чтобы найти нужное место на карте, воспользуйтесь поиском. В поле 
ввода поиска можно указать как искомый адрес, так и любую другую 
информацию: название объекта, достопримечательности, компании.

Навигация осуществляется следующим образом.

• Чтобы перемещаться по карте, перетяните ее, удерживая кнопку 
мыши. Чтобы повернуть карту, удерживайте кнопку мыши на ком-
пасе и двигайте мышью влево или вправо или поверните карту дву-
мя пальцами.

• Чтобы увеличить масштаб, дважды щелкните по карте в области, ко-
торую хотите приблизить.

• Чтобы уменьшить масштаб, дважды щелкните по карте, нажав 
и удерживая клавишу ⌥.

• Чтобы определить на карте свое местоположение, нажмите кнопку 
. Если у вас отключены службы геолокации, вы увидите соответ-

ствующее сообщение.
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� Примечание. Чтобы включить службы геолокации, выберите ко-
манду меню  ⇒ Системные настройки (  ⇒ System Preferen-
ces) и перейдите в раздел Защита и безопасность (Security & Pri-
vacy). На вкладке Конфиденциальность (Privacy) выберите пункт 
Службы геолокации (Location Services), отметьте флажок Вклю-
чить службы геолокации (Enable Location Services), после чего 
установите флажок Карты (Maps). Если будет запрошен пароль ад-
министратора, введите его и нажмите кнопку ОК.

Вы можете обозначать различные расположения на карте, чтобы в слу-
чае необходимости получить о них сведения и быстро находить в даль-
нейшем.

1. Чтобы установить булавку, перейдите к расположению, которое 
нужно обозначить, и, щелкнув мышью с нажатой клавишей ⌃, вы-
полните команду меню Установить булавку (Drop Pin).

2. Если булавка появилась на карте в ошибочной позиции, перетащи-
те ее, удерживая кнопку мыши.

3. Чтобы удалить булавку, щелкните по ней мышью и выполните ко-
манду меню Вид ⇒ Очистить булавку (View ⇒ Clear Pin).

Рис. 4.28. Прокладывание маршрута
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С помощью приложения Карты можно проложить маршрут и получить 
подробные указания для перемещения пешком или на машине. С этой 
целью следует нажать кнопку Маршруты (Directions) и в появившей-
ся боковой панели указать начальную и конечную точки путешествия 
(рис. 4.28).

Программа способна отобразить на карте информацию о пробках, вы 
можете использовать эту функцию при прокладывании маршрута. На-
жмите кнопку , чтобы ознакомиться с текущей ситуацией на дорогах. 
Движение на карте отмечено в виде точек: оранжевые — медленное 
движение, красные — затрудненное.

Контакты

При помощи приложения Контакты (Contacts)  вы можете легко создать 
базу данных, в которой будут храниться имена, почтовые и электронные 
адреса, номера телефонов и другая полезная информация о ваших дру-
зьях или клиентах. Несмотря на кажущуюся простоту, приложение Кон-
такты (Contacts) способно предоставить много полезных инструментов.

Используя его, вы сможете организовать свою информацию таким об-
разом, чтобы быстро находить нужные контакты, объединять их в груп-
пы для массовых рассылок, а также, при необходимости, распечатывать 
информацию, которая хранится в базе данных программы. В приложе-
нии предусмотрена возможность резервного копирования всех дан-
ных и создания смарт-групп со списком контактов, которые удовлетво-
ряют заданным вами критериям поиска.

Для каждого человека, контактные данные которого вы хотите занести 
в базу приложения, нужно создать персональную адресную карточку. 
В дальнейшем, взаимодействуя с программой Контакты (Contacts), вы 
сможете редактировать такие карточки, вплоть до их индивидуальной 
настройки.

Чтобы начать работу с приложением, выполните следующие шаги.

1. Запустите его, щелкнув мышью по значку  на панели Dock. От-
кроется основное окно приложения Контакты (Contacts) (рис. 4.29).

2. Чтобы создать новую карточку, нажмите кнопку , которая нахо-
дится в нижней части окна, и выберите в контекстном меню пункт 
Новый контакт (Address Book). В правой части окна появятся поля 
ввода, которые вам нужно заполнить.
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Рис. 4.29. Основное окно приложения Контакты

3. Укажите в них необходимую информацию. Чтобы перейти к следую-
щему полю ввода, нажмите клавишу � или щелкните по нужному 
полю мышью.

4. При желании вы можете добавить фотографию к контакту. Для этого 
дважды щелкните мышью по пустому полю слева от имени контакт-
ного лица. Откроется панель, при помощи элементов управления 
которой вы сможете загрузить фотографию (рис. 4.30).

Рис. 4.30. Добавление фотографии к контакту
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5. Перетащите в центр этой панели нужное изображение или выбери-
те одно из стандартных.

Если размер выбранной фотографии не подходит, его можно легко уве-
личить или уменьшить, переместив ползунковый регулятор, располо-
женный непосредственно под изображением.

6. Нажмите кнопку Готово (Finish), чтобы присвоить контакту выбран-
ную фотографию.

� Примечание. Программа позволяет синхронизировать контакты 
с сервисом iCloud, поэтому все изменения, вносимые на компью-
тере, отобразятся в контактах на устройствах iPhone , iPad или iPod, 
если они авторизованы с вашей учетной записью Apple ID.

7. Если вы захотите отредактировать адресную карточку, выберите ее, 
а затем нажмите кнопку Правка (Edit), которая расположена в пра-
вом нижнем углу окна программы.

8. Отредактируйте карточку и нажмите кнопку Готово (Finish), сохра-
нив тем самым изменения.

� Совет. Чтобы создать в адресной книге собственную адресную кар-
точку, сначала нужно создать ее и заполнить, а затем выбрать ко-
манду меню Карточка ⇒ Это моя карточка (Card ⇒ Make This My 
Card). Вы легко узнаете свою карточку в общем списке — слева от ее 
имени появится значок .

Можно использовать группы для систематизации контактов по катего-
риям или упрощения отправки сообщений электронной почты сразу 
нескольким пользователям. Для этого выполните следующие действия.

1. Нажмите кнопку , которая находится в нижней части окна, и вы-
берите в контекстном меню Новая группа (New Group).

2. Присвойте новой группе имя и нажмите клавишу �.

3. Выберите пункт Все контакты (All Contacts) в левой части окна про-
граммы и перетащите нужные контакты из центральной части окна 
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на созданную группу. Один и тот же контакт можно включить в раз-
ные группы.

� Примечание. Чтобы удалить контакт из группы, выделите его и вы-
берите команду меню Правка ⇒ Удалить из группы (Edit ⇒ Re-
move from Group). Чтобы удалить группу, выделите ее и выберите 
команду меню Правка ⇒ Удалить группу (Edit ⇒ Delete Group).

4. Чтобы отправить сообщение всем контактам группы, щелкните мы-
шью по ее названию при нажатой клавише ⌃ и в контекстном меню 
выберите пункт E-mail группе «название_группы» (Send Email to 
название_группы).

5. В открывшемся окне нового сообщения приложения Mail введите 
текст письма и отправьте его всем контактам из группы (при усло-
вии, что в карточках указаны адреса электронной почты).

Если вы хотите распечатать ту или иную карточку, выполните следую-
щие действия.

1. Выберите карточки, которые нужно вывести на печать, и нажмите 
сочетание клавиш �+P или выполните команду меню Файл ⇒ На-
печатать (File ⇒ Print). Откроется окно Печать (Print).

2. Задайте параметры печати и нажмите кнопку Напечатать (Print).

Хотя база контактов содержится не только на ваших устройствах, но 
и дублируется на сервере iCloud, если вы переживаете за ее сохран-
ность, можете выполнить резервное копирование. Оно осуществляет-
ся двумя способами.

• Выделите контакт и мышью перетащите его на рабочий стол или 
выберите команду меню Файл ⇒ Экспорт ⇒ Экспорт vCard 
(File ⇒ Export ⇒ Export vCard). Будет создан файл виртуальной кар-
точки (vCard), который можно сохранить в безопасном располо-
жении или на сменном носителе. Этот способ удобен, если нужно 
выполнить выборочное резервное копирование определенных 
контактов.

• Чтобы создать полную резервную копию информации из адрес-
ной книги, выполните команду меню Файл ⇒ Экспорт ⇒ Архив 
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адресной книги (File ⇒ Export ⇒ Contacts Archive) и укажите место 
хранения архива. Если потребуется восстановить адресную книгу, 
дважды щелкните мышью по файлу архива или выполните команду 
меню Файл ⇒ Импорт (File ⇒ Import), чтобы переместить содержи-
мое архивного файла в адресную книгу.

Смарт-группы автоматически отбирают контакты на основании задан-
ных критериев. Например, можно сгруппировать всех родственников, 
создав смарт-группу с контактами, которые имеют слово «родствен-
ник», в поле Заметка (Note) карточки. Теперь каждый раз, когда вы 
будете вводить в такое поле слово «родственник», контакт будет авто-
матически добавляться в смарт-группу родственников. Смарт-группы 
могут содержать контакты из любых учетных записей.

Чтобы создать смарт-группу, предпримите следующие действия.

1. Выполните команду меню Файл ⇒ Новая смарт-группа (File ⇒ New 
Smart Group). Появится панель, на которой нужно задать параметры 
отбора для будущей группы.

2. Укажите критерии поиска, по которым приложение должно отби-
рать новые контакты в смарт-группу, и подтвердите создание груп-
пы. В нее автоматически будут помещены контакты согласно ука-
занным настройкам.

C помощью программы Контакты (Contacts) можно определить распо-
ложение любого адреса из списка контактов и проложить к нему марш-
рут, щелкнув мышью по ссылке Показать карту (Show Address) в окне 
карточки.

Также приложение Контакты (Contacts) поддерживает поиск информа-
ции среди контактов, для чего служит поле ввода в верхней части окна 
программы.

Напоминания

С помощью приложения Напоминания (Reminders) вы всегда сможете 
запланировать будущие дела и встречи, чтобы в дальнейшем не забыть 
о них. Воспользуйтесь приложением Напоминания (Reminders), выпол-
нив следующие шаги.

1. Откройте окно Finder, перейдите в папку Программы (Applications) 
и запустите приложение Напоминания (Reminders) (рис. 4.31).
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Рис. 4.31. Окно программы Напоминания

Окно программы Напоминания (Reminders) разделено на две части. 
В левой перечислены списки напоминаний, а в правой отображается 
содержимое выбранного списка, то есть сами напоминания.

2. Чтобы добавить в приложение новый список, нажмите кнопку  
и введите его название.

3. Удерживая клавишу ⌃, щелкните мышью в правой части приложе-
ния и в появившемся контекстном меню выберите пункт Новое на-
поминание (New Reminder).

4. Напишите название напоминания, после чего повторите пункт 3, 
если хотите создать еще одно напоминание в своем списке.

Вы можете добавить к напоминаниям дополнительную информацию.

5. Установите указатель мыши на напоминание, после чего в его пра-
вой части появится значок . Щелкните по нему мышью. Откро-
ется всплывающее окно (рис. 4.32).

• Чтобы указать дату и время напоминания, установите флажок 
В день (On a Day) и выберите дату и время.
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Рис. 4.32. Дополнительные настройки напоминания

• Если вы активировали службы геолокации, то можете выбрать 
напоминание по месту назначения (то есть уведомление о нем 
появится, когда вы прибудете с данным компьютером в указан-
ное место (или покинете его)1). Для этого установите флажок По 
месту (At a Location), в появившемся поле ввода сообщите имя 
контакта или адрес, после чего установите переключатель в по-
ложение Убытие (Leaving) или Прибытие (Arriving).

• Если в списке требуется указать, какие напоминания важны, а ка-
кие не очень, воспользуйтесь возможностью установки приори-
тета, указав его в раскрывающемся списке Приоритет (Priority). 
Напоминания низкого приоритета отмечаются в списке одним 
восклицательным знаком, высокого приоритета — тремя вос-
клицательными знаками.

• В поле ввода Заметка (Note) вы можете указать дополнитель-
ную информацию, касающуюся выбранного напоминания.

6. Чтобы сохранить изменения, нажмите кнопку Готово (Done). На-
поминание отобразится в левом верхнем углу экрана согласно на-
стройкам даты и времени оповещения (рис. 4.33).

1 При условии, что включены службы геолокации и компьютер оборудован GPS-модулем.
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Рис. 4.33. Уведомление о напоминании

Если вы уже выполнили какое-либо напоминание, можете отправить 
его в список Завершено (Completed), установив флажок, расположен-
ный справа от названия напоминания, или, удерживая клавишу ⌃, 
щелкнуть по нему мышью и выбрать пункт Отметить как завершен-
ное (Mark as Completed).

� Совет. Чтобы перенести напоминание из одного списка в другой, 
удерживая клавишу ⌃, щелкните мышью по напоминанию и в по-
явившемся контекстном меню выберите пункт Переместить в спи-
сок (Move to List).

Когда напоминаний становится много, вы можете воспользоваться сле-
дующими функциями приложения, которые помогут быстро найти не-
обходимое.

• Нажмите кнопку  в нижней части окна программы, чтобы ото-
бразить календарь. В нем дни, на которые настроены напоминания, 
отмечены точками. Выберите такой день, и в правой части окна при-
ложения отобразится список напоминаний, связанных с этой датой.

• В левом верхнем углу приложения расположено поле ввода Поиск 
(Search). Введите там слово или другую информацию, которую хоти-
те найти в списке напоминаний.

Вы можете импортировать и экспортировать список напоминаний 
с одного компьютера Mac на другой, если они не связаны учетной за-
писью Apple ID (в противном случае процесс синхронизации за вас вы-
полняет сервис iCloud). Чтобы экспортировать список напоминаний, 
выполните команду меню Файл ⇒ Экспортировать (File ⇒ Export). 
Чтобы импортировать список напоминаний, выполните команду меню 
Файл ⇒ Импортировать (File ⇒ Import).

Просмотр

При помощи приложения Просмотр (Preview)  вы можете просматривать 
графические изображения и файлы в формате *.PDF, а также управлять 
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сканированием, импортировать изображения с фотоаппарата и делать 
снимки экрана. Программа способна работать не только с популярны-
ми форматами изображений, такими как .jpeg, .tiff, .ict, . png, .bmp и .gif, но 
и правильно воспроизводить графику в менее распространенных фор-
матах, таких как .sgi, .tga, .macpaint, .psd и .eps. В приложении Просмотр 
(Preview) можно редактировать изображения: обрезать, изменять цве-
топередачу, регулировать яркость, резкость, контрастность и т. д.

1. Чтобы использовать возможности приложения Просмотр, открой-
те в нем файл одним из следующих способов:

• откройте окно Finder, перейдите в папку Программы (Applica-
tions) и запустите приложение Просмотр (Preview). Появится 
окно для выбора файла. Выберите файл (в хранилище iCloud 
или на своем Mac, перейдя на соответствующую вкладку) и на-
жмите кнопку Открыть (Open);

• дважды щелкните мышью по изображению или документу PDF 
в окне приложения Finder или на рабочем столе.

 В обоих случаях вы увидите окно приложения Просмотр (Preview) 
с содержимым открытого файла (рис. 4.34).

2. Если вы хотите открыть несколько изображений, выделите в окне 
Finder группу объектов и выберите в контекстном меню пункт От-
крыть (Open) или нажмите сочетание клавиш �+O. Приложение 
Просмотр (Preview) откроет все выбранные файлы.

3. Фотографии удобнее всего смотреть в полноэкранном режиме, по-
этому, чтобы открыть изображение на весь экран, нажмите кнопку 

 в правом верхнем углу окна приложения или используйте соче-
тание клавиш ⌃+�+F.

4. Для перехода в обычный режим нажмите кнопку  (чтобы отобра-
зить ее, подведите указатель мыши к верхней части экрана).

В верхней части окна программы Просмотр (Preview) расположена па-
нель инструментов, на которой кроме стандартных элементов управле-
ния, предназначенных для сохранения документа, управления окном, 
поиска и перехода в полноэкранный режим, доступны следующие 
кнопки.

•  предназначена для выбора режима отображения документа: 
содержимое, миниатюры, оглавление, выделенный текст и приме-
чания, закладки, обзорный лист, непрерывная прокрутка, одна или 
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две страницы. Некоторые режимы доступны только при открытии 
PDF-файлов.

•  и  используются для изменения масштаба просмотра от-
крытого файла.

•  предназначена для отправки открытого файла в сообщении 
или электронном письме. Также с ее помощью можно публиковать 
изображения в социальных сетях Facebook, Flickr и Twitter.

•  доступна только при открытии PDF-файлов и выделяет текст 
цветным маркером или делает его подчеркнутым/зачеркнутым.

•  предназначена для поворота открытого файла. Каждое нажа-
тие поворачивает документ на 90° против часовой стрелки, а если 
удерживать клавишу ⌥ — по часовой стрелке.

•  используется для открытия панели редактирования, о которой 
рассказывается далее.

Рис. 4.34. Окно приложения Просмотр с открытой фотографией
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Рассмотрим приемы простой обработки изображений в приложении 
Просмотр (Preview).

Чтобы кадрировать изображение, нажав и удерживая кнопку мыши, 
перетащите указатель мыши по диагонали через тот фрагмент, кото-
рый вы хотите сохранить. Если нужно изменить область кадрирования, 
перетащите круглые маркеры на пунктирном прямоугольнике. Что-
бы совершить кадрирование, выполните команду меню Инструмен-
ты ⇒ Обрезать (Tools ⇒ Crop) или нажмите сочетание клавиш �+K. 
Сохраните кадрированное изображение в виде нового файла, нажав 
и удерживая клавишу ⌥ и выполнив команду меню Файл ⇒ Сохра-
нить как (File ⇒ Save as).

Также для редактирования изображения вы можете использовать па-
нель инструментов. Отобразите ее, нажав кнопку , или выполнив ко-
манду меню Вид ⇒ Показать панель редактирования (View ⇒ Show 
Edit Toolbar), или нажав сочетание клавиш �+�+K. В верхней части 
окна программы вы увидите панель редактирования (рис. 4.35).

� Совет. Чтобы просмотреть общую информацию об изображении, 
выполните команду меню Инструменты ⇒ Показать Инспектор 
(Tools ⇒ Inspector) или нажмите сочетание клавиш �+I.

Рис. 4.35. Панель редактирования при просмотре изображений

На панели редактирования доступны следующие элементы управ-
ления.

• Раскрывающийся список   предназначен для выбора ин-
струмента выделения — прямоугольного, эллипсом, лассо и смарт-
лассо (выделение на основе маски).

• Кнопка  позволяет быстро сделать прозрачными выбранные об-
ласти (потребуется сохранить файл в формате PNG) — данный при-
ем часто используется при подготовке изображений для публика-
ции на веб-страницах.
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• Кнопки ,  и  предназначены для добавления прямоугольни-
ков, эллипсов и стрелок соответственно. При нажатии одной из 
кнопок появляются дополнительные элементы управления:  слу-
жит для выбора цвета обводки,  позволяет указать цвет заливки, 
а раскрывающийся список  предназначен для выбора стиля ли-
нии (стрелки) и установки тени.

• Кнопка  дает возможность разместить на изображении тексто-
вые надписи (разного типа: обычный и контурный текст, а также об-
лачка с текстом) и отображает дополнительные элементы управле-
ния:  служит для выбора цвета шрифта,  позволяет указать цвет 
заливки, раскрывающийся список  предназначен для выбора 
стиля линии и установки тени, есть также раскрывающиеся списки 
выбора шрифта и его размера, а кроме того, кнопки ,  и , пред-
назначенные для выравнивания текстовых объектов. Пример об-
лачка с текстом приведен на рис. 4.36.

Рис. 4.36. Облачко с текстом на изображении и окно настройки цвета

• Кнопка  открывает окно настройки цвета (рис. 4.36). Оно содер-
жит множество ползунков, при помощи которых вы можете отре-
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гулировать яркость, контраст, выдержку, интенсивность цвета, рез-
кость и пр.

• Кнопка  открывает панель настройки размера. Здесь вы сможете 
увеличить или уменьшить выбранное изображение на свое усмо-
трение.

Приложение Просмотр (Preview) также позволяет открывать доку-
менты в формате .pdf, выполнять поиск в таких документах, копиро-
вать из них текстовые фрагменты, добавлять комментарии, запол-
нять формы и переходить по действующим ссылкам. При просмотре 
PDF-файлов также доступна панель редактирования, она содержит 
несколько дополнительных элементов управления взамен тех, кото-
рые требуются для обработки изображений и не нужны для формата 
PDF (рис. 4.37).

Рис. 4.37. Панель редактирования при просмотре PDF-файлов

• Кнопка  позволяет выбрать инструмент выделения текста, кото-
рый используется по умолчанию.

• Кнопка  предназначена для выбора инструмента выделения. В от-
личие от группы инструментов выделения при работе с изображе-
ниями, в PDF-файлах доступно только прямоугольное выделение.

• Кнопка  добавляет заметки в PDF-документ.

• Кнопка  предназначена для добавления в PDF-документ под-
писи, которую можно подготовить при помощи камеры компью-
тера.

Программа Просмотр (Preview) в операционной системе OS X оснаще-
на лупой, которая позволяет детально разглядеть все элементы изо-
бражения, открытого на экране вашего компьютера. Чтобы восполь-
зоваться лупой, в приложении Просмотр (Preview) выполните команду 
меню Инструменты ⇒ Показать лупу (Tools ⇒ Show Magnifier).

Также вы можете экспортировать PDF-документы в виде графических 
файлов, выбрав команду меню Файл ⇒ Экспортировать (File ⇒ Ex-
port).
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Системные настройки

В операционной системе OS X все параметры системы настроены та-
ким образом, чтобы обеспечить комфортные условия для большинства 
пользователей. Однако всегда есть возможность сконфигурировать 
систему по своему усмотрению. OS X предлагает своим пользователям 
широкий выбор настроек, доступ к которым происходит через прило-
жение Системные настройки (System Preferences) (рис. 4.38).

Рис. 4.38. Окно приложения Системные настройки

Чтобы запустить приложение, достаточно щелкнуть мышью по значку 
 на панели Dock или выполнить команду меню  ⇒ Системные 

настройки (  ⇒ System Preferences). Из-за специфики этого прило-
жения на протяжении всей книги мы будем периодически обращаться 
к нему, а наиболее подробное описание его возможностей вы найдете 
в главе 11.

Словарь

Приложение Словарь (Dictionary)  поможет вам не только перевести лю-
бое слово, но также узнать его точное значение и подобрать синонимы. 
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Для работы с английским языком по умолчанию установлены словари 
«Oxford Dictionary of English» и «Oxford Thesaurus of English». В качестве 
источников информации о терминах на русском языке использует-
ся словарь Apple и веб-сервис «Википедия». Кроме этих источников, 
в приложении Словарь (Dictionary) доступны следующие словари:

� Примечание. Перечисленные в списке словари по умолчанию 
неактивны. Чтобы подключить их, выполните команду меню Сло-
варь ⇒ Настройки (Dictionary ⇒ Preferences) и в открывшемся 
окне установите флажки напротив нужных словарей.

• американский английский словарь «New Oxford American Dictio-
nary»;

• немецкий словарь «Duden-Wissensnetz deutsche Sprache»;
• американский английский тезаурус «Oxford American Writer’s The-

saurus»;
• англо-японский и японско-английский словарь «

»;
• итальянский словарь «Dizionario italiano da un affiliato di Oxford Uni-

versity Press»;
• нидерландский словарь «Prisma woordenboek Nederlands»;
• англо-корейский и корейско-английский словарь «New Ace English-

Korean Dictionary/New Ace Korean-English Dictionary»;
• китайско-английский (упрощенный) словарь «Oxford Chinese Dic-

tionary»;
• французский словарь «Multidictionnaire de la langue française»;
• упрощенный китайский словарь « »;
• корейский словарь «New Ace Korean Language Dictionary»;
• испанский словарь «Diccionario General de la Lengua Española Vox»;
• японский словарь « »;

Чтобы воспользоваться приложением Словарь (Dictionary) , выполните 
следующие шаги.

1. Откройте окно Finder, перейдите в папку Программы (Applications) 
и запустите приложение Словарь (Dictionary) . Откроется основное 
окно приложения, а на панели Dock появится значок .
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2. Введите в поле поиска слово, которое нужно расшифровать, подо-
брать к нему синоним или найти на сайте «Википедия».

3. Выберите словарь на панели инструментов, а затем подходящий 
результат в левой части окна программы. Вы увидите подробное 
описание выбранного слова (словосочетания) (рис. 4.39).

Рис. 4.39. Раздел Википедия

Сообщения

Приложение Сообщения (Messages)  предназначено для обмена мгно-
венными сообщениями с людьми, которых вы добавили в свой список 
контактов. Оно представляет собой инструмент, помогающий органи-
зовать виртуальное общение в различных чатах. Используя это прило-
жение, можно не только обмениваться сообщениями, но и пересылать 
изображения и видеоролики.

Кроме того, данная программа поддерживает такие системы обмена 
сообщениями, как AIM, Jabber, Google Talk и Yahoo! (рис. 4.40).
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Рис. 4.40. Интерфейс приложения Сообщения

Шахматы

Операционная система OS X поставляется только с одной игрой — 
Шахматы (Chess), которая является электронным аналогом традици-
онных шахмат и при этом оснащена доской и набором реалистичных 
трехмерных фигур. Приложение Шахматы (Chess) позволит вам сы-
грать против компьютера или другого пользователя. Также вы можете 
понаблюдать, как компьютер играет сам с собой, что будет не только 
забавно, но и познавательно. В приложении Шахматы (Chess) доступно 
несколько вариантов оформления поля и фигур.

Чтобы сыграть в шахматы, нужно выполнить следующие действия.

1. Откройте папку Программы (Applications) и запустите приложение. 
При запуске программы автоматически начинается новая игра в ре-
жиме Пользователь против компьютера (Human vs. Computer). 
Вы (белые фигуры) будете играть против компьютера (черные фи-
гуры) (рис. 4.41).

 Так как ваши фигуры белые, чтобы игра началась, вам нужно пе-
редвинуть любую фигуру на ту позицию на доске, которая соот-
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ветствует выбранной вами стратегии. После этого в игру вступит 
компьютер. Чтобы сделать ход, вам не обязательно точно наво-
дить указатель мыши на выбранную фигуру. Достаточно щелкнуть 
мышью в любом месте клетки, занятой фигурой (программа выде-
лит клетку подсветкой), а затем — по нужной клетке. Дальнейшая 
игра полностью соответствует правилам традиционных шахмат: 
соперники делают поочередные ходы, пока кто-нибудь из них не 
выиграет .

Рис. 4.41. Окно приложения Шахматы

2. Если вы хотите начать новую игру, выполните команду меню Пар-
тия ⇒ Новая (Game ⇒ New Game) или воспользуйтесь сочетанием 
клавиш �+N. Откроется меню, в котором надо выбрать тип игры.

3. В раскрывающемся списке Игроки (Players) выберите тип игры: 
Человек против человека (Human vs. Human), Человек против 
компьютера (Human vs. Computer), Компьютер против человека 
(Computer vs. Human), Компьютер против компьютера (Computer 
vs. Computer) или Совпадение Game Center (Game Center Match). 
В последнем случае операционная система подбирает вам сопер-
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ника из числа других пользователей по всему миру, доступных 
в данный момент.

4. В раскрывающемся списке Вариант (Variant) вы найдете еще три 
вида игры, кроме традиционной: Шведские шахматы (Crazyhouse), 
Поддавки (Suicide) и Поддавки с шахами и матом (Losers). Если вы 
незнакомы с этими разновидностями, прочитайте о них в справоч-
ной системе программы Шахматы (Chess), выполнив команду меню 
Справка ⇒ Справка Шахмат (Help ⇒ Chess Help).

5. Нажмите кнопку Начать (Start), чтобы начать новую игру.

� Совет. Вы можете сохранить игру в любой момент, выполнив ко-
манду меню Партия ⇒ Сохранить (Game ⇒ Save), а потом возоб-
новить ее, воспользовавшись командой Партия ⇒ Открыть 
(Game ⇒ Open).

При желании вы можете изменить некоторые настройки приложения, 
выполнив команду меню Шахматы ⇒ Настройки (Chess ⇒ Preferen-
ces). В раскрывающемся списке Board (Доска) на открывшейся пане-
ли можно выбрать самые необычные материалы для доски: Дерево 
(Wood), Металл (Metal), Мрамор (Marble) или Трава (Grass), а в списке 
Pieces (Фигуры) — внешний вид для фигур: Дерево (Wood), Металл 
(Metal), Мрамор (Marble) или Мех (Fur).

Передвигая ползунок, расположенный ниже, вы указываете уровень 
игры компьютера. Чем ближе вы переместите ползунок к параметру 
Лучше (Stronger), тем больше вычислений станет выполнять компью-
тер перед тем, как сделать ход, то есть тем сложнее будет его обыграть. 
Если вы установите ползунок в крайнюю левую позицию возле параме-
тра Быстрее (Faster), компьютер начнет тратить на обдумывание хода 
не более пяти секунд. Установка ползунка в центральное положение 
сделает вашу победу не только вполне вероятной, но и более при-
ятной.

Элементы управления в группе Озвучивание голосом (Speech) позво-
ляют играть в шахматы с помощью встроенной функции распознавания 
речи: вы сможете сказать фигурам, куда идти, вместо того чтобы пере-
таскивать их, и услышать, какой ход делает противник. К сожалению, 
русский язык не поддерживается.
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В приложении Шахматы (Chess) есть полезные функции, которые по-
могут новичкам быстрее разобраться в тонкостях игры и повысить 
свой уровень, например меню Ходы (Moves). Оно содержит несколько 
команд, первая из которых (Отменить ход (Take Back Move)) отменяет 
ваш последний ход, команда Показать подсказку (Show Hint) подска-
зывает ход, когда вы растерялись и не можете решить, какой фигурой 
ходить, а команда Показать последний ход (Show Last Move) повтор-
но показывает предыдущий ход противника (на случай, если вы пропу-
стили, какой ход сделал компьютер). Выбрав команду Журнал партии 
(Game Log), вы просмотрите все ходы последней сыгранной партии, 
как ваши, так и соперника. А команда Достижения (Achievements) от-
крывает страницу игры Шахматы (Chess) в приложении Game Center со 
всеми вашими достижениями.

Шрифты

Операционная системы OS X поставляется с коллекцией из более двух-
сот самых разнообразных шрифтов, поэтому без особой необходимо-
сти вам не придется приобретать и устанавливать новые. Если же для 
работы вам понадобятся дополнительные шрифты, существует воз-
можность их установки. Приложение Шрифты (Font Book)  предназначе-
но для управления шрифтами. С его помощью вы сможете установить, 
просмотреть, найти (в том числе и поврежденные), подключить и от-
ключить шрифты, которые используются на вашем компьютере. Также 
приложение поможет распределить их по группам и проверить пра-
вильность отображения символов. Чтобы оценить возможности при-
ложения Шрифты (Font Book), выполните следующие шаги.

1. Откройте окно Finder, перейдите в папку Программы (Applications) 
и запустите приложение Шрифты (Font Book). Появится основное 
окно приложения.

2. Чтобы просмотреть шрифт, щелкните мышью по его имени в обла-
сти Шрифт (Front) (рис. 4.42).

3. Чтобы перемещаться по списку шрифтов, используйте клавиши ↓ 
и ↑ или мышь. При этом в правой части окна вы будете видеть при-
мер начертания каждого шрифта.

4. Если вы хотите увидеть все доступные разновидности выбранного 
шрифта: жирный, курсив и т. д., — щелкните мышью по небольшому 
треугольнику слева от его названия.
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Рис. 4.42. Интерфейс приложения Шрифты

Чтобы установить, отключить/включить или удалить шрифт, выполните 
следующие шаги.

1. Откройте окно Finder и дважды щелкните мышью по значку шриф-
та. Приложение Шрифты (Font Book) откроет его и продемонстри-
рует, как выглядит шрифт.

2. Нажмите кнопку Установить шрифт (Install Font). Приложение 
установит его в каталог Шрифты (Fonts) в вашей домашней папке, 
после чего шрифт автоматически появится в меню Шрифт (Font) 
установленных программ.

3. Чтобы удалить шрифт, выберите его в области Шрифт (Front) и на-
жмите клавишу ⌫. Подтвердите свои намерения, приложение уда-
лит его из базы.

Однако такой радикальный подход не рекомендуется, если какой-то 
шрифт вас не устраивает, его можно отключить.

4. Чтобы отключить шрифт, то есть скрыть в установленных програм-
мах, выберите его в приложении Шрифты (Font Book) и выполните ко-
манду меню Правка ⇒ Отключить название_шрифта (Edit ⇒ Di-
sab le название_шрифта) или нажмите сочетание клавиш �+�+D.

Подтвердите свои намерения, после этого название шрифта будет ото-
бражаться в области Шрифт (Front) серым цветом, а рядом с ним по-
явится надпись Выкл. (Off ).
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5. Чтобы включить шрифт, выберите команду меню Правка ⇒ Вклю-
чить название_шрифта (Edit ⇒ Enable название_шрифта) или 
нажмите сочетание клавиш �+�+D.

Для сортировки шрифтов удобно использовать коллекции. Некоторые 
уже предустановлены, но вы можете создать любое количество допол-
нительных.

1. Чтобы создать новую коллекцию шрифтов, нажмите кнопку  в ле-
вом нижнем углу окна программы и укажите имя новой коллекции.

2. Чтобы добавить шрифты в созданную коллекцию, откройте коллек-
цию Все шрифты (All Fonts) и перетащите при помощи мыши нуж-
ные шрифты на значок созданной коллекции. Допускается исполь-
зовать один и тот же шрифт в разных коллекциях.

� Совет. Также вы можете создавать смарт-коллекции, выбрав коман-
ду меню Файл ⇒ Новая смарт-коллекция (File ⇒ New Smart Col-
lection). На открывшейся панели укажите имя коллекции и атрибу-
ты отбора шрифтов в смарт-коллекцию, согласно семейству, имени 
шрифта, имени PostScript, типу, языку или стилю дизайна шрифта. 
Содержимое смарт-коллекции будет автоматически обновляться 
по мере добавления/удаления шрифтов, атрибуты которых совпа-
дают с заданными в настройках смарт-коллекции.

3. Чтобы удалить шрифт из коллекции, выберите его и нажмите кла-
вишу ⌫.

При желании вы можете распечатать полный набор символов любого 
шрифта, выполнив команду меню Файл ⇒ Напечатать (File ⇒ Print).

Служебные программы

Предустановленные в операционной системе OS X служебные про-
граммы находятся в отдельной подпапке Утилиты (Utilities) каталога 
Программы (Applications) и предназначены для мониторинга, регули-
ровки, настройки, поиска неисправностей в системе OS X и выполне-
ния других задач. Многие из них весьма узки в применении и представ-
ляют интерес только для компьютерных специалистов. Рассмотрим их 
вкратце.
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Grapher

Grapher —  это приложение для построения графиков функций или 
групп данных, которые можно вывести на экран в режиме реального 
времени. Используя приложение Grapher, вы можете визуализировать 
графики в 2D- или 3D-режимах. При визуализации данных разрешено 
использовать разные системы координат и любые математические 
функции, в том числе дифференциальные уравнения, параметрические 
кривые и т. д. (рис. 4.43).

Рис. 4.43. Пример проекта в программе Grapher

Вводить уравнения в утилиту Grapher нужно так же, как вы пишете их 
на бумаге (например, z=6xy). После построения графика вы сможете 
переместить его, повернуть вокруг своей оси, изменить цвет и толщи-
ну линий, размер и тип шрифта, добавить собственные комментарии, 
скопировать график в буфер обмена, а также экспортировать в другие 
приложения.

Х11

Программное средство X11  позволяет запустить на компьютере Mac 
приложения с графическим интерфейсом типа X Window System. Про-
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грамма представляет собой инструмент из среды UNIX, которая поло-
жена в основу операционной системы OS X. Среда UNIX обеспечивает 
корректное использование технологии X Window System и содержит 
несколько серверных программ X11, библиотек и средств разработки, 
а также ряд служебных программ, таких как xterm.

Приложение X11 не входит в комплект операционной системы OS X 
Mavericks, но доступ к серверу X11 и клиентским библиотекам можно 
получить на сайте xquartz.macosforge.org.

Ассистент миграции

С помощью утилиты Ассистент миграции (Migration Assistant)  (рис. 4.44) 
вы сможете автоматизировать передачу информации с одного ком-
пьютера на другой (под управлением операционной системы OS X или 
Windows).

Рис. 4.44. Интерфейс приложения Ассистент миграции

Программа перенесет документы, мультимедийные файлы, фотогра-
фии, приложения, а также сетевые и пользовательские настройки. Что-
бы обеспечить перенос данных, достаточно соединить два компьютера 
кабелем FireWire или Ethernet и запустить утилиту Ассистент миграции 
(Migration Assistant): весь процесс проходит быстро и в соответствии 
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с инструкциями, которые будут появляться на экране. Кроме того, че-
рез USB-порт или беспроводную сеть вы можете передать на другой 
компьютер резервные копии, которые создает в процессе работы при-
ложение Time Machine.

Ассистент Boot Camp

Если на вашем компьютере установлен процессор компании Intel, с по-
мощью приложения Ассистент Boot Camp (Boot Camp Assistant)  вы 
можете инсталлировать операционную систему Microsoft Windows на 
другой раздел жесткого диска вашего Mac. 

При загрузке компьютера разрешается выбрать, какую операционную 
систему использовать — Windows или OS X.

Программа позволяет управлять разделами диска для успешного раз-
мещения обеих систем (с разными файловыми системами). 

Полезную информацию о работе с программой вы найдете на странице 
www.apple.com/ru/support/bootcamp/.

Дисковая утилита

Приложение Дисковая утилита (Disk Utility ) используется в операцион-
ной системе OS X для различных операций с жестким диском: разбие-
ния на разделы, восстановления, очистки и дублирования дисков (в том 
числе и CD/DVD-дисков), управления RAID-массивами и образами дис-
ков, а также подключения папок сервера NFS с общим доступом. 

Программа актуальна при возникновении различных неполадок: она 
способна выполнить верификацию (проверку) жесткого диска и испра-
вить обнаруженные ошибки (рис. 4.45).

Чтобы проверить жесткий диск и определить наличие неисправностей 
файловой системы, достаточно запустить приложение Дисковая утили-
та (Disk Utility ) и активировать процесс проверки. 

Если программа не может исправить обнаруженные ошибки, это сви-
детельствует о том, что повреждения слишком серьезные, а значит, 
следует привлекать специалистов.

О приемах работы с программой Дисковая утилита (Disk Utility ) вы 
узнаете из приложения 1.
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Рис. 4.45. Интерфейс приложения Дисковая утилита

Информация о системе

Утилита Информация о системе (System Profiler)  проинформирует вас 
об устройствах и программном обеспечении на компьютере, что быва-
ет весьма полезно при поиске неисправностей.

Чтобы увидеть окно программы, следует открыть Finder, перейти 
в папку Утилиты (Utilities) каталога Программы (Applications) и запу-
стить приложение Информация о системе (System Profiler) (рис. 4.46).

В левой части окна могут быть выбраны следующие категории.

• Аппаратные средства (Hardware). В этой категории вы можете 
узнать модель своего компьютера, тип и количество процессо-
ров, объем памяти, тип графического адаптера и монитора, какие 
устройства находятся на шине, через какие интерфейсы подключе-
ны устройства (SCSI, USB и FireWire) и многое другое.

• Сеть (Network). В этой категории находятся сведения о типе и со-
стоянии сетевых устройств и программного обеспечения.
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Рис. 4.46. Окно приложения Информация о системе

• ПО (Software). Здесь вы можете узнать информацию о версии вашей 
операционной системы, сетевом имени компьютера, установлен-
ных программах, а также их версиях.

С помощью приложения Информация о системе (System Profiler) легко 
проверить компьютер Mac на соответствие требованиям новой про-
граммы или версии операционной системы.

Дополнительная информация доступна в окне Об этом Mac (About 
This Mac), для отображения которого следует выполнить команду меню 

 ⇒ Об этом Mac (  ⇒ About This Mac). 

После этого вы увидите небольшое окно, позволяющее проверить на-
личие обновлений программного обеспечения, а также просмотреть 
информацию о системе нажатием кнопки Подробнее (More Info). Она 
открывает окно Об этом Mac (About This Mac), содержащее несколько 
вкладок .

• Обзор (Overview). Здесь вы увидите краткую информацию о своем 
компьютере, а также сможете обновить программное обеспечение 
и вызвать окно, показанное на рис. 4.46, нажатием кнопки Отчет 
о системе (System Report).

• Мониторы (Displays). Эта вкладка служит для отображения сведе-
ний об используемых мониторах и вызова окна их настроек.
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• Хранилище (Storage). На вкладке отражена информация о жестких 
дисках и оптических приводах. Также вы можете вызвать инстру-
мент Дисковая утилита (Disk Utility ) (рис. 4.47).

Рис. 4.47. Содержимое вкладки Хранилище

• Память (Memory). Эта вкладка содержит сведения об установлен-
ном объеме оперативной памяти и включает ссылку на веб- страни-
цу поддержки компании Apple.

• Аккумулятор (Battery). Вкладка появляется только на портативных 
компьютерах Mac и содержит информацию об аккумуляторной ба-
тарее: требуется ли обслуживание, уровень заряда, источник пи-
тания и т. п. Кроме того, здесь можно вызвать окно для настройки 
режима энергосбережения.

• Поддержка (Support). Вкладка содержит ссылки на справочные ре-
сурсы Apple.

• Обслуживание (Service). Ссылки на этой вкладке позволяют про-
верить статус гарантии и варианты обслуживания, а также приоб-
рести план обслуживания AppleCare Protection Plan.

Колориметр DigitalColor

С помощью утилиты Колориметр DigitalColor  вы можете определить 
точный код цвета любой области (или пиксела) на экране вашего мони-
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тора. Это очень удобно для дизайнеров, которым приходится согласо-
вывать цвета в процессе работы.

Чтобы определить цвет области (пиксела), достаточно запустить Коло-
риметр DigitalColor и выбрать нужную область на экране. Программа 
покажет его увеличенное изображение и соответствующий цветовой 
код в модели RGB (рис. 4.48).

Рис. 4.48. Результат работы утилиты Колориметр DigitalColor 

Чтобы определить цвет конкретного пиксела, установите ползунок Раз-
мер апертуры (Aperture Size) на минимальное значение в один пиксел, 
в противном случае приложение покажет усредненное цветовое зна-
чение для обозначенной области.

Консоль

Утилита Консоль (Console)  предназначена для просмотра системных 
журналов (логов), где регистрируются внутренние сообщения UNIX, 
которыми система обменивается с установленными приложениями. 
В журналах содержится информация, помогающая при диагностике 
различных проблем.

Мониторинг системы

Программа Мониторинг системы (Activity Monitor) отражает запущен-
ные процессы и использование ресурсов компьютера в реальном вре-
мени. На рис. 4.49 показано окно программы Мониторинг системы (Ac-
tivity Monitor).

Даже если вы не запустили ни одного приложения, система в фоновом 
режиме выполняет десятки вычислительных задач (процессов). В окне 
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вы увидите все процессы, которые активны на данный момент. Прило-
жение Мониторинг системы (Activity Monitor) указывает, сколько ре-
сурсов процессора, памяти, электропитания, диска и сети потребляет 
каждый из них.

Рис. 4.49. Окно приложения Мониторинг системы

В верхней части окна приложения Мониторинг системы (Activity Moni-
tor) размещено несколько вкладок, которые предоставят подробную 
информацию об использовании ресурсов компьютера.

• На вкладке ЦП (CPU) вы сможете увидеть текущую загрузку процес-
сора.

• На вкладке Память (Memory) отражено потребление ресурсов опе-
ративной памяти.

• На вкладке Энергия (Energy) вы можете увидеть воздействие на 
энергопотребление компьютера различных процессов, запущен-
ных в данный момент. Эта информация может быть важна для вла-
дельцев ноутбуков.

• На вкладке Диск (Disk) отражен текущий процесс использования 
ресурсов жесткого диска.
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• На вкладке Сеть (Network) вы сможете оценить входящий и исходя-
щий трафик (пакеты и данные), который передается через сетевой 
адаптер.

Приложение Мониторинг системы (Activity Monitor) не только способ-
но показать информацию о загрузке процессора, использовании па-
мяти или количестве свободного пространства на жестком диске, но 
и предоставляет возможность закрыть зависшую программу в тех слу-
чаях, когда другие методы уже не помогают. О том, как это сделать, мы 
расскажем в приложении 1.

Настройка Audio-MIDI

Операционная система OS X обеспечивает поддержку интерфейса 
MIDI для высококачественного воспроизведения звучания музыкаль-
ных инструментов. Приложение Настройка Audio-MIDI (Audio MIDI Se-
tup)  представляет собой пульт управления разнообразными входными 
и выходными сигналами: микрофонами, линейным выходом, внешними 
динамиками и т. д. Программа работает с аудио- и MIDI-устройствами, 
подключенными к вашему компьютеру посредством интерфейсов 
FireWire (IEEE-1394), PCI, USB, PCMCIA и Bluetooth. После запуска при-
ложения и выбора устройства вы можете настроить его. Помимо этого, 
утилита позволяет конфигурировать акустическую систему для сте-
реофонического или объемного звучания, а также комбинировать не-
сколько устройств в одно.

Обмен файлами по Bluetooth

При помощи технологии Bluetooth вы можете обмениваться файлами 
между устройствами на расстоянии до 10 метров без создания локаль-
ной сети. Bluetooth — это беспроводная технология, которая обеспе-
чивает взаимодействие устройств, оснащенных соответствующими 
адаптерами: компьютеров, принтеров, органайзеров Palm и Pocket PC, 
видеокамер, беспроводных клавиатур, мобильных телефонов и т. д. 
Скорость Bluetooth-соединения по сравнению с другими возможностя-
ми подключения не особенно высока, но, если взять в расчет количе-
ство времени, которое потребуется для подключения кабелей, задава-
ния паролей и настроек для других методов соединения, в некоторых 
ситуациях технология Bluetooth оказывается предпочтительней. Что-
бы вы могли использовать эту возможность и настроить подключение, 
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в состав операционной системы OS X входит утилита Обмен файлами 
по Bluetooth (Bluetooth File Exchange) .

Чтобы с ее помощью отправить или получить файлы, выполните сле-
дующие шаги.

1. Включите режим передачи файлов через интерфейс Bluetooth на 
втором устройстве.

2. Запустите приложение Обмен файлами по Bluetooth (Bluetooth File 
Exchange) из папки Утилиты (Utilities) каталога Программы (Appli-
cations). Также вы можете щелкнуть мышью по значку  в строке 
меню в верхней части экрана и выбрать в контекстном меню пункт 
Отправить файл на устройство (Send File). Откроется окно Выбе-
рите файл для отправки (Select File to Send).

3. Укажите, какие файлы вы хотите передать, и нажмите кнопку Отпра-
вить (Send). Откроется окно Отправить файл (Send File) (рис. 4.50).

Рис. 4.50. Окно Отправить файл

� Совет. Если вы планируете постоянно передавать/получать файлы 
с того или иного устройства, можете запомнить связь, нажав кнопку 
Создать пару (Create Pair).
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� Примечание. С некоторыми устройствами соединение может не 
создаваться, например со смартфонами под управлением операци-
онной системы Windows Phone.

4. Выберите устройство, с которым вы хотите установить соединение, 
чтобы передать файлы, а затем нажмите кнопку Отправить (Send).

После этого управлять процессом будет принимающая сторона: на ко-
нечном устройстве появится сообщение, что запрашивается передача 
файлов, после чего операцию необходимо подтвердить.

Эту процедуру можно выполнить в обратном направлении, то есть при-
нимающей стороной станет ваш компьютер.

Редактор AppleScript

Утилита Редактор AppleScript  является удобным инструментом для раз-
работки и корректировки скриптов, написанных на языке AppleScript. 
Гибкий и расширяемый язык программирования AppleScript встроен 
в состав операционной системы OS X и позволяет быстро создавать 
различные сценарии: автоматизации повторяющихся операций, соб-
ственных программ и т. д.

Связка ключей

Приложение Связка ключей (Keychain Access)  предназначено для хра-
нения и управления сертификатами, ключами, паролями для досту-
па к файловым серверам, сайтам, веб-страницам и другим объектам, 
а также позволяет создавать и хранить секретные заметки. Приложе-
ние Связка ключей (Keychain Access) можно использовать для умень-
шения количества паролей, которые вам необходимо помнить. Связка 
ключей позволяет хранить пароли серверов, программ и веб-сайтов 
и даже конфиденциальную информацию, не относящуюся к вашему 
компьютеру, например номера банковских карт.

� Примечание. О приемах работы с приложением Связка ключей 
(Keychain Access ) вы узнаете из главы 10.
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Снимок экрана

С помощью приложения Снимок экрана (Grab)  вы легко сделаете сним-
ки целого экрана (сочетание клавиш �+Z), экрана с задержкой (сочета-
ние клавиш �+�+Z), окна (сочетание клавиш �+�+W) или выделен-
ной области (сочетание клавиш �+�+A). После того как вы сделаете 
снимок экрана, приложение поместит его в новое окно и предложит 
вам выбрать: вывести его на печать, сохранить в формате TIFF или вста-
вить в документ.

� Совет. Для создания снимков экрана и сохранения их в файл без 
запуска приложения Снимок экрана (Grab) можно использовать 
сочетания клавиш: �+�+3 — снимок всего экрана, или сочетание 
клавиш �+�+4 — для снимка выделенной области. Сочетания кла-
виш ⌃+�+�+3 и ⌃+�+�+4 создают снимки экрана и выделенной 
области соответственно и помещают их в буфер обмена.

Особенности приложения Снимок экрана (Grab):

• приложение умеет делать снимки с временнóй задержкой, когда 
захват выполняется через 10 секунд. Так предоставляется возмож-
ность открыть окна или переместить элементы, чтобы подготовиться 
к снимку. Затем нужно выполнить команду меню Снимок ⇒ Экран 
с задержкой (Capture ⇒ Timed Screen) или использовать сочетание 
клавиш �+�+Z;

• в приложении можно создать снимок экрана с точностью до пик-
села. Например, если снимок должен быть квадратом со стороной 
в 300 пикселов, точные параметры легко соблюсти, так как размер 
выделяемой области (в пикселах) отображается рядом с указателем 
мыши;

• приложение может включать в снимок указатель мыши, а также по-
зволяет выбрать его вид. Для этого выполните команду меню Сни-
мок экрана ⇒ Настройки (Capture ⇒ Timed Screen) (рис. 4.51).

Программа Снимок экрана (Grab) незаменима при разработке различ-
ных инструкций, учебников по работе на компьютере и других методи-
ческих материалов. Кроме того, вы можете использовать возможности 
этого приложения, чтобы зафиксировать странное поведение системы 
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или установленной программы, а затем показать снимок специалистам 
и выяснить, с чем связано такое состояние и как устранить причины 
его возникновения.

Рис. 4.51. Окно Настройки приложения Снимок экрана

Терминал

Утилита Терминал (Terminal)  открывает интерфейс командной стро-
ки, с помощью которой вы можете выполнять любые команды из со-
тен доступных для администрирования операционной системы OS X 
(рис. 4.52).

Рис. 4.52. Окно приложения Терминал

Для работы с утилитой Терминал (Terminal) потребуются определен-
ные умения и знание системных команд, которые можно использовать 
в командной строке. Вы можете узнать об основных возможностях 
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и приемах работы с утилитой Терминал (Terminal), запустив ее и выпол-
нив команду меню Справка ⇒ Справка Терминала (Help ⇒ Terminal 
Help). Узнать о командах приложения Терминал можно здесь: osxh.ru/
content/spisok-terminalnyh-komand-os-x, а также здесь: appstudio.
org/terminal/.

Утилита AirPort

Приложение Утилита AirPort вы будете использовать в тех случаях, 
если есть необходимость в настройке беспроводного доступа к Интер-
нету, а также настройке базовой станции AirPort Express, AirPort Extreme 
или AirPort Time Capsule. Станции AirPort — это еще одна возможность 
обеспечить доступ нескольких компьютеров в локальной сети к Интер-
нету. Настроить базовые станции достаточно просто, нужно запустить 
Утилиту AirPort и следовать инструкциям, которые будут появляться на 
экране. После того как укажете все необходимые параметры, аппара-
тура AirPort на ваших компьютерах будет должным образом настроена 
и готова к использованию.

� Примечание. Подробнее о настройке доступа к локальной сети 
и Интернету вы можете прочитать в главе 7. Кроме того, исчерпы-
вающие сведения о работе с Утилитой AirPort вы найдете в справоч-
ной системе OS X.

Утилита ColorSync

Утилита ColorSync  в составе операционной системы OS X выполняет 
несколько задач.

• Работа с профилями ColorSync и Quartz-фильтрами. Осущест-
вляется сравнение, просмотр, проверка и исправление ошибочных 
цветовых профилей, назначение профилей устройствам, а также 
редактирование Quartz-фильтров.

• Работа со значениями цветов. Захват значений цвета пикселов на 
экране, что удобно при веб-дизайне и работе с графикой, а также 
преобразование значений цвета для другого цветового простран-
ства/профиля с помощью встроенного калькулятора.
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• Работа с изображениями и PDF-документами. Добавление 
фильтров к изображениям, изменение их цветового пространства 
и коррекция яркости/контраста; изменение PDF-документов с по-
мощью Quartz-фильтров; а также вывод на печать изображений 
и PDF-файлов.

Инструмент незаменим для дизайнеров и верстальщиков веб- страниц .

Утилита VoiceOver

С помощью программы Утилита VoiceOver (VoiceOver Utility)  операцион-
ная система OS X становится ближе и доступнее пользователями с огра-
ничениями моторики, слуха и/или зрения. По сути, приложение пред-
ставляет собой полноценную программу экранного доступа и просто 
незаменимо для пользователей с различными дисфункциями, работаю-
щих с компьютером и желающих использовать все его возможности.

Чтобы увидеть окно программы, следует открыть окно Finder, перейти 
в папку Утилиты (Utilities) каталога Программы (Applications) и запу-
стить приложение Утилита VoiceOver (VoiceOver Utility) (рис. 4.53).

Рис. 4.53. Окно приложения Утилита VoiceOver

В окне Утилиты VoiceOver (VoiceOver Utility) элементы управления на-
стройками расположены на нескольких вкладках (настроек очень 



190 Глава 4

много, и предназначение большинства из них понятно из их названий, 
поэтому интерфейс описан кратко).

• Основные (General). На этой вкладке расположены элементы 
управления основными настройками приложения — параметры 
приветствия, допуск к настройкам VoiceOver с помощью сценариев 
AppleScript и конфигурация переносных настроек.

• Детализация (Verbosity). Эта вкладка позволяет установить уро-
вень детализации. Например, насколько подробно нужно прого-
варивать информацию о выбранном элементе на экране — со-
общить только его название или также статус и тип. Аналогичные 
настройки относятся к параметрам дисплея Брайля. На вкладке 
Текст (Text) доступны детальные настройки произношения тек-
ста. Элементы управления на вкладке Объявления (Announce-
ments) позволяют настроить уведомления, такие как оповеще-
ние при нажатии клавиши Caps Lock или перемещении указателя 
мыши в окно, а также определить задержку перед произноше-
нием названия элемента. Вкладка Подсказки (Hints) позволяет 
включить проговаривание инструкций по работе с выбранными 
объектами и определяет, следует ли произносить всплывающие 
подсказки.

• Речь (Speech). Здесь вы увидите две вкладки — Речь (Voices), пред-
назначенную для выбора и загрузки голоса VoiceOver, а также из-
менения его скорости, высоты, громкости интонации; и Произ-
ношение (Pronunciation), на которой можно указать, как следует 
произносить различные символы, смайлики и аббревиатуры.

• Навигация (Navigation). Данная вкладка позволяет управлять 
курсором VoiceOver и настройками указателя мыши в режиме Voi-
ceOver.

• Веб (Web). На этой вкладке настраиваются параметры навигации по 
веб-страницам, таблицам и изображениям, оповещения о загрузке 
веб-страниц, а также определяется порядок объектов при прокрут-
ке веб-страниц. Порядок объектов в списке можно изменить таким 
образом, чтобы наиболее часто используемые отображались при 
прокрутке первыми.

• Звук (Sound). На этой вкладке можно отключить звук, разрешить 
его приглушение или использование объемного звучания, а также 
выбрать выходное аудиоустройство.
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• Визуальные элементы (Visuals). Данная вкладка служит для на-
стройки визуальных элементов, таких как курсор VoiceOver, субти-
тры, панель Брайля, а также параметров меню VoiceOver.

• Программы Commander (Commanders). На этой вкладке настраи-
вается управление операционной системой с клавиатуры.

• Брайль (Braille). Данная вкладка позволяет установить и настроить 
дисплей Брайля.

• Действия (Activities). Эта вкладка служит для создания и настройки 
специальных действий, управляющих приложением VoiceOver.

Подробную информацию о каждом элементе управления вы можете 
узнать из справки по операционной системе OS X.



Глава 5
Покупка, прокат и воспроизведение 
аудио- и видеофайлов

При помощи приложения iTunes вы можете приобретать и воспроиз-
водить музыку, видеоклипы и фильмы, прослушивать интернет- радио-
станции, импортировать мультимедийные файлы с компьютера, соз-
давать собственные плейлисты и записывать их на CD- и DVD- диски, 
транслировать музыку из своей комнаты в другие помещения и мно-
гое другое. Приобретайте мультимедийные файлы непосредственно 
в онлайн- магазине iTunes Store или импортируйте их с жесткого или 
Flash- диска компьютера. Если вы используете iPhone , iPad или iPod, 
приложение iTunes поможет автоматически синхронизировать аудио- 
и видеофайлы вашего устройства с компьютером Mac.

Интерфейс программы iTunes

Основное окно программы iTunes представляет собой коллекцию всех 
музыкальных композиций, которые находятся на жестком диске ваше-
го компьютера в форматах MP3, AIFF, WAV, AC3, AAC и Apple Lossless. 
Приложение iTunes способно автоматически найти и распознать такие 
файлы, после чего отправить их в вашу домашнюю папку (подпапку 
iTunes (iTunes) в каталоге Музыка (Music)).

При первом запуске приложения iTunes следует ознакомиться с пред-
ложением отправлять данные о медиатеке в компанию Apple для рабо-
ты некоторых функций программы и затем принять или отвергнуть его. 
После этого появится основное окно приложения iTunes (рис. 5.1).

Рассмотрим интерфейс приложения iTunes. В верхней части окна про-
граммы (ниже строки меню, расположенной в верхней части экрана) 
вы увидите панель с основными элементами управления.

Ниже находятся элементы управления, которые вы будете использовать 
для сортировки мультимедийного контента. Так, в раскрывающемся 
списке можно выбрать пункт, соответствующий типу контента, напри-
мер Музыка (Music) или Видео (Video). С помощью кнопки iTunes Store 
в правой части окна программы вы можете приобрести новую музыку, 
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видеоклипы и приложения, купить или взять напрокат фильмы, загру-
зить подкасты и обучающие материалы из онлайн-магазина iTunes Store.

Рис. 5.1. Основное окно приложения iTunes

Выбрав в раскрывающемся списке пункт Домашняя коллекция (Home 
Sharing), вы получаете доступ к мультимедийным файлам, предостав-
ленным в общее пользование на всех устройствах под вашей учетной 
записью Apple ID. Вы можете объединить медиатеку для пяти компью-
теров в сети.

В программе доступна функция Genius, которая позволяет создавать 
плейлисты из сочетающихся композиций и предоставляет рекомен-
дации по расширению музыкальной коллекции. Когда вы активируете 
функцию Genius, программа iTunes автоматически собирает сведения 
о ваших музыкальных файлах в медиатеке и передает их в онлайн-
магазин iTunes Store. Процесс проходит анонимно, при этом ваша 
медиа тека сравнивается с композициями, представленными в iTunes 
Store, после чего данные о сочетающихся песнях загружаются в при-
ложение iTunes. Кроме этой функции, элементы управления которой 
доступны на вкладке Плейлисты (Playlists), в программе вы найдете 
список смарт- плейлистов, в которые приложение автоматически добав-
ляет файлы, отвечающие определенным критериям. Например, в плей-
листе 25 самых популярных (25 TOP) находятся файлы, которые вы за-
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пускаете чаще других, а в плейлисте Последние добавленные (Recent 
Added) — новые файлы, которые вы недавно приобрели или импорти-
ровали. При желании вы можете создать собственные плейлисты, в том 
числе и смарт-, и они также будут отображаться в этой группе.

Если вы пользуетесь устройством iPod, iPhone  или iPad, после того как 
вы подсоедините его к компьютеру, на панели окна приложения iTunes 
появится еще одна кнопка с названием устройства, нажав которую 
вы сможете управлять мультимедийным контентом на подключенном 
устройстве и синхронизировать его. Например, добавлять и удалять 
музыкальные композиции, видеофайлы и книги, настраивать размеще-
ние значков приложений и т. д.

В левом нижнем углу вкладки Плейлисты (Playlists) расположены эле-
менты управления, благодаря которым можно создать, отредактиро-
вать или удалить плейлист, смарт-плейлист или папку плейлиста.

� Совет. Создав папку плейлиста, вы можете добавить в нее другие 
плейлисты и папки, чтобы было проще систематизировать аудио- 
и видеофайлы.

Приложение iTunes автоматически сортирует все мультимедийные 
файлы по типу: музыка, фильмы и т. д., — размещая их в соответствую-
щих папках, выбор которых осуществляется в раскрывающемся спи-
ске, расположенном в левой части панели окна программы. Чтобы про-
смотреть содержимое такой папки, достаточно щелкнуть мышью по ее 
названию. Если вы хотите упорядочить файлы самостоятельно, тогда 
вам нужно создать плейлисты с произвольной подборкой композиций, 
фильмов и другого мультимедийного контента.

Приобретение и прокат аудио- и видеофайлов

Если вы решили приобрести музыку или видеофильмы, выполните сле-
дующие действия.

1. Нажмите кнопку iTunes Store на верхней панели окна программы 
iTunes. В окне программы откроется главная страница онлайн-
магазина iTunes Store, в котором вы найдете огромное количество 
композиций и альбомов различных исполнителей, фильмы, прило-
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жения и игры, бесплатные подкасты, книги и обучающие материа-
лы (рис. 5.2).

Рис. 5.2. Главная страница онлайн-магазина iTunes Store

Содержимое онлайн-магазина разделено по типам и категориям. Типы 
контента отображаются на верхней панели окна программы: Музыка 
(Music), Фильмы (Movies), App Store, Книги (Books), Подкасты (Pod-
casts) и ITunesU. В разделах App Store и ITunesU можно приобрести 
и загрузить программы, игры и обучающие материалы.

2. Для приобретения музыки выберите раздел Музыка (Music) на 
верхней панели окна программы iTunes. В правой части окна вы 
увидите ссылки на категории, такие как сборники, предзаказы, луч-
шие песни, видеоклипы и альбомы. В центральной части размеще-
ны ссылки на музыкальные альбомы и видеоклипы, также распре-
деленные по категориям.

� Примечание. Для совершения покупок в магазине iTunes Store не-
обходима авторизация с аккаунтом Apple ID. Для ее осуществления 
нажмите кнопку Войти (Join in) в левой части панели в окне програм-
мы iTunes. При этом в учетной записи должна быть авторизована бан-
ковская карта, с помощью которой вы сможете оплачивать покупки.
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3. Щелкните мышью по миниатюре понравившегося альбома, чтобы 
отобразить список композиций в его составе (рис. 5.3).

� Примечание. Разрешается приобретать как отдельные компози-
ции, так и альбом целиком, что значительно дешевле.

Рис. 5.3. Страница альбома в онлайн-магазине iTunes Store

Нажав кнопку , расположенную слева от названия композиции, вы 
сможете прослушать ее.

4. Щелкните мышью по кнопке с ценой слева от названия композиции 
для ее покупки или же по кнопке с ценой под обложкой альбома, 
чтобы приобрести весь альбом.

Будет выполнена загрузка музыки, о чем сообщит индикатор в верхней 
части окна программы iTunes.

5. Нажмите кнопку Медиатека (Library), чтобы отобразить список 
мультимедийных файлов, загруженных в программу. Купленная 
композиция (альбом) будет в их числе.



Покупка, прокат и воспроизведение аудио- и видеофайлов 197

� Совет. Чтобы найти музыкальную композицию, исполнителя, аль-
бом или видеофильм, вы можете использовать встроенный инстру-
мент поиска, поле ввода которого находится в правом верхнем углу 
окна программы iTunes.

Приобретение видеофильмов осуществляется схожим образом, за ис-
ключением того, что вы можете выбрать качество изображения (SD — 
стандартное, DVD-качество и HD — высокое разрешение) и не только 
купить фильм, но и взять напрокат (рис. 5.4).

Рис. 5.4. Страница фильма в онлайн-магазине iTunes Store

В последнем случае вам предоставляется 30 дней на то, чтобы начать 
просмотр (с момента приобретения напрокат), и 48 часов, чтобы завер-
шить просмотр (с момента начала воспроизведения). Предварительно 
вы можете бесплатно ознакомиться с трейлером фильма, чтобы опре-
делить, заинтересованы ли вы в его просмотре.

На вкладке App Store вы можете приобрести приложения для устройств 
iPad и iPhone , чтобы впоследствии синхронизировать их со своим 
смартфоном или планшетом. Зачастую выбирать приложения и игры 
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на мониторе с большой диагональю удобнее, чем на экране портатив-
ного устройства.

Раздел Книги (Books) предлагает к бесплатной загрузке книги, в основ-
ном на английском языке. Доступны как художественные произведе-
ния, так и руководства по устройствам компании Apple.

Раздел Подкасты (Podcasts) богат бесплатными аудио- и видеоподка-
стами, доступными для загрузки и подписки. При оформлении послед-
ней новые серии подкастов загружаются автоматически.

В разделе ITunesU находятся бесплатные обучающие материалы, кур-
сы для студентов, учебники и пр. Практически весь контент раздела 
представлен на английском языке.

Импорт мультимедийных файлов

Кроме покупки контента в онлайн-магазине iTunes Store, в медиатеку 
приложения iTunes можно импортировать мультимедийные файлы, ко-
торые хранятся на жестком диске вашего компьютера, а также загру-
жать их из Всемирной паутины и копировать с CD-дисков.

Импорт музыки с CD-дисков

Вы можете импортировать аудиоданные звуковых дорожек Audio CD-
дисков. Для этого выполните следующие действия.

1. Вставьте CD-диск в привод своего компьютера и подождите, пока 
запустится приложение iTunes.

Потребуется некоторое время, пока приложение iTunes соберет необ-
ходимую информацию об исполнителе, названии альбома, композици-
ях и т. д. Если этих данных нет на выбранном CD-диске, приложение по-
пробует найти нужные сведения в онлайн-базе данных, доступной при 
активном подключении к Интернету. После этого приложение iTunes 
отобразит информацию о диске в основном окне.

2. Установите флажки напротив названий тех композиций, которые 
вы хотите импортировать в приложение iTunes.

3. В правом верхнем углу окна приложения нажмите кнопку Импор-
тировать CD (Import CD).
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� Примечание. По умолчанию программа iTunes кодирует музыкаль-
ные файлы в формат AAC. При желании вы можете изменить пара-
метры кодирования в настройках программы. Для этого выберите 
команду меню iTunes ⇒ Настройки (iTunes ⇒ Preferences) и на 
вкладке Основные (General) нажмите кнопку Настройки импор-
та (Import settings). В появившемся окне вы можете выбрать кодек 
и его параметры.

Приложение iTunes скопирует выбранные музыкальные файлы в медиа-
теку. О том, что обработка композиции закончилась, сообщает зеленый 
флажок, который появится рядом с ее названием. Теперь вы сможете 
прослушать импортированные мелодии.

Если вы решите остановить импорт файлов, нажмите кнопку , которая 
располагается рядом с индикатором процесса в верхней области окна 
iTunes. При этом все песни, которые программа успела обработать до 
того, как вы отменили импорт, будут добавлены в медиатеку.

Пока приложение импортирует файлы с компакт-диска, вы можете 
пользоваться другими функциональными возможностями программы, 
например слушать музыку или смотреть видеоролики.

Если у импортированных музыкальных дорожек несодержательные 
имена наподобие «Дорожка 01», «Дорожка 02» и т. д., это означает, что 
компьютер не подключен к Интернету или приложение iTunes не мо-
жет найти информацию о CD-диске в базе данных Gracenote.

� Примечание. Если приложение iTunes обнаружит несколько со-
впадений, вам будет предложено выбрать один из вариантов и при 
необходимости отредактировать данные. В случае если у програм-
мы iTunes не получится найти сведения о музыкальных файлах, вы 
можете самостоятельно ввести информацию о композициях, а при 
желании и загрузить на сайт www.gracenote.com, чтобы другие 
пользователи могли ею воспользоваться.

Осуществив подключение компьютера к Интернету, выделите файлы, 
для которых необходимо найти информацию в базе данных, и, нажав 
кнопку Параметры (Options), расположенную в правом верхнем углу 
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окна приложения, выберите команду Получить названия дорожек 
(Get Track Names). Если программа обнаружит совпадение, она добавит 
имена исполнителей, названия песен и другие сведения к выбранным 
мультимедийным файлам.

Существует еще один способ импорта песен с компакт-диска: нужно от-
крыть содержимое диска в окне Finder и перетянуть файл на вкладку 
Музыка (Music) окна приложения iTunes.

Загрузка музыки из Всемирной паутины

Вы можете загрузить в медиатеку приложения iTunes аудиофайлы, раз-
мещенные во Всемирной паутине. Каким образом будет добавлена му-
зыка, зависит от выбранного веб-сайта. На некоторых из них можно за-
грузить аудиофайл целиком, а на других — только ссылку на него. 

В последнем случае приложение iTunes начнет загрузку мультимедий-
ных данных по URL-адресу ссылки и осуществит воспроизведение в по-
токовом режиме (именно так работает интернет-радио в приложении 
iTunes).

Импорт потоковых мультимедийных файлов в программу iTunes осу-
ществляется так же, как и файлов с жесткого диска.

Импорт мультимедийных файлов с жесткого диска

Если на вашем жестком диске сохранены мультимедийные файлы, ко-
торые вы хотите добавить в медиатеку приложения iTunes, откройте 
папку с ними в окне Finder, выберите нужные и перетащите их в соот-
ветствующую папку на боковой панели окна программы iTunes. Если вы 
хотите добавить все файлы из папки в окне Finder, тогда перетащите ее 
целиком.

Также вы можете добавить файлы в библиотеку приложения iTunes 
другим способом.

1. Выполните команду меню Файл ⇒ Добавить в медиатеку (Fi-
le ⇒ Add to Library). Откроется окно Добавить в медиатеку (Add to 
Library) (рис. 5.5).

2. Выберите нужные файлы и нажмите кнопку Открыть (Choose). При-
ложение iTunes добавит их в медиатеку.
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Рис. 5.5. Окно Добавить в медиатеку

Подождите, пока приложение iTunes загрузит указанные музыкальные 
файлы. За ходом загрузки вы сможете следить в индикаторе, располо-
женном в верхней части окна программы iTunes.

� Примечание. По умолчанию приложение создает копию каждо-
го импортируемого файла и помещает его в папку /Users/имя_ва-
шей_учетной_записи/Music/iTunes/iTunes Media. При этом исходные 
файлы остаются в целости на жестком диске и не связаны с медиа-
текой.

При желании вы можете изменить настройки приложения iTunes и сде-
лать так, чтобы мультимедийные файлы добавлялись в медиатеку без 
копирования в каталог iTunes Media.

1. Выполните команду меню iTunes ⇒ Настройки (iTunes ⇒ Prefere-
nces) и в открывшемся окне перейдите на вкладку Дополнения 
(Advanced).

2. Сбросьте флажок Копировать в папку iTunes Media при добавле-
нии в медиатеку (Copy files to iTunes Media folder when adding to 
library).

3. Нажмите кнопку OK, чтобы сохранить изменения.
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После этого, когда вы в следующий раз будете добавлять файлы в ме-
диатеку, указанные объекты появятся в плейлисте приложения iTunes, 
но их копии создаваться не будут.

Воспроизведение музыкальных композиций

Приложение iTunes хранит импортированные и приобретенные музы-
кальные файлы в разделе Музыка (Music) (выбирается в раскрываю-
щемся списке в левом верхнем углу окна программы iTunes). Причем, 
если на вкладке Песни (Songs) отображается простой список компо-
зиций, который вы можете сортировать по исполнителям, названи-
ям и т. п., то вкладки Альбомы (Albums), Артисты (Artists) и Жанры 
(Genres) выглядят куда более эстетично (рис. 5.6).

Рис. 5.6. Вид вкладки Альбомы в окне приложения iTunes

Чтобы воспроизвести файл, проще всего дважды щелкнуть по нему мы-
шью на любой вкладке медиатеки Музыка (Music). Программа iTunes 
начнет проигрывать мелодию, а на индикаторе в верхней части окна 
программы вы увидите имя исполнителя, название композиции и ука-
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затель текущей позиции, который представлен ромбовидным марке-
ром на горизонтальной полосе прокрутки (рис. 5.7).

� Примечание. За 800 рублей в год вы можете оформить подписку на 
сервис iTunes Match, вкладка которого доступна в окне программы 
iTunes. Он загружает всю вашу музыку в облачное хранилище iCloud 
и предоставляет к ней доступ со всех ваших устройств под управле-
нием операционной системы OS X и iOS. При этом те композиции, 
которые находятся в вашей медиатеке и присутствуют в магазине 
iTunes Store, считаются купленными.

� Примечание. Покупки/загрузки, выполненные с помощью других 
ваших устройств под управлением операционной системы iOS/
OS X, отмечены значком  в окне программы iTunes. Щелкните по 
нему мышью, чтобы начать их загрузку на текущий компьютер, при 
условии, что он авторизован в числе пяти возможных устройств 
для одного аккаунта Apple ID. Для выполнения авторизации выбе-
рите команду меню Магазин ⇒ Авторизовать этот компьютер 
(Store ⇒ Authorize this computer) и укажите адрес электронной 
почты и пароль своего аккаунта Apple ID. Если это не удается, воз-
можно, число авторизованных устройств превысило допустимое 
количество (то есть пять). В этом случае потребуется предваритель-
но деавторизовать одно из устройств, выбрав соответствующую ко-
манду в меню Магазин (Store).

Рис. 5.7. Индикатор воспроизведения музыкального файла в окне приложения iTunes

Приложение iTunes будет последовательно воспроизводить мультиме-
дийные файлы, по умолчанию в том порядке, в котором они находят-
ся в альбоме или списке (плейлисте). Если вы хотите перемешать их, 
чтобы файлы запускались в произвольном порядке, щелкните мышью 
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по значку , который расположен в правом нижнем углу индикатора 
в верхней части окна программы iTunes.

� Примечание. Значок , который расположен в левом нижнем углу 
индикатора в верхней части окна программы iTunes, служит для 
установки режима повтора. При этом при первом щелчке по нему 
мышью активируется режим повтора всех композиций в списке, 
при втором — режим повтора текущей композиции, а при третьем 
режим повтора отключается.

При желании вы можете сделать так, чтобы промежутки между ком-
позициями были удалены, то есть чтобы аудиофайлы микшировались 
друг за другом. Выполните следующие действия.

1. Выберите команду меню iTunes ⇒ Настройки (iTunes ⇒ Preferen-
ces) и в открывшемся окне перейдите на вкладку Воспроизведе-
ние (Playback).

2. Установите флажок Затухание песен (Crossfade Playback).

3. При необходимости измените положение ползункового регулятора 
Затухание песен (Crossfade Playback), чтобы установить, за сколько 
секунд до конца композиции начнется микширование.

4. Нажмите кнопку OK, чтобы сохранить изменения.

В приложении iTunes находится эквалайзер, который поможет настро-
ить звучание так, как вам захочется. Чтобы сделать это, выполните ко-
манду меню Окно ⇒ Эквалайзер (Window ⇒ Equalizer) или нажмите 
сочетание клавиш ⌥+�+2. Появится окно Эквалайзер (Equalizer) 
(рис. 5.8).

� Совет. Сочетание клавиш ⌥+�+1 служит для переключения в окно 
приложения iTunes. Сочетание клавиш ⌥+�+3 отображает мини-
плеер, а сочетание ⌥+�+4 — окно загрузок.

Перемещайте ползунковые регуляторы частот или выберите в раскры-
вающемся списке предустановку согласно направлению музыки, кото-
рую вы слушаете, чтобы добиться оптимального звучания.
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Рис. 5.8. Окно Эквалайзер

При желании вы можете отобразить визуальные эффекты, которые 
будут сопровождать воспроизведение музыкальных композиций. Эф-
фекты визуализатора iTunes зависят от той музыки, которую вы про-
игрываете. 

Если в вашем плейлисте есть видеоклипы, приложение будет автомати-
чески запускать их в окне визуализатора.

1. Выполните команду меню Вид ⇒ Показать визуализатор 
(View ⇒ Turn on Visualizer) или нажмите сочетание клавиш �+T. 
Приложение iTunes откроет визуализатор в основном окне.

2. Если вы хотите просмотреть визуальные эффекты в полноэкранном 
режиме, нажмите сочетание клавиш ⌃+�+F.

3. Чтобы отключить визуальные эффекты, нажмите клавишу � или со-
четание клавиш �+T.

Для более комфортного прослушивания музыки вы можете задейство-
вать функцию, которая будет поддерживать громкость воспроизведе-
ния всех композиций в пределах определенного уровня, чтобы вам не 
нужно было постоянно настраивать громкость для аудиофайлов с раз-
личным уровнем записи.

1. Выполните команду меню iTunes ⇒ Настройки (iTunes ⇒ Prefe-
rences) и в открывшемся окне перейдите на вкладку Воспроизве-
дение (Playback).

2. Установите флажок Проверка звука (Sound Check).

3. Нажмите кнопку OK, чтобы сохранить изменения.
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� Примечание. С приложением iTunes разрешается использовать 
дополнения, которые создают сторонние разработчики. Например, 
вы можете установить плагины, которые расширят список доступ-
ных визуальных эффектов. О том, как правильно установить плаги-
ны к приложению iTunes в операционной системе OS X, вы можете 
узнать из их сопроводительной документации.

При желании вы можете организовать общий доступ к музыкальной 
библиотеке, которая хранится в вашем приложении iTunes, для пользо-
вателей других компьютеров в локальной сети.

1. Выполните команду меню iTunes ⇒ Настройки (iTunes ⇒ Prefe-
rences) и в открывшемся окне перейдите на вкладку Доступ (Sha-
ring).

2. Установите флажок Предоставить общий доступ к медиатеке 
в локальной сети (Share my library on my local network).

3. Выберите условия доступа — ко всей медиатеке либо к избранным 
разделам и плейлистам.

4. Нажмите кнопку OK, чтобы сохранить изменения.

Теперь другие пользователи вашей локальной сети смогут воспроиз-
водить мультимедийные файлы из вашей медиатеки.

Прослушивание и просмотр подкастов

В онлайн-магазине iTunes Store можно загрузить не только музыкаль-
ные файлы, фильмы и видеоклипы, на его страницах вы также обна-
ружите большой выбор подкастов (как аудио, так и видео) различной 
тематики.

1. Щелкните мышью по вкладке Подкасты (Podcasts) в магазине iTunes 
Store, чтобы открыть список доступных к загрузке подкастов.

2. Выберите тот, что вас интересует, щелкнув мышью по его миниатю-
ре. Вы увидите страницу подкаста со списком серий (рис. 5.9).

3. Выберите серии, которые хотите загрузить, щелкнув мышью по 
кнопке Бесплатно (Free) слева от их названий.
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Рис. 5.9. Страница подкаста в магазине iTunes Store

� Совет. На странице подкаста публикуются отзывы о нем и список 
похожих подкастов — для этого предназначены соответствующие 
вкладки.

Вы можете следить за ходом загрузки, щелкнув мышью по кнопке  
в правом верхнем углу окна программы iTunes и открыв окно Загрузки 
(Downloads) (рис. 5.10).

Рис. 5.10. Окно Загрузки
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4. По окончании загрузки перейдите в медиатеку, нажав одноименную 
кнопку в правой части окна программы, и выберите пункт Подкасты 
(Podcasts) в раскрывающемся списке разделов медиатеки (рис. 5.11).

Рис. 5.11. Выбор раздела Подкасты

� Примечание. Число справа от названия раздела медиатеки в рас-
крывающемся списке означает количество новых мультимедийных 
элементов.

5. Определитесь, нужно ли синхронизировать настройки и подписки 
на подкасты на этом компьютере с другими вашими устройствами 
под управлением операционной системы iOS/OS X и требуется ли 
автоматическая загрузка новых серий (выпусков) подкастов, на ко-
торые вы подписаны, установив соответствующие флажки. Затем 
нажмите кнопку Продолжить (Next).

Вы увидите список загруженных подкастов, в том числе и с помощью дру-
гих ваших устройств под управлением операционной системы iOS/OS X.

6. Выберите нужный подкаст в списке и дважды щелкните по нему мы-
шью. Приложение iTunes начнет воспроизведение.

Программа запоминает, на каком моменте вы остановились, поэтому, 
если закрыть приложение, при следующем прослушивании воспроиз-
ведение начнется с того же места.

7. Завершите воспроизведение, нажав клавишу �.

Также вы можете получить в магазине iTunes Store бесплатные обучаю-
щие материалы: лекции, уроки иностранных языков, методические ма-
териалы и т. д.
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Загрузите и воспроизведите их, выполнив следующие действия.

1. Щелкните мышью по вкладке iTunes U в магазине iTunes Store, что-
бы открыть список доступных к загрузке обучающих материалов.

2. Выберите интересующий вас курс и загрузите на компьютер по ана-
логии с подкастами.

3. По окончании загрузки перейдите в медиатеку, нажав одноименную 
кнопку в правой части окна программы, и выберите пункт iTunes U 
в раскрывающемся списке разделов медиатеки.

4. Выберите нужный курс и дважды щелкните по нему мышью. При-
ложение iTunes начнет воспроизведение.

� Примечание. Возле новых загруженных серий подкастов прило-
жение iTunes отображает синюю точку, а рядом с теми, что вы не 
дослушали до конца, — половину синей точки. О том, как синхро-
низовать мультимедийный контент из приложения iTunes с устрой-
ствами iPod, iPhone  или iPad, вы узнаете немного позже.

Управление плейлистами
Плейлист представляет собой подборку песен из вашей музыкальной 
библиотеки. 

При желании вы можете создать собственные плейлисты, включив 
в них любимые композиции разных исполнителей. 

Приложение iTunes позволяет добавить одну и ту же мелодию в разные 
плейлисты. Собственные плейлисты легко записывать на CD и DVD-
диски.

Чтобы создать плейлист, выполните следующие действия.

1. Перейдите в медиатеку, нажав одноименную кнопку в правой части 
окна программы (если требуется), и выберите пункт Музыка (Mu-
sic) в раскрывающемся списке разделов.

2. Перейдите на вкладку Плейлисты (Playlists), нажмите кнопку , ко-
торая расположена в левом нижнем углу окна программы, и выбе-
рите пункт Новый плейлист (New Playlist) (рис. 5.12).
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Рис. 5.12. Создание плейлиста

В правой части окна программы появится панель нового плейлиста.

� Совет. Чтобы создать новый плейлист, можно также выполнить ко-
манду меню Файл ⇒ Новый ⇒ Плейлист (File ⇒ New ⇒ Playlist) 
или воспользоваться сочетанием клавиш �+N. Кроме того, если 
вы уже выделили композиции, которые хотите добавить в плей-
лист, выполните команду меню Файл ⇒ Новый ⇒ Плейлист из 
выбранного (File ⇒ New ⇒ Playlist From) или нажмите сочетание 
клавиш �+�+N.

3. Введите название нового плейлиста. В рассматриваемом примере 
использовано название «Мой новый плейлист».

4. В левой части окна программы при помощи мыши выделите музы-
кальные композиции, которые вы хотите добавить в плейлист, и пе-
ретащите их на его панель (рис. 5.13).

Рис. 5.13. Наполнение созданного плейлиста

5. Нажмите кнопку Готово (Finish) на панели нового плейлиста.
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� Примечание. Если удалить какую-то композицию из вашего плей-
листа, это не приведет к ее удалению из медиатеки или с жесткого 
диска вашего компьютера.

Обратите внимание, что еще до того, как вы создали собственный 
плейлист, в левой части окна программы iTunes (на вкладке Плейли-
сты (Playlists)) уже был представлен ряд плейлистов, созданных при-
ложением по умолчанию. Эти списки называют смарт-плейлистами, 
и созданы они, чтобы помочь вам в управлении музыкальными фай-
лами. Названия смарт-плейлистов соответствуют их предназначению. 
Так, например, композиции, которые вы слушали на днях, найдутся 
в плейлисте Последние исполненные (Recent Listen), а в списке 25 са-
мых популярных (25 TOP) — файлы, которые вы проигрываете чаще 
других. Новые музыкальные композиции, которые вы воспроизводите 
в приложении iTunes, автоматически добавляются в смарт- плейлисты 
в соответствии с их критериями. Чтобы вы могли отличить смарт- плей-
листы от обычных, приложение помечает их разными значками. Значок 

 указывает на смарт- плейлист, а значок  появляется возле обычных 
плейлистов, содержимое которых не меняется автоматически.

Смарт-плейлисты вы также можете создавать сами, выполнив следую-
щие действия.

1. На вкладке Плейлисты (Playlists) нажмите кнопку , которая рас-
положена в левом нижнем углу окна программы, и выберите пункт 
Новый смарт-плейлист (New Smart Playlist).

Откроется окно Смарт-плейлист (Smart Playlist) (рис. 5.14).

Рис. 5.14. Окно Смарт-плейлист
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� Совет. Также для создания нового смарт-плейлиста можно вы-
полнить команду меню Файл ⇒ Новый ⇒ Смарт-плейлист 
(File ⇒ New ⇒ Smart Playlist) или воспользоваться сочетанием кла-
виш ⌥+�+N.

2. В окне Смарт-плейлист (Smart Playlist) выберите критерии, соглас-
но которым будут отсортировываться мультимедийные файлы.

В первом раскрывающемся списке вы можете выбрать любой из более 
чем 40 критериев отбора, включая имя исполнителя, дату добавления 
и размер. Второй раскрывающийся список служит для указания усло-
вия — точно ли значение критерия соответствует правилам отбора, не 
совпадает и т. п. В поле правее указывается значение критерия отбора, 
например имя исполнителя или дата.

3. Ограничьте, если требуется, размер плейлиста по времени, разме-
ру файлов или количеству композиций, указав значения в группе 
элементов управления Максимально (Limit to).

� Совет. Вы можете добавить несколько критериев отбора, нажимая 
для создания каждого дополнительного кнопку .

4. Установите флажок Подбирать только отмеченные объекты 
(Match only checked items) для включения в смарт-плейлист только 
тех элементов медиатеки, которые отмечены флажками в окне про-
граммы iTunes.

5. Установите флажок Оперативное обновление (Live updating), что-
бы смарт-плейлист дополнялся новыми мультимедийными файла-
ми, соответствующими критериям отбора, при добавлении файлов 
в медиатеку.

После нажатия кнопки OK новый смарт-плейлист будет доступен для 
воспроизведения в окне программы iTunes.

Функция Genius
Суть функции Genius — отбирать в единый плейлист сочетающиеся 
композиции на основании аудиофайла, выбранного пользователем. 
Отбор композиций выполняется на основе статистики прослушивания 
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выбранного аудиофайла другими пользователями, а также анализе пе-
сен, которые они слушали до и после данного файла.

� Примечание. Функция Genius предоставляется бесплатно. Для ее 
использования необходима активация функции и активное под-
ключение к Интернету; также необходима авторизация с аккаунтом 
Apple ID.

Чтобы задействовать функцию Genius, выполните следующие дей-
ствия.

1. Перейдите в медиатеку, нажав одноименную кнопку в правой части 
окна программы (если требуется), и выберите пункт Музыка (Mu-
sic) в раскрывающемся списке разделов медиатеки.

2. Перейдите на вкладку Плейлисты (Playlists) и выберите пункт Ge-
nius в левой части окна программы.

3. Нажмите кнопку Включить Genius (Turn On Genius), которая рас-
положена в правом нижнем углу окна программы.

� Примечание. Также, чтобы задействовать функцию Genius, вы мо-
жете выбрать команду меню Магазин ⇒ Включить Genius (Turn 
On Genius).

Если компьютер не был авторизован, потребуется ввести данные учет-
ной записи Apple ID.

4. После успешного включения функции Genius среди композиций 
в медиатеке на любой вкладке выберите ту, на основе которой вы 
хотите создать плейлист сочетаемых мелодий, и щелкните по ней 
мышью, удерживая клавишу ⌃.

5. Выберите команду Создать плейлист Genius (Start Genius) в кон-
текстном меню. Будет создан плейлист Genius с сочетающимися 
композициями.

Если возникает окно с сообщением о невозможности создания плейли-
ста Genius, проблем может быть несколько.
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• Если вы недавно включили функцию Genius, необходимо немного 
подождать, прежде чем воспользоваться ею. Вновь попробуйте вы-
полнить команду Создать плейлист Genius (Start Genius) через не-
которое время.

• В медиатеке может быть недостаточное количество композиций 
для работы функции. Добавьте аудиофайлы.

• Результаты работы функции Genius устарели. Обновите данные, вы-
брав команду меню Магазин ⇒ Обновить Genius (Update Genius).

• Для данной композиции сочетаемые аудиофайлы не найдены. По-
пробуйте создать плейлист Genius с помощью другой композиции 
или альбома.

� Примечание. Приложение iTunes также позволяет создавать мик-
сы Genius — подборки похожих песен из медиатеки, которые вос-
производятся непрерывно.

Результаты Genius обновляются автоматически один раз в неделю во 
время запуска программы iTunes. Вы можете обновить их вручную, на-
пример, если добавили новую музыку в медиатеку iTunes, выбрав ко-
манду меню Магазин ⇒ Обновить Genius (Store ⇒ Update Genius).

Запись CD- и DVD-дисков
С помощью приложения iTunes можно записывать собственные диски 
с музыкой, фильмами и другими мультимедийными файлами, которые 
хранятся в медиатеке программы. Чтобы записать диск, вам понадо-
бится:

• компьютер с приводом, который может записывать диски. Для за-
писи Audio-CD или дисков с данными нужен комбинированный 
дисковод Apple Combo или SuperDrive. Если вы планируете записы-
вать DVD-диски, ваш компьютер должен быть оснащен приводом 
Apple SuperDrive;

• чистые диски: CD/DVD±R или CD/DVD±RW (многократная запись);

• плейлист с музыкой, фильмами и прочим мультимедийным контен-
том, который вы хотите записать.
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Помните, что при записи диска приложение iTunes не позволит выбрать 
музыкальные композиции прямо из медиатеки, каждый раз нужно сна-
чала формировать плейлист.

Создав плейлист, выполните следующие шаги.

1. Вставьте в привод чистый CD- или DVD-диск.

2. Если вы записываете музыкальный диск, помните, что количе-
ство песен, которое поместится на нем, зависит от объема диска 
и формата файлов. Так, объем большинства CD-дисков составляет 
650 Мбайт — это приблизительно 74 минуты звучания или около 
150 файлов в формате MP3. В свою очередь, на DVD-диске помеща-
ется 4,7 Гбайт информации, то есть почти в 5 раз больше, чем на CD.

3. Определитесь, на каких устройствах вы собираетесь воспроизво-
дить диск. Если вы создаете его для CD-плеера или компьютера, 
используйте диск CD-R или CD-RW, при условии, что ваш плеер 
поддерживает диски CD-RW. Если же вы хотите записать DVD-диск, 
который должен воспроизводиться на DVD-плеере, нужно брать 
исключительно DVD±R. Записанные диски DVD±RW вы сможете 
воспроизвести только на вашем (или другом) компьютере, но не на 
DVD-плеере.

4. Перейдите в основное окно приложения iTunes и выберите плей-
лист, который нужно записать. Учитывайте, что в программе iTunes 
на один компакт-диск можно записать только один плейлист.

� Примечание. Если выбранный плейлист невозможно записать на 
диск, возможно, он содержит объекты с ограничениями использо-
вания (например, композицию, на воспроизведение которой на ва-
шем компьютере отсутствует разрешение).

5. Чтобы начать запись, выберите команду меню Файл ⇒ Записать 
плейлист на диск (Burn Playlist to Disc). Откроется окно Настройки 
записи (Burn Settings) (рис. 5.15).

6. Выберите скорость записи (при необходимости) и тип диска — ау-
диодиск, MP3 или диск с данными.

7. Нажмите кнопку Записать (Burn).

Будет выполнена запись диска.
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Рис. 5.15. Окно Настройки записи

Если вы решите записать плейлист, который содержит больше музы-
кальных композиций, чем может поместиться на одном диске, прило-
жение iTunes сообщит, что для записи понадобится более одного диска. 
Когда первый диск будет заполнен, приложение автоматически извле-
чет его и предложит вам вставить следующий.

Просмотр видеофайлов

В онлайн-магазине iTunes Store несложно приобрести или взять напро-
кат видеофильмы и видеоролики (видеоролики только приобретаются), 
а при наличии устройства Apple TV вы можете воспроизводить файлы 
из медиатеки приложения iTunes на телевизоре с помощью функции 
Домашняя коллекция (Home Sharing). Чтобы настроить Apple TV, сле-
дует обратиться к инструкции к устройству, доступной по адресу sup-
port.apple.com/ru_RU/manuals/appletv.

В приложении iTunes вы можете просматривать как купленные или взя-
тые напрокат видеофайлы, так и импортированные, но преобразован-
ные в совместимый с приложением формат.

Чтобы просмотреть видеофильм с помощью приложения iTunes, вы-
полните следующие действия.

1. Приобретите, возьмите напрокат или импортируйте интересующие 
вас видеоматериалы, по аналогии с музыкой.

2. Перейдите в медиатеку, нажав одноименную кнопку в правой ча-
сти окна программы (если требуется), и выберите пункт Фильмы 
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(Movi es) в раскрывающемся списке разделов. Вы увидите перечень 
доступных видеофайлов (рис. 5.16).

Рис. 5.16. Содержимое раздела Фильмы медиатеки

3. Дважды щелкните мышью по миниатюре или названию видеофай-
ла. Приложение iTunes запустит выбранный фильм в основном 
окне. Аналогичным образом можно воспроизводить видеоклипы.

Прослушивание интернет-радиостанций

Благодаря приложению iTunes вы можете слушать передачи радио-
станций со всего мира. Для начала прослушивания выполните следую-
щие действия.

� Примечание. По умолчанию вкладка со списком интернет- ра-
диостанций не показывается в окне программы iTunes. Для ее 
отображения выполните команду меню iTunes ⇒ Настройки 
(iTunes ⇒ Preferences), в открывшемся окне перейдите на вкладку 
Основные (General) и установите флажок Интернет-радио (Inter-
net Radio).
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1. Перейдите в медиатеку, нажав одноименную кнопку в правой части 
окна программы (если требуется), и выберите пункт Музыка (Mu-
sic) в раскрывающемся списке разделов медиатеки.

2. Перейдите на вкладку Интернет (Internet). Вы увидите спи-
сок доступных радиостанций, отсортированных по категориям 
(рис. 5.17).

Рис. 5.17. Список интернет-радиостанций в окне программы iTunes

3. Выберите категорию, название которой соответствует интересую-
щему вас жанру.

4. Дважды щелкните мышью по названию радиостанции, которую вы 
хотите прослушать. Начнется ее воспроизведение.

Чтобы окно приложения iTunes не занимало много места на экране, 
пока вы слушаете интернет-радиостанции, можно минимизировать 
его, нажав кнопку  в правом верхнем углу окна программы. Откроет-
ся окно мини-плеера, а основное окно программы iTunes будет сверну-
то (рис. 5.18).

Радио продолжит вещание, но теперь окно будет занимать значитель-
но меньше места. Если потребуется снова развернуть основное окно, 
нажмите сочетание клавиш⌥+�+3.
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Рис. 5.18. Вид мини-плеера программы iTunes

Домашняя коллекция iTunes

С помощью функции Домашняя коллекция (Home Sharing) приложе-
ния iTunes вы можете обращаться к мультимедийным файлам, которые 
доступны на других устройствах вашего аккаунта Apple ID. Допустимо 
использовать не более пяти устройств с одним аккаунтом Apple ID.

Чтобы задействовать эту функцию, выполните следующие шаги.

1. Перейдите в медиатеку, нажав одноименную кнопку в правой ча-
сти окна программы (если требуется), и выберите пункт Домашняя 
коллекция (Home Sharing) в раскрывающемся списке разделов ме-
диатеки.

2. Укажите данные своей учетной записи Apple ID, а затем нажмите 
кнопку Включить Домашнюю коллекцию (Home Sharing).

Внимание! Работа функции Домашняя коллекция (Home Sharing) воз-
можна, если ваши устройства подключены к одной домашней сети!

� Примечание. Если компьютер не авторизован в вашей учетной за-
писи, потребуется выполнить авторизацию, нажав кнопку в появив-
шемся окне с запросом.

3. Повторите процедуру на каждом устройстве с вашей учетной за-
писью Apple ID (не более пяти устройств одновременно, включая 
компьютеры и ноутбуки Mac, iPhone , iPad и iPod).
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Теперь вы можете воспроизводить мультимедийные файлы с других 
устройств вашего аккаунта Apple ID без необходимости копирования 
их на данный компьютер.

Печать обложек для CD-дисков

С помощью приложения iTunes вы можете распечатать обложки для 
компакт-дисков. Для этого выполните следующие действия.

1. В приложении iTunes выберите плейлист, список композиций кото-
рого вы хотите вывести на печать.

2. Выполните команду меню Файл ⇒ Напечатать (File ⇒ Print) или 
нажмите сочетание клавиш �+P. Откроется окно Печать (Print) 
(рис. 5.19).

Рис. 5.19. Печать обложки альбома в приложении iTunes

3. Поэкспериментируйте с настройками печати, чтобы добиться жела-
емого результата. Выбрать сведения для печати позволяет группа 
переключателей Напечатать (Print) и раскрывающийся список Вид 
печати (Theme).

4. Нажмите кнопку Напечатать (Print), чтобы вывести обложку на пе-
чать.

Если вы решите распечатать оригинальную обложку альбома, устано-
вите переключатель в положение Обложку альбома (CD jewel case 
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insert) в группе Напечатать (Print), а в раскрывающемся списке Вид 
печати (Theme) выберите пункт Одна обложка (Single cover). Если вы 
выберете пункт Мозаика (Mosaic), то приложение iTunes распечатает 
список музыкальных композиций и коллаж из обложек для каждой 
песни, которую вы добавили в плейлист.

Интеграция с устройствами iPod, iPhone  и iPad

Плеер iPod, смартфон iPhone  и планшет iPad спроектированы так, что 
они легко синхронизируются с приложением iTunes. Нужно всего лишь 
подключить устройства к вашему компьютеру Mac при помощи кабеля 
Lightning или старого 30-контактного кабеля, после чего на боковой 
панели в верхней части окна приложения появится кнопка с названи-
ем подключенного устройства. Чтобы просмотреть его содержимое, 
достаточно нажать эту кнопку.

� Примечание. Для получения подробных сведений о синхрониза-
ции устройств под управлением операционной системы iOS с ком-
пьютером Mac обратитесь к таким книгам, как «iPhone . Исчерпы-
вающее руководство» или «iPad. Исчерпывающее руководство», 
выпущенным издательством Эксмо.

Вы можете управлять подключенными устройствами: загружать, 
устанавливать и удалять приложения/игры, синхронизировать ау-
дио- и видеофайлы, а также книги, настраивать параметры синхро-
низации, такие как беспроводное подключение, и выполнять другие 
действия.

Настройка приложения iTunes

Вы уже знаете, как минимизировать окно приложения iTunes, чтобы 
оно не занимало много места на экране. Но это далеко не все настрой-
ки основного окна приложения, предоставленные в ваше распоря-
жение.

Вы можете выбрать, какие столбцы хотите видеть в области просмотра 
основного окна, и скрыть ненужные. Для этого выполните следующие 
действия.
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1. Откройте желаемый список файлов, например плейлист 25 самых 
популярных (25 TOP), и щелкните мышью, удерживая клавишу ⌃, 
по панели с заголовками столбцов. Откроется контекстное меню.

2. Установите флажки напротив названий тех столбцов, которые долж-
ны отображаться в основном окне.

Если вы хотите скрыть некоторые разделы медиатеки, выполните сле-
дующие шаги.

1. Выполните команду меню iTunes ⇒ Настройки (iTunes ⇒ Prefe-
rences).

2. В открывшемся окне перейдите на вкладку Основные (General) 
и сбросьте флажки напротив названий нежелательных категорий.

3. Нажмите кнопку OK, чтобы сохранить изменения.

Если нужно не просто скрыть, а запретить приложению показывать не-
которые категории объектов (папки) на боковой панели, выполните 
следующие действия.

1. Откройте окно Настройки (iTunes ⇒ Preferences) и перейдите на 
вкладку Родительский контроль (Parental).

2. В группе элементов управления Отключить (Disable) установите 
флажки напротив категорий, которые вы хотите отключить.

3. Нажмите кнопку OK, чтобы сохранить изменения.

Таким образом вы можете настроить программу для своего удобства. 
Кроме того, не забывайте о справочном центре приложения iTunes, 
в котором вы найдете много полезных советов и рекомендаций.
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Вместе с релизом операционной системы OS X Mavericks компания Ap-
ple выпустила обновленные версии программ, ранее входивших в па-
кет iLife и iWork , а именно: iPhoto, iMovie, GarageBand, Pages, Numbers 
и Keynote. Их предназначение осталось прежним, но появились новые 
функции и возможности. В этой главе мы расскажем, для чего нужна 
каждая из программ, и кратко продемонстрируем, как ими пользо-
ваться.

iPhoto, iMovie и GarageBand представляют собой мультимедийные 
приложения, предназначенные для домашнего использования. Вы 
можете приобрести iPhoto и iMovie в магазине App Store, заплатив 
479 рублей за каждое. Приложение GarageBand предоставляется бес-
платно.

� Примечание. Важно отметить, что приложения iPhoto, iMovie, Pages, 
GarageBand, Numbers и Keynote поставляются бесплатно с каждым 
новым компьютером Mac. Пользователи приложений предыдущих 
версий, установившие операционную систему OS X Mavericks, могут 
бесплатно обновить программы через магазин App Store.

Приложения Pages, Numbers и Keynote разработаны с целью упростить 
процесс создания, оформления, представления и публикации доку-
ментов, электронных таблиц и презентаций. Вы можете приобрести эти 
программы в магазине App Store, заплатив 649 рублей за каждую.

� Примечание. Обновленные версии приложений iPhoto, iMovie, Ga-
rageBand, Pages, Numbers и Keynote стали 64-разрядными.

Итак, компания Apple предоставляет следующие приложения.
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• iPhoto, помогающее в сортировке, обработке, редактировании 
и хранении фотографий и других изображений. В новой версии 
помимо улучшений реализована поддержка видеороликов для 
загрузки на сервис iCloud, повышена надежность, производитель-
ность и стабильность работы приложения.

• iMovie, с помощью которого вы можете монтировать, обрабаты-
вать и экспортировать видеоролики. Обновлен интерфейс, реали-
зованы режим видеобраузера и возможность использования му-
зыки из приложения iTunes, добавлена поддержка видеоформата 
AVCHD.

• GarageBand представляет собой домашнюю студию звукозаписи 
и позволяет создавать музыкальные композиции. Обновлена кол-
лекция звуков и улучшен интерфейс, осуществлена поддержка до 
255 дорожек.

• Pages является мощным инструментом редактирования текстов 
и макетов страниц. Улучшен механизм отслеживания изменений, 
добавлено множество предустановленных шаблонов, осуществле-
на поддержка документов Word.

• Numbers, с помощью которого можно легко создавать многофунк-
циональные электронные таблицы. Реализована функция автоза-
вершения формул, добавлена новая панель фильтров, осуществле-
на поддержка документов Excel.

• Keynote, позволяющее создавать красивые и стильные презента-
ции. Реализована гибкая настройка макета, добавлены интерактив-
ные графики, осуществлена поддержка документов PowerPoint.

� Примечание. Для работы новых версий перечисленных программ 
требуется использование операционной системы OS X версии 10.9 
(Mavericks) или выше.

После установки приложений их значки автоматически появятся на 
панели Dock. Если вы не хотите, чтобы они там отображались, удалите 
значки, перетащив их при помощи мыши за границы панели. При этом 
установленные программы останутся на компьютере, и вы всегда смо-
жете запустить их из папки Программы (Applications).
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Ретуширование фотографий 
в приложении iPhoto

Приложение iPhoto предлагает широкий выбор инструментов сорти-
ровки, редактирования и улучшения фотографий. Благодаря функциям 
сортировки, вы быстро сгруппируете ваши фотографии по лицам, ме-
стам или событиям. Программу можно использовать, чтобы создавать 
слайд-шоу, книги, календари и открытки, а также отправлять фотогра-
фии по электронной почте, публиковать их в Facebook, Twitter и Flickr, 
использовать в качестве компьютерной заставки, заказывать печать 
или распечатывать их самостоятельно. 

При работе с приложением iPhoto вы можете использовать поддерж-
ку синхронизации с сервисом iCloud, создавать резервные копии при 
помощи приложения TimeMachine и многое другое. Программа iPho-
to поддерживает практически все модели цифровых фотоаппаратов 
и обеспечивает быстрый импорт фотографий в библиотеку.

1. Для начала работы запустите приложение iPhoto из папки Програм-
мы (Applications) или дважды щелкните мышью по значку  на па-
нели Dock. Откроется окно приложения iPhoto (рис. 6.1).

Рис. 6.1. Окно приложения iPhoto
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Прежде чем начать редактирование, нужно импортировать фотогра-
фии в медиатеку приложения iPhoto.

2. Если вы хотите скопировать снимки с карты памяти цифровой каме-
ры, подсоедините ее к вашему компьютеру, убедитесь, что камера 
появилась в списке источников, выберите фотографии и импорти-
руйте их.

Если же вы хотите импортировать фотографии с CD- или DVD-диска, 
Flash-накопителя, внешнего жесткого диска или папки на жестком дис-
ке вашего компьютера, просто перетащите их в медиатеку iPhoto. Так-
же вы можете использовать команду меню Файл ⇒ Импортировать 
в медиатеку (File ⇒ Importing to Library). После того как вы импорти-
руете фотографии, все они будут храниться в медиатеке iPhoto.

3. Чтобы просмотреть их, выберите пункт События (Events) на боко-
вой панели. Приложение iPhoto располагает фотографии в том по-
рядке, в каком вы добавили их в медиатеку.

� Примечание. В левом нижнем углу окна программы доступны 
кнопка Поиск (Search) для поиска фотографий и ползунковый регу-
лятор Масштаб (Zoom) для изменения масштаба просмотра миниа-
тюр фотографий в медиатеке.

В приложении iPhoto доступна замечательная функция распознавания 
лиц, с помощью которой вы можете быстро отсортировать снимки по 
именам людей на фотографиях. 

Функция интеллектуальна, поэтому автоматически предлагает имена 
людям, чьи лица схожи с изображенными на тех снимках, которые вы 
ранее именовали вручную. Для использования данной функции вы-
полните следующие действия.

1. Щелкните мышью по пункту Лица (Faces). Вам будет предложено 
указать имена людей на снимках (рис. 6.2).

2. Введите имена людей, показанных на первых двух фотографиях, 
а затем нажмите кнопку Показать другие лица (Confirm Additional 
Faces). При вводе имени будут продемонстрированы результаты по-
иска среди контактов, зарегистрированных в приложении Контак-
ты (Contacts), вы можете выбирать подходящие имена из списка.
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Рис. 6.2. Функция Лица приложения iPhoto

По мере именования людей на снимках приложение будет предлагать 
имена автоматически, указывая их в поле ввода. Вы можете согласить-
ся с предложением, нажав кнопку , или отказаться, нажав кнопку  
и введя правильное имя вручную (рис. 6.3).

Рис. 6.3. Автоматическое предложение имени

3. По завершении присвоения имен нажмите кнопку Перейти к ли-
цам (Continue to Faces). Вы всегда сможете продолжить процесс 
присвоения имен, нажав кнопку Найти лица (Find Faces) в правом 
нижнем углу окна программы.
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После того как вы сопоставите имена и лица, медиатеку можно синхро-
низировать с облачным хранилищем iCloud и устройствами iPad или 
iPhone , при этом подписи будут перенесены вместе с соответствующи-
ми фотографиями.

Еще одна интересная функция — Места (Places) — создает на карте 
метки, которые будут напоминать вам, где были сделаны фотографии. 
С помощью этой функции фотографии автоматически группируются по 
месту съемки на основе данных GPS-модуля камеры или iPhone /iPad. 
Если у вас нет устройства с поддержкой GPS, разрешается внести ин-
формацию о местах съемки самостоятельно, используя предложенные 
географические объекты и достопримечательности.

Вы можете сортировать фотографии, раскрыв меню Вид ⇒ Сортиро-
вать фотографии (View ⇒ Sort Photos) и затем выбрав способ сорти-
ровки файлов: по дате, по ключевому слову, по имени, по рейтингу, 
вручную, в порядке возрастания или убывания.

� Примечание. Ключевые слова — это пометки, которые вы можете 
добавлять к своим фотографиям и которые существенно ускоря-
ют сортировку. Например, удобно использовать ключевые слова 
«День рождения», «Свадьба» и т. д. Чтобы добавить ключевое слово, 
выберите фотографию и выполните команду меню Окно ⇒ Управ-
ление моими ключевыми словами (Window ⇒ Manage my key-
words), а затем в открывшемся окне выберите подходящий вариант. 
Вы можете добавить сколько угодно собственных ключевых слов, 
нажав кнопку Правка ключевых слов (Edit Keywords).

Также в качестве сортировки вы можете использовать собственный рей-
тинг фотографий, который будет показывать, насколько они вам нравят-
ся. Чтобы присвоить рейтинг, выберите фотографию и раскройте меню 
Фотография ⇒ Мой рейтинг (Photos ⇒ My Rating), а затем отметьте ко-
личество звезд, которое вы хотите ей присвоить. Использование таких 
рейтингов ускоряет сортировку и поиск нужной фотографии.

� Совет. Для удобства откройте панель Инфо (Info), на которой вы 
можете присваивать выбранным фотографиям рейтинг, ключевые 
слова и устанавливать место съемки (рис. 6.4).
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Рис. 6.4. Вид панели Инфо

Когда фотографий становится очень много, требуется их систематиза-
ция. Она заключается в их группировке в фотоальбомы, которые позже 
можно записать на CD- или DVD-диск, опубликовать во Всемирной пау-
тине или отправить по почте через приложение Mail.

1. Чтобы создать тематический фотоальбом, выделите фотографии, 
а затем нажмите кнопку Добавить (Add to) в правом нижнем углу 
окна программы и выберите в меню пункт Альбом (Albums). Далее 
следует выбрать уже существующий альбом или создать новый при 
помощи пункта Новый альбом (Album). На боковой панели по-
явится новая категория Альбомы (Albums), а в ней — альбом с вы-
деленным названием.

2. Укажите название альбома и нажмите клавишу �.

При желании вы можете создать из своих фотографий слайд-шоу и до-
бавить в него свои лучшие творения. Чтобы создать слайд-шоу, выпол-
ните следующие действия.

1. Выберите альбом или несколько фотографий из группы События 
(Events).

2. Нажмите кнопку Добавить (Add) в правом нижнем углу окна про-
граммы и выберите в меню пункт Слайд-шоу (Slideshow). На бо-
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ковой панели появится новая категория Слайд-шоу (Slideshow), 
а в ней — слайд-шоу, которому нужно присвоить название.

3. В верхней части окна программы расположите фотографии в нуж-
ном порядке и запустите слайд-шоу, чтобы оценить полученный ре-
зультат.

� Совет. С помощью кнопок в правом нижнем углу окна программы 
вы можете создать слайд с титрами, выбрать тему (оформление) 
слайд-шоу и наложить музыкальное сопровождение.

Возможности приложения iPhoto позволяют создать книгу, открытку 
и даже календарь с вашими фотографиями, которые позже можно рас-
печатать.

Чтобы создать книгу, выполните следующие действия.

1. Выделите нужные фотографии.

2. Нажмите кнопку Добавить (Add to) в правом нижнем углу окна про-
граммы и отметьте в меню пункт Книга (Book).

3. Выберите существующую книгу или создайте новую, задействовав 
пункт Новая книга (Book).

4. На боковой панели появится новая категория Книга (Book), 
а в ней — книга, которой вы можете присвоить соответствующее 
название. Помимо этого появится окно с запросом выбора страны, 
в которой будет напечатана книга. К сожалению, в списке стран Рос-
сия отсутствует, но вы можете выбрать другую и распечатать фото-
альбом самостоятельно или же оформить заказ в зарубежной ин-
тернет- фотолаборатории, если она поддерживает доставку заказов 
в Россию.

5. Выберите тип переплета и тему книги, а затем нажмите кнопку Соз-
дать (Create).

6. Отредактируйте макет книги, дважды щелкая мышью на ее страни-
цах и выбирая компоновку, масштаб фотографий и фон (рис. 6.5).

7. По завершении компоновки книги нажмите кнопку Купить книгу 
(Buy Book). Вы увидите форму заказа и сможете оплатить его, ука-
зав адрес доставки. Требуется авторизация с учетной записью Ap-
ple ID.



Инструменты для работы и творчества 231

Рис. 6.5. Создание фотоальбома

Открытки и календари создаются аналогичным образом.

В приложении iPhoto вы можете улучшить свои фотографии, используя 
встроенные инструменты ретуширования. Чтобы получить к ним до-
ступ, нажмите кнопку Правка (Edit) в правом нижнем углу окна про-
граммы. 

Приложение загрузит соответствующие инструменты, с помощью кото-
рых вы сможете поэкспериментировать и выбрать наилучший ва риант.

Чтобы поделиться фотографиями, нажмите кнопку Экспорт (Share) 
в правом нижнем углу окна программы. Вы можете отправить фото-
графии в сообщении, электронном письме, выгрузить их в хранилище 
iCloud, опубликовать в сети Facebook, Flickr или Twitter, а также вывести 
на печать.

Если возникнут вопросы во время работы с приложением iPhoto, обра-
титесь к справочным материалам, выбрав пункт Справка (Help). 

Также вы можете найти дополнительную информацию о приложении 
iPhoto, посмотреть практические советы и инструкции, а также ознако-
миться с технической информацией на официальном сайте компании 
Apple (www.apple.com/ru/support/mac-apps/iphoto/).
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Видеомонтаж в приложении iMovie

Основная задача приложения iMovie — предоставить инструменты, 
необходимые для монтажа видеоматериалов: фильмов, роликов, ко-
ротких сюжетов, семейного видео и т. д. — в домашних условиях. У про-
граммы простой и понятный интерфейс, с которым разберется даже 
неопытный пользователь. Вы можете импортировать видеофайлы, 
снятые как на камеру iPhone  или iPad, так и на профессиональную циф-
ровую видеокамеру. Кроме того, в проект разрешено добавлять изо-
бражения из библиотеки iPhoto и музыкальные файлы из медиатеки 
iTunes. Возможности программы iMovie позволяют вырезать ненужный 
видеоматериал, компоновать видеодорожки со звуком, добавлять раз-
личные эффекты, а также экспортировать готовые видеоролики в фай-
лы популярных форматов или сохранять их на жестком диске. Исполь-
зуя приложение iMovie, вы сможете монтировать фильмы, добавлять 
титры, переходы между сценами, музыкальное сопровождение или за-
кадровые комментарии. С помощью этой программы легко поделиться 
готовыми проектами с друзьями или близкими, опубликовав свои тво-
рения на таких сайтах, как YouTube и Vimeo.

Чтобы начать работу с программой iMovie, выполните следующие дей-
ствия.

Запустите приложение iMovie из папки Программы (Applications) или 
щелкните мышью по значку  на панели Dock. Откроется окно про-
граммы iMovie, предназначенное для управления проектами.

Оно состоит из двух вкладок. На вкладке Медиатека (Library) вы може-
те импортировать мультимедийные файлы, из которых будет состоять 
ваш будущий шедевр, и управлять ими. Вкладка Theater отображает 
экспортированные (готовые) проекты.

Для начала работы над проектом следует импортировать мультиме-
дийный материал, нажав кнопку Импортировать (Import) на вклад-
ке Медиатека (Library). После этого нажмите кнопку Создать (Create) 
и выберите тип проекта — Фильм (Film) или Трейлер (Trailer). В по-
следнем случае вы сможете смонтировать рекламный трейлер фильма 
в голливудском стиле.

Если вы выбрали тип проекта Фильм (Film), откроется окно Темы 
(Theme), в котором можно выбрать тему будущего фильма.

Определившись с темой и создав проект, вы увидите основное окно 
программы (рис. 6.6).
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Рис. 6.6. Окно приложения iMovie в режиме Фильм

Оно состоит из четырех основных частей. В верхней области окна на-
ходится библиотека мультимедийных файлов и панель для предвари-
тельного просмотра выбранного проекта или видеофайла. В нижней 
части окна располагается монтажный стол, на котором вы будете рабо-
тать с видеоматериалами: монтировать, накладывать эффекты, звуко-
вое сопровождение и т. п.

Перетаскивая мультимедийные файлы из библиотеки на монтажный 
стол, вы сможете собрать фильм и украсить его переходами, эффекта-
ми и звуковым сопровождением, доступными в левой части окна про-
граммы. Если же вы выбрали тип проекта Трейлер (Trailer), то перед 
вами появится несколько измененное окно программы (рис. 6.7).

В нем обнаружатся указания, как снять будущий ролик. После съемки 
вы сможете смонтировать видеоматериал, наложить звуковое сопро-
вождение, эффекты и титры.

Когда проект будет готов, вы можете экспортировать его или просто 
сохранить на жестком диске своего компьютера. В первом случае ис-
пользуйте варианты, доступные в меню Экспортировать (Export).

• Способ Theater позволяетт просчитать проект в мультимедийный 
файл и сделать его доступным для других устройств, авторизован-
ных с вашим аккаунтом Apple ID.
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Рис. 6.7. Окно приложения iMovie в режиме Трейлер

• Вариант Email позволяет отправить видеофайл в виде вложения 
в сообщение электронной почты.

• Вариант iTunes позволяет добавить видеофайл в медиатеку iTunes.

• Способ YouTube позволяет разместить готовые видеоматериалы 
на сайте видеохостинга YouTube. Чтобы опубликовать свои видео-
записи, вам потребуется учетная запись Google. При размещении 
следует выбрать нужную категорию, дать записи понятное назва-
ние и указать расширение. Желательно также составить краткое 
описание видеоролика и указать соответствующие теги, которые 
упростят поиск вашего ролика.

• Способ Facebook позволяет разместить видеоматериалы на вашей 
странице в социальной сети Facebook. Публикация проекта на стра-
нице в Facebook практически аналогична размещению материалов 
на сайте YouTube.

• Вариант Vimeo позволяет разместить ваш видеоролик на популяр-
ном видеохостинге Vimeo.

• Способ CNN iReport позволяет разместить видеоматериалы на сай-
те CNN iReport.

• Способ Файл (File) помогает сохранить видеоматериалы в любой 
папке на жестком диске вашего компьютера.
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Если у вас возникнут сложности во время работы с видеоматериала-
ми в приложении iMovie, можете обратиться к справочной системе, 
выбрав пункт Справка (Help), или найти дополнительную информа-
цию о приложении iMovie на официальном сайте компании Apple 
(www.apple.com/ru/support/mac-apps/imove).

Редактирование аудиофайлов 
в приложении GarageBand

Приложение GarageBand — это, по сути, домашняя студия звукозаписи. 
С его помощью вы можете создавать музыкальные композиции, исполь-
зуя огромное количество доступных семплов. Благодаря приложению 
GarageBand вы научитесь записывать, микшировать и выполнять аран-
жировку мелодий, играть на виртуальных музыкальных инструментах 
и, при желании, сможете поделиться результатом со своими друзьями 
и членами семьи. В программе GarageBand доступен набор профессио-
нальных инструментов, эффектов и обширная библиотека записанных 
звуков, которые можно использовать в собственных проектах. Кроме 
того, возможности приложения GarageBand позволяют захватывать 
сигнал с электроинструментов: синтезатора, электрогитары и дру-
гих, — используя специальный MIDI-переходник, а также записывать 
голос или любой акустический инструмент с помощью микрофона.

Чтобы начать работу с программой GarageBand, запустите ее из папки 
Программы (Applications) или щелкните мышью по значку  на панели 
Dock.

� Примечание. При первом запуске приложения GarageBand будет 
выполнена загрузка и установка стандартной библиотеки звуков 
и циклов. При широкополосном подключении к Интернету процесс 
может занять около часа.

В отличие от остальных «креативных» приложений компании Apple, 
программа GarageBand содержит массу инструментов и настроек, по-
этому интерфейс разработан таким образом, что в окне видны только 
те инструменты и средства, которые соответствуют выбранному режи-
му. При каждом запуске программа предлагает выбрать режим работы, 
как показано на рис. 6.8.
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Рис. 6.8. Окно выбора проекта в приложении GarageBand

При создании проекта приложение GarageBand предлагает несколько 
режимов работы:

• Клавишные (Keyboard Collection), в котором при помощи виртуаль-
ной клавиатуры вы сможете сыграть и записать любое музыкальное 
произведение;

• Усилители (Amp Collection), в котором представлена коллекция ги-
тарных и басовых усилителей легендарных моделей;

• Рингтон (Ringtone), предназначенный для записи рингтонов;

• Хип-хоп (Hip-Hop), в котором вы можете совместить звучание удар-
ных установок и аналоговых синтезаторов;

• Электронная (Electronic), сочетающий звучание ударных установок 
и цифровых синтезаторов;

• Автор песни (Songwriter), предназначенный для записи вокальных 
партий и совмещающий ударные и гитарные усилители;

• Пустой проект (Empty Project), позволяющий создать нетипичный 
проект с вашими собственными настройками.

Какой бы режим работы вы ни выбрали, основное окно программы 
GarageBand будет разделено на три области. В левой части окажется 
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область медиатеки с изображениями инструментов, в правой верх-
ней — монтажный стол с дорожками, на котором вы будете работать 
с виртуальными музыкальными инструментами, создавать компози-
ции из циклов (лупов) и многое другое, а в правой нижней части — на-
бор редакторов, таких как клавишный редактор и редактор партитуры, 
которые используются в процессе работы.

Чтобы создать новый проект в одном из перечисленных режимов, сле-
дует щелкнуть мышью по его названию в окне выбора. Для примера мы 
выберем режим Электронная (Electronic) (рис. 6.9).

Рис. 6.9. Окно проекта в режиме Электронная

В центральной части окна вы увидите панель дорожек (монтажный 
стол), на которой будете работать со звуками, а в правой части окна 
автоматически появится панель звуковых фрагментов (лупов, также на-
зываемых циклами).

Для удобства вы можете выбрать тип лупа в верхней части панели, 
а затем выбрать нужный фрагмент и перетащить его на монтажный 
стол. Например, возьмем лупы танцевального жанра. Чтобы выбрать 
их в библиотеке, нужно щелкнуть мышью по кнопке Джинглы (Ethnic). 
В результате в нижней части панели появится список фрагментов, от-
вечающих заданным условиям.

� Примечание. Для добавления в проект недоступны лупы с затенен-
ными названиями. Они приобретаются и загружаются от дельно.
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Чтобы переместить луп на монтажный стол, перетащите его при помо-
щи мыши из нижней части панели. Перед тем как добавлять на монтаж-
ный стол, луп рекомендуется прослушать, щелкнув по нему мышью.

После того как вы добавите луп на монтажный стол, пора переходить 
к использованию других инструментов. На этом этапе все зависит от 
уровня ваших знаний и фантазии. Например, вы можете растянуть луп 
или продублировать его множество раз. Чтобы растянуть луп, устано-
вите указатель мыши на левом или правом краю фрагмента и перета-
щите его, нажав и удерживая кнопку мыши.

Когда вы измените луп, стоит прослушать, как будет звучать дорожка. 
Для этого нажмите кнопку .

При необходимости вы можете настроить уровень громкости звуча-
ния дорожки в общей композиции и изменить баланс звучания. Все эти 
элементы управления находятся на панели каждой из дорожек в цен-
тральной части основного окна программы.

Если доступных элементов управления настройкой окажется недоста-
точно, дважды щелкните мышью по соответствующему лупу на дорож-
ке или, выбрав его, нажмите клавишу E, тогда в нижней части основно-
го окна появится панель редактора лупа (рис. 6.10).

Рис. 6.10. Панель редактора лупа

Чтобы вернуться к отображению панели смарт-пульта, нажмите клави-
шу B. Элементы управления на этой панели позволяют изменить каж-
дый параметр звучания.

Когда вы составите композицию и настроите звучание, можете экспор-
тировать готовую запись или сохранить ее на жестком диске своего 
компьютера. Для этого следует выполнить команду меню Экспортиро-
вать ⇒ Экспортировать песню на диск (Share ⇒ Export to Disk).
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Если вы хотите научиться играть на гитаре или фортепьяно, вам понра-
вится раздел Школа игры (Learn to Play). Чтобы перейти в него, выбе-
рите пункт Школа игры (Learn to Play) на боковой панели основного 
окна. Здесь вы найдете следующие вкладки: Уроки игры на гитаре 
(Guitar Lesson), Уроки игры на фортепиано (Piano Lessons) и Уроки 
мастерства (Artist Lessons), каждая из которых содержит соответствую-
щие курсы.

• На вкладке Уроки игры на гитаре (Guitar Lessons) доступны два 
бесплатных курса, изучая их, вы научитесь правильно держать аку-
стическую или электрогитару, сможете настраивать ее и брать ак-
корды. Также предусмотрена возможность записи своего исполне-
ния для оценки полученного результата (рис. 6.11).

Рис. 6.11. Обучение игре на гитаре

• На вкладке Уроки игры на фортепиано (Piano Lessons) доступен 
один урок, из него вы узнаете об устройстве фортепиано, пра-
вильной посадке, познакомитесь с основными приемами игры 
и т. д. Перед началом изучения курса не забудьте подключить MIDI-
клавиатуру.

• Раздел Уроки мастерства (Artist Lessons) по умолчанию пуст, так 
как в нем программа GarageBand хранит только те уроки, которые 
вы приобрели в разделе Магазин уроков (Lesson Store).
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Если уроков из базы GarageBand будет недостаточно, вы всегда смо-
жете воспользоваться разделом Магазин уроков (Lesson Store). В нем 
можно приобрести и загрузить дополнительные курсы игры на гитаре 
и фортепиано.

Если у вас возникнут сложности во время работы с приложением 
GarageBand, воспользуйтесь справочными материалами, выбрав 
пункт Справка (Help). Также вы можете найти дополнительную ин-
формацию о принципах работы с приложением GarageBand и позна-
комиться с технической информацией на официальном сайте ком-
пании Apple (www.apple.com/ru/support/mac-apps/garageband).

Редактирование документов 
в приложении Pages

Приложение Pages представляет собой удобный текстовый редактор, 
в котором можно создавать красивые и стильные документы: письма, 
отчеты, резюме, приглашения и т. д. — на компьютере Mac или устрой-
ствах iPad, iPhone  и iPod touch. Вам потребуется только выбрать шаблон 
документа и ввести текст, за стилем оформления программа будет сле-
дить самостоятельно. Благодаря такому подходу, документы, которые 
вы создадите в этом приложении, всегда будут выглядеть профессио-
нально и стильно. Чтобы начать работу с программой Pages , выполните 
следующие действия.

1. Запустите приложение из папки Программы (Applications) или щел-
кните мышью по значку  на панели Dock. Откроется окно про-
граммы Pages.

2. Выберите понравившийся макет из множества шаблонов, чтобы за-
дать стиль нового документа, и нажмите кнопку Выбрать (Choose). 
Вы увидите основное окно программы (рис. 6.12).

Окно приложения Pages по умолчанию разделено на три части. В верх-
ней располагается панель инструментов, отвечающая за вставку раз-
личных объектов. Боковая панель инструментов предназначена для 
форматирования текста в документе. Всю остальную часть окна зани-
мает рабочее поле, в котором отображается открытый документ.

Вы можете изменить масштаб документа, выбрав значение в раскры-
вающемся списке Изменить масштаб (Zoom) или указав оптимизиро-
ванный параметр Согласовать по ширине (Fit Width), который уместит 
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холст документа в окне программы. Выбрав параметр Согласовать 
с размером страницы (Fit Page), вы увидите страницу документа це-
ликом. Также вы можете выбрать в раскрывающемся списке Вид (View) 
в левом верхнем углу окна программы пункт Показать миниатюры 
страниц (Show Page Thumbnails) — слева от документа появятся не-
большие эскизы страниц, что позволит просмотреть компоновку тек-
ста на страницах документа. Чтобы скрыть отображение эскизов, вы-
берите пункт Скрыть миниатюры страниц (Hide Page Thumbnails).

Рис. 6.12. Основное окно программы Pages

Чтобы отформатировать текст, воспользуйтесь боковой панелью ин-
струментов Текст (Text). Для этого выполните следующие действия.

1. Выделите фрагмент текста в документе и примените параметры 
форматирования.

� Примечание. Если вы примените параметры форматирования, не 
выделив фрагмент, то они будут действительны только для текста, 
напечатанного впоследствии.
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В верхней части боковой панели инструментов расположен раскры-
вающийся список, позволяющий быстро выбрать один из стилей фор-
матирования текста. Вы можете расширить этот список, добавив новый 
стиль.

2. Не сбрасывая выделения с фрагмента текста с форматированием, 
откройте раскрывающийся список и нажмите кнопку , располо-
женную справа от пункта Стили абзацев (Paragraph Style).

3. Введите название нового стиля (рис. 6.13).

Рис. 6.13. Создание стиля абзаца

4. Для удаления стиля нажмите кнопку , расположенную справа от 
его названия, и выберите пункт Удалить стиль (Delete Style).

Элементы в боковой панели инструментов Текст (Text) размещены по 
разделам, каждый из которых отвечает за определенные параметры 
форматирования текста.

• Шрифт (Font). В этом разделе расположены элементы, отвечающие 
за вид шрифта текста. Вы можете изменить тип шрифта и его ото-
бражение, размер и цвет текста, а также выбрать стиль формати-
рования. Чтобы изменить тип шрифта, укажите нужное название 
шрифта в верхнем раскрывающемся списке. Вы можете изменить 
начертание выбранного шрифта, нажав соответствующую кнопку: 

 — сделать текст жирным,  — курсивный текст и  — под-
черкнутый. Разрешается выбрать несколько вариантов сразу, но 
учтите, что не каждый шрифт поддерживает начертание в том или 
ином виде. Рядом с этими кнопками отображается цвет выбранного 
фрагмента текста, щелкнув мышью по которому вы получите набор 
вариантов цвета. Нажатие кнопки  открывает окно, где можно вы-
брать любой другой цвет.
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• Выравнивание (Alignment). В этом разделе находятся элементы 
управления, отвечающие за расположение текста в документе. 
Воспользуйтесь соответствующими кнопками, чтобы выровнять 
текст:  — выравнивание по левому краю,  — по центру,  — 
по правому краю или , чтобы равномерно распределить текст 
по ширине. Если вы хотите, чтобы текст отступал от левого края 
документа, нажмите кнопку . Для уменьшения отступа нажмите 
кнопку .

• Интервалы (Spacing). Здесь вы можете задать интервалы между 
строками и между абзацами. По умолчанию установлен одинарный 
интервал. Чтобы увеличить расстояние между строками, раскройте 
раздел Интервалы (Spacing) и в поле ввода Строки (Lines) устано-
вите необходимый интервал. В поле ввода Перед абзацем (Before 
Paragraph) и После абзаца (After Paragraph) можно указать расстоя-
ние между двумя абзацами текста.

• Пункты и списки (Bullets & Lists). С помощью элементов этого раз-
дела вы можете добавить в документ список. Выберите в раскрыва-
ющемся перечне Стили списка (List Styles) один из предложенных 
вариантов. Раскройте раздел Пункты и списки (Bullets & Styles), что-
бы изменить дополнительные параметры списка, например интер-
вал отступа текста от пункта списка, цвет маркера или его размер .

Приложение Pages позволяет добавлять таблицы в документ. Чтобы 
сделать это, нажмите кнопку Таблица (Table), расположенную на верх-
ней панели инструментов, и выберите один из предложенных вариан-
тов таблицы. Изменить количество столбцов можно при помощи кноп-
ки , а количество строк — кнопкой . Чтобы переместить таблицу 
в другую часть документа, перетащите мышью кнопку . Во время 
редактирования таблицы в боковом меню появятся несколько новых 
разделов.

• Размер строки или столбца можно изменить, просто перетащив мы-
шью нужную линию в таблице. Чтобы указать точный размер, выде-
лите ячейку в столбце или строке, размер которых вы хотите изме-
нить, после чего укажите новые размеры в поле ввода Строка (Row) 
или Столбец (Column), находящемся в боковой панели, на вкладке 
Таблица (Table) в разделе Размер столбцов и строк (Row & Co-
lumns Size). Для применения новых параметров нажмите кнопку 
Подогнать (Fit). Чтобы изменить размеры всех строк и столбцов, 
выделите перед изменением всю таблицу, нажав кнопку . Если 
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установлен флажок Подогнать размер строк под размер содер-
жимого ячеек (Resize rows to fit cell contents), то размер строк будет 
ровно таким, чтобы уместить содержимое таблицы.

• Для добавления или удаления линий, разграничивающих строки 
и столбцы таблицы, нажмите соответствующую кнопку:  — скрыть/
отобразить горизонтальные линии,  — скрыть/отобразить верти-
кальные линии. Аналогично можно скрывать/отображать границы, 
расположенные в колонтитулах таблицы:  — горизонтальные ли-
нии,  — вертикальные линии верхних строк колонтитулов,  — 
вертикальные линии нижних строк колонтитулов.

• Чтобы закрасить строки через одну, установите флажок Чередую-
щиеся цвета строк (Alternating Row Color). Справа от него располо-
жено всплывающее меню, в котором отображается фоновый цвет 
выбранной строки. Щелкнув по нему мышью, вы увидите набор ва-
риантов цвета строки. При нажатии кнопки  откроется окно, в ко-
тором можно выбрать любой другой цвет.

• Вне зависимости от выбранных параметров таблицы вы всегда мо-
жете отметить любую ячейку, закрасив ее другим цветом. Для это-
го выделите ее и перейдите в боковую панель, на вкладку Ячейка 
(Cell). Раскрыв раздел Заливка (Fill), вы сможете выбрать цвет ячей-
ки и тип заливки. В разделе Граница (Border) вы можете изменить 
стиль и орнамент границы одной или нескольких ячеек.

Приложение Pages позволяет добавлять диаграммы в документ. Чтобы 
сделать это, выполните следующие шаги.

1. Нажмите кнопку Диаграммы (Chart), расположенную на верхней 
панели инструментов, и выберите один из предложенных вариан-
тов диаграмм.

2. Чтобы изменить данные диаграммы, щелкните по ней мышью и на-
жмите кнопку Редактировать (Edit Chart Data). Появится таблица 
со значениями диаграммы, в которой следует указать нужные дан-
ные (рис. 6.14).

3. Чтобы добавить в таблицу новую строку, щелкните мышью, удер-
живая клавишу ⌃, по строке, возле которой нужно добавить новую 
строку, и в появившемся контекстном меню выберите пункт Вста-
вить строку сверху (Insert Row Above) или Вставить строку снизу 
(Insert Row Below).
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Рис. 6.14. Добавление диаграммы

4. Чтобы добавить в таблицу новый столбец, щелкните мышью, удер-
живая клавишу ⌃, по столбцу, возле которого вы хотите добавить 
новый столбец, и в появившемся контекстном меню выберите пункт 
Вставить столбец до (Insert Column Before) или Вставить столбец 
после (Insert Column After). После редактирования закройте окно 
с таблицей, и все данные автоматически сохранятся.

В боковой панели инструментов Диаграмма (Chart) вы можете указать 
дополнительные параметры оформления, например шрифт текста, ис-
пользуемого в диаграмме, ее фон и т. д.

� Совет. Вы можете добавлять в документ графические изображе-
ния, мелодии и видеоклипы. Первые допустимо добавлять как из 
приложения iPhoto, нажав кнопку Медиа (Media), расположенную 
в верхней панели инструментов, так и перетащив файл на рабочее 
поле документа.

По умолчанию документ сохраняется в формате .pages, который под-
держивает только приложение Pages. Чтобы сохранить его в этом фор-
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мате, выполните команду меню Файл ⇒ Сохранить (File ⇒ Save). Что-
бы сохранить документ в другом формате, выполните команду меню 
Файл ⇒ Экспортировать в (File ⇒ Export To) и выберите необходимый 
формат.

• PDF — формат документов программы Adobe Acrobat, без возмож-
ности редактирования.

• Word — формат документов приложения Word, входящий в пакет 
офисных программ Microsoft Office, с возможностью дальнейшего 
редактирования.

• Простой текст (Plain Text) — формат документов, совместимый 
практически с любым текстовым редактором. При экспорте доку-
мента в файл с этим расширением сохраняется только текст без 
форматирования.

• ePub — распространенный формат документов, в котором выпу-
скаются электронные книги. Совместим с приложением iBooks.

• Pages ’09 — формат, совместимый со старой версией приложения 
Pages.

Если у вас возникнут вопросы во время работы с приложением Pa-
ges, обратитесь к справочным материалам, выбрав пункт Справка 
(Help). Кроме того, вы можете найти дополнительную информацию 
о приложении Pages, посмотреть практические советы и инструк-
ции, а также ознакомиться с технической информацией на офици-
альном сайте компании Apple (www.apple.com/ru/support/mac-
apps/pages/).

Электронные таблицы в приложении Numbers

С помощью приложения Numbers легко создавать красивые и практич-
ные таблицы. Благодаря возможностям этой программы вы без труда 
составите планы, структурируете и проанализируете большие объемы 
данных, используя преимущества электронных таблиц.

Чтобы начать работу с Numbers , выполните следующие действия.

1. Запустите приложение из папки Программы (Applications) или щелк-
ните мышью по значку  на панели Dock. После выбора шаблона 
откроется окно программы (рис. 6.15).
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Рис. 6.15. Окно приложения Numbers

С приложением Numbers вам не придется тратить время на то, чтобы 
самостоятельно создавать таблицу и оформлять ее, достаточно вы-
брать один из множества предустановленных шаблонов, чтобы доба-
вить таблицу, которая значительно упростит выполнение различных 
заданий. При выборе ее макета можете быть уверены, что используе-
мые цвета, шрифты и текстуры полностью соответствуют друг другу. 
Кроме того, приложение Numbers автоматически подбирает форму-
лы, которые вам понадобятся (в соответствии с выбранным макетом), 
и может самостоятельно рассчитать каждую из 250 формул и функций, 
которые есть в его базе. Вам остается только внести свои данные и при 
желании добавить изображения, текстовые пояснения или применить 
графические эффекты.

На одном листе можно создать столько таблиц, сколько вам необходи-
мо, и самостоятельно указать их размер и местоположение на листе. 
При изменении размера таблицы или ее перемещении все вычисле-
ния в ячейках остаются неизменными. Несмотря на то что приложение 
Numbers предлагает использовать макеты, вы в любой момент може-
те изменить выбранный шаблон: отредактировать строки, столбцы 
и ячейки, добавить формулы, интервалы, настроить цвета, выбрать 
шрифт и т. д. В приложении Numbers вы найдете все инструменты, ко-
торые привыкли использовать при построении электронных таблиц 
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в других программах, в том числе возможности сортировки, разно-
образные способы организации данных, справку по использованию 
формул и т. д.

Окно приложения Numbers имеет такую же структуру, как и окно при-
ложения Pages. На рабочем поле размещена электронная таблица, 
с которой мы и будем работать. Рабочее поле приложения Numbers 
разделено на строки и столбцы, обозначенные индивидуальным за-
головком. Для столбцов используются латинские буквы, а для строк — 
цифры. На пересечении строки и столбца находится ячейка. У каждой 
есть индивидуальный адрес. Например, ячейка на пересечении заго-
ловков F и 17 имеет адрес F17. В нижней части окна показан тип вы-
бранной ячейки и ее содержимое. При выборе нескольких ячеек там 
отображается сумма чисел в них, минимальное, среднее и максималь-
ное значение, а также количество выбранных ячеек.

По умолчанию верхняя строка и левый столбец оформлены как колон-
титулы. В раскрывающихся списках, расположенных в разделе Верхние 
и нижние колонтитулы (Headers & Footer) на панели инструментов Та-
блица (Table), можно изменить количество колонтитулов или вообще 
их удалить, указав значение 0. Выбрав пункт Зафиксировать столб-
цы бокового колонтитула (Freeze Header Rows) или Зафиксировать 
строку верхнего колонтитула (Freeze Header Rows), вы можете закре-
пить колонтитул, после чего он всегда будет отображаться на экране 
при прокрутке таблицы. В остальном же боковая панель инструментов 
и форматирование таблицы ничем не отличаются от работы с таблица-
ми в приложении Pages.

По умолчанию приложение определяет содержимое ячеек автомати-
чески. Поэтому, если конечное содержимое ячейки отличается от зна-
чения, которое вы ввели в нее, необходимо изменить формат ячейки. 
Для этого выполните следующие действия.

1. Выделите одну или несколько ячеек и перейдите в боковую панель 
инструментов, на вкладку Ячейка (Cell).

2. В разделе Формат данных (Data Format) выберите формат данных 
ячейки и укажите дополнительные параметры (рис. 6.16).

Основным назначением приложения Numbers является возможность 
работы с функциями. Вводя функцию в ячейку, можно выполнить в ней 
подсчет значений других ячеек. 
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Рис. 6.16. Выбор формата данных в ячейке

Добавить функцию в ячейку можно несколькими способами.

• Выберите ячейку, в которую хотите добавить функцию. Нажми-
те кнопку Функция (Function), расположенную в верхней панели 
инструментов окна приложения, и в списке выберите нужную вам 
функцию. Этот способ очень прост и удобен, но только в том слу-
чае, если вам необходимо подсчитать значения в ячейках, располо-
женных выше выбранной вами. В списке доступны такие формулы, 
как сумма, количество, произведение ячеек, а также минимальное, 
среднее или максимальное значение. Дополнительные функции 
отображаются на панели Функции (Functions) в правой части окна 
программы. Вы можете отредактировать функцию, дважды щелкнув 
мышью по ячейке с ней (рис. 6.17).

• Выберите несколько ячеек, значения которых вы хотите подсчи-
тать. В нижней части окна приложения отобразятся результаты этих 
вычислений. Чтобы добавить подсчет в таблицу, просто перетащите 
его в нужную вам ячейку. Нажав кнопку , вы можете добавить 
или удалить подсчеты из нижней части окна приложения.

• Выберите ячейку, куда хотите добавить функцию, и введите символ 
= (равно), после чего откроется редактор формул. Выберите ячейку, 
значение которой будет первой в формуле, или укажите свое. Вве-
дите арифметический оператор и выберите ячейку, которая будет 
второй в формуле, или укажите свое значение. После составления 
формулы нажмите кнопку .
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Рис. 6.17. Ввод и редактирование функций

� Примечание. Если в приложении Pages данные для диаграмм извле-
кались из отдельной специальной таблицы, то в приложении Num-
bers они могут браться из самой таблицы, которая отображается в ра-
бочем поле. Чтобы добавить диаграмму в таблицу, выделите ячейки 
с данными, которые вы хотите использовать в качестве значений для 
диаграммы, нажмите кнопку Диаграмма (Chart) и выберите ее вид.

По умолчанию документ сохраняется в формате .numbers, который 
поддерживается только приложением Numbers. Чтобы сохранить до-
кумент в этом формате, выполните команду меню Файл ⇒ Сохранить 
(File ⇒ Save). Чтобы сохранить документ в другом формате, выполните 
команду меню Файл ⇒ Экспортировать в (File ⇒ Export To) и выбери-
те необходимый формат.

• PDF — формат документов программы Adobe Acrobat, без возмож-
ности редактирования.

• Excel — формат документов приложения Excel, входящий в пакет 
офисных программ Microsoft Office, с возможностью дальнейшего 
редактирования.
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• CSV — формат, предназначенный для сохранения значений, кото-
рые разделяются запятыми. Файл с таким расширением можно от-
крыть в приложении Numbers, Microsoft Excel и большинстве дру-
гих приложений для работы с электронными таблицами.

• Numbers ’09 — формат, совместимый со старой версией приложе-
ния Numbers.

Если у вас возникнут вопросы во время работы с приложением Numbers, 
обратитесь к справочным материалам, выбрав пункт Справка (Help). 
Кроме того, вы можете найти дополнительную информацию о приложе-
нии Numbers, посмотреть практические советы и инструкции, а также 
ознакомиться с технической информацией на официальном сайте ком-
пании Apple (www.apple.com/ru/support/mac-apps/numbers/).

Создание презентаций в приложении Keynote

Keynote — мощная программа для разработки презентаций. С помо-
щью этого приложения вы можете не только создать и красиво офор-
мить свою презентацию, но и опубликовать ее. Чтобы начать работу, 
сначала выберите одну из тем, которые предустановлены в приложе-
нии Keynote. После этого не нужно отвлекаться на оформление пре-
зентации, все слайды будут выполнены в одном стиле: согласованный 
шрифт, цвета и фон, текстуры для таблиц, диаграмм и т. д. Чтобы начать 
работу с программой Keynote, выполните следующие действия.

1. Запустите приложение Keynote из папки Программы (Applications) 
или щелкните мышью по значку  на панели Dock. После выбора 
шаблона откроется окно программы (рис. 6.18).

После того как вы выбрали шаблон новой презентации, в окне прило-
жения Keynote вы увидите первый ее слайд на рабочем поле, а в левой 
части окна — эскизы слайдов. Можете как воспользоваться структурой 
шаблона, так и добавить свой текст, изображения и другие элементы 
презентации в любое место слайда. Чтобы добавить текст, нажмите 
кнопку Текст (Text), расположенную в верхней панели инструментов, 
и выберите его стиль во всплывающем меню. Текстовый блок отобра-
зится на слайде. Перетащите текстовый блок мышью в нужную позицию. 
Для редактирования блока дважды щелкните по нему мышью и введи-
те текст. Во время редактирования текстового блока в боковой панели 
инструментов откроется раздел Текст (Text), воспользовавшись кото-
рым вы можете изменить шрифт и отображение текста, добавить спи-
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сок или изменить выравнивание в редактируемом текстовом блоке — 
все делается так же, как и при работе в приложении Pages. На вкладке 
Стиль (Style) боковой панели инструментов вы можете изменить фон 
текстового блока, добавить ему границы и различные эффекты. Чтобы 
удалить блок, щелкните по нему мышью и нажмите клавишу ⌫.

Рис. 6.18. Интерфейс приложения Keynote

Как и в Pages, в приложении Keynote можно добавлять различные гра-
фические изображения, аудио- и видеофайлы, диаграммы, таблицы, 
фигуры и многие другие элементы. Если два объекта накладываются 
друг на друга, вы можете изменить их расположение на слайде, выбрав, 
какой из объектов будет расположен на переднем плане, а какой — на 
заднем. Для этого выполните следующие действия.

1. Выберите один или несколько объектов, расположение которых вы 
хотите изменить, и перейдите на боковую панель инструментов, на 
вкладку Расстановка (Arrange).

2. Нажмите кнопку Назад (Back), чтобы переместить объект в заднюю 
часть слайда, или кнопку Вперед (Front), чтобы переместить объект 
в переднюю часть слайда.

Если нажать кнопку Дальше (Backward) или Ближе (Forward), вы пере-
местите объект в заднюю или переднюю часть на один шаг, что позво-
лит расположить его между двумя другими элементами.
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Выделив объект, вы увидите на его границах несколько точек, пере-
тащив которые при помощи мыши можно увеличить, уменьшить или 
растянуть объект. Для более точного изменения размеров и поворота 
(отражения) объекта выполните следующие действия.

1. Перейдите на боковую панель инструментов, на вкладку Расста-
новка (Arrange).

2. В поле ввода Ширина (Size) укажите желаемую ширину объекта, 
а в поле ввода Высота (Height) — его высоту. Размеры указываются 
в пикселах и применяются сразу после изменения.

Если установлен флажок Сохранять пропорции (Constrain propor-
tions), то при изменении одного параметра будет автоматически из-
меняться другой, чтобы сохранить пропорцию размеров выбранного 
объекта. Здесь же можно указать и точное расположение объекта на 
слайде, задав координаты X и Y в поле ввода X и Y соответственно.

3. Для вращения объекта введите угол поворота в поле ввода Угол. 
Чтобы зеркально отразить объект по горизонтали, нажмите кнопку 

, чтобы отразить его по вертикали — кнопку .

Если вы поместили объект на слайд и не хотите случайно его переме-
стить во время дальнейшего редактирования, выполните следующие 
шаги.

1. Выделите объект и перейдите на вкладку Расстановка (Arrange) бо-
ковой панели инструментов.

2. Чтобы заблокировать перемещение объекта, нажмите кнопку За-
крепить (Lock).

3. Чтобы вернуть возможность переместить объект, нажмите кнопку 
Снять закрепление (Unlock).

4. Выделите два или более объектов и на вкладке Расстановка (Ar-
range) боковой панели инструментов нажмите кнопку Группиро-
вать (Group).

После этого выбранные объекты окажутся связаны между собой, и все 
действия с одним из них будут применяться для всех этих объектов. Так, 
при перемещении одного объекта будут перемещены и остальные.

5. Чтобы вновь сделать объекты независимыми друг от друга, нажми-
те кнопку Разгруппировать (Ungroup).
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Для добавления слайдов выполните следующие действия.

1. Чтобы добавить новый слайд, удерживая клавишу ⌃, щелкните мы-
шью по эскизу последнего слайда и в появившемся контекстном 
меню выберите пункт Новый слайд (New Slide) или выполните ко-
манду меню Слайд ⇒ Новый слайд (Slide ⇒ New Slide).

2. Чтобы добавить новый слайд среди уже готовых, удерживая клави-
шу ⌃, щелкните мышью по тому слайду, после которого вы хотите 
поместить новый.

3. Чтобы добавить слайд с новой компоновкой, нажмите кнопку , 
расположенную в нижней части панели эскизов, и в появившемся 
меню выберите макет добавляемого слайда (рис. 6.19).

Рис. 6.19. Добавление слайда

К объектам слайда можно применять различные эффекты, которые бу-
дут использоваться при воспроизведении презентации. Для их нало-
жения выполните следующие действия.
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1. Выделите объект на слайде и нажмите кнопку Анимация (Ani-
mate).

2. На боковой панели инструментов нажмите кнопку Добавить эф-
фект (Add effect), выберите эффект и при необходимости настройте 
его. У разных эффектов параметры могут различаться.

3. Чтобы изменить порядок воспроизведения эффектов, нажмите 
кнопку Порядок анимации (Build Order) и в появившемся окне 
перетащите мышью эффекты в нужном вам порядке.

� Примечание. Если требуется сменить макет ранее добавленного 
слайда, следует выбрать его на панели эскизов. После этого в боко-
вой панели инструментов Макет слайда (Slide Layout) можно будет 
выбрать фоновый цвет слайда, применить изображение в качестве 
фона или изменить всю компоновку.

По умолчанию при воспроизведении презентации слайд меняется по-
сле щелчка мыши. Если вы хотите, чтобы это происходило автоматиче-
ски, выполните следующие действия.

1. Нажмите кнопку Настройка (Setup) и в раскрывающемся списке 
Тип презентации (Presentation Type) выберите пункт Автовоспро-
изведение (Self-Playing).

2. В поле ввода Переходы (Transitions) укажите время отображения 
одного слайда, в поле ввода Анимации (Builds) — время перехода 
одного слайда на другой.

На этой же панели можно изменить соотношение сторон слайдов. По 
умолчанию используется соотношение «4:3», подходящее для старых 
мониторов и большинства проекторов.

3. Если вы хотите подстроить презентацию под широкоформатные 
экраны, в раскрывающемся списке Размер слайда (Slide Size) вы-
берите пункт Широкий экран (Widescreen (16:9)).

4. Чтобы подстроить презентацию под нестандартное разрешение 
экрана, укажите его в пункте Собственный размер слайда (Cus-
tom Slide Size).

К презентации можно добавить и звуковое сопровождение. Для этого 
выполните следующие шаги.
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1. Нажмите кнопку Настройка (Setup) и на боковой панели инстру-
ментов откройте вкладку Аудио (Audio).

2. Перетащите звуковые файлы в поле Добавить аудиофайлы (Add 
Audio Files) (рис. 6.20).

Рис. 6.20. Добавление звукового сопровождения к презентации

3. Нажмите кнопку Записать (Record), чтобы добавить к презентации 
закадровый комментарий.

4. Для просмотра презентации перед сохранением нажмите кнопку 
Воспроизведение (Play).

5. Чтобы выйти из презентации, нажмите клавишу Escape.

По умолчанию документ сохраняется в формате .key, который под-
держивается только приложением Keynote. Чтобы сохранить доку-
мент в этом формате, выполните команду меню Файл ⇒ Сохранить 
(File ⇒ Save). Чтобы сохранить документ в другом формате, выполните 
команду меню Файл ⇒ Экспортировать в (File ⇒ Export To) и выбери-
те необходимый формат.

• PDF — формат документов программы Adobe Acrobat, без возмож-
ности редактирования.
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• PowerPoint — формат документов приложения PowerPoint, входя-
щего в пакет офисных программ Microsoft Office, с возможностью 
дальнейшего редактирования.

• QuickTime — сохранение презентации в качестве видеоролика 
в формате MP4.

• HTML — сохранение презентации в формате HTML. В дальнейшем 
этот документ можно будет просмотреть в любом браузере, открыв 
файл index.html.

• Изображения (Images) — сохранение каждого слайда в виде по-
следовательности изображений в формате JPG, PNG или BMP.

• Keynote ’09 — формат, совместимый со старой версией приложе-
ния Keynote.

Если у вас возникнут вопросы во время работы с приложением Keynote, 
обратитесь к справочным материалам, выбрав пункт Справка (Help). 
Кроме того, вы можете найти дополнительную информацию о прило-
жении Keynote, посмотреть практические советы и инструкции, а также 
ознакомиться с технической информацией на официальном сайте ком-
пании Apple (www.apple.com/ru/support/mac-apps/keynote/).



Глава 7
Подключение к локальной сети 
и Интернету

Кроме всего прочего, компьютеры Mac замечательны еще и тем, что 
практически сразу готовы к работе в сети. Изучив эту главу, вы узнаете, 
как настроить новое подключение, объединить несколько компьюте-
ров в локальную сеть, обеспечить совместный доступ к файлам, а также 
познакомитесь с возможностями совместного использования экрана.

В локальной сети копировать папки и файлы с одного компьютера на 
другой так же просто, как и на одной и той же машине. Можно обме-
ниваться сообщениями, использовать общую базу данных, демонстри-
ровать результаты своей работы или организовать совместный доступ 
к принтеру и Интернету для нескольких устройств.

Чаще всего компьютеры Mac объединяют в локальную сеть с помо-
щью Ethernet или Wi-Fi. Каждый современный компьютер Mac оснащен 
портом Ethernet, который обычно располагается на задней или боко-
вой панели. Если вы с помощью кабелей подключите свои компьюте-
ры к концентратору (хабу) или маршрутизатору (роутеру), то получите 
очень быструю и надежную связь. Когда у вас только два компьютера, 
достаточно будет только кабеля Ethernet, которым вы соедините соот-
ветствующие порты обоих компьютеров.

Сеть Wi-Fi используют, чтобы создать беспроводное подключение 
в пределах домашней сети. Кроме того, с помощью адаптеров Wi-Fi 
ноутбуки Mac позволяют подключаться к Интернету через в обще-
ственные точки доступа, которые устанавливаются в офисах, кафе, го-
стиницах, аэропортах и т. д. В настоящее время оборудование для под-
держки сетей Wi-Fi (называемое AirPort) встраивается практически во 
все компьютеры Mac.

Подключение компьютера к Интернету

Если вы задали параметры настройки сети при первом включении ком-
пьютера, указав данные, необходимые для того, чтобы система могла 
самостоятельно установить соединение с Интернетом, то вам остает-
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ся только запустить веб-браузер Safari и начать работу. Если же это не 
было сделано, пришло время заняться настройкой. Все необходимые 
данные указываются путем настройки параметров сети в окне Сеть 
(Network). Ваш компьютер способен иметь несколько вариантов соеди-
нения, при этом не важно, используете вы их все или только один. Пол-
ный перечень устройств, которые можно использовать, чтобы создать 
соединение, находится в левой панели окна Сеть (Network). Если вы 
используете несколько вариантов подключения, очень важно, в каком 
порядке они перечислены, от этого зависит, в какой последовательно-
сти ваш компьютер будет пробовать различные способы подключения 
к сети.

В большинстве случаев, если вы правильно подключили кабели и ис-
пользуете исправное сетевое оборудование, операционная система 
OS X автоматически распознает подключение. Но когда ей это не уда-
ется, настройку можно осуществить вручную, выполнив следующие 
действия.

1. Выберите команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) или щелкните мышью по значку Системные на-
стройки (System Preferences) на панели Dock. Появится окно Си-
стемные настройки (System Preferences).

2. В открывшемся перечне выберите пункт Сеть (Network). Появится 
одноименное окно (рис. 7.1).

3. В списке, расположенном в левой части окна Сеть (Network), щелк-
ните мышью по пункту Ethernet.

4. Нажмите кнопку Дополнительно (Advanced). Откроется всплы-
вающая панель, которая полностью займет все пространство окна 
Сеть (Network). Она содержит шесть вкладок. По умолчанию будет 
открыта вкладка TCP/IP (рис. 7.2).

5. В раскрывающемся списке Конфигурация IPv4 (Configure IPv4) вы-
берите пункт Используя DHCP (Using DHCP).

6. Если в поле Адрес IPv4 (IPv4 Address), расположенном ниже, не ото-
бражается IP-адрес, нажмите кнопку Запросить адрес DHCP (Re-
new DHCP Lease). IP-адрес должен появиться, если все настроено 
правильно и оборудование работает исправно.

7. Нажмите кнопку ОК, чтобы закрыть всплывающую панель. Затем — 
кнопку Подтвердить (Apply). Окно Сети (Network) будет закрыто.
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Рис. 7.1. Окно Сеть

Рис. 7.2. Вкладка TCP/IP окна Сеть
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Если для создания сети требуется указать конкретный IP-адрес, это 
можно сделать следующим способом.

1. Откройте окно Сеть (Network).

2. В списке слева щелкните мышью по пункту Ethernet.

3. Нажмите кнопку Дополнительно (Advanced). Появится всплываю-
щая панель, по умолчанию открытая на вкладке TCP/IP.

4. В раскрывающемся списке Конфигурация IPv4 (Configure IPv4) вы-
берите пункт Вручную (Manually). Если ваша сеть использует марш-
рутизатор или другой DHCP-сервер, но вам все равно требуется ука-
зать IP-адрес вручную, в раскрывающемся списке Конфигурация 
IPv4 (Configure IPv4) выберите пункт Используя DHCP с заданным 
адресом (Using DHCP with Manual Address).

5. Введите нужный вам IP-адрес в поле ввода Адрес IPv4 (IPv4 Ad-
dress).

� Примечание. В большинстве домашних сетей используются IP-
адреса типа 192.168.0.0, где в позиции последнего нуля может на-
ходиться любое число от 0 до 255. При планировании сетей следует 
учитывать, что у каждого компьютера в сети должен быть уникаль-
ный IP-адрес. Если вы вручную укажете двум компьютерам одной 
сети один и тот же IP-адрес, это приведет к проблемной ситуации.

При выборе в раскрывающемся списке Конфигурация IPv4 (Configure 
IPv4) пункта Используя DHCP с заданным адресом (Using DHCP with 
Manual Address) поля Маска подсети (Subnet Mask) и Маршрутизатор 
(Router) будут заполнены автоматически.

6. Нажмите кнопку ОК, что закрыть всплывающую панель. Затем на-
жмите кнопку Подтвердить (Apply). Окно Сеть (Network) будет за-
крыто.

При помощи окна Сеть (Network) подобным образом можно настро-
ить сети, использующие технологии, отличные от Ethernet. Если вам 
требуется подключиться к такой сети, выберите нужное устройство 
или интерфейс в списке в левой части окна Сети (Network). Например, 
для подключения посредством интерфейса Bluetooth выберите пункт 
Blue tooth.
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Если вы настроили несколько подключений и хотите изменить их по-
рядок в окне Сеть (Network), выполните следующие действия.

1. Откройте окно Сеть (Network).

2. Нажмите в нем кнопку , которая находится под списком подклю-
чений, и выберите в контекстном меню пункт Выбрать порядок 
служб (Set Service Order). Появится панель, на которой будут пере-
числены все способы подключения вашего компьютера к Интерне-
ту или локальной сети.

3. При помощи мыши разместите элементы списка в нужном порядке 
и нажмите кнопку OK.

� Совет. Если для подключения к сети на вашем компьютере исполь-
зуется широкополосное проводное соединение, рекомендуется 
поместить его в начало списка, потому что этот способ практически 
всегда обеспечивает самое быстрое подключение к Интернету.

4. В окне Сеть (Network) нажмите кнопку Применить (Apply), чтобы 
изменения вступили в силу.

Компьютеры Mac способны поддерживать несколько сетевых соеди-
нений одновременно: Ethernet, AirPort, VPN, PPPoE и даже Bluetooth. 
Мультисетевое подключение особенно удобно, если вы используете 
ноутбук. В этом случае, как только вы откроете веб-браузер, компью-
тер сам выяснит, какое из соединений доступно в данный момент, про-
верив их по очереди, начиная с первого в списке.

Создание беспроводных подключений
Технологии корпорации Apple, связанные с беспроводными соедине-
ниями, получили название AirPort . Оборудование AirPort полностью 
совместимо с оборудованием для создания беспроводных соедине-
ний других производителей. Поэтому, используя компьютер Mac, вы 
можете без проблем подключаться к сетям Wi-Fi, которые сейчас очень 
распространены в публичных местах, а также к персональным компью-
терам других пользователей, работающих в операционных системах 
OS X и Windows.

Оборудование AirPort встроено практически во все устройства Mac.
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� Примечание. Если ваш компьютер не имеет встроенного сетевого 
оборудования AirPort, вы можете приобрести его и подключить как 
отдельное устройство AirPort Extreme или AirPort Express (рис. 7.3).

Рис. 7.3. Точка доступа AirPort Express (слева) и AirPort Extreme (справа)

Компьютер Mac способен установить беспроводное соединение со 
следующими устройствами.

• Базовая станция AirPort Express или AirPort Extreme компании Apple. 
Позволяет создавать сети в несколько десятков компьютеров.

• Точки доступа других производителей. Компьютеры Mac прекрасно 
работают с таким оборудованием. Как правило, эти устройства рас-
считаны на одновременную работу с меньшим количеством ком-
пьютеров.

• Другой компьютер Mac. В этом случае он будет имитировать базо-
вую станцию AirPort.

Если вы хотите иметь в своем доме беспроводной Интернет, потребует-
ся приобрести личную точку доступа. Она представляет собой комму-
татор, способный в том числе передавать информацию без использо-
вания кабелей.

Тем не менее точка доступа, как правило, имеет также несколько разъ-
емов Ethernet-типа для организации обмена данными по кабелю. Также 
точка доступа подключается Ethernet-кабелем к сети WAN, которая пред-
ставляет собой, говоря простым языком, не что иное, как Ин тернет.
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Настройка беспроводного подключения

Чтобы настроить точку доступа AirPort, выполните следующие шаги.

1. Подключите точку доступа AirPort. Чтобы сделать это правильно, 
предварительно прочтите инструкцию к оборудованию.

2. На компьютере Mac откройте окно Finder и щелкните мышью по 
пункту Программы (Applications) на боковой панели. В папке Ути-
литы (Utility) щелкните мышью по значку приложения Утилита Air-
Port (AirPort Utility) .

3. Точка доступа AirPort должна автоматически появиться в окне дан-
ного приложения. Если это произошло, выделите ее и нажмите 
кнопку Продолжить (Continue). Соединение будет установлено. 
В противном случае вам придется настроить подключение в руч-
ном режиме.

4. Для этого нажмите кнопку Настройка вручную (Manual Setup). 
Введите имя и пароль базовой станции, который в дальнейшем бу-
дет использоваться для изменения ее параметров. Если вы не знае-
те имя и пароль базовой станции, их можно найти в руководстве 
к устройству.

Если все прошло успешно, новая точка доступа появится в окне при-
ложения Утилита AirPort (AirPort Utility).

5. Щелкните по ней мышью. В правой части окна отобразятся параме-
тры подключения.

6. В поле ввода Имя беспроводной сети (Wireless Network Name) ука-
жите имя беспроводной сети. Если вы добавляете базовую станцию 
к уже существующей беспроводной сети, их имена должны совпадать. 
Если же вы создаете новую беспроводную сеть, укажите произволь-
ное название. Проследите, чтобы оно отличалось от имен других бес-
проводных сетей, находящихся в зоне доступа устройства AirPort.

7. В полях ввода Пароль беспроводного подключения (Wireless 
Password) и Подтверждение пароля (Verify Password) укажите па-
роль сети. Если вы планируете использовать данное соединение 
постоянно, установите флажок Запомнить этот пароль (Remem-
ber this password in my keychain), чтобы операционная система за-
помнила пароль подключения. Это избавит вас от необходимости 
вводить его каждый раз при установке подключения.
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� Примечание. Переключатель в центральной части окна приложе-
ния Утилита AirPort (AirPort Utility) позволяет выбрать параметры 
безопасности сети — тип шифрования данных. Рекомендуется ис-
пользование положение WPA/WPA2 Personal. Этот режим предпо-
лагает максимальный уровень безопасности беспроводной сети, 
однако ваше оборудование должно поддерживать данную техно-
логию. О наличии такой возможности вы можете узнать в его руко-
водстве.

8. Нажмите кнопку Продолжить (Continue).

Теперь нужно указать тип сетевого оборудования, которое вы исполь-
зуете.

9. Установите переключатель в центральной части окна приложения 
AirPort Utility в положение Я подключаюсь к Интернету через DSL 
модем или модем с использованием DHCP (I connect to the Inter-
net with a DSL or cable modem using DHCP). Укажите в полях ввода 
в нижней части окна необходимую для подключения информацию, 
если вы используете уже настроенный маршрутизатор или модем, 
которые используют технологию DHCP. В противном случае устано-
вите переключатель в положение Я не использую DHCP (I do not 
use DHCP) и подтвердите параметры DHCP по умолчанию.

10. Нажмите кнопку Продолжить (Continue), чтобы подтвердить вве-
денные данные.

После перезагрузки базовой станции вы увидите сообщение о том, что 
соединение успешно установлено. 

Если не получилось установить соединение, попробуйте настроить его 
заново, предварительно удостоверившись в правильности всех пара-
метров подключения. Для уточнения параметров подключения к Ин-
тернету свяжитесь со службой технической поддержки вашего провай-
дера.

Если по какой-то причине не удалось сразу обнаружить базовую стан-
цию, попробуйте еще раз осуществить поиск, нажав в окне утилиты 
Утилита AirPort (AirPort Utility) кнопку Обновить (Refresh).

Беспроводное соединение с точкой доступа других производителей 
устанавливается аналогичным образом.
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Подключение к беспроводной сети

Когда беспроводная сеть настроена, необходимо подключиться к ней, 
чтобы получить возможность обмениваться данными с другими ком-
пьютерами сети.

Для этого выполните следующие действия.

1. Щелкните мышью по значку  в строке меню в верхней части эк-
рана.

2. В появившемся перечне выберите пункт Включить AirPort (Turn 
AirPort On).

Теперь ваш компьютер готов к беспроводному подключению.

� Совет. Если вы работаете с ноутбуком, учтите, что сетевое оборудо-
вание имеет достаточно высокие показатели энергопотребления. 
Поэтому в те моменты, когда вы не пользуетесь сетью, можно вре-
менно выключать оборудование AirPort, чтобы сэкономить заряд 
батареи.

3. Если операционной системе удалось обнаружить открытые бес-
проводные сети, вы можете выбрать из них нужную и подключить-
ся. Не подключайтесь к незнакомым сетям, если вы в них не увере-
ны, — это может нанести вред вашему компьютеру.

Если необходимо выполнить подключение к другой сети, сделать это 
можно, щелкнув мышью по значку  в строке меню и выбрав в спи-
ске нужную сеть. Если обнаружить ее в списке не удалось, значит, эта 
сеть в данный момент недоступна по какой-либо причине: находится 
вне зоны доступа вашего оборудования AirPort или отключена точка 
доступа.

Когда нужно разорвать подключение к беспроводной сети, следует вы-
брать пункт Выключить AirPort (Turn Airport Off ).

Беспроводная сеть, к которой вы хотите подключиться, может оказать-
ся закрытой. Такие сети не отображаются в списке найденных сетей 
устройства AirPort. В этом случае процесс установления соединения 
будет следующим.
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1. Щелкните мышью по значку  в строке меню. В появившемся пе-
речне выберите пункт Подключиться к другой сети (Join Other 
Network). Появится небольшое диалоговое окно, в котором необхо-
димо ввести сведения о закрытой сети.

2. В поле ввода Имя сети (Network Name) введите точное имя сети, 
также называемое SSID.

3. Если закрытая сеть защищена паролем, укажите его в поле ввода 
Пароль (Password), предварительно выбрав тип шифрования дан-
ных в раскрывающемся списке Безопасность (Security).

4. Если вы планируете и в дальнейшем работать с данной сетью, уста-
новите флажок Запомнить эту сеть (Remember this network), чтобы 
операционная система запомнила ее.

5. Когда закончите установку параметров подключения, нажмите 
кнопку Присоединиться (Join), чтобы попытаться установить со-
единение с закрытой беспроводной сетью.

Если после нескольких попыток подсоединиться к сети так и не уда-
лось, стоит учесть, что причиной тому могут быть не только неверно 
введенные параметры. 

Подобное происходит, например, когда закрытая сеть находится вне 
зоны доступа вашего оборудования. Кроме того, владелец точки до-
ступа мог настроить ее таким образом, чтобы запретить возможность 
внешнего подключения.

Установка соединения с другим компьютером

Для того чтобы ваши данные стали доступны другим пользователям, 
недостаточно просто подключиться к сети. Необходимо задействовать 
соответствующий режим в настройках системы. Для этого выполните 
следующие действия.

1. Выберите команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) или щелкните мышью по значку Системные на-
стройки (System Preferences) на панели Dock. Откроется окно Си-
стемные настройки (System Preferences).

2. Выберите в нем пункт Общий доступ (Sharing). Появится одно-
именное окно.
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3. В поле ввода Имя компьютера (Computer’s name) укажите имя 
вашего компьютера, по которому другие пользователи сети будут 
находить ваши общие папки, или используйте значение по умол-
чанию.

4. В списке, расположенном в левой части окна Общий доступ (Sharing), 
установите флажок Общий доступ к файлам (File Sharing) (рис. 7.4).

Рис. 7.4. Вид окна Общий доступ

В списке Общие папки (Shared Folders) вы можете увидеть перечень 
общих папок этого компьютера.

5. Чтобы добавить новую общую папку, нажмите кнопку , располо-
женную ниже списка Общие папки (Shared Folders).

6. В появившейся всплывающей панели укажите каталог, к которому 
требуется предоставить общий доступ, и нажмите кнопку Доба-
вить (Add).

Для каждой такой папки можно отдельно настроить права различных 
пользователей.

7. Выберите в списке Общие папки (Shared Folders) интересующую 
вас папку — в списке Пользователи (Users) отобразится перечень 
пользователей, которые имеют к ней доступ.
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8. Щелкните мышью по раскрывающемуся списку справа от имени 
пользователя, чтобы изменить уровень прав. Вы можете выбрать 
один из следующих вариантов.

• Чтение и запись (Read & Write). Пользователь имеет полноцен-
ный доступ к содержимому папки: он может читать, изменять 
и удалять ее содержимое, а также копировать туда собственные 
файлы.

• Только чтение (Read Only). Пользователь не может вносить ни-
каких изменений в содержимое вашей папки. При этом он впра-
ве полноценно просматривать ее содержимое.

• Только запись (Write Only (Drop Box)). Пользователь не может 
прочесть содержимое вашей папки, однако он способен копи-
ровать туда собственные файлы.

• Без доступа (No Access). Пользователь лишен всех прав. Это 
удобная альтернатива удалению пользователя из списка тех, кто 
имеет доступ к папке. Если со временем вам потребуется вос-
становить его права, не придется тратить время на добавление 
нового пользователя.

9. Если нужно блокировать для кого-то доступ к вашей папке, выбери-
те его в списке Пользователи (Users), а затем нажмите кнопку , 
которая расположена ниже списка.

Вы также можете добавить новых пользователей или целые группы, ко-
торые смогут работать с вашими общими папками.

10. Нажмите кнопку , расположенную ниже списка Пользователи 
(Users). Откроется всплывающая панель, в которой вы сможете вы-
брать нужного пользователя.

11. Чтобы добавить его, нажмите кнопку Выбрать (Select), после чего 
имя этого пользователя появится в списке Пользователи (Users).

Одновременно добавить несколько пользователей можно только 
в виде группы. Если пользователи не состоят в одной группе, вам по-
требуется выполнить процедуру добавления несколько раз.

12. Закройте окно Общий доступ (Sharing).

Теперь вы можете скопировать в ваши общие папки те файлы, которыми 
хотите поделиться с другими пользователями. Последние в свою оче-
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редь смогут оставлять собственные файлы в ваших общих папках, конеч-
но, при условии, что у них хватает прав на выполнение этого действия.

Подобным образом можно предоставить доступ только пользователем, 
использующим операционные системы семейства OS X. Пользователи 
операционных систем семейства Windows ваших общих папок не уви-
дят. Однако эта проблема имеет решение, о котором будет подробно 
рассказано в следующем разделе.

� Совет. Каждый раз, когда вы выходите в сеть через публичные 
точки доступа, рекомендуется сбрасывать флажок Общий доступ 
к файлам (File Sharing) окна Общий доступ (Sharing). Это позволит 
обезопасить ваш компьютер от посещения посторонними.

Работа с вашими общими папками в программе Finder, как и во всех 
других приложениях, ничем не отличается от работы с остальными 
папками вашего компьютера.

Вы также можете работать с содержимым общих папок других пользо-
вателей вашей сети, разумеется, если они предоставили вам соответ-
ствующие права на их ресурсы.

1. Запустите приложение Finder.

По умолчанию на боковой панели программы Finder отображается 
группа элементов управления Общий доступ (Shared). Пункты этой 
группы вы можете использовать для быстрого доступа к общим папкам 
других пользователей сети: пункты носят имена компьютеров пользо-
вателей.

2. Выберите компьютер интересующего вас пользователя, после чего 
в правом верхнем углу программы Finder появится кнопка Под-
ключиться как (Connect As).

3. Нажмите кнопку Подключиться как (Connect As). Откроется не-
большое диалоговое окно, в котором от вас потребуется предста-
виться системе (рис. 7.5).

 Вы можете представиться системе как.

• Зарегистрированный пользователь. Для этого установите пере-
ключатель Подключиться как (Connect As) в положение Как 
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зарегистрированный пользователь (Registered User). Доступ 
зарегистрированных пользователей к общей папке осущест-
вляется только в случае, если ее владелец выдал соответству-
ющему пользователю права, а тот в свою очередь верно ввел 
свое имя и пароль. Укажите имя пользователя и пароль в полях 
ввода Имя (Name) и Пароль (Password).

Рис. 7.5. Подключение к компьютеру другого пользователя

• Гость. Для этого установите переключатель Подключиться как 
(Connect As) в положение Как гость (Guest). Гостем является про-
извольный пользователь сети, который не хочет представлять-
ся чужой системе. Доступ гостей к общей папке осуществляется 
только в случае, если она открыта для всех пользователей сети.

� Совет. Если вы часто просматриваете общие папки какого-то кон-
кретного пользователя, можно отказаться от рутинного процесса 
авторизации при каждом посещении — имя пользователя и пароль 
можно сохранить в памяти операционной системы. Для этого уста-
новите флажок Запомнить этот пароль в связке ключей (Remem-
ber the password in my keychain).

4. Нажмите кнопку Подключиться (Connect). Если вы правильно ука-
зали все параметры и владелец общих папок действительно дал 
вам некоторые права на совершение операций с его ресурсами, то 
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вскоре вы увидите содержимое общих папок другого пользователя 
вашей сети.

Как только соединение будет установлено, вы можете приступать к ра-
боте с общими папками. Этот процесс ничем принципиально не отли-
чается от работы с папками, размещенными на вашем компьютере. Од-
нако процессы копирования и записи могут происходить значительно 
медленнее — их скорость определяется пропускной способностью 
сети и некоторыми другими параметрами.

Если же требуется установить между двумя компьютерами беспровод-
ное соединение, выполните следующие действия.

1. На первом компьютере щелкните мышью по значку  в строке 
меню.

2. В появившемся перечне выберите пункт Создать сеть (Create Net-
work). Откроется диалоговое окно Компьютер-компьютер (Com-
puter-to-Computer).

3. В поле ввода Имя (Name) укажите имя сети.

В раскрывающемся списке Канал (Channel) вы можете выбрать нужный 
вам канал беспроводного соединения. Однако, чтобы избежать воз-
можных проблем, рекомендуется использовать автоматический меха-
низм определения канала — режим Автоматически (Automatic).

4. В раскрывающемся списке выберите тип шифрования данных. Ре-
комендуется выбрать тот, который обеспечивает максимальный 
уровень защиты и при этом поддерживается обоими компьюте-
рами.

5. Укажите пароль сети в полях ввода Пароль (Password) и Подтверж-
дение (Verify). Минимальная длина пароля определяется типом 
шифрования данных, который вы выбрали, — читайте примечание 
в центральной части диалогового окна Компьютер-компьютер 
(Computer-to-Computer).

6. Нажмите кнопку ОК, чтобы создать сеть.

7. На втором компьютере вы сможете выбрать созданную сеть из спи-
ска значка  на панели индикаторов. Чтобы подключиться к сети, 
просто щелкните по соответствующему пункту мышью, введите па-
роль в появившемся диалогом окне — и все готово!
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8. Когда работа с сетью будет завершена, щелкните мышью по значку 
 на панели индикаторов. В появившемся меню выберите пункт 

Отключиться от текущей сети (Disconnect from Current Network).

Настроив общий доступ, вы сможете работать со всеми папками и фай-
лами, к которым вам разрешен доступ (рис. 7.6).

Рис. 7.6. Содержимое удаленного компьютера в окне Finder

Если вы только начинаете работать с локальной сетью, то можете за-
путаться, какой диск находится на вашем компьютере, а какой — на 
удаленном в сети или с какими файлами вы работаете. Чтобы избежать 
такой ситуации, никогда не запускайте приложения и не открывайте 
документы, которые находятся на других компьютерах. При работе 
с данными из локальной сети рекомендуется скопировать необходи-
мые документы на свой компьютер и работать с ними автономно. По-
сле того как вы закончите, можно поместить отредактированные до-
кументы и файлы на любой компьютер в сети, создав новую папку или 
заменив старые версии.

Построение и использование гибридных сетей

Процесс построения сетей, в которых задействованы компьютеры, ис-
пользующие различные платформы, несколько отличается от процесса 
построения сетей, состоящих только из компьютеров Mac. В этом раз-
деле книги мы рассмотрим, как построить сети, в которых задейство-
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ваны компьютеры под управлением операционных систем OS X и Win-
dows.

В примерах построения сетей с использованием компьютеров под 
управлением операционной системы Windows речь идет об устрой-
ствах под управлением версии не ниже XP, то есть Windows XP, Windows 
Vista, Windows 7 и Windows 8/8.1, а также их серверных версий. В случае 
с более старыми версиями операционной системы Windows процесс 
может выглядеть несколько иначе.

Чтобы пользователи компьютеров под управлением операционных 
систем семейства Windows могли получить доступ к вашим общим пап-
кам, вы должны открыть общий доступ к ним следующим образом.

1. Выберите команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) или щелкните мышью по значку Системные на-
стройки (System Preferences) на панели Dock. Откроется окно Си-
стемные настройки (System Preferences).

2. Выберите пункт Общий доступ (Sharing). По явится одноименное 
окно.

3. В поле ввода Имя компьютера (Computer’s name) укажите имя ва-
шего компьютера, по которому другие пользователи сети будут на-
ходить ваши общие папки.

4. В списке в левой части окна Общий доступ (Sharing) установите 
флажок Общий доступ к файлам (File Sharing).

5. Нажмите кнопку Параметры (Options). Появится всплывающая па-
нель.

6. Установите флажок Предоставление общего доступа к фай-
лам и папкам с помощью SMB (Share files and folders using SMB) 
(рис. 8.8).

Технология SMB  позволяет пользователям операционных систем се-
мейства Windows работать с вашими общими папками. Обязательным 
условием использования технологии SMB является наличие у вашей 
учетной записи пароля.

7. Установите флажок напротив учетной записи, в которой требуется 
включить использование технологии SMB. Откроется диалоговое 
окно Аутентификация (Authentication), в котором от вас потребу-
ется ввести пароль учетной записи.
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Рис. 7.7. Предоставление общего доступа к файлам и папкам с помощью SMB

8. В поле ввода Пароль (Password) укажите пароль учетной записи, 
который нужен для организации общего доступа к файлам. Нажми-
те кнопку ОК.

9. Повторите шаги 6–7 для всех учетных записей, к общим папкам ко-
торых требуется предоставить доступ для Windows-пользователей.

10. Нажмите кнопку Готово (Done).

11. Закройте окно Общий доступ (Sharing).

Теперь пользователи компьютеров под управлением операционной 
системы Windows смогут обмениваться с вами данными, используя 
ваши общие папки. Если вам потребуется прекратить доступ Windows-
пользователей к вашим общим папкам, откройте окно Общий доступ 
(Sharing), нажмите кнопку Параметры (Options), а в появившейся всплы-
вающей панели сбросьте флажок Предоставление общего доступа 
к файлам и папкам с помощью SMB (Share files and folders using SMB).

Узнайте, к какой рабочей группе принадлежит компьютер под управле-
нием Windows. Вашему компьютеру Mac потребуется определить такое 
же имя рабочей группы.
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Установить соединение с компьютером Windows, можно следующим 
способом.

� Примечание. На компьютере семейства Windows должна быть 
включена функция общего доступа к ресурсам.

1. Выберите команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) или щелкните мышью по значку Системные на-
стройки (System Preferences) на панели Dock. Откроется окно Си-
стемные настройки (System Preferences).

2. Выберите пункт Сеть (Network). Появится одноименное окно.

3. В списке, в левой части окна Сеть (Network), выберите подключе-
ние, которое планируете использовать для создания сети с ком-
пьютером под управлением операционной системы Windows.

4. Нажмите кнопку Дополнительно (Advanced). Появится всплываю-
щая панель.

5. Перейдите на вкладку WINS всплывающей панели (рис. 7.8).

6. В поле ввода Рабочая группа (Workgroup) укажите имя рабочей 
группы  компьютера Windows.

7. Нажмите кнопку ОК. Всплывающая панель будет скрыта.

8. Закройте окно Сеть (Network).

9. Откройте программу Finder.

10. На боковой панели в группе Общий доступ (Shared) вы должны 
увидеть имя компьютера под управлением Windows. Щелкните по 
нему мышью.

 При первом установлении соединения, скорее всего, вы увидите 
сообщение об ошибке подключения.

11. Нажмите кнопку Подкл. как (Connect As). Откроется небольшое 
безымянное диалоговое окно.

 Теперь вам предстоит выбрать, как представиться операционной 
системе Windows. Как и в случае установления соединения с ком-
пьютерами Mac, у вас два варианта.
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Рис. 7.8. Вкладка WINS всплывающей панели

• Зарегистрированный пользователь. Для этого установите пере-
ключатель Подключение(Connect As) в положение Как Зареги-
стрированный пользователь (Registered User) и укажите имя 
пользователя и пароль в полях ввода Имя (Name) и Пароль 
(Password). Имя пользователя и пароль должны быть действи-
тельными для операционной системы компьютера Windows PC.

• Гость. Для этого установите переключатель Подключиться как 
(Connect As) в положение Как Гость (Guest). Гостем является 
произвольный пользователь сети, который не хочет представ-
ляться чужой системе.

 Запомнить имя пользователя и пароль, чтобы не вводить их при 
следующих подключениях, можно, установив флажок Запомнить 
этот пароль в связке ключей (Remember the password in my key-
chain).

12. Нажмите кнопку Подключиться (Connect), чтобы попытаться уста-
новить соединение.

Когда соединение будет установлено, вы сможете работать с общими 
папками компьютера Windows. Этот процесс практически ничем не от-
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личается от процесса работы в программе Finder с любыми локальны-
ми папками вашего компьютера.

Совместный доступ к Интернету

Если вы используете кабельный модем или DSL-соединение для досту-
па к Интернету, то можете сделать так, чтобы данный способ подключе-
ния был доступен для всех компьютеров в локальной сети. Это допусти-
мо сделать двумя способами: приобрести и настроить маршрутизатор 
(роутер) или использовать функцию Общий доступ (Internet Sharing). 
В последнем случае вы можете распределить один интернет- канал 
между компьютерами в локальной сети без использования дополни-
тельных устройств. Достаточно активировать функцию Общий доступ 
(Internet Sharing) на компьютере, который непосредственно подклю-
чен к Интернету, тогда он станет шлюзом для всех остальных.

� Примечание. Не забывайте, что если вы выключите компьютер-
шлюз (или отправите его в спящий режим), для других компьюте-
ров в локальной сети Интернет будет недоступен.

Чтобы организовать общий доступ к Интернету, выполните следующие 
действия.

1. На основном компьютере (который подключен к Интернету) вы-
полните команду меню  ⇒ Системные настройки (  ⇒ System 
Preferences) и в открывшемся окне выберите пункт Общий доступ 
(Sharing).

Чтобы организовать совместный доступ, вам нужно указать, каким спо-
собом основной компьютер подключен к Интернету.

2. В раскрывающемся списке Общее подключение (Share your con-
nection from) выберите нужный пункт, например Ethernet.

Затем следует указать, как основной компьютер соединен с остальны-
ми машинами в локальной сети.

3. В группе Для компьютеров, использующих (To computers using) 
установите флажки напротив тех типов сетевого соединения, кото-
рые используют другие компьютеры для подключения к основной 
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машине. В появившемся окне с предупреждением нажмите кноп-
ку OK.

4. В левой части окна Общий доступ (Sharing) установите флажок Об-
щий Интернет (Internet Sharing) и подтвердите свое намерение, на-
жав кнопку Включить (Enable) на появившейся панели (рис. 7.9).

Рис. 7.9. Включение функции совместного доступа к Интернету

Теперь на остальных компьютерах сети выполните следующие дей-
ствия.

1. Выполните команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) и в открывшемся окне выберите пункт Сеть (Net-
work).

2. Появится одноименное окно, в котором нужно выбрать способ под-
ключения этих компьютеров к локальной сети.

3. В раскрывающемся списке Конфигурировать (Configure) выбери-
те пункт Используя DHCP (Using DHCP) и нажмите кнопку Приме-
нить (Apply).

Теперь, пока основной компьютер активен, все компьютеры в локаль-
ной сети могут одновременно подключаться к Интернету.
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Использование функции AirDrop

AirDrop —  это встроенная функция программы Finder. Основная ее осо-
бенность в том, что она позволяет большому количеству компьютеров, 
расположенных недалеко друг от друга, обмениваться данными одно-
временно. При этом совершенно не требуется настраивать сеть или 
устанавливать дополнительные приложения — вы можете сразу при-
ступить к обмену файлами.

� Примечание. Чтобы пользоваться функцией AirDrop, компьютер 
должен иметь возможность подключаться к сетям Wi-Fi, что обе-
спечивается наличием адаптера беспроводных сетей. Практически 
любой современный компьютер Mac отвечает этим требованиям 
и имеет соответствующие устройства, поэтому данное условие не 
должно стать для вас проблемой.

После того как при помощи функции AirDrop вам удастся обнаружить 
нужное устройство, перетащите на его значок те файлы, которые тре-
буется передать: сам процесс отправки данных для вас ничем не отли-
чается от обычного копирования файлов из одной папки вашего ком-
пьютера в другую.

Чтобы осуществить обмен данными при помощи функции AirDrop, вы-
полните следующие действия.

1. Откройте окно программы Finder.

2. Щелкните мышью по пункту AirDrop на боковой панели окна про-
граммы. Его содержимое изменится: вы увидите своего рода карту 
сети, в нижней части которой появится значок компьютера, испу-
скающего «волны».

Это означает, что ваш компьютер сканирует окружающее пространство 
на наличие других устройств, использующих функцию AirDrop. Если та-
ковые будут найдены, вы увидите их значки на карте сети AirDrop.

3. Чтобы передать файл на другой компьютер, перетащите значок дан-
ного файла на значок компьютера на карте сети. При этом откроет-
ся диалоговое окно, в котором потребуется подтвердить ваши на-
мерения.

4. Нажмите кнопку Послать (Send), чтобы отправить файл.
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Передача информации начнется не сразу — сначала требуется полу-
чить согласие от владельца компьютера, которому вы пытаетесь отпра-
вить файл. Как только оно будет получено, начнется процесс обмена 
данными.

Если другой пользователь захочет отправить вам какой-либо файл, от 
вас потребуется дать на это согласие. О том, что кто-то пытается от-
править вам файлы, вы узнаете из диалогового окна, которое появит-
ся прямо над значком пользователя-отправителя. Вам будут доступны 
следующие варианты.

• Отклонить (Decline). Запретить прием файлов.

• Сохранить (Save). Разрешить прием файлов. При этом все приня-
тые данные автоматически сохраняются в вашей пользовательской 
папке в каталоге Загрузки (Downloads).

• Сохранить и открыть (Save and Open). Позволяет не только разре-
шить прием файлов, но и автоматически открыть папку, в которой 
после завершения загрузки будут сохранены принятые данные.

Ваш компьютер перестанет быть виден другим пользователям функции 
AirDrop, как только вы закроете окно программы Finder. Следователь-
но, передача данных будет уже невозможна.

Функция AirDrop позволяет значительно упростить задачу обмена дан-
ными между компьютерами. С ней вам даже не потребуется настраи-
вать сеть — все происходит автоматически.



Глава 8
Всемирная паутина

Для посещения веб-страниц и загрузки файлов в операционной си-
стеме OS X используется браузер Safari. Изучив эту главу, вы сможете 
эффективно организовать свою работу во Всемирной паутине, узнаете, 
что представляет собой браузер Safari, познакомитесь с его возможно-
стями, а также научитесь работать с веб-страницами: просматривать, 
сохранять и отправлять их друзьям и коллегам. Вы сможете использо-
вать вкладки и создавать закладки на понравившиеся веб-страницы. 
А также научитесь формировать список для чтения, пользоваться бо-
ковым меню, выводить страницы на печать и работать в защищенном 
(безопасном) режиме частного доступа.

Интерфейс браузера Safari

Браузер Safari  сочетает в себе простоту управления и функциональ-
ность. В нем реализовано множество интересных возможностей, ко-
торые пригодятся вам при работе во Всемирной паутине. Окно Safari 
содержит ряд элементов, с которыми вам предстоит познакомиться 
(рис. 8.1).

Рассмотрим основные элементы браузера Safari  .

• В верхней части его окна расположена панель инструментов, на 
которой находятся часто используемые и важные элементы управ-
ления. В левой части панели вы найдете кнопки  и , которые 
позволяют перемещаться по просмотренным веб-страницам. На-
жмите кнопку , если хотите перейти на ранее просмотренную 
страницу, а затем кнопку , чтобы вернуться к текущей. Если на-
жать и удерживать кнопку мыши на одной из этих кнопок, откроет-
ся список всех веб-страниц, которые вы посетили за время текуще-
го сеанса работы.

• Правее вы найдете кнопку , нажав ее, сможете получить доступ 
к ссылкам, по которым переходили с прочих устройств, автори-
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зованных с вашей учетной записью Apple ID (рис. 8.2). Это может 
быть как другой компьютер Mac, так и мобильное устройство 
под управлением операционной системы iOS, например iPhone  
или iPad.

Рис. 8.1. Окно приложения Safari

Рис. 8.2. Облачные ссылки в браузере Safari

• Кнопка  предназначена для выполнения следующих действий 
с веб-страницей: добавления в закладки или в список для чтения, 
а также отправки страницы в текстовом сообщении или электрон-
ном письме и публикация в социальной сети Twitter или Face-
book.
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• Нажатие кнопки  добавляет веб-страницу в список для чтения, 
а удерживание — открывает меню, с помощью команд которого 
страницу можно добавить не только туда, но и в закладки/Избран-
ное или Top Sites (по выбору).

• В центре панели инструментов находится адресная строка, в ней вы 
будете указывать URL-адреса сайтов, которые хотите посетить.

• Справа от адресной строки расположена кнопка , позволя-
ющая открывать веб-страницы в режиме чтения для комфортного 
просмотра без рекламы и лишних элементов.

• В правом верхнем углу панели инструментов вы найдете кнопку 
перехода в полноэкранный режим ( ).

Под адресной строкой расположены группа закладок (как можно ими 
управлять, будет рассмотрено далее) и две кнопки:

• кнопка  открывает боковую панель, где приложение хранит все 
веб-страницы, которые вы добавили в журнал Список для чтения 
(Reading List) и список закладок;

• кнопка  открывает раздел Top Sites, предоставляющий доступ 
в журнал История (History), где хранится перечень регулярно по-
сещаемых веб-страниц и тех, что вы просмотрели в последнее 
время .

В центральной области окна браузера отображается содержимое от-
крытой веб-страницы.

В нижней его части находится строка статуса, где отображается вы-
полнение заданного процесса (соединение с сервером, переход на 
веб- страницу и т. д.).

� Совет. Если в окне браузера вы не видите строку статуса, выпол-
ните команду меню Вид ⇒ Показать меню статуса (View ⇒ Show 
Status Bar), и она появится.

Многие элементы управления меню и окна браузера Safari, как и пра-
вила работы с ними, являются общими для приложений системы OS X. 
В окне Safari можно использовать стандартные элементы управления: 
изменять масштаб окна, выбирать визуальные ориентиры, применять 



Всемирная паутина 285

сочетания клавиш и т. д. Как и для многих приложений операционной 
системы OS X, окно браузера Safari можно развернуть на весь экран. 
Для этого нужно нажать кнопку , которую вы найдете в правом верх-
нем углу окна приложения Safari, или нажать сочетание клавиш ⌃+�+F. 
Чтобы перейти в обычный режим, еще раз нажмите кнопку  (отобра-
зить ее можно, подведя указатель мыши к верхней части экрана).

Навигация по веб-страницам

Для работы во Всемирной паутине нужно освоить приемы навигации 
по веб-страницам.  

Для начала выполните следующие действия.

1. Запустите браузер, щелкнув мышью по значку  на панели Dock, 
или выберите приложение Safari в папке Программы (Applications). 
Откроется основное окно браузера.

2. Чтобы открыть веб-страницу, введите в адресной строке ее URL-
адрес, например apple.ru, и нажмите на клавиатуре клавишу �. 
Откроется выбранная веб-страница (рис. 8.3).

Рис. 8.3. Просмотр веб-страницы сайта компании Apple в браузере Safari
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� Примечание. Если вместо содержимого веб-страницы появится со-
общение об ошибке (обычно 404), значит, либо вы ошиблись при вво-
де URL-адреса, либо искомая страница была перемещена (или уда-
лена) администратором ресурса. Кроме того, сообщение об ошибке 
может появиться в случае, если компьютер не подключен к Интер-
нету. Как создать подключение рассказывалось в главе 7, а о том, как 
устранить неполадки подключения, говорится в приложении 1.

3. Щелкайте по ссылкам (обычно они отформатированы синим шриф-
том с подчеркиванием), кнопкам, меню, изображениям для перехо-
да между веб-страницами и документами/изображениями.

Если вы уже просматривали страницы в браузере Safari, то при вводе 
адреса активизируется функция автозаполнения, которая будет срав-
нивать набираемый запрос со списком веб-сайтов, которые вы недав-
но посещали. При этом появится меню с веб-адресами, схожими с тем, 
что вы вводите. Если какой-то адрес совпадает с искомым, щелкните по 
нему мышью для быстрого перехода. Кроме того, в меню будут пред-
ставлены наиболее популярные запросы в поисковых системах, кото-
рые начинаются с введенных вами символов, результаты поиска в за-
кладках, истории посещений и на текущей открытой странице. Таким 
образом, адресная строка берет на себя и функцию многоцелевого по-
иска (рис. 8.4).

Рис. 8.4. Использование адресной строки в браузере Safari

В процессе просмотра веб-страниц вы обнаружите, что многие из них 
занимают бóльшую площадь, чем может отобразить экран. Чтобы уви-
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деть следующий фрагмент веб-страницы, используйте ползунки полос 
прокрутки либо нажмите клавишу Пробел, чтобы увидеть следующую 
часть веб-страницы, или сочетание клавиш �+Пробел, если захотите 
переместиться вверх. Также вы можете просматривать страницу по-
строчно с помощью клавиш ↑ и ↓ или поэкранно, используя клавиши 
Page Up и Page Down. Перемещаться в начало и конец открытой веб-
страницы можно с помощью клавиш Home и End. Если вам удобнее ра-
ботать с мышью, тогда используйте ее колесико для вертикальной про-
крутки веб-страницы, а чтобы обеспечить горизонтальную прокрутку, 
удерживайте при этом клавишу �.

� Совет. Вы можете использовать возможность быстрого ввода но-
вого веб-адреса. Дважды щелкните мышью по фрагменту, который 
находится между префиксом www и суффиксом (в данном слу-
чае — .ru), система выделит только имя домена, которое вы сможе-
те быстро изменить, введя с клавиатуры.

� Совет. Стоит отметить, что не нужно каждый раз вводить имя про-
токола (http://), достаточно указать адрес и нажать клавишу �. На-
пример, чтобы перейти по адресу http://www.apple.com, можно 
ввести просто apple.com и нажать клавишу �, все остальное брау-
зер сделает сам.

� Совет. Если текст на веб-странице кажется вам слишком мелким, 
выберите команду меню Вид ⇒ Увеличить (View ⇒ Zoom In) или 
используйте сочетание клавиш �++. А если, наоборот, содержи-
мое страницы не помещается на экране, выберите команду меню 
Вид ⇒ Уменьшить (View ⇒ Zoom Out) или нажмите сочетание кла-
виш �+-. Предварительно выделять текст при этом не нужно.

� Совет. На устройствах с сенсорными экранами или трекпаде/мыши 
Magic Mouse вы можете использовать жесты смахивания для про-
крутки, двойного касания/сведения и разведения — для измене-
ния масштаба просмотра.
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Поиск во Всемирной паутине

Для поиска во Всемирной паутине можно использовать расположен-
ную на панели инструментов адресную строку, которая автоматиче-
ски отправляет ваш запрос на выбранный поисковый сайт, например 
www.google.com (поисковую систему можно сменить в настройках 
браузера — доступны Google, Yandex, Yahoo! и Bing). 

Щелкните мышью по адресной строке, введите свой запрос и нажмите 
клавишу �. Приложение Safari откроет веб-страницу выбранной поис-
ковой системы с результатами поиска (рис. 8.5).

Рис. 8.5. Поиск во Всемирной паутине с помощью браузера Safari

Если нужно выполнить поиск определенного слова или текстового 
фрагмента на веб-странице, которую вы просматриваете в данный мо-
мент, нажмите сочетание клавиш �+F и введите это слово (фрагмент) 
в появившемся поле поиска.

� Совет. Также вы можете ввести поисковый запрос прямо в адрес-
ную строку, а затем выбрать последний пункт в открывшемся 
меню — Найти «поисковый запрос» на этой странице (совпаде-
ний nn) (Find «поисковый запрос» on This Page (nn matches)).
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Приложение Safari выполнит поиск и отобразит панель с количеством 
совпадений и элементами управления, предназначенными для пере-
хода между найденными фрагментами, изменения и отмены запроса 
(рис. 8.6).

Рис. 8.6. Поиск на веб-странице в браузере Safari

Чтобы просмотр результатов стал более наглядным, вся страница будет 
затемнена, а найденные совпадения — выделены. Чтобы убрать затем-
нение, щелкните мышью в любой позиции страницы (вне ссылок) или 
нажмите кнопку Готово (Done) на панели поиска. Приложение Safari 
сохраняет последний введенный запрос поиска. Поэтому вы можете 
перейти на другую страницу, нажать сочетание клавиш �+F, и прило-
жение повторит поиск совпадений с теми же ключевыми словами.

Режим Reader

Просматривая страницы во Всемирной паутине, мы постоянно стал-
киваемся с огромным количеством рекламы, баннеров, посторонних 
изображений и прочих элементов, которые иногда могут очень сильно 
отвлекать от чтения. На персональных сайтах часто можно встретить 
такие сочетания фона и шрифта текста, которые быстро утомляют глаза. 
Функция Reader в браузере Safari позволяет повысить удобство чтения 
публикаций, освобождая страницу от «мусора», оставляя только самое 
необходимое. Кроме того, при просмотре статьи в режиме Reader уда-
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ляется весь текст, не относящийся к ней, а сам материал отображается 
стандартным шрифтом.

1. Чтобы просмотреть страницу в режиме Reader, нажмите кнопку 
, расположенную справа от адресной строки браузера. Стра-

ница будет автоматически перестроена для более удобного про-
смотра статьи (рис. 8.7).

Рис. 8.7. Режим Reader браузера Safari

2. Чтобы уменьшить размер шрифта, нажмите кнопку . Чтобы увели-
чить его, нажмите кнопку .

� Совет. Статья, отображенная в режиме Reader, оптимизирована для 
распечатывания на принтере.

Как видно из рис. 8.7, в режиме Reader браузера Safari контент веб-
страниц максимально комфортен для чтения. Чтобы выйти из данного 
режима, следует вновь нажать кнопку .
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Работа со вкладками

Каждый раз, когда вы переходите по ссылке, браузер Safari открывает 
новую веб-страницу на этой же вкладке (если на самом веб-сайте не 
настроено иначе), что в некоторых случаях может быть неудобно. Что-
бы не потерять из виду первоначальную веб-страницу, вы можете от-
крыть следующую ссылку на новой вкладке . Для этого щелкните по ней 
мышью, удерживая клавишу ⌃ или �, и выберите в контекстном меню 
пункт Открыть ссылку в новой вкладке (Open a link in new Tabs). Так 
вы сможете сохранять открытыми несколько веб-страниц и при не-
обходимости быстро перемещаться между ними. Если сочетание кла-
виш не работает должным образом, следует проверить, включена ли 
данная функция в настройках браузера. Для этого выполните команду 
меню Safari ⇒ Настройки (Safari ⇒ Preferences), в открывшемся окне 
перейдите на вкладку Вкладки (Tabs) и убедитесь, что установлен фла-
жок �-нажатие мыши открывает ссылку в новой вкладке (�-click 
opens a link in new tab) (рис. 8.8).

Рис. 8.8. Настройка вкладок в браузере Safari

� Совет. Также вы можете изменить поведение браузера по умолча-
нию, выбрав нужное значение в раскрывающемся списке Откры-
вать страницы во вкладках, а не в окнах (Open pages in tabs in-
stead of windows).

Переходить с одной вкладки на другую можно, щелкнув мышью по ее 
ярлыку на панели вкладок. Чтобы закрыть вкладку, нажмите кнопку  
в левой ее части или сочетание клавиш �+W.
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Создание закладок

Как и в любом другом браузере, в Safari вы можете добавлять понра-
вившиеся сайты в закладки , чтобы ускорить их поиск. Работа с заклад-
ками ведется при помощи меню Закладки (Bookmarks) и одноименной 
панели в окне браузера. Чтобы было удобнее управлять закладка-
ми, используется панель, которая расположена в окне браузера под 
адресной строкой. Если в данный момент она не видна, нажмите кноп-
ку  в левой части панели браузера или выполните команду меню 
Вид ⇒ Показать боковое меню закладок (View ⇒ Show Sidebar). 
Теперь вы сможете открывать сохраненные в качестве закладок веб-
страницы, просто щелкнув мышью по нужной вам.

Чтобы добавить веб-страницу в закладки, выполните следующие шаги.

1. Откройте нужную веб-страницу.

2. Нажав и удерживая кнопку мыши на кнопке , выберите размеще-
ние закладки в раскрывающемся списке (например, пункт Заклад-
ки (Bookmarks)) (рис. 8.9).

Рис. 8.9. Добавление закладки

� Примечание. Также вы можете выполнить команду меню Заклад-
ки ⇒ Добавить закладку (Bookmarks ⇒ Add Bookmark) или нажать 
сочетание клавиш �+D.

В следующий раз, когда вы захотите посетить эту веб-страницу, выбе-
рите ее название в боковом меню закладок, нажав кнопку .
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� Совет. Для еще более быстрого доступа к закладке той или иной 
страницы вы можете сохранить ее на панели избранного. Для этого, 
нажав и удерживая кнопку мыши на кнопке , в качестве разме-
щения закладки выберите в раскрывающемся списке пункт Строка 
«Избранное» (Favorites Bar) (или подпапку ниже данного пункта).

Нажмите кнопку  в левой части панели браузера, чтобы отобразить 
список сохраненных закладок (рис. 8.10).

Рис. 8.10. Боковое меню закладок

Управление закладками осуществляется следующим образом.

• В списке при помощи мыши перетащите нужную закладку вверх 
или вниз. Здесь же вы можете переименовать закладку, щелкнув по 
ее имени мышью, удерживая клавишу ⌃, или удалить ее, нажав кла-
вишу ⌫.

• Если раньше вы пользовались другим обозревателем и у вас со-
хранены закладки или ссылки в Избранном, экспортируйте их из 
старого браузера, запустите приложение Safari и выполните ко-
манду меню Файл ⇒ Импорт закладок (File ⇒ Import Bookmarks). 
Это избавит вас от необходимости заново создавать все закладки 
вручную .
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• Чтобы сэкономить место на панели закладок, вы можете распреде-
лить их по папкам. Щелкните мышью по значку +, который располо-
жен под списком закладок, и в нем появится новая папка. Укажите 
для нее имя и нажмите клавишу � (рис. 8.11).

Рис. 8.11. Создание папки для закладок

Теперь, когда вы будете создавать закладки на понравившиеся сайты, 
в списке кнопки  вы сможете выбрать созданную папку, в которой 
будут храниться закладки на схожие ресурсы. Также вы можете пере-
местить в эту папку уже существующие закладки при помощи мыши.

Работать с папками закладок удобно еще и потому, что, создав папку, 
в которой будут храниться веб-сайты, посещаемые вами ежедневно, 
вы сможете запустить их все одновременно. Достаточно выбрать папку 
на панели закладок, щелкнув по ней мышью при нажатой клавише ⌃, 
и выбрать в контекстном меню пункт Открыть во вкладках (Open in 
Tabs). И пока вы будете работать с первым сайтом в группе, остальные 
загрузятся на собственных вкладках.

Страница Top Sites и история просмотра

Приложение Safari запоминает, какие веб-страницы вы посещаете, и ав-
томатически помещает их миниатюры в два журнала: Top Sites  и Исто-
рия (History) . В списке Top Sites хранятся веб-страницы, которые вы 
посещаете регулярно, а в списке История (History) — сайты, куда вы 
заходили хотя бы раз.

Чтобы просмотреть журнал Top Sites, нажмите кнопку , располо-
женную на панели инструментов, или сочетание клавиш ⌥+�+1. От-
кроется страница Top Sites (рис. 8.12).

На странице Top Sites приложение Safari хранит веб-страницы, кото-
рые вы посещаете чаще всего. Чтобы перейти на любой из этих сайтов, 
достаточно щелкнуть мышью по его миниатюре. 
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Рис. 8.12. Страница Top Sites

Изначально содержимое страницы Top Sites приложение Safari форми-
рует самостоятельно, но вы можете корректировать этот перечень.

• Если вы хотите удалить миниатюру веб-страницы из списка Top 
Sites, установите на нее указатель мыши, а затем нажмите кнопку 

, которая появится в левом верхнем углу миниатюры.

• Если нужно добавить текущую веб-страницу в список Top Sites, на-
жав и удерживая кнопку мыши на кнопке , выберите в качестве 
размещения закладки в раскрывающемся списке пункт Top Sites.

• Если вы хотите, чтобы миниатюра определенной веб-страницы 
всегда оставалась в списке Top Sites, установите на нее указатель 
мыши, а затем нажмите кнопку , которая появится в левом верх-
нем углу миниатюры.

В свою очередь на вкладке История (History) приложение хранит пере-
чень всех веб-страниц, которые вы посещали в последнее время. Чтобы 
просмотреть его, выберите команду меню История ⇒ Показать исто-
рию (History ⇒ View History) или нажмите сочетание клавиш ⌥+�+2 
(рис. 8.13).

Чтобы открыть одну из веб-страниц, которые хранятся в списке Исто-
рия (History), дважды щелкните мышью по соответствующей строке.
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Рис. 8.13. Вкладка История

Для поиска среди веб-страниц, которые хранятся в списке История 
(History), используйте поле в правом нижнем углу окна программы.

Если вы хотите удалить записи обо всех веб-страницах из журнала Исто-
рия (History), выберите команду меню История ⇒ Очистить историю 
(History ⇒ Clear History).

Список для чтения

В журнале Список для чтения (Reading List ) вы можете сохранить стра-
ницы, которые не успели дочитать в прошлый раз.

� Примечание. Отличие закладок в списке для чтения от обычных 
состоит в том, что веб-страницы из списка для чтения доступны 
даже в автономном режиме (без подключения к Интернету).

1. Чтобы добавить веб-страницу в список для чтения, откройте ее 
и нажмите кнопку  на панели браузера. Также вы можете исполь-
зовать сочетание клавиш �+�+D.
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2. Чтобы просмотреть содержимое журнала Список для чтения 
(Reading List), нажмите кнопку , расположенную в левой части 
панели инструментов, и перейдите на вкладку Список для чтения 
(Reading List) (рис. 8.14).

Рис. 8.14. Журнал Список для чтения

3. Если вы хотите вернуться к чтению веб-страницы в журнале Список 
для чтения (Reading List), щелкните мышью по соответствующему 
пункту. Приложение откроет веб-страницу, и вы сможете продол-
жить работу с ней.

4. Чтобы удалить закладку из списка для чтения, нажмите кнопку , 
расположенную в правом верхнем углу каждого пункта в списке. Вы-
бранная веб-страница будет из него удалена.

� Совет. Если вы хотите удалить все закладки из списка для чтения, 
щелкните по нему мышью, удерживая клавишу ⌃, и выберите ко-
манду Удалить все объекты (Clear All).

5. Если вы хотите просмотреть только непрочитанные закладки, 
перей дите на вкладку Не прочитано (Unread). Чтобы вернуться 
к полному списку всех закладок в журнале Список для чтения 
(Reading List), перейдите на вкладку Все (All).
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Закладки в журнале Список для чтения (Reading List) сохраняются до 
тех пор, пока вы не удалите их самостоятельно.

Загрузка файлов из Всемирной паутины

Приложение Safari позволяет легко загружать любые файлы из Всемир-
ной паутины. Чтобы сделать это, выполните следующие действия.

1. Найдите на веб-странице ссылку вида «скачать» или «download» 
и щелкните по ней мышью. В правом верхнем углу окна браузера по-
явится кнопка , нажав которую вы сможете отслеживать процесс 
загрузки файлов, не прерывая просмотр веб-страниц (рис. 8.15).

Рис. 8.15. Загрузка файла из Всемирной паутины

2. Если нужно приостановить загрузку файла, но оставить его в спи-
ске загрузок, нажмите кнопку . Когда вы решите продолжить за-
грузку, нажмите кнопку , которая появляется автоматически после 
приостановки загрузки.

3. Чтобы просмотреть загруженный файл, нажмите кнопку . Веб-
браузер Safari откроет его в соответствующем приложении.

4. Удалить записи о загрузках на панели Загрузки (Download) можно, 
нажав кнопку Очистить (Clear), которая расположена в верхней ча-
сти всплывающей панели.

Все файлы, что вы загружаете из Всемирной паутины, приложение Sa-
fari автоматически помещает в папку Загрузки (Download). Просмотреть 
их можно, открыв эту папку при помощи приложения Finder или щел-
кнув мышью по значку  на панели Dock.



Всемирная паутина 299

� Совет. Если вам нужно сохранить изображение, опубликованное 
на веб-странице, щелкните по нему мышью, нажав и удерживая 
клавишу ⌃, и выберите в контекстном меню пункт Сохранить изо-
бражение как (Save Image as) или Сохранить изображение в «За-
грузки» (Save Image to the Downloads). Приложение Safari сохранит 
изображение на жестком диске вашего компьютера в выбранном 
каталоге или в папке Загрузки (Downloads) соответственно.

Общие ссылки
Благодаря функции Общие ссылки (Shared Links) в браузере Safari вы 
всегда будете в курсе, чем хотят поделиться с вами ваши друзья в со-
циальных сетях Facebook и Twitter. Для активации этой функции вам 
достаточно авторизоваться на сайте одной из социальных сетей. По-
сле авторизации в боковой панели браузера появится вкладка Общие 
ссылки (Shared Links) (рис. 8.16).

Рис. 8.16. Вид вкладки Общие ссылки

Эта функция позволяет вам смотреть публикации со ссылками, раз-
мещенными вашими друзьями в социальных сетях, не посещая сайты 
самих сетей.
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На вкладке показаны только ссылки. В каждой отображается аватар 
пользователя, который разместил публикацию и краткое содержание 
этой публикации. Щелкнув мышью по ссылке, вы увидите страницу 
с подробным текстом или другой страницей, ссылка которой была ука-
зана в публикации.

Список обновляется автоматически, но вы в любой момент можете сде-
лать это вручную — просто щелкните мышью, удерживая клавишу ⌃, 
и в появившемся контекстном меню выберите команду Обновить об-
щие ссылки (Update Shared Links).

Общие ссылки из социальной сети Twitter можно «ретвитнуть», то есть 
поделиться со своими подписчиками сообщением другого человека. 
Для этого щелкните мышью, удерживая клавишу ⌃, по нужной ссылке 
и в появившемся контекстном меню выберите пункт Ретвит (Retweet).

Чтобы посмотреть профиль пользователя, который опубликовал об-
щую ссылку, щелкните по ней мышью, удерживая клавишу ⌃, и в по-
явившемся контекстном меню выберите пункт Показать профиль 
пользователя (Show <username> on <address>).

Также вы можете выполнить поиск среди общих ссылок, указав в поле 
ввода в верхней части вкладки Общие ссылки (Shared Links) ключевые 
слова, например имя пользователя.

Отправка, сохранение и печать веб-страниц
Приложение Safari используется не только для просмотра веб-страниц, 
оно также позволяет отправлять по электронной почте содержимое 
веб-страниц , включая графические файлы и ссылки. Чтобы отправить 
веб-страницу по электронной почте, выполните следующие действия.

1. Откройте в браузере Safari веб-страницу, которую хотите отправить 
по почте.

2. Нажмите кнопку  на панели браузера и выберите пункт Отпра-
вить эту страницу по e-mail (File ⇒ Email This Page) или нажми-
те сочетание клавиш �+I. Запустится приложение Mail, при этом 
в поле темы уже будет внесено название веб-страницы (рис. 8.17).

� Примечание. Более подробно о возможностях приложения Mail 
вы узнаете в главе 9.
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Рис. 8.17. Отправка веб-страницы по электронной почте

Вы можете удалить ненужный контент со страницы, выделив его и на-
жав клавишу ⌫.

3. Укажите адрес получателя и нажмите кнопку .

Также допускается отправлять страницы в текстовых сообщениях 
(в виде ссылок) и публиковать тексты с миниатюрными изображения-
ми — ссылками на веб-страницы в социальных сетях Twitter и Facebook 
(рис. 8.18).

Вы можете сохранить веб-страницу  на жестком диске своего компьюте-
ра, чтобы просмотреть ее позднее в автономном режиме (без подклю-
чения к Интернету). Приложение позволяет сохранить веб-страницу 
полностью со всем содержимым — текстом, графикой и ссылками — 
или же только как HTML-файл. 

В процессе сохранения будет создан файл (так называемый файл ар-
хива), который вы сможете открыть и просмотреть в любое время, при 
этом все ссылки будут функционировать. Щелкнув по ним, вы откроете 
соответствующую веб-страницу (при условии подключения к Интер-
нету).
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Рис. 8.18. Публикация ссылки на веб-страницу в сети Facebook

� Примечание. Некоторые веб-страницы невозможно сохранить на 
жесткий диск из-за введенных их владельцем ограничений.

Также вы можете распечатать веб-страницу , например, если планируе-
те заняться ее изучением во время поездки.

Чтобы сохранить веб-страницу на жесткий диск, выполните следующие 
действия.

1. Откройте веб-страницу, которую хотите сохранить, и выполните ко-
манду меню Файл ⇒ Сохранить как (File ⇒ Save As) или нажмите 
сочетание клавиш �+S. Откроется панель, где следует задать пара-
метры сохранения веб-страницы.

2. Присвойте имя файлу веб-страницы и выберите в раскрывающемся 
списке папку, в которую необходимо сохранить его.

3. В раскрывшемся списке Формат (Format) выберите пункт Веб-архив 
(Web Archive), чтобы сохранить страницу с рисунками и прочим 
контентом, или Программный код страницы (Page Source) — для 
сохранения только кода HTML, а затем нажмите кнопку Сохранить 
(Save).
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Теперь вы сможете просмотреть страницу, щелкнув мышью по ее 
файлу .

Чтобы распечатать содержимое веб-страницы, выполните следующие 
действия.

1. Выберите команду меню Файл ⇒ Напечатать (File ⇒ Print) или на-
жмите сочетание клавиш �+P. Откроется панель Печать (Print).

2. Задайте необходимые параметры печати и убедитесь, что в послед-
нем раскрывающемся списке выбран пункт Safari. Оцените внеш-
ний вид веб-страницы в режиме предварительного просмотра.

3. Теперь нажмите кнопку Напечатать (Print). Приложение Safari от-
правит текущую веб-страницу на печать.

� Совет. Вы можете поискать на веб-странице ссылку вида «Версия 
для печати» и щелкнуть по ней мышью. Такая версия веб-страницы 
на бумаге выглядит лучше.

Те веб-страницы, которые вы сохранили на жестком диске своего ком-
пьютера, можно открывать и просматривать в автономном режиме. Но 
в этом случае вы не сможете переходить по ссылкам и открывать свя-
занные веб-страницы, пока не установите подключение к Интернету.

Просмотр веб-страниц в режиме 
частного доступа

Вы уже убедились, что браузер Safari способен справиться со сво-
ей основной задачей — сделать вашу работу во Всемирной паутине 
максимально комфортной. Он отслеживает веб-страницы, которые 
вы посетили, и запоминает их адреса, сохраняет результаты поиска 
по ключевым словам, поисковые запросы, запоминает пользователь-
ские имена и другую контактную информацию, которую вы указываете 
при регистрации на сайтах, а также ваши личные данные, в том числе 
номера ваших кредитных карточек. Когда вы единственный пользо-
ватель, эти способности Safari кажутся невероятно удобными. Но как 
быть, если учетной записью пользуетесь не только вы или пришлось 
воспользоваться чужим компьютером? В этом случае будет правильно, 
если вы запретите приложению Safari отслеживать и хранить подобную 
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информацию. А сделать это можно при помощи так называемого режи-
ма частного доступа .

Когда вы активируете режим частного доступа, браузер будет исполь-
зовать следующие правила:

• не станет запоминать данные, которые вы вводите при работе с веб-
страницами;

• не будет сохранять cookie-файлы, посещаемых страниц;

� Примечание. Cookie-файлы того или иного сайта сохраняются на 
вашем компьютере и позволяют идентифицировать вас как посети-
теля, что дает возможность не вводить заново данные для автори-
зации, банковские реквизиты и т. п.

• не станет добавлять ваши поисковые запросы во всплывающее 
меню для поля поиска Google;

• не будет запоминать (добавлять в список История (History) и Top 
Sites) адреса веб-страниц, которые вы посетите;

• браузер автоматически удалит ссылки на загруженные из Всемир-
ной паутины файлы.

Чтобы задействовать защищенный режим работы, выполните следую-
щие действия.

1. Выполните команду меню Safari ⇒ Частный доступ (Safari ⇒ Pri-
vate Browsing). Браузер попросит подтвердить ваши намерения, по-
этому нажмите кнопку OK. Теперь можете не переживать, что при-
ложение Safari запомнит вашу личную информацию, а потом к ней 
получат доступ другие пользователи.

2. Когда вам понадобится отключить защищенный режим, первым де-
лом закройте все окна браузера Safari, а затем повторно выполните 
команду меню Safari ⇒ Частный доступ (Safari ⇒ Private Browsing).

� Совет. Также для отключения защищенного режима вы можете на-
жать кнопку  в адресной строке браузера.
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После выхода из режима частного доступа браузер удалит все данные, 
касающиеся вашего сеанса работы.

Настройка браузера Safari

При желании вы можете изменить внешний вид панели инструментов: 
отобразить или скрыть ряд отдельных элементов управления, что по-
может не только настроить ее по своему усмотрению, но и значитель-
но упростить работу с веб-страницами. Выбрать элементы управления 
можно, выполнив команду меню Вид ⇒ Настроить панель инстру-
ментов (View ⇒ Customize Address bar) и тем самым открыв панель 
с полным списком доступных элементов (рис. 8.19).

Рис. 8.19. Панель доступных элементов управления

Чтобы добавить элемент управления, достаточно перетащить его на па-
нель инструментов браузера. Рассмотрим наиболее полезные из них.

• Кнопка  предоставляет возможность быстро открывать домаш-
нюю веб-страницу.

Изменить домашнюю веб-страницу можно, перейдя на желаемый 
веб-сайт, а затем выполнив команду меню Safari ⇒ Настройки (Sa-
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fari ⇒ Preferences). На вкладке Основные (General) в поле ввода До-
машняя страница (Home Page) вы увидите адрес текущей домашней 
веб-страницы. Здесь же можно его изменить, нажав кнопку Текущая 
страница (Set to Current Page) или введя адрес вручную.

• Кнопка  позволяет использовать функцию автозаполнения. Если 
щелкнуть по ней мышью, браузер заполнит веб-форму: укажет ваши 
имя, адрес и другие данные. Браузер Safari запоминает имена поль-
зователей, пароли и прочую информацию, которую вы указываете 
в регистрационных формах при работе во Всемирной паутине.

Чтобы включить функцию автозаполнения, выполните команду меню 
Safari ⇒ Настройки (Safari ⇒ Preferences), перейдите на вкладку Ав-
тозаполнение (AutoFill) и установите флажок Из моей карточки 
в Адресной книге (Using info from my Contacts card). Теперь, когда 
вам понадобится указать на сайте адрес доставки, достаточно нажать 
кнопку , и приложение Safari автоматически поместит в поля дан-
ные из вашей личной карточки (конечно, если вы потрудились ее за-
полнить).

• Кнопки  и  позволяют управлять размером (кеглем) текста на 
веб-странице. Если он кажется вам слишком мелким, используйте 
кнопку , и наоборот, если содержимое страницы не помещается 
на экране — кнопку .

• Кнопка  будет полезна в случае, если вы часто распечатываете 
содержимое просматриваемых веб-страниц.

• Кнопка  предназначена для быстрого открытия истории посеще-
ния веб-узлов.

Контроль доступа к веб-сайтам

Если ваш компьютер периодически используют дети , имеет смысл уста-
новить ограничения на доступ к некоторым веб-сайтам. Первым делом 
создайте для ребенка отдельную учетную запись. Затем, чтобы запре-
тить ему доступ к нежелательным веб-ресурсам, войдите в систему под 
учетной записью администратора. После этого можно сделать так, что-
бы ваш ребенок смог открывать и просматривать только те сайты, ко-
торые вы поместили на закладки. Пользователи с ограниченными пра-
вами на работу в сети не смогут ввести URL-адреса в адресную строку, 
изменить закладки и воспользоваться полем поиска в Google.
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Чтобы ограничить доступ к сайтам Всемирной паутины, выполните сле-
дующие действия.

1. Войдите в систему под учетной записью администратора и выпол-
ните команду меню  ⇒ Системные настройки (  ⇒ System 
Preferences).

2. В открывшемся окне щелкните мышью по значку  Пользователи 
и группы (Users & Groups). Откроется одноименное окно, в котором 
необходимо создать новую учетную запись для ребенка.

3. Щелкните мышью по значку  и введите пароль администратора, 
чтобы система разрешила вам внести необходимые изменения.

4. Создайте новую учетную запись и установите для нее флажок 
Включить Родительский контроль (Enable Parental Control). Тип 
учетной записи в левой части окна должен измениться на Управ-
ляемая (Managed) (указывается под учетной записью) (рис. 8.20).

Рис. 8.20. «Детская» учетная запись создана

5. Теперь нажмите кнопку Родительский контроль (Parental Controls) 
и в открывшемся окне перейдите на вкладку Веб (Web). При появ-
лении запроса введите пароль администратора, чтобы система раз-
решила вам внести необходимые изменения.
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6. Установите переключатель в положение Разрешить доступ толь-
ко к следующим веб-сайтам (Allow access to only these websites). 
Ниже расположена область, в которой вам нужно указать разре-
шенные сайты, причем список частично заполнен сотрудниками 
корпорации Apple (рис. 8.21).

Рис. 8.21. Окно Родительский контроль

7. Если вы хотите добавить в этот список другие сайты, нажмите кноп-
ку  и выберите в контекстном меню пункт Добавить закладку 
(Add Bookmark). Появится панель, с помощью которой вы сможете 
создать новую закладку.

8. Введите название веб-сайта, укажите его URL-адрес и нажмите кноп-
ку OK.

� Совет. Если какой-либо сайт нужно удалить из списка разрешен-
ных, выделите его и нажмите кнопку .

9. Теперь войдите в систему под учетной записью ребенка, для кото-
рой вы использовали средства родительского контроля, запустите 
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браузер Safari и убедитесь в том, что нужный результат достигнут. 
Вы увидите все сайты, которые разрешены к просмотру, на панели 
закладок.

10. Теперь попробуйте открыть один из сайтов, доступ к которому вы 
не разрешали, — система должна заблокировать попытку.

После того как вы установили средства родительского контроля, мо-
жете не переживать, что ребенок зайдет на сайты, которые вы не раз-
решаете ему посещать. Но помните, что установленные ограничения 
распространяются только на браузер Safari. Если ваш ребенок будет 
использовать другой обозреватель, эти ограничения ему не помеша-
ют. Чтобы обеспечить надежную защиту, в данном случае желательно 
запретить ребенку запускать любые приложения и виджеты, кроме 
тех, которые вы одобрили. Для этого в окне Родительский контроль 
(Parental Controls) перейдите на вкладку Программы (Apps), установи-
те флажок Ограничивать программы (Limit Applications) и укажите 
в нижней части окна, какие программы вы разрешаете запускать. Те-
перь, даже если ребенок установит под своей учетной записью другой 
браузер, система не позволит ему запустить это приложение.

Сброс браузера Safari

Вы можете удалить личные данные (например, если работаете на чу-
жом компьютере), выполнив команду меню Safari ⇒ Сбросить Safari 
(Safari ⇒ Reset Safari). Откроется окно Сбросить Safari (Reset Safari), 
в котором вы можете удалить все следы своей деятельности во Все-
мирной паутине, установив соответствующие флажки и нажав кнопку 
Сбросить (Reset). Стоит отметить, что использование этой функции 
приводит к удалению данных выбранного типа за весь период време-
ни, а не только за последний сеанс работы.



Глава 9
Обмен сообщениями электронной 
почты

В составе операционной системы OS X вы найдете программу Mail для 
обмена сообщениями, которая поможет вам справиться с потоком 
электронной почты, защититься от спама и позволяет работать одно-
временно с несколькими почтовыми учетными записями. В приложе-
нии Mail вы сможете использовать индивидуальное оформление ва-
ших почтовых сообщений, применять специальное форматирование 
отправляемых писем, добавлять изображения, вложения и т. д.

Итак, изучив эту главу, вы узнаете, как создавать почтовые учетные за-
писи, читать и отправлять сообщения в приложении Mail, настраивать 
блокировку нежелательной почты, оптимизировать работу с помощью 
смарт-ящиков, использовать возможности поиска и индивидуальной 
настройки подписей к сообщениям. А также научитесь заносить собы-
тия в приложение Календарь (Calendar) и просматривать адреса и кон-
тактную информацию адресатов прямо из приложения Mail.

Создание новой учетной записи

Если при первом запуске операционной системы OS X вы не создали 
почтовую учетную запись  в приложении Mail, это можно сделать в лю-
бой другой момент. Процедура заметно упростится, если вы получили 
свой почтовый ящик у крупных провайдеров, например iCloud, Ex-
change, Gmail, AOL или Yahoo. В этом случае вы сможете настроить по-
чту в автоматическом режиме, так как компания Apple встроила в опе-
рационную систему настройки для нескольких самых популярных 
почтовых служб. Если же приложение Mail не сможет самостоятельно 
идентифицировать вашего почтового провайдера, вам понадобится 
ввести ряд параметров в окнах для настройки учетных записей элек-
тронной почты.

Чтобы добавить новую учетную запись в приложении Mail, выполните 
следующие действия.
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1. Запустите приложение Mail, щелкнув мышью по значку  на пане-
ли Dock или выбрав его в папке Программы (Applications) окна про-
граммы Finder.

При первом запуске приложения откроется окно мастера, в котором 
нужно указать основные параметры учетной записи. В том случае, 
если это не первый запуск приложения Mail, выберите команду меню 
Mail ⇒ Добавить учетную запись (Add Account). В последнем случае 
в приложении появится панель для ввода данных почтовой учетной за-
писи. На первом шаге это выбор провайдера услуг электронной почты 
(рис. 9.1).

Рис. 9.1. Выбор провайдера услуг электронной почты

Далее следует установить переключатель в положение, соответствую-
щее используемому вами провайдеру.

Как правило, в России используются пять основных провайдеров услуг 
электронной почты — Google (Gmail), Mail, Rambler, Yandex и Live.ru. 
В случае с Gmail приложение уже имеет предустановленные настрой-
ки — достаточно установить переключатель в положение Google 
и действовать согласно инструкциям на экране. Никакие сложные дан-
ные указывать не нужно (кроме логина и пароля, естественно). В слу-
чае с Mail.ru, Rambler.ru, Yandex.ru и Live.ru ситуация сложнее, так как 
приложение не имеет предустановок для данных провайдеров. Их на-
стройку мы и рассмотрим далее на примере Live.ru.

2. Установите переключатель в положение Добавить другую учет-
ную запись Mail (Add Other Mail Account) и нажмите кнопку Про-
должить (Continue). Вы увидите панель с запросом ввода основных 
данных о вашей учетной записи (рис. 9.2).
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Рис. 9.2. Ввод основных данных о вашей учетной записи

3. В поле ввода Полное имя (Full Name) укажите имя пользователя, 
которое система должна соотнести с данной почтовой записью.

4. В поле ввода Адрес e-mail (Email Address) укажите электронный 
адрес, с которым приложение будет работать в дальнейшем.

5. В поле ввода Пароль (Password) укажите пароль, который вы ис-
пользуете для доступа к почтовому ящику.

6. Нажмите кнопку Создать (Create) и подождите, пока система про-
верит, доступны ли для провайдера, которому соответствует вве-
денный адрес e-mail, предустановки в приложении Mail.

Так как в нашем случае настройки для указанного провайдера не об-
наружены, приложение Mail выведет соответствующее сообщение 
и кнопку Дальше (Continue).

7. Нажмите кнопку Дальше (Continue). Откроется панель, на которой 
следует указать настройки сервера входящей почты (рис. 9.3).

Рис. 9.3. Ввод настроек сервера входящей почты

8. Укажите протокол вашей учетной записи, выбрав соответствующую 
вкладку — POP или IMAP.
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При работе по протоколу POP программа-клиент подключается к сер-
веру, загружает новую (или всю, в зависимости от настройки) почту и от-
ключается от сервера. При работе по протоколу IMAP почтовый клиент 
подключается к серверу и предоставляет возможность работы с почтой 
на сервере так, как будто вся почта находится на вашем компьютере. 

Протокол POP рекомендуется использовать в случае сильно ограни-
ченного места на сервере или в случае, когда постоянное подключе-
ние к почтовому серверу невозможно. В остальных случаях предпочти-
тельнее использовать IMAP.

9. В поле Сервер входящей почты (Incoming Mail Server) укажите 
сервер входящей электронной почты — imap-mail.outlook.com 
(для протокола IMAP) или pop3.live.com (для протокола POP).

� Примечание. Для Mail.ru, Rambler.ru и Yandex.ru адреса сер-
вера входящей электронной почты выглядят так: imap.mail.ru 
(pop.mail.ru), imap.rambler.ru (pop. rambler.ru) и imap.yandex.ru 
(pop. yandex.ru), соответственно.

10. В поле ввода Имя пользователя (User Name) укажите полный адрес 
почтового ящика.

11. В поле ввода Пароль (Password) укажите пароль, который исполь-
зуется для доступа к почтовому ящику.

12. Нажмите кнопку Дальше (Continue) и подождите, пока система 
проверит указанные параметры. Если процесс завершится успеш-
но, вы увидите панель для ввода данных сервера исходящей почты 
(рис. 9.4).

Рис. 9.4. Ввод настроек сервера исходящей почты
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13. В поле ввода Сервер исходящей почты (Outgoing Mail Ser-
ver) укажите сервер исходящей почты вида smtp.name.com, где 
name.com — доменное имя провайдера электронной почты.

� Примечание. Для Mail.ru, Rambler.ru и Yandex.ru адреса серве-
ра исходящей электронной почты выглядят так: smtp.mail.ru, 
smtp.yandex.ru и smtp.rambler.ru, соответственно.

14. В полях ввода Имя пользователя (User Name) и Пароль (Password) 
укажите полный адрес почтового ящика и пароль, который исполь-
зуется для доступа к нему, соответственно.

� Примечание. Если по каким-то причинам доступ к почтовому 
ящику из программы Mail невозможен, вероятно, изменились па-
раметры входящих/исходящих серверов и/или требуются допол-
нительные настройки аутентификации пользователя. Получить 
дополнительную информацию вы можете на сайтах windows.mic-
rosoft.com/ru-ru/windows/outlook/send-receive-from-app (live.ru), 
help.mail.ru/mail-help/mailer/popsmtp (Mail.ru), help.rambler.ru/
mail/mailpochtovye-klienty (Rambler.ru) и help.yandex.ru/mail/
mail-clients.xml (Yandex.ru).

15. Нажмите кнопку Создать (Create). Учетная запись будет создана, 
и, если доступны новые входящие сообщения, они будут загружены 
в программу.

Вы в любой момент можете создать дополнительную почтовую запись, 
выполнив команду меню Файл ⇒ Добавить учетную запись (File ⇒ Add 
Account) и следуя инструкциям на экране. А если потребуется внести 
изменения в существующую учетную запись, нужно выполнить коман-
ду меню Mail ⇒ Настройки (Mail ⇒ Preferences) и в открывшемся окне 
перейти на вкладку Учетные записи (Accounts). Затем следует выбрать 
учетную запись в левой части окна и изменить ее настройки.

После того как вы создадите новую учетную запись, приложение Mail 
импортирует сообщения из почтового ящика на сервере провайдера. 
Возможно, придется подождать загрузки, если на сервере скопилось 
внушительное количество сообщений.
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Просмотр входящих сообщений

Приложение Mail загружает новые сообщения автоматически, но вы 
можете инициировать их загрузку и вручную . Для этого выполните сле-
дующие действия.

1. Запустите приложение Mail и нажмите кнопку  на панели ин-
струментов. Если на сервере доступны новые сообщения, они будут 
загружены в программу. Непрочитанные сообщения помечаются 
синим кружком в левой части окна программы (рис. 9.5).

Рис. 9.5. Интерфейс приложения Mail

� Примечание. Также, чтобы получить новые сообщения электрон-
ной почты, можно щелкнуть мышью, удерживая клавишу ⌃, по 
значку приложения Mail ( ) на панели Dock и выбрать в контекст-
ном меню пункт Получить новую почту (Get New Mail).

 При получении новой почты значок приложения Mail в панели Dock 
меняет внешний вид: в правом верхнем углу появляется наклейка 
красного цвета, в которой указывается количество непрочитанных 
сообщений — .



316 Глава 9

� Примечание. По умолчанию приложение Mail автоматически про-
веряет почтовый ящик на наличие новых сообщений каждые пять 
минут. Если вы хотите изменить это значение или вовсе отклю-
чить автоматическую проверку почты, выполните команду меню 
Mail ⇒ Настройки (Mail ⇒ Preference) и на вкладке Основные 
(General) измените значение в раскрывающемся списке Проверять 
наличие новой почты (Check for New Mail).

2. Чтобы прочитать сообщение, щелкните по нему мышью (в левой ча-
сти окна программы Mail). Содержимое письма отобразится в пра-
вой части окна.

� Совет. Чтобы открыть сообщение в новом окне, щелкните по нему 
мышью дважды.

Если вы хотите прочитать некоторые сообщения или ответить на них 
позднее, можно пометить их флажками разного цвета, которые будут 
служить вам напоминанием и помогут сортировать сообщения.

3. Чтобы добавить флажок, щелкните мышью по сообщению (или вы-
деленной группе сообщений) в списке, удерживая клавишу ⌃, и вы-
берите цвет флажка. Также можно выбрать цвет флажка в раскры-
вающемся списке  на панели инструментов основного окна 
приложения. Mail отобразит выбранный флажок рядом с указан-
ными сообщениями и добавит их на вкладку Отмеченные флаж-
ком (Flagged) панели, расположенной в верхней части окна про-
граммы.

 Допускается использовать флажки для пометки любых сообщений: 
входящих, исходящих, черновиков или отправленных.

� Совет. Для быстрой установки флажка красного цвета вы можете, 
выделив сообщение, нажать сочетание клавиш �+�+L.

4. Чтобы просмотреть сообщения, помеченные флажками (независи-
мо от цвета флажка), перейдите на вкладку Отмеченные флажка-
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ми (Flagged) на панели в верхней части окна программы. Вы можете 
выбрать сообщения, помеченные флажками определенного цвета, 
с помощью раскрывающегося списка вкладки (рис. 9.6).

Рис. 9.6. Просмотр сообщений, помеченных флажками

5. Чтобы сбросить пометку флажком с сообщения (или группы сооб-
щений), щелкните мышью по нему (или выделенной группе), удер-
живая клавишу ⌃, и укажите в качестве цвета флажка символ × или 
в раскрывающемся списке  на панели инструментов окна при-
ложения Mail выберите пункт Снять флажок (Clear Flag).

Вы изучили две вкладки на панели инструментов окна приложения 
Mail — Входящие (Inbox) и Отмеченные флажками (Flagged). В пер-
вом случае вы видите все входящие сообщения, а во втором — только 
помеченные флажками. Также панель инструментов окна приложения 
Mail содержит еще несколько вкладок, которые будут рассмотрены 
позднее, а именно — VIP (куда отфильтровывается почта от адресатов, 
помеченных особым VIP-статусом), Отправленные (Sent) (сюда попа-
дают все отправленные вами письма) и Черновики (Drafts) (на этой 
вкладке хранятся все написанные, но не отправленные письма). Эти 
же вкладки (папки) доступны в боковом меню, которое по умолчанию 
скрыто. Чтобы открыть его, нажмите кнопку Показать (Show) на пане-
ли инструментов окна приложения Mail (рис. 9.7).

Помимо перечисленных папок, в боковом меню присутствуют еще 
две — Спам (Junk) для сбора нежелательных (рекламных) сообщений 
и Корзина (Trash), куда попадают удаленные сообщения.

В группе Смарт-ящики (Smart Mailboxes) создаются смарт-ящики, 
как будет описано позднее в данной главе. А в группе Активность 
Mail (Mail Activity) отображается процесс отправки/получения сооб-
щений.
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Рис. 9.7. Боковое меню приложения Mail

� Совет. Вы можете распечатать любое сообщение. Для этого нужно 
выбрать сообщение (или группу сообщений) и выполнить коман-
ду меню Файл ⇒ Напечатать (File ⇒ Print) или нажать сочетание 
клавиш �+P. На открывшейся панели выберите принтер, задайте 
настройки печати и нажмите кнопку Напечатать (Print). Если вы 
отправили на печать несколько сообщений, то каждое из них про-
грамма Mail распечатает как отдельный документ.

Приложение Mail тесно интегрировано c программой Календарь (Calen-
dar), так как часто информация, которая поступает на почтовый ящик, 
требует от получателя каких-либо действий. Это стоит использовать, 
чтобы было проще справляться с потоком почты и планировать пред-
стоящие события. Например, вы можете сделать так, что все приглаше-
ния, которые придут на почтовый ящик, приложение Mail будет автома-
тически добавлять в календарь. Для этого нужно выполнить команду 
меню Mail ⇒ Настройки (Mail ⇒ Preferences) и в открывшемся окне 
на вкладке Основные (General) в раскрывающемся списке Добавлять 
приглашения в Календарь (Add invitations to Calendar) выбрать пункт 
Автоматически (Automatically).
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Также вы можете создать событие в календаре из сообщения в прило-
жении Mail.

1. Установите указатель мыши на дату или время, указанные в теле 
письма, и подождите, пока вокруг даты появится контур серого 
цвета с кнопкой .

2. Нажмите кнопку . Откроется панель, на которой вы сможете на-
строить добавленное событие (рис. 9.8).

Рис. 9.8. Добавление события в приложение Календарь

3. Нажмите кнопку Подробнее (Details), чтобы детально настроить 
добавляемое событие.

4. Нажмите кнопку В Календарь (Add to Calendar), чтобы добавить со-
бытие в приложение Календарь (Calendar).

Из приложения Mail можно добавить контактную информацию в при-
ложение Контакты (Contacts), а также воспользоваться приложением 
Карты (Maps) для просмотра адреса на карте и прокладывания марш-
рута проезда. Для этого выполните следующие действия.

1. Установите указатель мыши на контактную информацию, указан-
ную в теле письма, и подождите, пока вокруг нее появится контур 
серого цвета с кнопкой .
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2. Нажмите кнопку . Откроется панель, в которой вы сможете про-
смотреть контактную информацию (рис. 9.9).

Рис. 9.9. Просмотр контактной информации в приложении Mail

3. Вы можете добавить данную информацию как новый контакт, нажав 
кнопку Новый контакт (New Contact), или обновить уже существу-
ющую карточку контакта, нажав кнопку Добавить (Add).

4. Установите указатель мыши на адрес, указанный в теле пись-
ма, и подождите, пока вокруг него появится контур серого цвета 
с кнопкой .

5. Нажмите кнопку . Откроется панель, в которой вы можете про-
смотреть выбранный адрес на карте, а также проложить маршрут 
к нему, щелкнув мышью по кнопке , расположенной справа от 
слова Маршруты (Directions) (рис. 9.10).

Рис. 9.10. Просмотр адреса в приложении Mail



Обмен сообщениями электронной почты 321

Если у вас возникли проблемы при подключении к учетным записям, 
выполните команду меню Окно ⇒ Проверка подключения (Win-
dow ⇒ Connection Doctor), чтобы получить подробные сведения о том, 
какие из ваших учетных записей настроены неверно или недоступны.

Создание и отправка почтовых сообщений

Рассмотрим, как создать и отправить новое сообщение электронной 
почты. Для этого выполните следующие действия.

1. Чтобы создать новое сообщение, запустите приложение Mail и на-
жмите кнопку  на панели инструментов или сочетание �+N. 
Появится окно Новое сообщение (New Message) (рис. 9.11).

Рис. 9.11. Окно нового сообщения электронной почты (заполнено)

 Окно Новое сообщение (New Message) состоит из трех основных 
областей: в верхней его части вы увидите панель инструментов, 
которая предоставляет доступ к элементам управления, ниже рас-
положена область для ввода адресов получателей и темы письма, 
и основную область занимает тело письма для ввода текста сооб-
щения.
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2. В поле Кому (To) укажите адрес электронной почты получателя.

Если этот адрес есть в базе данных приложения Контакты (Contacts), 
достаточно ввести несколько первых букв имени или адреса, после 
чего программа автоматически заполнит адрес. Если приложение Mail 
выберет не тот вариант, наберите еще несколько букв, чтобы перейти 
к нужному адресу. Если вы хотите отправить сообщение нескольким 
адресатам, перечислите нужные адреса в этом поле через запятую. Так-
же вы можете выбрать адресатов из приложения Контакты (Contacts), 
нажав кнопку , как показано на рис. 9.11.

� Совет. Для удобства вы можете перемещаться по полям ввода, на-
жимая клавишу �.

 Если вы хотите отправить копию сообщения другим получателям, 
нужно указать их адреса в поле ввода Копия (Cc). Если же вы сами 
получите сообщение, в котором ваше имя отображается в строке 
Копия (Cc), значит, отправитель посчитал, что вам может быть инте-
ресно это сообщение, но он не ожидает, что вы на него ответите.

3. В поле Тема (Subject) введите краткое описание содержания со-
общения.

Вы можете выбрать формат сообщения: простой текст или формати-
рованный. Сообщения, которые содержат простой текст, приложение 
отправляет и открывает быстрее, к тому же их корректно восприни-
мают любые почтовые программы. В свою очередь, форматированные 
сообщения выглядят более красиво, но часто медленно открываются, 
кроме того, некоторые почтовые программы могут не воспринимать 
форматирование. Поэтому использовать его в сообщениях рекоменду-
ется только тогда, когда вы уверены, что почтовая программа получа-
теля поддерживает такие сообщения. Выполните команду меню Фор-
мат ⇒ Конвертировать в простой текст (Format ⇒ Make Plain Text), 
чтобы задать формат простого текста (и команду меню Формат ⇒ Кон-
вертировать в форматированный текст (Format ⇒ Make Rich Text), 
чтобы вернуть форматирование).

 Независимо от того, какой формат сообщения вы выбрали, можно 
прикреплять и отправлять вместе с ним фотографии, текстовые до-
кументы или другие файлы.
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4. Чтобы прикрепить файл (вставить изображение) к сообщению, пе-
ретащите значок этого файла с рабочего стола или из окна Finder 
в окно нового сообщения или нажмите кнопку  или  для 
вставки документа или изображения из библиотеки графического 
приложения (например, iPhoto) соответственно. О том, что файл 
удачно прикреплен, говорит появившийся значок-ссылка (или 
вставленное изображение), щелкнув по которому мышью получа-
тель откроет вложенный файл.

� Примечание. Более подробно о приемах работы с вложениями 
см. в соответствующем разделе далее в этой главе.

5. Введите текст сообщения.

6. Нажмите кнопку , чтобы отобразить панель форматирования 
текста. С помощью появившихся элементов управления вы можете 
изменить шрифт, его размер, начертание и цвет, а также способ вы-
равнивания текста в письме, создать маркированный или нумеро-
ванный список и добавить отступ/выступ.

� Совет. Если вы не хотите сразу отправлять сообщение, выберите 
команду меню Файл ⇒ Сохранить (File ⇒ Save) или нажмите соче-
тание клавиш �+S. Когда потребуется снова открыть сохраненное 
сообщение, выберите вкладку Черновики (Drafts) в окне програм-
мы Mail и дважды щелкните мышью по сообщению, которое вы хо-
тите дописать и отправить.

7. Чтобы отправить сообщение, нажмите кнопку  или сочетание 
клавиш �+�+D. Приложение Mail отправит ваше сообщение полу-
чателю.

При необходимости вы можете переслать полученное сообщение дру-
гому пользователю, добавив его как текст или вложение. Для этого 
выберите сообщение в списке и выполните команду меню Сообще-
ние ⇒ Переслать (Message ⇒ Forward) или нажмите кнопку  на 
панели инструментов основного окна. Чтобы переслать сообщение во 
вложении, выполните команду меню Сообщение ⇒ Переслать как 
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вложенный файл (Message ⇒ Forwards as Attachment), а затем укажи-
те адрес получателя нового сообщения, введите текст письма и нажми-
те кнопку Отправить (Send).

� Совет. Если вам удобнее, чтобы программа Mail сначала помещала 
новые сообщения в папку Исходящие (Outbox), а не подключалась 
к Интернету всякий раз, когда вы нажимаете кнопку Отправить (Send), 
выполните команду меню Ящик ⇒ Все учетные записи — в режим 
офлайн (Mailbox ⇒ Take all Accounts Offline). Приложение Mail перей-
дет в режим автономной работы и отправит сообщения только тогда, 
когда вы выполните команду меню Ящик ⇒ Все учетные записи — 
в режим онлайн (Mailbox ⇒ Take all Accounts Online).

Использование бланков оформления

Для повседневной или служебной переписки достаточно обычных со-
общений с простым или форматированным текстом. Но иногда возни-
кает необходимость сделать сообщение более интересным и привле-
кательным. Например, чтобы поздравить коллег с профессиональным 
праздником. В этом случае вам помогут встроенные бланки оформле-
ния в приложении Mail . В коллекции вы найдете шаблоны на все случаи 
жизни. Получатели, несомненно, оценят красочные сообщения, разме-
щенные фотографии, витиеватые шрифты и другие элементы декора. 
Важно, чтобы почтовые программы адресатов воспринимали формати-
рование с HTML-кодом, используемым приложением Mail.

1. Создайте новое сообщение, выполнив команду меню Файл ⇒ Но-
вое сообщение (File ⇒ New message), нажав кнопку  или соче-
тание клавиш �+N. Откроется окно Новое сообщение (New Mes-
sage).

2. Нажмите кнопку  на панели инструментов окна приложения 
Mail. Появится панель с миниатюрами доступных бланков, рас-
сортированных по категориям.

3. Выберите категорию, а затем щелкните мышью по миниатюре блан-
ка, который вы хотите применить к своему сообщению. Оформле-
ние сообщения изменится в соответствии с выбранным бланком 
(рис. 9.12).
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Рис. 9.12. Выбор бланка для нового сообщения электронной почты

4. Нажмите кнопку  на панели инструментов окна, чтобы свернуть 
панель бланков.

� Примечание. Если вы по каким-то причинам решите отказаться от 
бланка и отправить письмо с простым текстом, выберите на панели 
выбора бланков категорию Бланк письма (Stationery) и щелкните 
мышью по миниатюре Пустой (Original). Программа отменит фор-
матирование вашего сообщения.

5. Чтобы добавить изображения из собственной коллекции, перета-
щите их из окна приложения Finder в окно сообщения или нажмите 
кнопку  на панели окна приложения Mail. В последнем случае 
откроется окно со всеми вашими фотографиями, которые хранят 
приложения iPhoto и Photo Booth. Если вы не храните фотографии 
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в этих программах, перетащите в это окно папку со своими фото-
графиями.

6. Поместите нужную фотографию на изображение-заполнитель 
в бланке. Если потребуется масштабировать фотографию, щелкни-
те по ней мышью и используйте появившийся ползунковый регу-
лятор.

7. Чтобы отредактировать текст письма, достаточно щелкнуть мышью 
по нужному фрагменту, программа выделит текст рамкой, внутри 
которой отображается текстовый курсор. Введите текст. При этом 
общее оформление текста будет сохранено: расположение, размер, 
цвет шрифта и т. д.

8. Укажите адрес электронной почты получателя и тему, а затем на-
жмите кнопку . Приложение Mail отправит ваше сообщение.

Вы можете использовать не только встроенные бланки, но и создавать 
свои собственные. Создайте новое сообщение, оформите его по свое-
му усмотрению: шрифты, цветовая палитра, изображения и т. д., а потом 
выполните команду меню Файл ⇒ Сохранить как бланк (File ⇒ Save 
as Stationery). Присвойте бланку имя и сохраните его. При создании но-
вого сообщения вы найдете созданный бланк в категории Произволь-
ный (Custom), которая появится в нижней части списка.

Любимые бланки вы можете перетащить в категорию Избранное (Fa-
vorites), что позволит сократить время поиска. Если вы решите удалить 
бланк из категории Избранное (Favorites), установите на него указа-
тель мыши и нажмите кнопку  в левом верхнем углу миниатюры. В ис-
ходной категории этот бланк останется.

Подписи в сообщениях электронной почты

При желании вы можете создать подпись к почтовому сообщению — 
фрагмент текста или изображение, который будет автоматически до-
бавляться в конец ваших почтовых сообщений. Это может быть ваша 
контактная информация, любимые цитаты и т. д.

Чтобы добавить подпись, выполните следующие шаги.

1. Выполните команду меню Mail ⇒ Настройки (Mail ⇒ Preferences) 
и в открывшемся окне перейдите на вкладку Подписи (Signatures).
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2. В левой части окна выберите пункт Все подписи (All Signatures) 
и нажмите кнопку , чтобы создать новую подпись.

3. В правой части окна введите содержание подписи, а затем перета-
щите подпись из среднего столбца на имя учетной записи слева.

Если же вы хотите добавить к сообщению автограф, выполните следу-
ющие действия.

1. Распишитесь на листе бумаги, а затем запустите приложение Про-
смотр (Preview).

2. Выполните команду меню Просмотр ⇒ Настройки (Preview ⇒ Prefe-
rences) и в открывшемся окне перейдите на вкладку Подписи (Sig-
natures).

3. Нажмите кнопку Создать подпись (Create a Signatures), поднесите 
лист бумаги к объективу вашей камеры.

4. Выровняйте подпись по синей линии и нажмите кнопку Принять 
(Accept). Приложение сохранит вашу подпись, после чего вы може-
те добавлять ее в различные документы, в том числе в почтовые со-
общения.

5. Для этого выделите сохраненную подпись, нажмите сочетание кла-
виш �+С, а в окне Подписи (Signatures) приложения Mail добавьте 
подпись, нажав сочетание клавиш �+V.

Вы можете создать множество подписей и присваивать учетным запи-
сям разные подписи.

Управление вложениями

Часто появляется необходимость не просто написать электронное 
письмо, а отправить вместе с ним какие-то объекты: текстовые доку-
менты, рабочие файлы, фотографии и т. д. С помощью приложения Mail 
вы легко справитесь с почтовыми вложениями : сможете отправлять их 
и сохранять присланные. При необходимости вы можете указать папку, 
в которой программа Mail должна сохранять вложения, приходящие 
вместе с письмами, или выбрать место хранения для каждого вложе-
ния отдельно.

Для отправки письма с вложением выполните следующие действия.
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1. Откройте окно нового сообщения, заполните нужные поля и введи-
те текст сообщения.

2. Чтобы создать вложение, нажмите кнопку , выполните команду 
меню Файл ⇒ Вложить файлы (File ⇒ Attach File) или нажмите со-
четание клавиш �+�+A. Откроется панель для выбора файлов.

3. Выберите файл и нажмите кнопку Выбрать файл (Choose File).

� Совет. Если вы хотите вложить несколько файлов, удерживая кла-
вишу �, щелкните мышью по всем файлам, которые нужно прикре-
пить к сообщению.

4. В окне сообщения вы увидите значок, символизирующий прикре-
пленный файл. Файлы разного типа имеют различные значки, а видео-
файлы и изображения отображаются в виде миниатюр (рис. 9.13).

Рис. 9.13. Письмо с вложениями
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5. Если требуется удалить вложенный файл из сообщения, выберите 
его значок или миниатюру и нажмите клавишу ⌫ или перетащите 
значок файла на значок Корзина (Trash) на панели Dock.

� Совет. Выполните команду меню Сообщение ⇒ Удалить прикре-
пленные файлы (Message ⇒ Remove Attachments), чтобы удалить 
все вложения.

6. Отправьте почтовое сообщение, нажав кнопку . Вложенный 
файл адресат получит вместе с письмом.

Если вы получили письмо с вложением, выполните следующие действия.

1. Откройте почтовое сообщение, в конце письма вы найдете значок 
вложенного файла или его миниатюру. Если вложенный файл — 
фотография или видеоролик и вам нужно только просмотреть его, 
в этом случае вся ваша работа с почтовым вложением закончится 
на этом этапе.

� Совет. Чтобы указать папку, в которой приложение Mail должно со-
хранять все вложения, выполните команду меню Mail ⇒ Настрой-
ки (Mail ⇒ Preferences) и в открывшемся окне на вкладке Основные 
(General) в раскрывающемся списке Папка загрузок (Downloads 
folder) выберите папку, в которую вы хотите сохранять вложения.

2. Чтобы сохранить вложенный файл, вы можете использовать один 
из следующих способов:

• перетащите при помощи мыши значок файла на рабочий стол 
или в окно приложения;

• выполните команду меню Файл ⇒ Сохранить вложенные фай-
лы (File ⇒ Save Attachments) и укажите папку, куда программа 
Mail должна сохранить вложение;

• щелкните мышью по значку вложенного файла при нажатой 
клавише ⌃ и выберите в контекстном меню нужный пункт, на-
пример Сохранить вложенный файл (Save Attachment).

 Какой бы вариант вы ни выбрали, вложенные файлы будут сохране-
ны на жестком диске вашего компьютера в указанной папке.
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Если вы захотите удалить вложения из полученного сообщения, выбе-
рите письмо и выполните команду меню Сообщение ⇒ Удалить вло-
женные файлы (Message ⇒ Remove Attachments). Приложение Mail 
удалит вложения из указанного сообщения (кроме тех, что вы успели 
сохранить или отредактировать), но само письмо останется в почтовом 
ящике с пометкой, что его вложения удалены вручную. Помните, что, 
если вы удалите сообщение из почтового ящика, приложение Mail вме-
сте с ним сотрет и прикрепленные вложения.

� Совет. Если вы хотите изменить способ обработки вложений при 
удалении сообщений, выполните команду меню Mail ⇒ Настройки 
(Mail ⇒ Preferences) и в открывшемся окне на вкладке Основные 
(General) в раскрывающемся списке Удалять необработанные 
загрузки (Remove unedited downloads) выберите подходящий ва-
риант.

Сортировка электронной почты

Чтобы эффективно управлять электронной почтой, в приложении Mail 
помимо существующих почтовых ящиков (папок) можно создать соб-
ственные. В левой части окна приложения Mail расположены различ-
ные категории (некоторые из них могут появляться при определенных 
условиях) и относящиеся к ним ящики (рис. 9.14).

Рис. 9.14. Иерархия категорий и ящиков приложения Mail
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Если боковая панель в программе Mail скрыта, нажмите кнопку Пока-
зать (Show) на панели инструментов.

• В группе Ящики (Mailbox) размещены следующие папки (часть из 
них дублируется на панели инструментов).

— Входящие (Inbox). В этой папке приложение хранит все сооб-
щения, которые поступили на ваш адрес. Если у вас несколько 
адресов, тогда в этой папке вы найдете вложенные папки для 
каждого зарегистрированного адреса.

— VIP. В этой папке расположены сообщения от контактов, кото-
рым присвоен VIP-статус (см. далее).

— Отмеченные флажком (Flagged). В этой папке находятся со-
общения, помеченные флажками.

— Исходящие (Outbox). В этой папке хранятся написанные, но не 
отправленные вами сообщения. Если в настоящий момент таких 
писем нет, эта папка не видна.

— Черновики (Drafts). В этой папке вы найдете сообщения, поме-
ченные как черновики и планируемые к отправке. Если вы не 
сохраняли черновики, эта папка не видна.

— Отправленные (Sent). В этой папке приложение Mail хранит ко-
пии отправленных вами сообщений.

— Спам (Junk). Здесь приложение хранит сообщения, причислен-
ные к спаму.

— Корзина (Trash). В этой папке находятся удаленные сообщения.

• Смарт-Ящики (Smart-Mailbox). В этой группе размещены смарт-
ящики, в которые попадает почта согласно указанным вами на-
стройкам. Если вы не создавали смарт-ящики, эта папка не видна.

• На моем Mac (On My Mac). В этой папке приложение Mail хранит 
все сообщения, расположенные на компьютере, а не на почтовом 
сервере.

• Активность Mail (Mail Activity). Эта панель отображает процесс 
отправки писем. Чтобы скрыть или отобразить ее, нажимайте 
кнопку , которая расположена под боковой панелью.

Вы можете самостоятельно создавать ящики с различным предназна-
чением. Чтобы создать новый ящик, нажмите кнопку , которая рас-
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положена под боковой панелью, и выберите пункт Новый ящик (New 
Mailbox) в контекстном меню. Если при нажатой клавише ⌃ вы щелкне-
те мышью непосредственно по имени папки на боковой панели, тогда 
приложение создаст новый почтовый ящик внутри нее. Создав струк-
туру почтовых ящиков, вы сможете максимально эффективно исполь-
зовать систему фильтров и использовать функцию автоматического пе-
ренаправления входящей почты в соответствующие почтовые ящики.

Присвоение отправителю статуса VIP

Избранным собеседникам вы можете присвоить особый статус — VIP, 
чтобы помещать их в папку VIP и просматривать отдельно от остальной 
почты. Для присвоения/отключения VIP-статуса выполните следующие 
действия.

1. Щелкните мышью по звездочке слева от имени отправителя в заго-
ловке сообщения. Можно также установить указатель мыши на имя 
отправителя, нажать появившуюся стрелку, а затем выбрать пункт 
Добавить в VIP (Add to VIPs) (рис. 9.15).

Рис. 9.15. Присвоение VIP-статуса

� Примечание. В список VIP можно добавить не более 100 контак-
тов.

В почтовый ящик VIP будет добавлена новая папка (см. боковое меню 
окна программы Mail) с именем отправителя. Теперь все входящие со-
общения от данного отправителя будут попадать в эту папку.

2. Щелкните мышью по звездочке VIP-контакта в сообщении. Папка 
отправителя будет удалена из почтового ящика VIP.
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Если для VIP-контакта зарегистрированы несколько адресов электрон-
ной почты в приложении Контакты (Contacts), то в почтовом ящике VIP-
контакта отображаются сообщения со всех этих адресов.

Если вы синхронизируете приложение Контакты (Contacts) со службой 
iCloud, ваши VIP-контакты будут доступны на других ваших компьюте-
рах Mac (под управлением операционной системы OS X 10.8 или более 
поздней версии) и устройствах под управлением операционной систе-
мы iOS 6 или более поздней версии, на которых включена синхрониза-
ция приложения Контакты (Contacts) со службой iCloud.

Управление разговорами

Когда у вас в почтовом ящике накапливается много писем, неизбежно 
возникает вопрос, как сгруппировать все сообщения, которые относят-
ся к определенной тематике. Разобраться со списком сообщений вам 
поможет встроенная функция приложения Mail — управление разгово-
рами. Приложение Mail группирует сообщения по разговорам, основы-
ваясь на теме сообщений, заголовке, адресе отправителя (получателя), 
а также дате получения (отправки). С ее помощью вы сможете сгруп-
пировать сообщения по определенным темам. Например, объединить 
в один разговор переписку с коллегами, где вы обсуждали, как лучше 
организовать корпоративный праздник. Чтобы научиться управлять 
разговорами, выполните следующие действия.

1. Для группировки сообщения по разговорам откройте почтовый 
ящик и выполните команду меню Вид ⇒ Организовать по разго-
ворам (View ⇒ Organize by Conversation), чтобы установить напро-
тив имени данной команды флажок.

2. Если вам понадобится отменить группировку по разговорам, сбрось-
те флажок Вид ⇒ Организовать по разговорам (View ⇒ Organize 
by Conversation).

Если нужно отобразить связанные сообщения текущего разговора, 
выполните команду меню Вид ⇒ Показать связанные сообщения 
(View ⇒ Show Related Messages). Чтобы скрыть связанные сообщения 
разговора, выполните команду меню Вид ⇒ Скрыть связанные со-
общения (View ⇒ Hide Related Messages).

Программа Mail сворачивает разговоры в списке сообщений так, что вы 
видите только последнее в разговоре. Программа помечает его серым 
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прямоугольником, в котором отображается, сколько всего сообщений 
в данном разговоре. Их полный список показан в области предвари-
тельного просмотра. Чтобы определить порядковый номер сообщения 
в разговоре, посмотрите на число в правом верхнем углу. Если вы не 
видите порядкового номера, значит, это связанное сообщение, кото-
рое было добавлено из другого почтового ящика.

Чтобы просмотреть сообщения в другом разговоре, щелкните мышью 
по серому прямоугольнику возле этого разговора. Если нужно свер-
нуть сообщения, выполните это действие еще раз.

Если потребуется развернуть все разговоры в списке сообще-
ний, выполните команду меню Вид ⇒ Развернуть все разговоры 
(View ⇒ Expand all conversations). Чтобы увидеть только последние 
сообщения во всех разговорах в списке сообщений, выполните ко-
манду меню Вид ⇒ Свернуть все разговоры (View ⇒ Collapse all 
conversations).

Чтобы перемещаться между сообщениями в открытом разговоре, 
либо выполняйте команды Вид ⇒ Выбрать ⇒ Следующее сооб-
щение в разговоре (View ⇒ Select ⇒ Next message in this conversa-
tion) и Вид ⇒ Выбрать ⇒ Предыдущее сообщение в разговоре 
(View ⇒ Select ⇒ Previous message in this conversation), либо исполь-
зуйте клавиши ↑ и ↓ соответственно.

Кроме группировки и просмотра, вы можете управлять сообщениями, 
объединенными в разговор. Так, чтобы убрать из разговора конкретное 
сообщение (при условии, что вы не добавляете в разговор связанные 
сообщения из других ящиков), выберите нежелательное сообщение 
и переместите в другой почтовый ящик, например в ящик Черновики 
(Drafts).

В случае если вам понадобится удалить все сообщения, входящие 
в разговор, сгруппируйте их и удалите последнее из них. Теперь этот 
разговор больше не существует, останутся только связанные с ним со-
общения в других почтовых ящиках.

Если вы хотите настроить параметры просмотра сообщений, которые 
программа Mail объединила в разговор, выполните команду меню 
Mail ⇒ Настройки (Mail ⇒ Preferences) и в открывшемся окне на вклад-
ке Просмотр (Viewing) установите флажки напротив соответствующих 
параметров настройки в группе Просмотр разговоров (View Conver-
sations).
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Фильтрация входящих сообщений
Инструменты приложения Mail позволяют создавать правила обработ-
ки сообщений (фильтров)  и, основываясь на них, автоматически сохра-
нять, распределять или удалять сообщения согласно темам, адресам 
отправителей, размерам вложений и т. д. С системой фильтров работа 
с программой станет намного удобнее и эффективнее.

Чтобы создать систему фильтров в приложении Mail, выполните сле-
дующие действия.

1. Запустите приложение и выполните команду меню Mail ⇒ На-
стройки (Mail ⇒ Preferences).

2. В открывшемся окне Настройки (Preferences) перейдите на вкладку 
Фильтры (Rules).

3. Чтобы создать новый фильтр, нажмите кнопку Добавить (Add Rule). 
Откроется панель, на которой вы сможете задать настройки нового 
фильтра (рис. 9.16).

Рис. 9.16. Панель настройки нового фильтра

4. Определите параметры, согласно которым будет производиться 
фильтрация почтовых сообщений. Например, если вы хотите, что-
бы программа отслеживала сообщения от определенного адреса-
та, выберите во втором и третьем раскрывающихся списках пун-
кты Отправитель (From) и содержит (Contains) соответственно; 
а в поле ввода правее введите значение, например ivan@site.ru.

5. В нижней части панели укажите, как программа должна обраба-
тывать сообщения, которые соответствуют заданным критериям: 
перемещать в определенный ящик, удалять, пересылать и т. д.
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Если вы еще не создали специальную папку, в которую приложение 
должно перенаправлять сообщения согласно критериям фильтрации, 
это можно сделать, не покидая панель фильтров. Выполните команду 
меню Ящик ⇒ Новый ящик (Mailbox ⇒ New Mailbox), укажите назва-
ние ящика и подтвердите его создание. Теперь новый ящик можно вы-
брать на панели фильтров.

6. Нажмите кнопку OK. Новое правило будет создано, а приложение 
Mail станет отфильтровывать все входящие сообщения, которые со-
ответствуют заданным условиям.

Программа Mail применяет правила фильтрации в том порядке, в ко-
тором они расположены в окне Фильтры (Rules) (сверху вниз). Если 
вы обнаружите, что какое-то правило работает не так, как ожидалось, 
возможно, на его работу влияет предыдущий фильтр. Попробуйте ис-
править это, поменяв их порядок в окне Фильтры (Rules).

Обработка спама

В приложении Mail внедрен фильтр , который поможет вам отсеивать 
спам. Этот фильтр функционирует в режиме обучения. Открыв нежела-
тельное сообщение, нажмите кнопку  на панели инструментов. За-
головок письма будет отформатирован коричневым цветом, и по явится 
значок . Далее программа будет «учиться» с вашей помощью: если вы 
пометите сообщение как спам, она запомнит это и следующее сообще-
ние, которое придет с этого адреса, автоматически пометит как спам. 
В любой момент вы можете отменить фильтрацию того или иного сооб-
щения, выбрав его и нажав кнопку  на панели инструментов. В завер-
шение следует выбрать действие, которое следует выполнять программе 
с нежелательной почтой: выполните команду меню Mail ⇒ Настройки 
(Mail ⇒ Preferences), в открывшемся окне перейдите на вкладку Спам 
(Junk Mail) и установите переключатель При получении спама (When 
junk mail arrives) в одно из положений. При необходимости настройте до-
полнительные параметры взаимодействия со спамом.

Использование смарт-ящиков
В приложении Mail вы можете использовать обучаемые смарт-ящики , 
которые будут фильтровать почтовые сообщения, соответствующие за-
данным вами критериям. Между правилами фильтрации почты и смарт-
ящиками существуют следующие различия.
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• Правила фильтрации — это действия, которое приложение Mail 
применяет к входящим сообщениям. Например, перемещает со-
общения в определенную папку. А смарт-ящик только отображает 
письма, которые соответствуют заданным критериям поиска, при 
этом никакие действия с сообщениями не выполняются.

• В смарт-ящиках не хранятся исходные сообщения, поэтому одно 
и то же письмо может находиться в разных папках.

• Критерии поиска, заданные для смарт-ящиков, применяются ко 
всем сообщениям в вашем почтовом ящике, а не только к новым 
письмам.

Создать смарт-ящик можно следующим образом.

1. Нажмите кнопку , которая расположена под боковой панелью, 
и выберите команду меню Новый смарт-ящик (New Smart Mailbox) 
в контекстном меню. Откроется панель, в которой необходимо за-
дать параметры смарт-ящика (рис. 9.17).

Рис. 9.17. Панель настройки смарт-ящика

2. Задайте параметры сортировки в раскрывающихся списках на па-
нели, введите имя смарт-ящика и нажмите кнопку OK. Приложение 
Mail добавит в группу Смарт-Ящики (Smart Mailbox) на боковой па-
нели новый смарт-ящик.
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3. Если понадобится изменить параметры смарт-ящика, щелкните мы-
шью, удерживая клавишу ⌃, по его названию на боковой панели 
и выберите команду меню Редактировать смарт-ящик (Edit Smart 
Mailbox) в контекстном меню.

Существует более быстрый способ создания и настройки смарт-ящика.

1. Выполните поиск сообщений, к которым требуется применить 
фильтрацию, в окне программы Mail.

2. Если результаты вас устраивают и вы знаете, что часто будете ис-
пользовать поиск с такими критериями, нажмите кнопку Сохра-
нить (Save), которую вы найдете под строкой поиска. Приложение 
Mail автоматически создаст смарт-ящик с соответствующими атри-
бутами поиска.

Настройка интерфейса программы Mail

При желании вы можете настроить окна приложения Mail  и задать ин-
дивидуальные параметры для панели инструментов, изменить количе-
ство полей ввода и т. д.

Чтобы настроить окна приложения Mail, выполните следующие дей-
ствия.

1. Чтобы изменить внешний вид панели инструментов основного окна 
приложения, выполните команду меню Вид ⇒ Настроить панель 
инструментов (View ⇒ Customize Toolbar). Появится панель, пока-
занная на рис. 9.18.

Рис. 9.18. Настройка панели инструментов
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2. Чтобы добавить на панели инструментов кнопки, соответствующие 
часто выполняемым действиям, перетащите их на нее при помощи 
мыши.

3. Если вы, наоборот, хотите убрать какую-либо кнопку с панели ин-
струментов, перетащите ее на рабочий стол, и она исчезнет.

� Примечание. Также при помощи мыши вы можете изменить поло-
жение элементов управления на панели.

Для настройки окна Новое сообщение (New Message), помимо выбора 
команды меню Вид ⇒ Настроить панель инструментов (View ⇒ Cus-
tomize Toolbar), позволяющей отдельно настроить панель инструмен-
тов данного окна, вы можете выполнить следующие действия.

1. Откройте окно нового сообщения.

2. Нажмите кнопку  и выберите в контекстном меню пункт Настро-
ить (Customize). Появится полный список элементов управления 
(рис. 9.19).

Рис. 9.19. Список доступных полей в окне Новое сообщение

3. Установите флажки напротив тех элементов управления, которые 
вы хотите видеть при создании нового сообщения, и нажмите кноп-
ку OK, чтобы сохранить изменения.
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Настройки окон сразу вступят в силу, и приложение Mail будет исполь-
зовать их в дальнейшем при работе с почтовыми ящиками, зарегистри-
рованными в текущей учетной записи пользователя в системе.

Поиск сообщений

Время от времени могут возникать ситуации, когда вам нужно найти 
определенное письмо, но вы не можете вспомнить, где оно хранится. 
Чтобы помочь с этой проблемой, в приложении Mail реализована функ-
ция поиска в почтовых ящиках. С помощью ключевых слов вы сможете 
организовать поиск в определенном почтовом ящике или во всех, что 
вы создали в приложении Mail.

Чтобы организовать поиск, выполните следующие действия.

1. В поле поиска, которое расположено в правой части панели ин-
струментов окна приложения Mail, введите ключевое слово или 
словосочетание. По мере того как вы будете вводить текст, в списке 
сообщений отобразятся только отвечающие поисковому запросу 
из всех почтовых ящиков письма (рис. 9.20).

Рис. 9.20. Результаты поиска писем

Приложение Mail сортирует результаты поиска по категориям, пере-
чень которых зависит от вашего ключевого слова. Например, вы мо-
жете увидеть категории по отправителю, теме, контактам, вложениям 
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и т. д. Сообщение, отвечающее запросу, можно выбрать сразу из списка 
поля поиска.

2. Чтобы просмотреть сообщение, подходящее по запросу, достаточ-
но щелкнуть по нему мышью, и приложение Mail откроет его в об-
ласти просмотра сообщений.

 При необходимости вы можете уточнить параметры поиска, допол-
нив ключевое слово в поле поиска. Также можно сузить диапазон 
поиска определенной папкой (почтовым ящиком) выбрав одну из 
вкладок на панели инструментов, например VIP.

3. Чтобы сохранить результаты поиска, создайте смарт-ящик: нажмите 
кнопку Сохранить (Save), которая расположена в правой части па-
нели инструментов, и настройте новый смарт-ящик.

� Совет. При необходимости вы можете добавить в область поиска 
такие ящики, как Корзина (Trash) и Спам (Junk), а также зашифро-
ванные сообщения. Чтобы сделать это, выполните команду меню 
Mail ⇒ Настройки (Mail ⇒ Preferences) и в открывшемся окне на 
вкладке Основные (General) установите соответствующие флажки.

Помните, что при поиске приложение Mail добавит в результаты по-
иска все сообщения, которые содержат любое слово из вашего запро-
са. Если вы проводите поиск по всем сообщениям или всем почтовым 
ящикам, тогда приложение Mail найдет сообщения, в которых есть лю-
бое слово из запроса или производные от него, при этом слова могут 
быть расположены в любом порядке. Например, если вы задали поиск 
по слову «свет», то в результаты поиска также войдут сообщения, в ко-
торых содержатся слова «светлый» или «светлая».

Синхронизация сообщений на компьютерах 
и устройствах

Если у вас есть такие портативные устройства, как iPhone , iPod или iPad, 
вы можете синхронизировать информацию между этими устройствами 
и своим компьютером Mac. Процесс синхронизации заключается в об-
новлении и обмене информацией, которая хранится на компьютере 
и этих устройствах.
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Прежде чем приступать к синхронизации, убедитесь, что компьютер 
и устройства подключены к Интернету.

Чтобы синхронизировать устройства, выполните следующие шаги.

1. Выполните команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) и щелкните мышью по значку  iCloud. Откроет-
ся одноименное окно (рис. 9.21).

Рис. 9.21. Окно iCloud

2. Авторизуйтесь, при необходимости указав адрес электронной по-
чты и пароль к учетной записи iCloud в соответствующих полях 
и нажав кнопку Войти (Sign In).

� Примечание. Если у вас до сих пор нет учетной записи Apple ID, 
вы можете создать ее, щелкнув мышью по ссылке Создать новый 
Apple ID (Create Apple ID).

3. Установите флажок Mail. Появится окно с запросом создания адре-
са электронной почты в системе iCloud.

4. Введите желаемый адрес электронной почты и нажмите кнопку OK. 
Будет включена синхронизация всех устройств, авторизованных 
с вашим Apple ID.



Обмен сообщениями электронной почты 343

� Примечание. Если для загрузки сообщений и данных приложения 
Mail свободного пространства на сервисе iCloud недостаточно, вы 
можете управлять им, приобретя дополнительное пространство 
либо удалив ненужные файлы. Подробнее об этом рассказывается 
в главе 11.

Теперь вы сможете одинаково работать на всех устройствах, авторизо-
ванных с вашей учетной записью Apple ID, и с включенной функцией 
синхронизации приложения Mail. Например, создав смарт-ящик в при-
ложении Mail на компьютере Mac, вы увидите его и на планшете iPad 
или смартфоне iPhone .



Глава 10
Обеспечение безопасности 
и защиты данных

Изучив эту главу, вы узнаете о том, каким образом операционная си-
стема OS X Mavericks позволяет защитить вашу информацию, научитесь 
использовать пароли для защищенного входа в систему, настраивать 
параметры безопасности, использовать приложение Связка ключей 
(Keychain Access) и функцию FileVault. А также познакомитесь с резерв-
ным копированием и восстановлением системы.

Компьютеры Mac, на которых установлена операционная система OS X, 
обладают широким спектром средств для защиты личных данных поль-
зователя. Большинство таких функций не требуют вмешательства поль-
зователя, а их работа практически незаметна. Единственное, что может 
увидеть пользователь, — это очередные обновления защитных функ-
ций, которые будет загружать система. Но кроме подобных защитных 
механизмов операционная система OS X предлагает набор инструмен-
тов, которые требуют вашего непосредственного участия.

• Операционная система содержит целый ряд настроек, которые 
можно защитить паролем, чтобы затруднить доступ других пользо-
вателей к вашему компьютеру и личным данным.

• Предусмотрена возможность активировать функции защиты от по-
сторонних в тех случаях, когда вам потребуется оставить компью-
тер без присмотра. В OS X есть несколько простейших механизмов 
борьбы с нежелательным любопытством окружающих.

• Вам доступны средства программы Связка ключей (Keychain Ac-
cess), которая будет хранить все ваши пароли в виде заблокирован-
ных цепочек ключей (keychains). С помощью данного приложения 
можно беречь и другую конфиденциальную информацию.

• В случае если вы держите на компьютере особо ценную и важную 
информацию, будет целесообразно использовать функцию File-
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Vault, которая сделает уровень защиты максимальным, применив 
метод шифрования к вашей домашней папке. Если у вас ноутбук, 
тогда использовать эту функцию не только полезно, но и необхо-
димо, так как она поможет защитить конфиденциальные данные 
в случае кражи компьютера.

• Также желательно помнить о возможности полной очистки папки 
Корзина (Trash), когда файлы удаляются из нее таким способом, что 
восстановить их в домашних условиях становится невозможным.

� Примечание. Подробнее о функциях очистки корзины рассказано 
в главе 3.

Если вы хотите защитить свои данные от посторонних, первое, что нуж-
но сделать, — создать пароль для входа в систему под вашей учетной 
записью. На каждом компьютере можно использовать несколько ви-
дов паролей.

• Пароль администратора . Когда вы в первый раз включите свой 
новый компьютер, система предложит указать пароль для учетной 
записи, которая будет считаться главной, а ее владелец — рассма-
триваться как основной пользователь. Введите пароль и запомните 
его. Если вы переживаете, что можете забыть пароль администра-
тора, запишите его и храните в безопасном месте. Этот пароль при-
дется вводить довольно часто: при установке нового программного 
обеспечения, настройке некоторых параметров системы и других 
изменениях системной конфигурации (рис. 10.1).

Рис. 10.1. Окно для ввода пароля администратора
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 Если вы по какой-то причине решите не устанавливать пароль адми-
нистратора и оставите соответствующие поля пустыми, система все 
равно будет каждый раз запрашивать пароль при сколько-нибудь 
серьезных изменениях в конфигурации. В этом случае, чтобы про-
должить работу, достаточно нажать кнопку подтверждения. Если 
вы забудете пароль к своей учетной записи, его можно переустано-
вить. О том, как это сделать, вы узнаете в приложении 1.

• Пароль пользователя . Если на вашем компьютере планируют 
работать несколько пользователей, имеет смысл создать для них 
обычные учетные записи и назначить каждой из них собственный 
пароль. Тогда не возникнет путаницы с файлами и споров о персо-
нальных настройках системы. Если кто-нибудь из дополнительных 
пользователей забудет пароль, администратор, используя свои 
права, легко сможет его восстановить.

• Пароль учетной записи Apple ID . Для доступа к некоторым воз-
можностям операционной системы OS X и приложений необходима 
учетная запись Apple ID. Например, для совершения покупок в ма-
газинах App Store и ITunes Store обязательно требуется авторизация 
с учетной записью Apple ID. Это сделано для того, чтобы злоумыш-
ленник, завладевший вашим компьютером, не мог приобрести за 
ваш счет программы и мультимедийные материалы.

• Пароль для доступа к базе данных программы Связка ключей 
(Keychain Access). Этот пароль соответствует вашему паролю для 
входа в систему. Собственную связку ключей можно создать для 
каждого пользователя компьютера.

• Главный пароль . Под учетной записью администратора можно 
установить пароль, который будет действовать в масштабах все-
го компьютера. Такие пароли обычно используются в комбинации 
с функцией FileVault и могут быть назначены каждому пользова-
телю в системе. Если вы решили задать главный пароль, сделайте 
все возможное, чтобы не забыть его, так как он понадобится при 
переустановке забытых пользовательских паролей. Кроме того, 
переустановить главный пароль нельзя.

Если вы опытный пользователь, тогда знаете, как правильно составлять 
пароли. В противном случае прочитайте нижеизложенные рекоменда-
ции. Чтобы пароль надежно защищал ваши данные, важно придержи-
ваться следующих правил:
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• ваш пароль должен быть достаточно сложным, чтобы его нельзя 
было угадать, но таким, чтобы вы могли его запомнить (хотя бы со 
временем);

• чтобы пароль был надежным, он должен содержать более 8 сим-
волов;

• не следует использовать в качестве паролей свое имя или имена 
близких родственников, названия городов, улиц, телефонные но-
мера, дату своего рождения или их комбинации;

• чтобы повысить сложность пароля, используйте в нем символы 
верхнего и нижнего регистра и цифры;

• также нежелательно составлять пароли из символов, которые рас-
положены на клавиатуре подряд или рядом. Например, qwerty или 
qazwsx.

Чтобы создать эффективный пароль, лучше всего использовать гене-
раторы паролей — специальные программы, которые вы найдете во 
Всемирной паутине. Однако у таких паролей есть существенный недо-
статок: их невозможно запомнить с первого раза, приходится записы-
вать и первое время вводить по шпаргалке. 

С другой стороны, если вы не можете быстро запомнить пароль, зна-
чит, у посторонних не остается шансов угадать его, что, в принципе, вам 
и требуется.

Настройки безопасности операционной 
системы OS X

Инструменты, предназначенные для обеспечения безопасности си-
стемы,  сосредоточены в разделе Защита и Безопасность (Security & 
Privacy) окна параметров системы. Мы рассмотрим наиболее важные 
и полезные из них.

Чтобы настроить параметры безопасности, предпримите следующее.

1. Выполните команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) и в открывшемся окне Системные настройки (Sys-
tem Preferences) щелкните мышью по значку  Защита и Безопас-
ность (Security & Privacy). Откроется одноименное окно на вкладке 
Основные (General) (рис. 10.2).
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Рис. 10.2. Окно Защита и безопасность

 Все параметры, кроме Запрашивать пароль при выходе из режи-
ма сна или заставки (Require password to wake this computer from 
sleep or screen saver begins), действуют на каждую учетную запись 
на вашем компьютере.

2. Установите флажок Запрашивать пароль при выходе из режима 
сна или заставки (Require password to wake this computer from sleep 
or screen saver begins), если вы хотите, чтобы каждый раз при выхо-
де компьютера из спящего режима система запрашивала у пользо-
вателя его пароль. В раскрывающемся списке вы можете указать 
интервал, по истечении которого должен запрашиваться пароль. 
Например, выбрав значение 15 минут (15 minutes), вы настроите 
систему так, что пароль будет запрашиваться, только если компью-
тер провел в режиме сна или заставки не менее 15 минут.

3. Чтобы на заблокированном экране отображалось сообщение, уста-
новите флажок Показывать сообщение, если экран заблокиро-
ван (Show a message when the screen is locked) и введите текст со-
общения, нажав кнопку ниже.

4. Установите флажок Выключить автоматический вход (Disable au-
tomatic login), чтобы запретить автоматическую авторизацию в си-
стеме.
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5. Определите, какие приложения можно запускать на компьютере, 
установив переключатель Разрешить использование программ, 
загруженных из (Allow apps downloaded from) в одно из положений.

Нажав кнопку Дополнительно (Advanced), вы получите доступ к еще 
двум настройкам.

6. Если вы хотите задать время отсутствия активности пользователя, 
после которой система должна переходить в спящий режим, устано-
вите флажок Выходить спустя хх минут бездействия (Log out after 
xx minutes of inactivity) и укажите нужное значение в поле ввода. Те-
перь, если вы на некоторое время оставите компьютер без присмо-
тра, через указанное вами време система автоматически перейдет 
в режим сна и ограничит посторонним доступ к компьютеру.

7. Установите флажок Запрашивать пароль администратора для 
системных настроек (Require an administrator password to access 
system-wide preferences), тогда система не разрешит пользователям 
менять системные настройки без предварительного ввода пароля 
администратора.

О правилах работы с вкладкой FileVault окна Защита и безопасность 
(Security & Privacy) мы расскажем чуть позже. А элементы управления на 
вкладке Брандмауэр (Firewall) в этом окне вам придется настраивать, 
только если вы используете функцию совместного доступа к файлам 
и ресурсам через локальную сеть. Параметры совместного доступа на-
страиваются в окне Сеть (Sharing), а на вкладке Брандмауэр (Firewall) 
вы можете управлять активностью брандмауэра (включать и отключать), 
чтобы обеспечить другим пользователям доступ к вашему компьютеру.

Вкладка Конфиденциальность (Privacy) позволяет просмотреть и на-
строить приложения, запрашивающие доступ к основным приложени-
ям и компонентам операционной системы OS X, принять участие в про-
грамме улучшения качества продуктов, а также управлять службами 
геолокации.

Отключение автоматической авторизации в системе

Если на вашем компьютере активирована функция автоматической 
авторизации , система разрешит пользователю начать работу без вво-
да пароля, то есть он сможет автоматически авторизоваться в системе 
в момент запуска. Чтобы обеспечить своему компьютеру надежную за-
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щиту и оградить систему от посторонних, следует не только отключить 
функцию автоматической авторизации, но и обязательно выходить из 
системы, когда оставляете компьютер без присмотра, пусть и на корот-
кий промежуток времени. Тогда посторонние люди не смогут войти в си-
стему без ввода соответствующего пароля, даже если перезагрузят ваш 
компьютер. При желании вы можете заблокировать автоматическую ав-
торизацию для всех пользователей, зарегистрированных в системе.

Чтобы выключить функцию автоматического входа в систему, выполни-
те следующие шаги.

1. Войдите в систему под учетной записью пользователя с правами 
администратора.

2. Выполните команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) и в открывшемся окне Системные настройки 
(System Preferences) щелкните мышью по значку  Пользователи 
и группы (Users & Groups). Откроется одноименное окно.

3. Щелкните мышью по значку  и введите пароль администратора.

4. Щелкните мышью по пункту Параметры входа (Login Options), ко-
торый расположен под списком учетных записей.

5. Выберите в раскрывающемся списке Автоматический вход (Auto-
matic Login) пункт Выкл. (Disabled) (рис. 10.3).

Рис. 10.3. Отключение автоматической авторизации в системе



Обеспечение безопасности и защиты данных 351

Теперь потребуется вводить пароль пользователя каждый раз при вхо-
де в систему.

Есть еще один прием, который можно использовать: даже если вы 
единственный пользователь компьютера, создайте еще одну учетную 
запись со стандартными правами и в тех ситуациях, когда рядом есть 
посторонние люди, входите в систему под этой записью. При таком 
подходе никто не сможет войти в систему под учетной записью с пра-
вами администратора, внести существенные изменения в систему или 
сбросить (переустановить) пароль администратора.

Приложение Связка ключей

В настоящее время, когда мы используем Всемирную паутину не толь-
ко для того, чтобы читать новости и общаться с друзьями, но также 
совершаем в ней покупки, оплачиваем счета и используем различные 
сервисы, указывая личную информацию, возникает проблема — при-
ходится запоминать все большее количество паролей. Доступ к веб-
сайтам, FTP-сервисам, совместно используемым папкам, электронным 
платежным системам, счетам в банке и т. д. — для каждого из этих 
ресурсов требуется собственный пароль. Поэтому иногда вы можете 
обнаружить, что у вас не получается вспомнить пароль для доступа 
к какому-либо сайту во Всемирной паутине. Чтобы избавить вас от 
подобных неприятностей, разработано приложение Связка ключей 
(Keychain Access ). Суть подхода состоит в том, что при каждом входе 
в систему OS X вы вводите не только пароль к учетной записи, но и спе-
циальный код, благодаря которому система может определить, что это 
действительно вы. После вашей идентификации система в автомати-
ческом режиме заполняет все поля паролей, которые вы применяете 
для работы в сети: для веб-сайтов, сетевых дисков, беспроводной сети, 
FTP-программ и т. д.

Если вы используете приложение Связка ключей (Keychain Access ), мо-
жете смело забыть все пароли, кроме пароля к учетной записи, и ниче-
го фатального при этом не случится.

Остальные приложения в составе OS X при вводе новых паролей пред-
ложат вам сохранить их в связке. Например, веб-браузер Safari будет 
предлагать сохранить пароли для доступа к веб-страницам, приложе-
ние Дисковая утилита (Disk Utility) — к зашифрованному диску, почто-
вая программа Mail — к учетным записям и т. д. Кроме того, с помощью 
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приложения Связка ключей (Keychain Access ) можно хранить пароли 
к общему диску или папке в локальной сети.

Приложение Связка ключей (Keychain Access ) призвано обеспечить 
безопасное хранение информации, для доступа к которой вы исполь-
зуете логин и пароль. Программе можно доверять, у нее есть спосо-
бы надежно хранить все ваши данные. Кроме того, с помощью этого 
приложения можно создать защищенные связки ключей для хране-
ния номеров кредитных карточек, PIN-кодов, банковской, финансовой 
и прочей информации, которую нужно тщательно беречь, но при этом 
обеспечить к ней быстрый и удобный доступ.

Суть работы программы Связка ключей (Keychain Access ) заключается 
в том, что она формирует файл связки на основании вашего пароля 
к учетной записи. Каждый раз, когда вы будете входить в систему под 
своей учетной записью, та будет автоматически открывать соответ-
ствующую связку ключей (паролей). Чтобы гарантировать их защиту, 
для каждой учетной записи в вашей системе должен быть свой файл 
связки ключей. Ни в коем случае не добавляйте пароли всех пользова-
телей в один файл связки.

Чтобы воспользоваться возможностями приложения Связка ключей 
(Keychain Access ), выполните следующие действия.

1. Войдите в систему под своей учетной записью и запустите прило-
жение Finder.

2. Перейдите в папку Утилиты (Utilities) каталога Программы (Applica-
tions) и запустите утилиту Связка ключей (Keychain Access ). Откроет-
ся основное окно программы (рис. 10.4).

3. Чтобы просмотреть ту или иную связку ключей, дважды щелкните 
по ней мышью. Откроется окно, в котором нужно установить фла-
жок Показать пароль (Show password).

 Система предложит вам ввести пароль к связке ключей, то есть па-
роль на вход в систему. Если вы единственный пользователь, тогда 
этот пароль будет совпадать с паролем администратора. Теперь он 
отображается открытым текстом, при желании вы можете отредак-
тировать или полностью изменить его.

� Совет. Нажав кнопку , вы откроете окно, позволяющее сгенери-
ровать сложный пароль.
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Рис. 10.4. Основное окно приложения Связка ключей

Если вы хотите использовать все возможности приложения Связка 
ключей (Keychain Access ), внимательно ознакомьтесь с файлами спра-
вочной системы.

Шифрование данных при помощи 
инструмента FileVault

Функция FileVault  разработана с целью обеспечить дополнительную 
защиту персональных данных. Суть ее заключается в том, что в авто-
матическом режиме шифруются все объекты, которые вы храните на 
жестком диске своего компьютера, для чего используется надежный 
алгоритм. Это означает, что если вы никому не назовете ваш пароль 
для входа в систему, прочесть ваши файлы не сможет никто, кроме вас 
и root-пользователя (главного администратора компьютера). Функция 
FileVault выполняет свою работу в фоновом режиме и не требует боль-
шого количества системных ресурсов. Шифрование особенно пригодит-
ся владельцам ноутбуков: в этом случае если кто-то завладеет компью-
тером, то не сможет просмотреть ваши файлы, не зная нужного пароля.

Действия функции FileVault связаны с некоторыми моментами, о кото-
рых вам нужно знать.
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• Функция активна, пока вы не авторизованы в системе. Как только 
вы авторизуетесь, ваши файлы станут доступными и уже не будут 
столь надежно защищены. Поэтому не следует оставлять компью-
тер без присмотра. Блокируйте его, если требуется отойти.

• К вашим защищенным данным имеет доступ root-администратор. 
В операционной системе OS X у него практически неограниченные 
права, и с помощью мастер-пароля он легко обойдет защиту функ-
ции FileVault.

• Существует возможность, что другие пользователи смогут удалить 
ваши зашифрованные файлы, несмотря на то что функция FileVault 
будет включена. В ее обязанности входит только шифрование дан-
ных, а не защита их от удаления.

• Функция FileVault подчиняется тому, кто введет соответствующий 
пароль, поэтому, если кто-то узнает ваш пароль авторизации, он 
сможет обойти защиту функции.

• Если вы единственный пользователь и, следовательно, админи-
стратор в системе, то должны помнить свой пароль авторизации 
и мастер-пароль. Если вы не сможете авторизоваться в системе, 
останется только попрощаться со своими данными, очистить жест-
кий диск и начать все сначала.

• Чтобы вы могли использовать функцию FileVault, нужно создать 
раздел восстановления на загрузочном диске, где устанавливается 
система OS X, а не на внешнем накопителе. Если в процессе уста-
новки системы OS X вы не создадите раздел восстановления, то не 
сможете воспользоваться преимуществами функции FileVault.

Чтобы задействовать функцию FileVault, выполните следующие шаги.

1. Войдите в систему под учетной записью администратора.

2. Выполните команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preference) и в открывшемся окне щелкните мышью по значку 

 Защита и Безопасность (Security & Privacy).

3. Перейдите на вкладку FileVault открывшегося окна.

4. Щелкните мышью по значку  и введите имя и пароль администра-
тора, чтобы система разрешила вам настроить необходимые пара-
метры.
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5. Нажмите кнопку Включить FileVault (Turn On FileVault). Если на ва-
шем компьютере созданы учетные записи для нескольких пользо-
вателей, появится панель, на которой вам нужно указать, кому из 
них вы разрешите отключать защиту. Другими словами, вам следует 
сообщить системе, какие пользователи могут запускать компьютер 
(выводить из спящего режима или режима ожидания) самостоя-
тельно, каким требуется участие администратора или другого поль-
зователя с соответствующими правами (рис. 10.5).

Рис. 10.5. Панель выбора пользователей, которым разрешено отключать защиту

 Пользователи, которым вы не разрешили отключать защиту, смо-
гут войти в систему, только если пользователь с соответствующими 
правами запустит компьютер и введет свой пароль. Они смогут ра-
ботать с системой, пока компьютер не перейдет в режим ожидания 
или не будет выключен. После этого для дальнейшей работы снова 
потребуется участие пользователя с правами отключения защиты.

6. Нажмите кнопку Вкл. пользователя (Enable User) напротив учетных 
записей тех пользователей, которым вы доверяете. Затем нажмите 
кнопку Продолжить (Continue), чтобы вернуться к настройке функ-
ции FileVault.

7. Откроется панель с ключом восстановления, который следует ис-
пользовать в том случае, если вы (или другой пользователь с пра-
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вами отключения защиты) забудете пароль к своей учетной записи. 
Этот ключ позволит отключить защиту, войти в систему и восстано-
вить забытый пароль пользователя (рис. 10.6).

Рис. 10.6. Панель с ключом восстановления

 Обязательно сохраните ключ восстановления, так как без него вы 
не сможете войти в систему, если забудете пароль администрато-
ра. Ключ восстановления следует сохранить на внешнем носителе, 
распечатать или записать и убрать в надежное место. Также вы мо-
жете сохранить ключ восстановления на сервере компании Apple. 
Хранить его на диске вашего компьютера не имеет смысла, так как, 
если вы забудете пароль на вход в систему, то, соответственно, не 
сможете добраться и до ключа.

8. После того как вы сохраните ключ восстановления у себя, нажмите 
кнопку Продолжить (Continue), и система предложит вам сохра-
нить его на сервере компании Apple.

9. Если вы решите использовать сервер Apple, установите переклю-
чатель в положение Хранить ключ восстановления в Apple (Store 
the recovery key with Apple) и нажмите кнопку Продолжить (Con-
tinue). В противном случае установите переключатель в положе-
ние Не хранить ключ восстановления в Apple (Do not store the 
re covery key with Apple).
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10. Нажмите кнопку Продолжить (Continue).

 При выборе варианта Хранить ключ восстановления в Apple 
(Store the recovery key with Apple) появится панель с тремя раскры-
вающимися списками, в которых вам нужно выбрать вопросы и ука-
зать ответы, которые система использует для шифрования ключа 
восстановления перед его отправкой на сервер Apple. При выборе 
вопросов и вводе ответов учитывайте, что эти данные вам понадо-
бятся, если потребуется получить ключ восстановления с сервера 
компании Apple. Поэтому серьезно подходите к выбору вопросов 
и основательно продумывайте ответы. Для большей надежности 
желательно сохранить вопросы и ответы на них вне жесткого диска 
вашего компьютера (рис. 10.7).

Рис. 10.7. Заполнение ответов на три контрольных вопроса

11. Указав необходимые данные, нажмите кнопку Продолжить (Con-
tinue). Когда система предложит перезагрузить компьютер, нажми-
те кнопку Перезагрузить (Restart). После перезагрузки появится 
экран входа, введите свой пароль на вход. Система отобразит про-
цесс загрузки, показав вращающиеся шестеренки. Это означает, что 
функция FileVault включена.
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12. Чтобы на компьютере мог работать пользователь, у которого нет 
прав отключения защиты, войдите в систему под своей учетной за-
писью, а затем выполните команду меню  ⇒ Завершить сеанс 
(имя пользователя) (  ⇒ Log Out (user name)) и запустите учет-
ную запись пользователя, которому вы собираетесь предоставить 
свой компьютер.

Учитывайте, что при первом включении функции FileVault шифрование 
содержимого жесткого диска может занять несколько часов. Процесс 
будет проходить в фоновом режиме и не потребует много системных 
ресурсов, поэтому вы можете работать в обычном режиме во время 
первого шифрования. Несмотря на то что при первом шифровании до-
пускается переход в спящий режим, выход из системы и даже выключе-
ние компьютера, стоит подождать, пока функция закончит свою работу, 
чтобы гарантированно обезопасить все свои данные.

Если по какой-то причине вам потребуется выключить функцию 
File Vault, выполните команду меню  ⇒ Системные настройки 
(  ⇒ System Preference), щелкните мышью по значку  Защита 
и Безо пасность (Security & Privacy), перейдите на вкладку FileVault 
и нажмите кнопку Отключить FileVault (Turn Off FileVault). После того 
как вы введете главный пароль и нажмете кнопку OK, система приоста-
новит работу функции FileVault и начнется дешифровка диска. Чаще 
всего выключение функции FileVault связано с необходимостью изме-
нить ключ восстановления. Чтобы сделать это, по окончании дешиф-
ровки следует нажать кнопку Включить FileVault (Turn On FileVault), 
указать пользователей, которые могут самостоятельно разблокировать 
жесткий диск, после чего система создаст новый ключ восстановления 
и предложит отправить его на сервер компании Apple. Теперь никто не 
сможет использовать прежний ключ для разблокирования заново за-
шифрованного диска. А при запросе восстановления компания Apple 
предоставит только новый ключ на основании серийного номера и но-
мера записи, который вы отправите в запросе.

Резервное копирование 
и восстановление данных

При случайном удалении нужной папки, нарушении работы системы 
или других, более серьезных неполадках вы можете потерять много 
информации: фотографии, музыкальные коллекции, собрание люби-
мых фильмов, почтовые сообщения, списки контактов и т. д. Поэтому 
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время от времени необходимо создавать резервные копии данных. 
Многие пользователи пренебрегают этой возможностью, несмотря на 
то что неоднократно слышали о необходимости резервного копиро-
вания. 

Разумеется, операционная система OS X является надежным и стабиль-
ным продуктом, и, вероятнее всего, в течение длительного времени все 
будет в порядке. Но никто не может гарантировать, что в один далеко 
не прекрасный день вы, включив свой компьютер, не обнаружите, что 
часть важных файлов отсутствует и вы не можете их найти или в систе-
ме произошли какие-то нежелательные изменения.

Что же делать в такой ситуации? Если вы ранее все-таки создали ре-
зервную копию своей системы, то сможете легко восстановить поте-
рянную информацию. А если нет, не исключено, что данные утрачены 
навсегда. В системе OS X за резервное копирование отвечает прило-
жение Time Machine . Для его использования вам не нужно предприни-
мать каких-то серьезных усилий, программа выполняет все операции 
автоматически.

Итак, изучив эту главу, вы узнаете, что резервное копирование — это 
не нудный и сложный процесс, а необходимость, которая способна 
сильно облегчить вам жизнь в некоторых неприятных ситуациях. Вы 
также научитесь работать с приложением Time Machine, создавать ре-
зервную копию своего жесткого диска, восстанавливать потерянные 
файлы и управлять резервными копиями системы.

Создание резервных копий в приложении Time Machine

Альтернативой резервному копированию может стать запись фотогра-
фий, музыки, фильмов на чистые CD- или DVD-диски. Но такой способ 
оставит без защиты другие важные данные: установленные програм-
мы, настройки приложений и системы в целом, не говоря уже о файлах 
самой операционной системы.

Поэтому вам нужна надежная и полная система резервного копирова-
ния, которая способна работать в автономном режиме и возвращать 
вам потерянные или восстанавливать поврежденные данные. Такой 
системой как раз и является приложение Time Machine, ведь не зря его 
название дословно переводится как «машина времени». Оно выполня-
ет свою работу незаметно, не потребляя много системных ресурсов, но 
при этом надежно оберегает вас от потери данных.
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Единственное неудобство, которое способно доставить вам приложе-
ние Time Machine, — это необходимость приобрести второй жесткий 
диск. Только при его наличии автоматическое резервное копирова-
ние можно считать абсолютно надежным. В качестве второго жестко-
го диска допускается использовать внутренний жесткий диск, а также 
устройство Time Capsule или диск, подключенный через интерфейс 
USB, FireWire и Thunderbolt. Диск может быть подключен к компьютеру 
Mac напрямую или по сети. Если он разбит на разделы, можно исполь-
зовать один из них.

При необходимости вы можете создавать резервные копии данных 
с нескольких компьютеров на одном внешнем диске, если его объем 
достаточно велик для этого. Допускается хранить резервную копию на 
жестком диске, где уже записана другая информация, но все же жела-
тельно отдать в распоряжение приложения Time Machine пустой диск. 
Чем больше дискового пространства вы выделите приложению Time 
Machine, тем на более ранний срок сможете вернуться, когда потребу-
ется восстановить потерянные или поврежденные файлы.

Какой бы диск вы ни выбрали для резервного копирования, он обязан 
соответствовать одному условию — его объем должен быть больше, 
чем объем диска, который вы собираетесь копировать (в идеале — на-
много больше). В качестве диска для резервной копии нельзя исполь-
зовать iPod, внешний диск, подключенный через устройство AirPort Ex-
treme, или диск, отформатированный под Windows.

Когда вы подключите накопитель, операционная система OS X автома-
тически предложит вам использовать его в качестве резервного диска 
для приложения Time Machine.

Если запрос использования диска для резервного копирования не по-
явился, убедитесь, что диск исправен, правильно подключен и при 
необходимости очищен (отформатирован) с помощью приложения 
Дисковая утилита (Disk Utility). Чтобы отформатировать новый диск, вы-
полните следующие действия.

1. Перейдите в папку Утилиты (Utilities) каталога Программы (Applica-
tions) и запустите приложение Дисковая утилита (Disk Utility).

2. В открывшемся окне щелкните мышью по имени нужного диска, пе-
рейдите на вкладку Раздел диска (Partition), выберите пункт Mac 
OS Extended (журнальный) (Mac OS Extended (Journaled)) в рас-
крывающемся списке Формат (Volume Format) и нажмите кнопку 
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Применить (Apply). Система отформатирует указанный выбранный 
диск в заданном формате, после этого приложение Time Machine 
сможет с ним работать.

Кроме того, вы можете попробовать вручную указать диск в настрой-
ках программы Time Machine.

Для запуска и настройки программы Time Machine выполните следую-
щие действия.

1. Выполните команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) и в открывшемся окне Системные настройки (Sys-
tem Preferences) щелкните мышью по значку  Time Machine. От-
кроется окно приложения Time Machine.

2. Переместите переключатель слева в положение Вкл. (On). Откроет-
ся панель, предназначенная для выбора диска резервного копиро-
вания (рис. 10.8).

Рис. 10.8. Выбор диска резервного копирования

3. Выберите диск и нажмите кнопку Использовать диск (Use Disk). Вы 
увидите основное окно приложения Time Machine. Спустя две ми-
нуты начнется создание первой резервной копии (рис. 10.9).

Переключатель в левой части окна программы Time Machine позволя-
ет прекратить или возобновить работу приложения, кнопка Выбрать 
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диск (Select Backup Disk) — выбрать жесткий диск, на котором будут 
храниться резервные копии, а кнопка Параметры (Options) — изме-
нить некоторые настройки приложения, в том числе выбор папок, ре-
зервное копирование которых не требуется, и уведомление об удале-
нии старых версий.

Рис. 10.9. Процесс создания резервной копии

Когда вы делаете резервное копирование в первый раз, может потре-
боваться довольно много времени — час или более того, особенно 
если на жестком диске хранится много файлов, поскольку система пол-
ностью дублирует их все, включая файлы операционной системы OS X, 
установленные программы и домашние папки всех пользователей.

В процессе создания резервной копии программа Time Machine не 
шифрует и не сжимает данные, а копирует все файлы именно в таком 
виде, в каком они хранятся на вашем жестком диске. Это делается для 
того, чтобы обеспечить максимальную надежность и возможность пол-
ного восстановления информации.

Создав резервную копию, приложение Time Machine в дальнейшем будет 
автоматически проверять файлы компьютера раз в час. Если программа 
обнаружит, что вы изменили (создали, скопировали) какой-то файл, пап-
ку или установили настройку, она добавит эти объекты к резервной ко-
пии. Данный процесс не займет много времени и не потребует большого 
количества ресурсов, так как в этом случае приложение Time Machine 
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копирует только измененные объекты. Теперь, если произойдут какие-
то нежелательные события, под угрозой окажутся только те файлы и на-
стройки, с которыми вы работали в течение последнего часа.

Если нужно, вы можете управлять процессом копирования. В ситуа-
ции, когда необходимо сделать копию немедленно, удерживая клави-
шу ⌃, щелкните мышью по значку  на панели в верхней части экра-
на и в контекстном меню выберите пункт Создать резервную копию 
сейчас (Back Up Now). Если вы, наоборот, хотите временно остановить 
копирование, выберите в контекстном меню пункт Остановить ре-
зервное копирование (Stop Backing Up). Не забудьте позже снова за-
пустить процесс.

Результатом работы приложения Time Machine будут 24 почасовые ко-
пии в конце каждых суток на втором жестком диске. Чтобы сэкономить 
место на диске, по истечении суток программа Time Machine заменяет 
все эти копии одной ежедневной. Это значит, что на следующий день 
вы не сможете откатиться к 3 часам вчерашнего дня, но легко восста-
новите систему к состоянию, в котором она находилась по окончании 
прошедших суток. Точно так же в конце недели ежедневные резервные 
копии будут заменены еженедельной, а в конце месяца вы получите 
ежемесячную копию.

Идея заключается в том, что приложение Time Machine хранит не одну 
копию вашей информации, а несколько. Программа запоминает не 
только вчерашний состав каждой папки, но и что в ней хранилось на 
прошлой неделе, в прошедшем месяце и т. д. Приложение Time Ma-
chine продолжит создавать резервные копии вашего жесткого диска 
до тех пор, пока на диске, выбранном для резервного копирования, 
будет оставаться свободное место.

Когда пространство на резервном диске закончится, программа Time 
Machine известит вас об этом, а потом предложит выбрать, что делать 
дальше. Если вы решите продолжить сохранять копии на том же дис-
ке, программа начнет постепенно стирать старые резервные копии, 
освобождая место для новых. В ситуации, когда старые копии требу-
ется оставить, вам придется установить или выбрать другой жесткий 
диск (Time Capsule), на который программа сможет записывать новые 
резервные копии.

Если вы не хотите, чтобы программа предупреждала вас об удалении 
старых резервных копий, а также если желаете произвести некоторые 
другие настройки, выполните следующие действия.
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1. Откройте окно приложения Time Machine и нажмите кнопку Па-
раметры (Options). Откроется панель настроек программы 
(рис. 10.10).

Рис. 10.10. Панель настроек программы Time Machine

2. Сбросьте флажок Уведомлять, если старые резервные копии 
удалены (Warn when old backups are deleted). После этого каждый 
раз, когда на резервном диске будет заканчиваться свободное ме-
сто, приложение Time Machine станет автоматически стирать ста-
рые версии, не спрашивая разрешения.

По различным причинам у вас может возникнуть потребность исклю-
чить некоторые папки или файлы из области действия приложения 
Time Machine. Например, на вашем диске могут храниться конфиден-
циальные материалы, которые запрещено копировать, или вы захоти-
те сэкономить место на резервном диске и не делать копии фильмов 
и изображений.

3. Чтобы исключить материалы из резервной копии, нажмите кнопку 
 ниже списка исключенных объектов и выберите файлы или папки, 

которые приложению Time Machine не следует копировать. Также 
вы можете найти их значки в окне Finder и перетащить в список .

4. Если вы случайно добавили не те файлы или папки, воспользуйтесь 
кнопкой , чтобы убрать их из списка исключений.
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5. Нажмите кнопку Сохранить (Save).

В приложении Time Machine реализована функция создания локаль-
ных моментальных копий (снимков), которая позволяет сохранить 
копии ваших файлов на жестком диске компьютера. Так что теперь вы 
можете дополнить ими основные резервные копии приложения, кото-
рые храните на внешнем жестком диске или устройстве Time Capsule. 
Эта функция была разработана на тот случай, если вы случайно удалите 
файл в тот момент, когда внешний диск резервного копирования будет 
недоступен.

Эта функция запускается автоматически, как только вы активируете 
приложение Time Machine. После этого каждый час в фоновом режиме 
программа будет создавать локальные моментальные копии файлов 
и документов.

Ежедневные моментальные копии сохраняются каждые 24 часа, начи-
ная с момента включения или перезагрузки компьютера. Недельные 
моментальные копии сохраняются каждую неделю.

Когда свободного пространства на диске становится очень мало, вы-
полняется дополнительное сжатие.

• Когда свободное пространство составляет менее 20% от общего 
объема диска, приложение Time Machine удаляет моментальные 
копии, начиная с самых старых. Как только свободного простран-
ства становится более 20%, удаление копий прекращается.

• Если приложение Time Machine не может освободить достаточно 
пространства на диске (более 10% или 5 Гб), все моментальные ко-
пии удаляются и прекращается создание новых. Как только свобод-
ного пространства становится более 10% или 5 ГБ, создание копий 
возобновляется.

Чтобы узнать, сколько места на жестком диске занимают локаль-
ные моментальные копии, выполните команду меню  ⇒ Об этом 
Mac (  ⇒ About This Mac), нажмите кнопку Подробнее (More Info) 
и перейдите на вкладку Хранилище (Storage) (рис. 10.11).

Если вы заметите разницу между информацией о свободном простран-
стве жесткого диска на вкладке Хранилище (Storage) и теми же сведе-
ниями в приложении Finder, не удивляйтесь, это вполне нормальное 
явление. Так происходит потому, что приложение Finder при опреде-
лении свободного места не учитывает то количество дискового про-
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странства, которое используется для хранения локальных моменталь-
ных копий, так как система может в любой момент заменить их другими 
данными (другими копиями или их ежедневными и еженедельными 
архивами).

Рис. 10.11. Вкладка Хранилище окна Об этом Mac

Восстановление файлов и папок

Смоделируем неприятную ситуацию: приложение Time Machine регу-
лярно работает с вашими данными, вы спокойны за их сохранность, 
и вдруг с компьютером что-то случается. Вы не можете найти нужный 
файл, папку, или возникла необходимость вернуться к более ранней 
версии сохраненного документа. Сначала рекомендуется еще раз вни-
мательно поискать файл, может быть, вы его куда-нибудь перемести-
ли, это все-таки быстрее, чем начинать восстановление. Если поиск не 
принес результатов — пришло время испробовать возможности при-
ложения Time Machine по восстановлению данных.

Чтобы восстановить потерянные файлы , выполните следующие дей-
ствия.

1. Откройте окно для объекта, который вы хотите восстановить. На-
пример, если вы случайно удалили файл из папки Документы 
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(Docu ments), откройте этот каталог. Если вы хотите восстановить 
утерянное сообщение электронной почты, откройте папку с входя-
щими сообщениями в Mail.

2. Затем запустите приложение Time Machine, щелкнув мышью по 
значку  на панели в верхней части экрана, и в контекстном меню 
выберите пункт Войти в Time Machine (Enter Time Machine). Если 
в качестве резервного диска вы используете устройство AirPort 
Time Capsule или другой сетевой диск, подождите, пока приложе-
ние Time Machine подключится к нему.

3. Когда приложение Time Machine создаст подключение, вы сможете 
понаблюдать за происходящим на экране. У приложения Time Ma-
chine очень зрелищный режим восстановления, который «перене-
сет вас во времени», открывая разные варианты ваших папок и дис-
ков (рис. 10.12).

Рис. 10.12. Восстановление документа

 На переднем плане вы увидите множество окон, которые слов-
но растянулись назад во времени. Каждое показывает состояние 
файла в момент создания резервной копии. Вы можете просмо-
треть все локальные моментальные и резервные копии своих па-
пок и файлов, созданных приложением Time Machine, щелкая мы-
шью по временнó �й шкале, которая находится справа на рабочем 
столе.
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4. Чтобы восстановить найденный объект, выделите его и нажмите 
кнопку Восстановить (Restore), которую вы найдете в правом углу 
рабочего стола. Приложение Time Machine восстановит выбранный 
файл или папку в ту же локацию, в которой он находился ранее. 
Если папка, где ранее хранился объект, уже не существует, тогда 
программа Time Machine автоматически создаст ее.

Если вы попробуете восстановить файл или папку поверх существую-
щего, приложение Time Machine предложит вам сделать выбор: сохра-
нить обе версии файла или заменить последнюю резервной копией.

Использовать приложение Time Machine можно из многих программ, 
например, вы можете вернуть фотографии, адреса или почтовые со-
общения, находясь в приложении iPhoto, Контакты (Contacts) или Mail.

Чтобы восстановить тот или иной файл, откройте соответствующее при-
ложение, а затем запустите Time Machine. На экране вы увидите упро-
щенную копию основного окна приложения и сможете найти и восста-
новить необходимые файлы.

� Совет. Иногда требуется восстановить из резервной копии всю би-
блиотеку приложения iPhoto, полный файл программы Контакты 
(Contacts) или все письма почтовой программы Mail. Для этого нуж-
но нажать кнопку Восстановить все (Restore All).

Версии документов в приложении TextEdit

В операционной системе OS X у программы TextEdit есть полезная 
функция — в процессе работы приложение автоматически сохраняет 
версии — копии документов, которые вы редактировали. С помощью 
этих копий вы при необходимости сможете восстановить предыдущие 
версии документов. Когда вы работаете с документом, приложение 
Text Edit сохраняет версии каждый час, если вы вносите много измене-
ний, копии будут создаваться чаще. Как и приложение Time Machine, 
программа TextEdit периодически уменьшает количество версий: де-
лает их ежедневными и еженедельными, чтобы сэкономить место на 
жестком диске и упростить поиск нужной копии. Ежедневные копии 
приложение TextEdit хранит в течение месяца, затем группирует их 
в еженедельные версии и т. д. У этой программы есть одна особенность, 
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о которой вам нужно помнить: если вы удалите документ с жесткого 
диска компьютера, программа TextEdit удалит все его версии. После 
этого восстановить документ можно будет только при помощи прило-
жения Time Machine.

Чтобы использовать возможности приложения TextEdit, выполните 
следующие шаги.

1. Откройте в программе TextEdit файл, который требуется восстано-
вить.

2. Чтобы просмотреть версии документа, выполните команду 
меню Файл ⇒ Вернуть к объекту ⇒ Просмотреть все версии 
(File ⇒ Revert to ⇒ Browse All Versions). Вы увидите окно, показанное 
на рис. 10.12.

3. Выберите нужную версию на временнóй шкале, а затем нажмите 
кнопку Восстановить (Restore).

Таким образом вы вернетесь к раннему состоянию документа, сохра-
ненному программой TextEdit.



Глава 11
Настройка операционной системы OS X

Теперь, когда вы освоили принципы работы в операционной системе 
OS X Mavericks и основных приложениях, можно переходить к индиви-
дуальным настройкам самой системы и изменять ее так, как хочется. 
Возможности настройки системы  предлагают широкий выбор: вы мо-
жете изменить фон рабочего стола, внешний вид и положение панели 
Dock, параметры общего доступа, добавить принтер, увеличить или 
уменьшить размер значков и многое другое.

Изучив эту главу, вы узнаете о принципах индивидуальной настройки 
системы OS X: сможете настроить панель Dock и интерфейс приложе-
ния Finder, научитесь изменять параметры при помощи утилиты Си-
стемные настройки (System Preferences), а также настраивать принтеры 
и факсы.

Настройка панели Dock

Когда вы включаете компьютер, панель Dock по умолчанию находит-
ся в нижней части рабочего стола и имеет стандартный размер. Но это 
не означает, что она всегда должна выглядеть именно так. Вы можете 
легко изменить настройки панели Dock : отрегулировать ее размер или 
положение на рабочем столе, включить эффект увеличения значков 
или сделать так, что панель Dock будет появляться на рабочем столе 
только при определенных условиях.

Всего в операционной системе OS X для этих целей предусмотрено три 
способа: с помощью утилиты Системные настройки (System Preferen-
ces), используя команду Dock в меню  или контекстное меню самой 
панели.

Чтобы настроить панель Dock, выполните следующие действия.

1. Запустите утилиту Системные настройки (System Preferences), вы-
полнив команду меню  ⇒ Системные настройки (  ⇒ System 
Preferences).
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2. Щелкните мышью по значку  Dock, чтобы открыть окно с пара-
метрами панели (рис. 11.1).

Рис. 11.1. Настройки панели Dock

В окне Dock представлены элементы управления, при помощи кото-
рых вы можете изменить размеры панели, задействовать функцию 
увеличения значков при наведении на нее указателя мыши, настроить 
положение панели на рабочем столе, а также задать другие параметры 
ее настройки.

Чтобы изменить размер панели Dock, следует перемещать ползунковый 
регулятор Размер (Size) в нужном направлении. Чем ближе ползунок 
к значению Малый (Small), тем меньше будет размер панели, и наобо-
рот — при выборе значения Большой (Large) панель примет макси-
мальный размер (растянется по всей длине нижнего края эк рана).

� Совет. Изменить размер панели Dock можно и более простым пу-
тем: установите указатель мыши на светлую разделительную полосу 
на панели и, когда указатель мыши примет вид , нажав и удержи-
вая кнопку мыши, перетаскивайте его, пока панель не станет нуж-
ного размера.

Чтобы размер значков на панели Dock увеличивался при наведении 
указателя мыши, следует установить флажок Увеличение (Magnifica-
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tion). Чтобы указать, до какого размера должны увеличиваться значки, 
передвиньте ползунок. Если вы переместите его к параметру Макс. 
(Max), значки при наведении станут огромными, но это может быть не 
всегда удобно. Эффект увеличения показан на рис. 11.2.

Рис. 11.2. Увеличение значков на панели Dock

Переключатель Расположение на экране (Position on screen) допу-
скает три варианта размещения панели Dock на рабочем столе: Сле-
ва (Left), Внизу (Bottom) и Справа (Right). Установите переключатель 
в то положение, которое позволит расположить панель Dock наиболее 
удобным для вас способом.

Раскрывающийся список Убрать в Dock с эффектом (Minimize win-
dows using) позволяет выбрать один из двух визуальных эффектов при 
сворачивании окна — Джинн (Genie Effect) и Простое уменьшение 
(Scale Effect). Оцените оба эффекта, чтобы выбрать тот, какой понравит-
ся больше.

Флажок Убирать в Dock двойным нажатием на заголовок окна (Dou-
ble click a windows's bar to minimize) позволяет сворачивать открытые 
окна в панель Dock двойным щелчком мыши по заголовку.

Установите флажок Убирать окно в Dock в значок программы (Mini-
mize windows into application icon), если хотите, чтобы при минимиза-
ции окно сворачивалось в значок приложения на панели Dock, а не 
справа от разделительной полосы, как задано по умолчанию.

Флажок Анимировать открывающиеся программы (Animate open-
ing applications) установлен по умолчанию. Он разрешает для значков 
визуальные эффекты, которые сопровождают запуск приложений с па-
нели Dock. Если вам не нравятся прыгающие значки, сбросьте этот фла-
жок.

Флажок Автоматически показывать или скрывать Dock (Automati-
cally hide and show the Dock) позволяет управлять отображением па-
нели. Установите этот флажок, и она станет отображаться только при 
наведении указателя мыши, а все остальное время будет скрыта. Чтобы 
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панель Dock появилась на рабочем столе, нужно переместить указа-
тель мыши к той границе рабочего стола, вдоль которой она располо-
жена.

Флажок Показывать индикаторы открытых программ (Show indica-
tor lights for open applications) позволяет включить/отключить отобра-
жение подсвечивающего индикатора под значками запущенных при-
ложений на панели Dock.

После того как вы задали нужные настройки, закройте окно Систем-
ные настройки (System Preferences).

Если вы хотите поэкспериментировать с параметрами настройки пане-
ли в меню , выполните команду  ⇒ Dock, а затем выберите нуж-
ные параметры в открывшемся подменю.

Используя меню , вы сэкономите время при настройке некоторых 
параметров панели Dock. Например, при выборе ее расположения на 
рабочем столе или изменении параметров увеличения. Если вам пона-
добится открыть окно Dock, выберите пункт Настройки Dock (Prefe-
rences Dock).

Чтобы настроить панель Dock, используя параметры контекстного 
меню, щелкните мышью, нажав и удерживая клавишу ⌃, по раздели-
тельной полосе на панели Dock. Появится контекстное меню, в кото-
ром легко выбрать желаемые настройки (рис. 11.4).

Индивидуальную настройку панели Dock вы можете выполнять любым 
из перечисленных способов и при желании сочетать их. Попробуйте 
изменить настройки панели разными способами и выберите тот вари-
ант, который для вас удобнее и проще всего.

Настройка приложения Finder

В приложении Finder  предусмотрен целый ряд элементов управления, 
предназначенных для настройки программы, на вкладках окна На-
стройки Finder (Preferences Finder).

Чтобы задать параметры приложения Finder, выполните следующие 
действия.

1. Щелкнув мышью по пустому пространству рабочего стола или свер-
нув все приложения, выберите команду меню Finder ⇒ Настройки 
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(Finder ⇒ Preferences). Откроется окно Настройки Finder (Prefe-
rences Finder).

2. Перейдите на вкладку Основные (General) (рис. 11.3).

Рис. 11.3. Вкладка Основные окна Настройки Finder

Вкладка Основные (General) содержит элементы управления, при по-
мощи которых можно скрывать/отображать значки накопителей, выби-
рать начальную папку для нового окна Finder и управлять каталогами.

В группе элементов управления Показывать на Рабочем столе (Show 
these items on the Desktop) можно выбрать, значки каких накопите-
лей — жестких дисков, оптических и портативных устройств, а также 
серверов — вы хотите видеть на рабочем столе.

Раскрывающийся список Показывать в новых окнах Finder (New 
Finder window open) определяет, какая папка должна открываться при 
запуске нового окна Finder. По умолчанию задан параметр Мои фай-
лы (All my files), то есть когда вы запустите приложение, в новом окне 
Finder автоматически откроется содержимое указанной папки. Разре-
шается задать в качестве стартовой любую другую папку.

Если вам удобно, чтобы каждая папка открывалась не во вкладках, 
а в новом окне Finder, сбросьте флажок Открывать папки во вклад-
ках, а не в новых окнах (Open folders in tabs instead of new windows).
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Флажок Автоматически открывать папки и окна (Spring-load folders 
and windows) позволяет автоматически открывать папки, некоторое 
время удерживая указатель мыши поверх значка папки. Установите 
его, чтобы активировать эту функцию. При помощи ползункового ре-
гулятора Задержка (Delay) выберите интервал времени, то есть как 
долго следует удерживать указатель мыши поверх значка для открытия 
папки.

Чтобы выбрать цветовые теги для пометки файлов и папок, перейди-
те на вкладку Теги (Tags) в окне Настройки Finder (Preferences Finder). 
Используя ее элементы управления, вы можете переименовать теги, 
отключить ненужные, а также перетащить часто используемые в меню 
приложения Finder (рис. 11.4).

Рис. 11.4. Вкладка Теги окна Настройки Finder

Если требуется настроить внешний вид бокового меню окна Finder, 
перейдите на вкладку Боковое меню (Sidebar) окна Настройки Finder 
(Preferences Finder). Установите флажки напротив тех элементов боко-
вого меню, которые вы хотите видеть в окне Finder.

На последней вкладке — Дополнения (Advanced) — вы сможете вы-
полнить следующие настройки.
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• Флажок Показывать все расширения имен файлов (Show all file 
extensions) определяет, что все файлы в окне Finder видны с рас-
ширением.

• Флажок Предупреждать при изменении расширения (Show 
warning before changing an extension) относится к настройкам 
безопас ности. Если вы установите его, а затем решите самостоя-
тельно изменить расширение файла, появится предупреждающее 
сообщение. Этот флажок незаменим для тех, кто только начинает 
работать с операционной системой OS X, а также для администра-
торов, которые хотят обезопасить совместно используемые файлы 
от случайных (неумелых) действий других пользователей.

• Флажок Предупреждать при очистке Корзины (Show warning be-
fore emptying the Trash) также является элементом безопасности. 
Если установить его, система будет запрашивать у вас подтвержде-
ние перед тем, как очистить корзину.

• Когда установлен флажок Очищать Корзину необратимо (Secure 
Empty Trash), система при очистке корзины задействует специаль-
ный алгоритм, после которого восстановить файлы будет практиче-
ски невозможно.

• Раскрывающийся список При выполнении поиска (When perform-
ing a search) определяет, в каких местах будет выполняться поиск 
по умолчанию — искать по всему жесткому диску компьютера, в те-
кущей папке или в расположении, использовавшиеся при послед-
нем поиске.

Вы можете экспериментировать с параметрами окна Finder, пока не 
подберете сочетание настроек, которое сделает работу с ним наибо-
лее комфортной для вас.

Кроме индивидуальной настройки самого окна Finder, операционная 
система OS X позволяет задать параметры интерфейса. Например, из-
менить размер значков или текстовых меток, настроить порядок ин-
формационных колонок и вариант их отображения в окне и т. д. Раз-
личные параметры настройки будут доступны в зависимости от того, 
в каком режиме просмотра вы работаете в окне Finder.

Настройка режима просмотра в виде значков

В режиме просмотра в виде значков все файлы и папки выглядят как 
маленькие изображения. Чтобы изменить вид содержимого в окне 
Finder в данном режиме, выполните следующие действия.



Настройка операционной системы OS X 377

1. Запустите приложение Finder и нажмите кнопку  на панели ин-
струментов.

2. Выполните команду меню Вид ⇒ Показать параметры вида 
(View ⇒ Show View Options). Откроется окно с перечнем доступных 
параметров (рис. 11.5).

Рис. 11.5. Окно с настройками режима просмотра значков

Вы можете настроить приложение Finder таким образом, чтобы его 
окна всегда открывались в режиме просмотра значков, установив фла-
жок Всегда открывать как значки (Always open in icon view). Если при 
этом установить флажок Смотреть как значки (Browse in icon view), 
то при следующем открытии настраиваемого окна вид будет сброшен 
на установленный по умолчанию. Обратите внимание, что заголовок 
окна с настройками соответствует заголовку окна Finder, то есть име-
ни папки, которая открыта в данный момент. Это говорит о том, что 
ваши настройки система применит именно к содержимому активной 
папки.

В раскрывающемся списке Упорядочить (Arrange by) выберите способ 
выравнивания значков в окне Finder, а в раскрывающемся списке Со-
ртировать (Sort by) — порядок их сортировки. Например, если указать 
параметр По имени (Name), все файлы, которые вы поместите в актив-
ную папку, система отсортирует по именам в алфавитном порядке.
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Перемещая ползунковый регулятор Размер значка (Icon size), вы лег-
ко измените размер значков в окне Finder. Чем ближе ползунок к ле-
вому краю шкалы, тем меньше будут значки, и наоборот, чем дальше 
вправо — тем крупнее они станут.

Ползунковый регулятор Размер сетки (Grid spacing) позволяет регу-
лировать расстояние между значками. Чем ближе ползунок к левому 
краю шкалы, тем компактнее они располагаются в окне Finder.

В раскрывающемся списке Текст (Text size) можно увеличить или 
уменьшить размер шрифта имен файлов. При помощи переключателя 
Поместить имя (Label position) выберите способ их выравнивания от-
носительно значка — Внизу (Bottom) или Справа (Right).

Если вы хотите видеть не только текстовые метки, но и информацию 
о значках, установите флажок Показывать свойства (Show item info). 
Теперь вы будете знать, сколько элементов содержится в каждой папке 
(рис. 11.6).

Рис. 11.6. Действие флажка Показывать свойства

Если вы установите флажок Показывать вид значков (Show icon pre-
view), файлы графических и некоторых других форматов будут отобра-
жать свое содержимое.

В группе элементов управления Фон (Background) вы можете выбрать, 
на каком фоне должны отображаться значки. Если установить пере-
ключатель в положение Цветной (Color), справа от параметра появит-
ся индикатор цвета. Щелкнув по нему, вы откроете окно Цвета (Colors), 
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в котором сможете выбрать любой оттенок. Если установить переклю-
чатель в положение Картинка (Picture), вы сможете выбрать в качестве 
фона графический файл, который нужно будет перетащить на появив-
шийся индикатор.

Если вы захотите, чтобы ваши индивидуальные настройки распростра-
нялись на все окна Finder, а не только на активное, перед тем как за-
крыть окно, нажмите кнопку Использовать как стандартные (Use as 
Default).

Настройка режима просмотра в виде списка

В режиме просмотра в виде списка все значки в окне Finder отобра-
жаются в виде списка. Чтобы изменить вид содержимого в окне Finder 
в данном режиме просмотра, вам нужно выполнить следующие дей-
ствия.

1. Запустите приложение Finder и нажмите кнопку  на панели ин-
струментов.

2. Затем выполните команду меню Вид ⇒ Показать параметры вида 
(View ⇒ Show View Options). Откроется окно с перечнем доступных 
параметров (рис. 11.7).

Рис. 11.7. Окно с настройками режима просмотра списка
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Помимо элементов управления, уже описанных в предыдущем разде-
ле, вы найдете здесь и уникальные для данного режима просмотра.

Переключатель Размер значка (Icon size) позволяет изменить разме-
ры значков.

Также разрешается выбрать, какие колонки вы хотите видеть при рабо-
те с папками в окне Finder. Установите флажки напротив названий тех 
колонок в группе Показать колонки (Show Columns), которые должны 
отображаться в окне.

Если вы установите флажок Относительные даты (Use relative dates), 
тогда в столбцах Дата создания (Date Created) и Дата изменения (Date 
Modified) система укажет не точные даты создания или изменения фай-
лов и папок, а относительные: сегодня (today), вчера (yesterday) и т. д.

Если вы хотите видеть размер не только документов и файлов, но и па-
пок, установите флажок Вычислять все размеры (Calculate all sizes). 
Но обратите внимание, что на определение размеров всех папок си-
стеме может понадобиться некоторое время, это может сказаться на 
скорости открытия новых окон Finder на компьютерах с низкой произ-
водительностью.

Настройка режима просмотра в виде колонок

В режиме просмотра в виде колонок все значки отображаются списком 
с дополнительной областью просмотра. Чтобы изменить вид содержи-
мого в окне Finder в данном режиме, нажмите кнопку  на панели 
инструментов.

Помимо элементов управления, уже описанных ранее, вы увидите фла-
жок Колонка просмотра (Show preview column). Сбросьте его, если 
вам не нужна область предварительного просмотра в окне Finder.

Настройка режима просмотра в виде CoverFlow 

При просмотре содержимого папок в режиме CoverFlow  файлы отобра-
жаются как набор слайдов. Чтобы изменить вид содержимого в окне 
Finder в данном режиме просмотра, вам нужно нажать кнопку  на 
панели инструментов .

Элементы управления для настройки данного режима такие же, как для 
режима просмотра в виде списка.
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Настройка приложения Центр уведомлений

Приложение Центр уведомлений (Notification center) отображает 
в верхнем правом углу экрана напоминания и различные системные 
уведомления, не мешая при этом работе пользователя. Также вы може-
те просмотреть весь список актуальных уведомлений и напоминаний, 
нажав кнопку .

Чтобы настроить параметры приложения Центр уведомлений (Notifica-
tion center), выполните следующие действия.

1. Откройте окно Системные настройки (System Preferences), щелк-
нув мышью по значку  на панели Dock.

2. В открывшемся окне щелкните мышью по значку . Откроется 
окно Уведомления (Notifications).

� Совет. Для настройки уведомлений вы также можете нажать кноп-
ку , расположенную в нижнем правом углу панели приложения 
Центр уведомлений (Notification center).

В левой части окна вы увидите список программ, которые используют 
приложение Центр уведомлений (Notification center). Щелкнув мышью 
по названию приложения, вы увидите элементы управления для на-
стройки его уведомлений и напоминаний в правой части окна. В зави-
симости от выбранной программы параметры могут отличаться друг от 
друга, но у большинства приложений они схожи (рис. 11.8).

• Стиль напоминаний (Alert Style) — выберите режим отображения 
уведомлений в верхнем правом углу экрана. Нет (None) — уведом-
ления не станут отображаться, Баннеры (Banners) — уведомления 
будут появляться и исчезать спустя короткий промежуток времени, 
Предупреждения (Alerts) — уведомления станут появляться, но их 
необходимо будет закрывать вручную.

• Показывать уведомления на заблокированном экране (Show 
notifications on lock screen) — если флажок установлен, то уведом-
ления станут отображаться на экране блокировки.

• Показывать в Центре уведомлений (Show in Notification Cen-
ter) — в раскрывающемся списке вы можете указать количество 
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отображаемых последних уведомлений соответствующего прило-
жения на панели. Если флажок сброшен, то его уведомления не бу-
дут отображаться в списке.

• Наклейка на значке (Badge app icon) — если флажок установлен, 
то на панели Dock на значке приложения будет показано количе-
ство уведомлений.

• Воспроизводить звуковой сигнал при получении уведомлений 
(Play sound for notification) — если флажок установлен, при появ-
лении уведомления будет воспроизводиться звуковой сигнал. Если 
флажок сброшен, то уведомления вновь станут отображаться без 
звукового сопровождения.

Рис. 11.8. Окно с настройками уведомлений

Чтобы изменить порядок расположения разделов в списке, выбери-
те соответствующий пункт в раскрывающемся перечне Сортировка 
в Центре уведомлений (Sort Notification Center).

• Чтобы разделы располагались в списке в нужном вам порядке, вы-
берите пункт Вручную (Manually) и в левой части окна перетащите 
мышью каждый из них в выбранную позицию.
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• Если вы хотите, чтобы разделы отображались по дате соответствую-
щих уведомлений, выберите пункт Хронологически (By Time). По-
сле этого первым в списке будет отображаться тот раздел, уведом-
ления которого наиболее актуальны в данный момент.

Помимо настройки уведомлений, отображаемых программами, вы мо-
жете изменить другие параметры данного приложения. По умолчанию 
на его панели показаны кнопки, предназначенные для быстрой отправ-
ки сообщений и публикаций в социальных сетях, таких как LinkedIn, 
Twitter и Facebook. Если вы хотите отключить отображение этих кно-
пок, выберите пункт Кнопки «Поделиться» (Share Buttons) и сбросьте 
флажок Показывать кнопки экспорта в Центре уведомлений (Show 
share buttons in Notification Center). Если компьютер остается вклю-
ченным на ночь, вы можете установить автоматическое включение 
и отключение режима «Не беспокоить». В этом режиме уведомления 
и напоминания не станут отображаться на экране, а звуковые сигналы 
будут отключены. Чтобы установить автоматическое включение и от-
ключение режима «Не беспокоить», выполните следующие шаги.

1. Установите флажок Включить «Не беспокоить» (Turn on Do Not 
Disturb) (рис. 11.9).

Рис. 11.9. Окно с настройками режима «Не беспокоить»
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2. В поле ввода С (From) установите время включения режима «Не бес-
покоить».

3. В поле ввода До (To) установите время его отключения.

Если установлен флажок Видеоповтор на телевизоры и проекторы 
(When mirroring to TVs and projectors), то режим «Не беспокоить» будет 
автоматически включаться в то время, когда изображение дублируется 
на экраны телевизоров или проекторов.

4. Вы можете сделать исключение для определенных вызовов Face-
Time во время включенного режима «Не беспокоить». Для этого 
установите флажок Разрешить вызовы FaceTime (Allow FaceTime 
calls from) и в расположенном справа раскрывающемся списке вы-
берите группу людей, на которых ограничения режима не будут рас-
пространяться. По умолчанию эта функция касается только первого 
вызова. Если вы хотите отключить режим для всех вызовов, уста-
новите флажок Разрешить повторные вызовы (Allow repeated 
calls).

Чтобы быстро включить или отключить режим «Не беспокоить», открой-
те панель приложения Центр уведомлений (Notification center) и с по-
мощью мыши или жеста смахните панель вниз. Вы увидите переклю-
чатель Не беспокоить (Do Not Disturb), управляя которым вы сможете 
включить или отключить режим «Не беспокоить» в любой момент.

Настройка рабочего стола

Кроме настройки панели Dock и окна Finder в OS X у вас есть воз-
можность по отдельности изменить параметры отображения объек-
тов на рабочем столе . Для этого надо щелкнуть мышью по рабочему 
столу и выполнить команду меню Вид ⇒ Показать параметры вида 
(View ⇒ Show View Options). В появившемся окне Рабочий стол (Desk-
top) вы увидите те же элементы управления, с которыми работали при 
настройке интерфейса приложения Finder в режиме просмотра знач-
ков. Например, можно увеличить или уменьшить размеры значков, 
которые вы поместили на рабочий стол, или изменить размер шрифта 
имен файлов и папок, задать параметры предварительного просмотра, 
выровнять значки по сетке рабочего стола и выбрать тип сортировки.

Чтобы не открывать окно Рабочий стол (Desktop) каждый раз, ког-
да вы хотите изменить настройки рабочего стола, удерживая клави-
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шу ⌃,щелкните мышью по любой незанятой области на нем и в от-
крывшемся контекстном меню выберите нужный пункт. Кстати, там же 
есть команда, при помощи которой вы сможете быстро изменить фон 
рабочего стола.

Настройка приложения Mission control

Если требуется настроить приложение Mission Control, выполните коман-
ду меню  ⇒ Системные настройки (  ⇒ System Preferences) и в от-
крывшемся окне Системные настройки (System Preferences) щелкните 
мышью по значку . Откроется окно Mission Control (рис. 11.10).

Рис. 11.10. Окно Mission Control

Рассмотрим элементы управления в этом окне:

• используя элементы управления в верхней части окна, вы можете 
настроить приложение Mission Control;

• используя раскрывающиеся списки слева, вы можете назначить со-
четания клавиш для действий;
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• используя раскрывающиеся списки справа, вы сможете сделать 
клавиши функционально эквивалентными дополнительным кноп-
кам многокнопочной мыши;

• в левом нижнем углу находится кнопка Активные углы (Hot cor-
ners), при помощи которой можно превратить углы рабочего стола 
в активные области, то есть, если вы наведете указатель мыши на 
один из этих углов, система выполнит определенное действие.

При желании можно настроить соответствующие параметры и исполь-
зовать оба способа активации функций, в одних ситуациях нажимать 
сочетания клавиш, в других — перемещая указатель или щелкая той 
или иной кнопкой мыши.

Для настройки приложения Mission Control доступны следующие эле-
менты управления.

• Если вы хотите убрать приложение Dashboard из окна программы 
Mission Control, сбросьте флажок Показать Dashboard как про-
странство (Show Dashboard as a Space). В этом случае для доступа 
к приложению Dashboard можно использовать программу Launch-
pad или клавишу F12.

• Если вы хотите, чтобы система самостоятельно отсортировала ми-
ниатюры рабочих столов по частоте их использования, установи-
те флажок Автоматически использовать последнее положение 
пространств (Automatically rearrange spaces based on most re-
cent use).

• Если вы хотите, чтобы при переходе в другое приложение система 
автоматически меняла также и рабочий стол, установите флажок 
При переключении на программу переключаться в простран-
ство с открытыми окнами программы (When switching to an ap-
plication, switch to a space with open windows for the application). 
В этом случае, если вы находитесь на первом рабочем столе и на-
жмете сочетание клавиш �+�, чтобы перейти в текстовый редак-
тор, открытый на третьем, система автоматически перейдет на тре-
тий рабочий стол. Если флажок сброшен, тогда описанное действие 
приведет к тому, что перед вами появится окно текстового редакто-
ра, но вы останетесь на том же рабочем столе.

• При одновременной работе с несколькими окнами разных про-
грамм можно сгруппировать их при переходе в режим Mission Con-
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trol. Для этого установите флажок Сгруппировать окна по про-
граммам (Group windows by application).

• Если вы используете функцию Spaces для разбиения рабочего про-
странства на логические области при использовании нескольких 
мониторов, можно настроить отдельные области для каждого экра-
на, установив флажок Мониторы с разными пространствами 
(Displays have separate Spaces).

• Если вы хотите назначить действиям новые сочетания клавиш, вос-
пользуйтесь списками слева в центральной области окна Mission 
Control. Раскрывающиеся списки Mission Control, Окна актив-
ной программы (Application windows), Показать Рабочий стол 
(Desktop) и Показать Dashboard (Dashboard) соответствуют соче-
таниям клавиш ⌃+↑, ⌃+↓, F11 и F12. В каждом раскрывающемся 
списке вы можете выбрать любые функциональные клавиши — F1, 
F2, F3 и т. д. Чтобы назначить сочетание клавиш, вам нужно нажать 
клавишу-модификатор (⌃, �, ⌥, � или fn), а затем выбрать функ-
циональную клавишу. Выбранное сочетание появится в раскрыва-
ющемся списке. Например, ⌥+F1.

• Если вы хотите использовать кнопки мыши для активации функций, 
которые вызывают сочетания клавиш ⌃+↑, ⌃+↓, F11 и F12, вам по-
надобится специальная многокнопочная мышь. Тогда в правой части 
окна программы в каждом раскрывающемся списке будут доступны 
названия кнопок мыши. При помощи этих списков можно назначить 
различным кнопкам мыши запуск соответствующих функций.

• Чтобы использовать углы рабочего стола при работе с приложени-
ем Mission Control, нажмите кнопку Активные углы (Hot corners), 
открывающую одноименную панель. Каждый раскрывающийся 
список на ней соответствует тому же углу рабочего стола. Напри-
мер, список в левом верхнем углу панели определяет параметры 
для левого верхнего угла рабочего стола. В каждом перечне вы мо-
жете выбрать один пункт, задающий реакцию системы.

— Пункт Mission Control. Выбрав его, вы сможете запускать это 
приложение, наведя указатель мыши на соответствующий угол 
рабочего стола.

— Пункт Окна программ (Application Window) — система будет 
выделять окна активного приложения, как при нажатии сочета-
ния клавиш ⌃+↓.
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— Пункт Рабочий стол (Desktop) — система скроет все окна от-
крытых приложений, как при нажатии клавиши F11.

— Пункт Dashboard — запустится приложение Dashboard.

— Пункт Центр уведомлений (Notification Center) — откроется 
центр уведомлений.

— Пункт Launchpad — запустится приложение Launchpad.

— Пункт Запустить заставку (Start Screen Server) — запустится 
скринсейвер.

— Пункт Отключить заставку (Disable Screen Server) — система 
отключит скринсейвер и загрузит рабочий стол.

— Пункт Перевести монитор в режим сна (Put Display to Sleep) — 
монитор вашего компьютера перейдет в спящий режим. Это 
очень удобно, если компьютер нужно ненадолго оставить без 
присмотра в помещении, где есть посторонние.

— Если вы выберете для какого-то угла пункт — (прочерк), система 
сделает этот угол неактивной областью и при наведении на нее 
указателя мыши ничего не будет происходить.

Вы можете выбрать любой пункт для каждого из углов рабочего стола 
по своему усмотрению. Новые настройки приложения Mission Control 
вступят в силу сразу же, как только вы закроете окно Mission Control.

Настройка приложения Dashboard
Кроме программ, файлов и документов, в операционной системе OS X 
вы найдете еще одну категорию объектов — виджеты (widgets). Видже-
тами  называют небольшие приложения, встроенные в операционную 
систему и обеспечивающие быстрое решение определенного круга за-
дач. Если вы нажмете клавишу F12, все виджеты, установленные в си-
стеме по умолчанию, появятся на рабочем столе вашего компьютера 
поверх других окон. 

Управлять виджетами вы можете при помощи приложения Dashboard  
или, как его еще называют, панели виджетов. Последние бывают разных 
типов, их можно добавлять или скрывать, настраивать быстрый доступ 
к наиболее востребованным виджетам, выполнять их индивидуальную 
настройку и т. д.
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Возможности приложения Dashboard

Приложение Dashboard позволяет настроить быстрый доступ к нужной 
именно вам информации, поэтому вы можете задавать содержимое па-
нели виджетов по своему усмотрению. Вся информация в приложении 
Dashboard отображается в окнах выбранных виджетов.

Панель виджетов может выглядеть по-разному — внешний вид зави-
сит от того, изменяли ли вы ее содержимое (рис. 11.11). По умолчанию 
на панели вы найдете простой калькулятор, сводку погоды, календарь 
и часы. Чтобы увидеть панель виджетов, нажмите клавишу F12.

Рис. 11.11. Интерфейс настроенного приложения Dashboard

Виджеты — это не совсем приложения, потому что с их помощью нель-
зя создавать файлы, и у них нет соответствующих значков на панели 
Dock. Однако их нельзя считать и документами, так как виджеты нель-
зя изменить, присвоить им имя или сохранить. Больше всего виджеты 
напоминают небольшие веб-страницы или веб-приложения, ведь на 
них отображается информация, значительную часть которой система 
загружает из Всемирной паутины. Кроме того, виджеты создаются при 
помощи языков веб-программирования — HTML и JavaScript. Именно 
потому, что данные для них загружаются из Всемирной паутины, ино-
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гда приходится немного подождать, пока все запущенные виджеты об-
работают полученную информацию.

При быстром соединении с Интернетом они появятся на экране через 
секунду после того, как вы активизируете приложение Dashboard. Все 
виджеты можно условно разделить на три группы.

• Информационные . Они обеспечат вам доступ к необходимым 
данным, представленным в Интернете. Используя такие виджеты, 
можно просматривать сведения о различных внешних событиях: 
погоде на текущий день в любой точке земного шара, расписании 
авиарейсов, курсах валют или ценных бумаг, биржевых индексах 
и т. д. Чтобы информационные виджеты работали корректно, ваш 
компьютер должен быть подключен к Интернету. Виджеты могут 
выглядеть по-разному в зависимости от того, какую функцию они 
выполняют (рис. 11.12).

Рис. 11.12. Пример виджета, который отображает информацию о рынке ценных бумаг

• Прикладные . Такие виджеты взаимодействуют с различными при-
ложениями, установленными на вашем компьютере. Их основная 
задача — предоставить вам быстрый и удобный доступ к наиболее 
важным функциям определенного приложения. Например, виджет, 
работающий на основе календаря, помогает быстро узнать сегод-
няшнее число, день недели и просмотреть заметки, которые вы соз-
дали в приложении Календарь (Calendar) (рис. 11.13).

Рис. 11.13. Виджет Календарь
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• Дополнительные . Это небольшие самостоятельные утилиты, ко-
торые выполняют разнообразные функции. Самые распространен-
ные из них — часы, калькулятор, таймеры, конвертеры и т. п. Эти 
виджеты не работают с другими приложениями на вашем компью-
тере, но многим из них требуется подключение к Интернету. Напри-
мер, виджет, показанный на рис. 11.14, отображает актуальный про-
гноз погоды.

Рис. 11.14. Пример дополнительного виджета

Вы в любой момент можете удалить виджеты, которые вам не нужны, 
добавить новые, настроить или изменить их положение относительно 
друг друга.

Добавление новых виджетов 
и удаление ненужных

Если вы хотите добавить  в состав панели виджетов новые элементы, сна-
чала запустите приложение Dashboard, а затем нажмите кнопку , кото-
рую вы найдете в левом нижнем углу экрана. Вы увидите все доступные 
виджеты (рис. 11.15).

Чтобы добавить понравившийся виджет в приложение Dashboard, до-
статочно щелкнуть по нему мышью или перетащить его значок на ра-
бочий стол.

Если вы решили удалить какой-то виджет с поверхности рабочего сто-
ла Dashboard, нажмите кнопку , расположенную в левом нижнем 
углу экрана, а затем кнопку , которую вы найдете в левом верхнем 
углу виджета.

Если вам нужно переместить виджет, перетащите его при помощи 
мыши в нужную позицию. 

Приложение Dashboard запомнит ваши настройки и при следующем 
запуске разместит виджеты в указанном порядке.
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Рис. 11.15. Виджеты, установленные в операционной системе OS X по умолчанию

Управление виджетами

Каждый виджет выполняет различные функции  и содержит различные 
настройки. Если хотите освоиться со всеми виджетами, представленны-
ми в приложении Dashboard, у вас один путь — экспериментировать. 
Добавляйте виджеты, оценивайте их работу и ценность результатов, 
а также изучайте возможные настройки. Увидеть доступные параме-
тры можно, щелкнув мышью по информационной кнопке, помеченной 
символом i. Чаще всего она не видна, пока вы не подведете указатель 
мыши достаточно близко, но обычно эта кнопка находится в нижнем 
правом углу виджета.

Чтобы убедиться в том, что для виджета доступна информационная 
кнопка, наведите на него указатель мыши. Когда информационная 
кнопка появится, щелкните по ней мышью. В нашем примере щелчок 
по информационной кнопке открывает окно с настройками виджета, 
который показывает погоду в выбранном городе (рис. 11.16).

В окне с настройками виджетов заданы параметры, которые система 
использует по умолчанию. Если вам требуется изменить настройки, 
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укажите в раскрывающихся списках нужную информацию, а затем на-
жмите кнопку Готово (Done), чтобы применить новые параметры и за-
крыть окно с настройками.

Рис. 11.16. Настройки виджета

К управлению виджетами можно отнести одновременное отображение 
нескольких экземпляров одного виджета. Несколько копий может по-
надобиться в различных ситуациях. Например, если требуется узнать 
прогноз погоды в разных регионах страны (мира) или нужно следить 
за несколькими авиарейсами и т. д.

Поместить несколько виджетов одного вида в приложение Dashboard 
проще простого: щелкните по нужному виджету мышью столько раз, 
сколько копий вы хотите видеть на экране рабочего стола. Вам остает-
ся только перетащить их в нужные позиции.

Настройка печати

Операционная система OS X способна распознать и автоматически на-
строить большинство принтеров и факсов, можно задавать для при-
ложений дополнительные параметры печати и при необходимости 
совместно использовать принтеры в локальной сети. Кроме этого, вы 
можете самостоятельно установить новый принтер, изменить пред-
варительные настройки драйверов принтера и параметры печати от-
дельных приложений, наладить совместное использование принтеров 
в сети, настроить отправку и прием факсов.

Установка принтера

Первое, что вам нужно сделать при установке нового принтера,  — под-
ключить его к вашему компьютеру и источнику питания. Затем следует 
в обязательном порядке установить программное обеспечение, кото-
рым комплектуется принтер, чтобы у вас был доступ ко всем специали-
зированным возможностям устройства. Если вы считаете нужным об-
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новить драйверы, посетите веб-сайт производителя, на котором можно 
бесплатно загрузить их актуальные версии. 

После этого нужно попробовать распечатать какой-либо документ 
и проверить, соответствуют ли доступные параметры печати заявлен-
ным возможностям принтера.

Для установки принтера выполните следующие действия.

1. Прежде всего убедитесь, что принтер подсоединен к вашему ком-
пьютеру, проверьте, правильно ли подключены кабели и обеспече-
но ли электропитание принтера. Затем проверьте, нажата ли кнопка 
включения на устройстве. Если все подключено правильно, пере-
ходите к следующему шагу.

2. Откройте окно Системные настройки (System Preferences), щелк-
нув мышью по значку  на панели Dock.

3. В открывшемся окне щелкните мышью по значку . Откроется окно 
Принтеры и сканеры (Print & Scan).

4. В левом нижнем углу окна нажмите кнопку .

 Откроется окно Добавить (Add), в котором система перечислит 
все принтеры, которые она смогла обнаружить. Если устройство 
правильно подсоединено и включено, его имя будет в этом списке 
(рис. 11.17).

5. Щелкните мышью по имени принтера, который вы хотите выбрать. 
При необходимости выберите драйвер принтера в раскрывающем-
ся списке Использовать (Use).

� Примечание. Если отображается сообщение, что драйвер не мо-
жет быть предоставлен компанией Apple, обратитесь на официаль-
ный сайт производителя принтера, чтобы загрузить драйвер для 
операционной системы OS X. После установки драйвера он станет 
доступен в раскрывающемся списке Использовать (Use) окна До-
бавить (Add).

6. Нажмите кнопку Добавить (Add), после этого в раскрывающемся 
списке Принтер (Printer) появится имя выбранного принтера, мож-
но печатать.
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Рис. 11.17. Список обнаруженных принтеров

Это самый простой способ подключения принтера. Если же принтер 
все-таки не работает так, как ожидалось, вспомните, не было ли про-
блем при установке драйверов, и проверьте, в тот ли порт подключен 
принтер. Также возможно, что нарушена целостность кабелей. Обрати-
тесь за помощью к системному администратору или продавцу в мага-
зине, где вы приобрели принтер.

Рис. 11.18. Окно Принтеры и сканеры
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Если у вас несколько принтеров, тогда придется установить драйверы 
и настройки печати для каждого из них. В итоге вы получите список 
всех доступных принтеров, с которыми может работать ваш компью-
тер. Когда вам понадобится использовать другой принтер, достаточно 
сообщить компьютеру, с каким принтером следует взаимодействовать 
в данный момент. Все доступные принтеры (и сканеры) отображаются 
в окне Принтеры и сканеры (Print & Scan) (рис. 11.18).

Специализированные функции принтера 
и возможности приложений

Рекомендуется всегда устанавливать программное обеспечение, по-
ставляемое в комплекте с вашим принтером, даже если операционная 
система предлагает установить драйверы самостоятельно. Так вы га-
рантированно сможете использовать дополнительные функциональ-
ные возможности принтера : выбирать тип бумаги, указывать качество 
печати, настраивать цветопередачу и т. д. К тому же некоторые при-
ложения при выводе на печать предлагают свой список расширенных 
возможностей, который тоже можно использовать.

Чтобы получить доступ к специализированным настройкам печати, вы-
полните следующие действия.

1. Отправьте документ (файл) на печать, выполнив команду меню 
Файл ⇒ Напечатать (File ⇒ Print) или нажав сочетание кла-
виш �+P.

2. На открывшейся панели нажмите кнопку Подробнее (Show De-
tails), раскрывающую расширенный набор параметров печати 
(рис. 11.19).

3. Выберите нужные параметры печати. В правой части панели вы 
увидите разный набор элементов управления в зависимости от 
того, какая модель принтера выбрана. Современные принтеры 
предоставят вам множество возможностей: выбор типа бумаги или 
другого носителя, вид и качество печати и т. д.

4. Отправьте документ на печать, нажав кнопку Напечатать (Print).

Если в приложении, в котором создан документ, предусмотрены до-
полнительные возможности настройки печати, тогда вы также увидите 
их на панели. Например, приложение Keynote, в котором можно раз-
рабатывать мультимедийные презентации, предлагает специальные 
функции печати.
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Рис. 11.19. Дополнительные элементы управления для настройки печати

Каждое приложение в составе операционной системы OS X предложит 
вам собственный набор дополнительных параметров печати. 

Поэкспериментируйте с программами, которые вы используете чаще 
всего, и выберите для себя самую удобную комбинацию этих настроек.

Совместный доступ к принтерам

Вы можете настроить систему таким образом, что с одним принтером 
смогут работать пользователи нескольких компьютеров, объединен-
ных в сеть.Чтобы обеспечить совместный доступ к принтеру, выполни-
те следующие действия.

1. Подключите принтер к одному из компьютеров локальной сети 
и нажмите кнопку включения на самом принтере.

2. На компьютере, к которому подключен принтер, выполните коман-
ду меню  ⇒ Системные настройки (  ⇒ System Preferences) 
и щелкните мышью по значку . Откроется окно Общий доступ 
(Sharing) (рис. 11.20).
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Рис. 11.20. Окно Общий доступ

3. В левой части окна поставьте флажок Общие принтеры (Printer 
Sharing).

4. Установите флажок, расположенный слева от модели принтера.

5. Чтобы распечатать документ на принтере с общим доступом, от-
кройте его на одном из компьютеров, подключенном к локальной 
сети, и выполните команду меню Файл ⇒ Напечатать (File ⇒ Print) 
или нажмите сочетание клавиш �+P.

6. Имя сетевого принтера должно присутствовать в раскрывающемся 
списке Принтер (Printer), выберите его из этого списка.

7. Затем нажмите кнопку Печать (Print), чтобы отправить документ на 
сетевой принтер.

В процессе печати могут появляться сообщения о неполадках. Напри-
мер, на рис. 11.21 показано окно с информацией, что в принтер не 
вставлена бумага.

Если вы не можете найти имя сетевого принтера в списке, используйте 
пункт Добавить принтер (Add Printer) из этого списка и укажите прин-
тер вручную.
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Рис. 11.21. Сообщение об отсутствии бумаги

Как только вы добавите сетевой принтер в список, он станет доступен 
из меню окна Печать (Print), конечно, при условии, что принтер дей-
ствительно подключен к одному из компьютеров сети и его пользова-
тель правильно настроил параметры общего доступа.

Системные настройки

Чтобы разобраться с общими настройками операционной системы 
OS X Mavericks , следует подробно изучить содержимое окна Систем-
ные настройки (System Preferences).

В этом окне вы найдете все доступные настройки вашего компьютера: 
здесь можно изменить фон рабочего стола, настроить дату и время, 
условия перехода в спящий режим, изменить параметры клавиатуры 
и мыши, выбрать способы взаимодействия с CD/DVD-дисками, задать 
параметры безопасности, установить родительский контроль, создать 
и удалить учетные записи и многое другое.

Открыть окно Системные настройки (System Preferences) можно, 
выполнив команду меню  ⇒ Системные настройки (  ⇒ Sys-
tem Preferences) или щелкнув мышью по значку  на панели Dock 
(рис. 11.22).

Если на вашем компьютере работает несколько человек, изменять 
все настройки OS X сможет только основной пользователь — админи-
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стратор системы. Эта особенность связана с тем, что одни настройки 
действительны для всей системы (глобальные настройки), а другие — 
только для конкретного пользователя. Если вы обладаете правами ад-
министратора, то можете ограничить для неопытных пользователей 
доступ к глобальным настройкам, чтобы те необдуманными действия-
ми не причинили неудобства остальным. Рассмотрим в общих чертах 
те настройки, с которыми вы захотите поэкспериментировать прежде 
всего.

Рис. 11.22. Окно Системные настройки

Персональные настройки

Настройки, которые позволяют персонализировать компьютер, нахо-
дятся в окне Основные (General). Чтобы увидеть эти настройки, щелк-
ните мышью по значку  (рис. 11.23).

В окне Основные (General) вы сможете изменить цвета интерфейса 
и выделенных элементов, параметры полос прокрутки и сворачивания 
окон, размер значков в боковом меню, настройки последних использо-
ванных объектов, определить поведение полосы прокрутки и восста-
новление окон приложений.
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Рис. 11.23. Окно Основные

Открыв окно Рабочий стол и заставка (Desktop & Screen Saver) щелч-
ком мыши по значку , вы увидите элементы управления фоном ра-
бочего стола и настройками заставки.

В окне Рабочий стол и заставка (Desktop & Screen Saver) вашему вни-
манию представлена коллекция изображений для рабочего стола 
(обоев). Чтобы изменить фон рабочего стола, сначала нужно выбрать 
категорию доступных изображений в левой части окна, а затем в от-
крывшейся коллекции щелкнуть мышью по понравившейся миниа-
тюре. Также в качестве фона вы можете установить сплошной цвет из 
числа предустановленных или настроить любой оттенок с помощью 
панели. Кнопка  позволяет добавить папку на компьютере, содержа-
щую изображения. Вы можете как установить статичное изображение, 
так и позволить фоновым рисункам меняться через определенное вре-
мя автоматически.

На вкладке Заставка (Screen Saver) можно выбрать, какая заставка долж-
на отображаться на экране, когда компьютер простаивает (рис. 11.24).

Помимо персональных настроек каждой из заставок, вы можете опре-
делить общие параметры: время простоя, по истечении которого долж-



402 Глава 11

на включаться заставка, назначить случайный выбор заставки, а также 
отобразить текущее время на фоне изображения заставки. Кроме того, 
кнопка Активные углы (Hot Corners) позволяет задать действия, кото-
рые будут выполняться при перемещении указателя мыши в один из 
четырех углов экрана: включение и отключение заставки, запуск про-
граммы, переход в режим сна и т. п.

Рис. 11.24. Настройки заставки

С возможностями настройки панели Dock и инструмента Mission Con-
trol вы уже познакомились ранее в этой главе, поэтому обзор окон, от-
крываемых щелчком мыши по значкам  и  окна Системные на-
стройки (System Preferences), на данном этапе пропустим.

Много полезных настроек находится в окне Язык и регион (Langua-
ge & Region), открываемом щелчком мышью по значку  (рис. 11.25).

По умолчанию ваш компьютер Mac будет использовать язык той 
страны, где был приобретен. Другими словами, если вы купили свой 
компьютер в США, он будет настроен на английский язык, если вы 
приобрели компьютер в России — основным языком системы будет 
русский. 
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Рис. 11.25. Вид окна Язык и регион

В случае если вам потребуется другой язык интерфейса системы, сле-
дует в левой части окна Язык и регион (Language & Region) перетянуть 
при помощи мыши нужный язык в начало списка, после чего останет-
ся перегрузить компьютер или выйти и снова войти в систему, чтобы 
в силу вступили новые языковые настройки.

� Примечание. Перезагрузка компьютера требуется для изменения 
языка интерфейса программы Finder. В других программах язык ме-
няется без перезагрузки.

Обратите внимание, что при изменении языка желательно изменить 
и форматы, которые система использует для отображения даты, вре-
мени и чисел. Форматы настраиваются в правой части окна Язык и ре-
гион (Language & Region) и на панели, вызываемой нажатием кнопки 
Дополнительные (Advanced). Прежде всего следует выбрать нужный 
регион, после этого система автоматически изменит систему мер, ва-
люту, календарь и укажет первый день недели, которые приняты в вы-
бранной стране. Выбирать страну следует в раскрывающемся списке 
Регион (Region).

Нажатием кнопки Настройки клавиатуры (Keyboard preferences) вы 
откроете окно Клавиатура (Keyboard) на вкладке Источники ввода 
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(Input Sources). На этой вкладке вы можете определить раскладки кла-
виатуры. Если вы хотите, чтобы при вводе текста вам были доступны 
несколько языков, то следует нажать кнопку  и выбрать нужные ис-
точники ввода на открывшейся панели (рис. 11.26).

Рис. 11.26. Добавление источников ввода

� Совет. Проследите, чтобы был установлен флажок Показывать 
меню клавиатур в строке меню (Show Input menu in menu bar), 
тогда вы всегда будете знать, какой язык в данный момент выбран, 
взглянув на строку меню: флаг страны соответствует активному 
языку.

Чтобы использовать переключение между источниками ввода, исполь-
зуйте сочетание клавиш �+Пробел для перехода к предыдущему ис-
точнику и ⌥+�+Пробел — к следующему.

Обеспечить защиту учетной записи можно в окне Защита и безопас-
ность (Security & Privacy), открывающемся значком . Вы можете опре-
делить правила выхода из спящего режима (запрос пароля), разрешить 
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использование приложений, не только загруженных из магазина App 
Store, воспользоваться функцией шифрования данных FileVault, вклю-
чить и настроить брандмауэр, позволяющий контролировать и огра-
ничивать внешние подключения к вашему компьютеру, и выполнить 
настройки доступа приложений к данным, в том числе и к службам гео-
локации. Правила безопасности рассмотрены в главе 10.

Также в окне Системные настройки (System Preferences) вы можете 
настроить параметры функции поиска Spotlight. Щелкните мышью по 
значку  и в открывшемся окне Spotlight укажите категории поиска 
и порядок их сортировки. Вдобавок вы можете ограничить поиск, ис-
ключив некоторые папки, и настроить сочетания клавиш, открываю-
щие меню и окно Spotlight.

Значок  открывает доступ к настройкам центра уведомлений. О них 
вы узнали ранее в этой главе.

Аппаратное обеспечение

В этой группе настраиваются системные параметры, актуальные при ра-
боте с CD- и DVD-дисками, клавиатурой, мышью, мониторами, принтера-
ми, факсами, звуковой аппаратурой и другими внешними устройствами.

Окно CD и DVD (CDs & DVDs), открываемое щелчком мышью по значку 
, показано на рис. 11.27.

Рис. 11.27. Окно CD и DVD

В окне CD и DVD (CDs & DVDs) можно определить поведение системы 
при обнаружении CD- и DVD-дисков. Например, вы вставляете музы-
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кальный диск, а система автоматически запускает его в приложении 
iTunes. Точно так же можно добиться, чтобы система автоматически от-
крывала приложение iPhoto, когда вы вставляете диск с фотография-
ми, или запускала программу DVD-плеер при обнаружении в приводе 
DVD-диска с фильмами.

Щелкнув по значку , вы откроете окно Мониторы (Displays), в ко-
тором доступны элементы управления, связанные с настройкой пара-
метров экрана — разрешением и цветовыми профилями. С помощью 
мастера, запускаемого на вкладке Цвет (Color), вы можете откалибро-
вать монитор для наилучшей цветопередачи и сохранить настройки 
как новый профиль.

Полезные для мобильных компьютеров настройки содержит окно 
Экономия энергии (Energy Saver), которое открывается щелчком 
мыши по значку . Вы можете задать временной интервал для пере-
хода в спящий режим монитора и компьютера, а также сформировать 
расписание автоматического перехода в сон, перезагрузки, включе-
ния и выключения компьютера. Хотя многие пользователи и не от-
носятся серьезно к настройкам спящего режима, временное отклю-
чение компьютера в момент простоя не только снизит потребление 
электроэнергии, но и продлит жизнь вашему монитору, а также помо-
жет увеличить время автономной работы устройства без подзарядки 
аккумулятора.

Следующие параметры, которые могут пригодиться, — это настройки 
клавиатуры и мыши. Щелкнув по значку , вы откроете окно Кла-
виатура (Keyboard), в котором можно установить частоту автоповто-
ра при нажатии клавиш и, что особенно удобно, изменить сочетания 
клавиш, которые назначены определенным функциям или приложе-
ниям.

Вкладка Клавиатура (Keyboard) предназначена для настройки пара-
метров клавиатуры, в частности скорости автоповтора клавиши и за-
держки до начала автоповтора. Здесь же вы можете установить фла-
жок Показывать панели «Клавиатура» и «Символы» в строке меню 
(Show Keyboard & Character Viewers in menu bar), позволяющий вывести 
команды открытия данных панелей в строку меню, как показано на 
рис. 11.28.

На этой же вкладке вы можете настроить внешнюю клавиатуру, под-
ключаемую через интерфейс Bluetooth, и переназначить клавиши-
модификаторы, нажав соответствующие кнопки.
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Рис. 11.28. Панели Клавиатура и Символы

На вкладке Текст (Text) окна Клавиатура (Keyboard) доступны элемен-
ты управления, которые позволят настроить автоматическую замену 
сокращений на специальные символы и словосочетания.

На вкладке Сочетание клавиш (Shortcuts) вы можете просмотреть 
и настроить предустановленные сочетания клавиш, а также добавить 
новые.

Вкладка Источники ввода (Input Sources) была описана в предыдущем 
разделе.

Чтобы настроить работу компьютерной мыши, щелкните по значку . От-
кроется окно Мышь (Mouse), в котором можно отрегулировать скорость 
перемещения указателя мыши по экрану, скорость прокрутки, интервал 
двойного нажатия кнопок, выбрать основную кнопку мыши и настроить 
мышь, подключаемую к компьютеру через интерфейс Bluetooth.

Щелкнув по значку , вы откроете окно Трекпад (Trackpad), в кото-
ром вы найдете элементы управления, связанные с настройкой трек-
пада (рис. 11.29).
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Рис. 11.29. Окно Трекпад

В операционной системе OS X Mavericks по умолчанию обеспечивает-
ся плавный и реалистичный отклик на жесты, особенно на прокрутку, 
масштабирование и смахивание в полноэкранном режиме. Благодаря 
элементам управления в окне Трекпад (Trackpad) вы можете тонко на-
строить устройство под себя.

Приемы настройки принтеров и сканеров (окно  Принтеры и скане-
ры (Print & Scan)) были рассмотрены ранее в этой главе.

Настройка звука происходит в окне Звук (Sound), открывающемся 
щелчком по значку . В нем можно, например, выбрать звуковой 
сигнал предупреждения, которым система будет привлекать ваше 
внимание, изменить уровень громкости, а также определить уровень 
и параметры устройств входа и выхода звука, то есть микрофона и ди-
намиков.

Щелкнув мышью по значку , вы откроете окно Ink с параметрами, 
которые отвечают за обработку рукописного ввода. К сожалению, до-
ступными языками для этого окна являются только английский, фран-
цузский и немецкий. Если вы хотите узнать, как система может об-
рабатывать рукописный текст, обратитесь к справке операционной 
системы OS X.
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Интернет и беспроводная сеть

Настройки данной группы используются при подключении к Интерне-
ту или локальной сети, а также для установки параметров учетной за-
писи iCloud. Некоторые настройки этой группы вы изучили в главе 7.

Технология iCloud, одноименное окно настроек которой показано на 
рис. 11.30, представляет собой бесплатный веб-сервис, реализованный 
по принципу облачного хранения данных. Чтобы получить доступ к сво-
им файлам, достаточно подключиться к Интернету с любого устройства 
под своей учетной записью Apple ID, и все данные (календари, заклад-
ки, контакты и т. п.) между устройствами будут синхронизированы. То 
есть, создав новый контакт на компьютере Mac, вы увидите его авто-
матически и на смартфоне iPhone , если таковой подключен к сервису 
iCloud с той же учетной записью Apple ID.

Рис. 11.30. Окно iCloud

Сервис iCloud предоставляет пространство на сервере, к которому 
можно быстро получить доступ с устройств iPhone , iPad, iPod touch, 
а также компьютеров под управлением операционной системы OS X 
или Windows. По умолчанию сервис бесплатно предоставляет каждому 
пользователю 5 Гбайт пространства, которые можно использовать для 
хранения фотографий, документов, электронных писем и резервных 
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копий файлов. Для начала выделенного объема в 5 Гб вполне достаточ-
но: ваши данные хранятся особым образом, поэтому купленные при-
ложения, фотографии, электронная почта, документы и настройки не 
займут много места. В любом случае, если окажется, что выделенного 
пространства не хватает, вы сможете легко увеличить его объем.

� Примечание. Дополнительные 10 Гб пространства на сервере 
iCloud обойдутся вам в 650 рублей в год, 20 Гб — в 1300 рублей/год, 
а 50 Гб — в 3250 рублей/год.

Благодаря сервису iCloud работа с приложениями и данными с любых 
устройств осуществляется посредством беспроводной технологии 
Push . Кроме того, сервис отлично взаимодействует с мобильной опе-
рационной системой iOS, которая установлена на всех устройствах 
iPhone , iPad и iPod touch.

Все приобретенные приложения, новые фотографии, электронные 
сообщения, контакты, календари отправляются сервисом по любой 
доступной сети Wi-Fi или Ethernet на все зарегистрированные вами 
устройства. По сути, вам больше не нужно синхронизировать данные, 
сервис iCloud сделает это за вас.

Посредством сервиса iCloud вы также сможете загружать приложения 
и книги, приобретенные в онлайн-магазинах App Store и iBooks Store, 
на все устройства, авторизованные под одним аккаунтом Apple ID, не 
ограничиваясь только тем, с которого вы совершили покупку. И нако-
нец, с помощью приложения Найти Mac (Find My Mac), которое являет-
ся частью сервиса iCloud, вы легко определите местоположение своих 
родных, друзей и коллег, конечно, при условии, что они подтвердят за-
прос на возможность обнаружения.

� Примечание. Для устройств под управлением операционной си-
стемы iOS данное приложение носит название Найти iPad (Find My 
iPad), Найти iPhone  (Find My iPhone ) или Найти iPod (Find My iPod) 
соответственно.

Пользоваться сервисом iCloud очень просто, он оснащен понятным 
и удобным интерфейсом. Вам необходимо пройти простую процедуру 
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регистрации/авторизации, после чего все ваши данные на устройствах 
iPhone , iPad, iPod touch и Mac будут синхронизироваться.

Если вы еще не зарегистрировали и/или не авторизовали свою учет-
ную запись Apple ID, вы увидите окно, показанное на рис. 11.31.

Рис. 11.31. Авторизация с учетной записью Apple ID

1. Введите в первое поле адрес электронной почты вашей учетной за-
писи Apple ID.

� Примечание. Если у вас еще нет учетной записи Apple ID, щелкни-
те мышью по ссылке Создать новый Apple ID (Create Apple ID) и, 
следуя указаниям мастера регистрации, получите свои адрес элек-
тронной почты и пароль учетной записи Apple ID.

2. Введите во второе поле пароль вашей учетной записи Apple ID.

После успешной авторизации вы сможете выбрать типы данных, кото-
рые следует синхронизировать с сервисом iCloud, установив соответ-
ствующие флажки.

� Примечание. Для синхронизации заметок и данных приложения 
Mail потребуется указать (зарегистрировать) адрес электронной 
почты на домене @icloud.com.
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Для работы некоторых приложений, таких как Контакты (Contacts), Ка-
лендарь (Calendar), Сообщения (Messages) и Mail, в операционной си-
стеме OS X требуется настройка учетных записей. Для этого понадобит-
ся окно Учетные записи Интернета (Internet Accounts). Чтобы открыть 
его, щелкните мышью по значку  (рис.12.32).

Рис. 11.32. Окно Учетные записи Интернета

В этом же окне вы можете создавать новые учетные записи и удалять 
те, которые вам уже не требуются.

Если вам нужно настроить подключение к Интернету или локальной 
сети, тогда вам следует открыть окно Сеть (Network), щелкнув мышью 
по значку .

В окне Сеть (Network) вы увидите статусы всех доступных соединений, 
которые может использовать система при подключении к Интернету. 
В левой части окна отображаются все возможные конфигурации се-
тевых портов, которые есть на вашем компьютере. Так вы всегда смо-
жете узнать, каким образом компьютер подключен к Интернету или 
к другим компьютерам в домашней или корпоративной локальной 
сети. Соединение, которое отображается в списке первым и отмечено 
флажком зеленого цвета, является основным для вашего компьютера, 
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то есть при попытке подключиться к Интернету система будет про-
верять его первым. О настройке сетевых подключений вы узнали из 
главы 7.

Если вы пользуетесь беспроводной технологией Bluetooth для соеди-
нения устройств и передачи файлов, вам потребуются настройки, кото-
рые доступны в окне Bluetooth. Щелкните мышью по значку , чтобы 
открыть его. Вы сможете настроить обмен и синхронизацию данных 
между компьютером и устройствами с поддержкой Bluetooth, а также 
подключить к компьютеру беспроводную клавиатуру, мышь, принтер, 
гарнитуру, наушники и т. д. и обеспечить общий доступ для устройств 
Bluetooth. О приемах передачи файлов через интерфейс Bluetooth вы 
узнали из главы 4.

Если вам понадобится предоставить доступ к файлам, рабочему столу, 
принтерам, сканерам, Интернету и т. д., используйте элементы управ-
ления в окне Общий доступ (Sharing). Чтобы открыть его, щелкните 
мышью по значку  Общий доступ (Sharing).

Прежде всего при настройке общего доступа к файлам или устрой-
ствам нужно обеспечить связь между несколькими компьютерами, на-
пример создать локальную сеть. О приемах работы с настройками окна 
Общий доступ (Sharing) вы узнали в главе 7.

Системные параметры

С помощью данных элементов управления вы можете настроить пара-
метры резервного копирования данных, учетные записи пользовате-
лей, изменить настройки магазина App Store, включить родительский 
контроль, изменить настройки даты и времени, научить компьютер 
реагировать на звуковые команды и т. д.

Щелкнув мышью по значку  Пользователи и группы (Users & 
Groups), вы откроете одноименное окно, показанное на рис. 11.33.

В этом окне приведен список пользователей, для которых в системе 
существуют учетные записи. Вы можете указать пароль на вход для 
каждого из них, установить изображения для пользователей, которые 
будут показываться при входе в систему, а также ограничить возмож-
ности для отдельных пользователей. Кроме того, вы можете настроить 
параметры входа, например отключить автоматическую авторизацию, 
и изменить приложения в автозагрузке.
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Рис. 11.33. Окно Пользователи и группы

Если за вашим компьютером работают дети и вы хотите оградить их 
от определенных веб-ресурсов, приложений или ограничить для них 
время работы за компьютером, вам поможет окно Родительский кон-
троль (Parents Control). Щелкните мышью по значку  Родительский 
контроль (Parents Control) и в открывшемся окне укажите, для какой 
учетной записи вы хотите установить ограничения.

На вкладках Программы (System) и Веб (Web) вы можете указать, ка-
кие приложения может запускать ваш ребенок под своей учетной за-
писью, а также создать список разрешенных веб-ресурсов. Подробнее 
о том, как работать с этими вкладками, рассказано в главе 8.

Если вы считаете нужным ограничить список контактов, с которыми 
ваш ребенок может переписываться по электронной почте в програм-
ме Mail, перейдите на вкладку Пользователи (People) (рис. 11.34). Здесь 
родительский контроль можно настроить так, что ребенок сможет пе-
реписываться только с теми адресами, которые вы указали в списке 
разрешенных.

Для ограничения установите флажок Разрешить переписку в Mail 
только с разрешенными контактами (Limit Mail to allowed contacts). 
Теперь следует создать список разрешенных контактов, для чего на-
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жмите кнопку  и введите адрес электронной почты и данные раз-
решенного контакта. Не забудьте оставить ребенку возможность по-
просить у вас разрешение на переписку с контактом, которого нет 
в списке, установив флажок Отправить запрос на адрес (Send requests 
to) и указав свой электронный адрес в поле ввода ниже. После этого на 
ваш электронный ящик будут приходить запросы на разрешение пере-
писки с собеседниками с адресами, которые вы не добавили в список.

Рис. 11.34. Вкладка Пользователи окна Родительский контроль

При получении запроса о добавлении нового пользователя в список 
разрешенных контактов вы имеете право либо разрешить обмен со-
общениями, либо заблокировать этот контакт. Также вы можете сле-
дить за тем, с кем ваш ребенок обменивается мгновенными сообще-
ниями в приложении Сообщения (Messages). Как и для программы Mail, 
вы можете создать список разрешенных контактов. Чтобы ограничить 
список собеседников, установите флажок Разрешить переписку в Со-
общениях только с разрешенными контактами (Limit Messages to 
allowed contacts) и создайте список разрешенных контактов.

С помощь настроек родительского контроля на вкладке Время (Time 
Limits) легко ограничить продолжительность работы вашего ребенка 
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за компьютером (рис. 11.35). С помощью этих настроек можно указать, 
сколько часов в день ребенок может пользоваться компьютером в ра-
бочие дни, по вечерам и по выходным дням. А также установить точное 
время автоматического выключения компьютера, если в этот момент 
активна учетная запись вашего ребенка.

Рис. 11.35. Вкладка Время окна Родительский контроль

Если нужно установить максимальное время работы за компьютером 
в рабочие дни (с понедельника по пятницу), установите флажок Огра-
ничить доступ по будням до (Weekday time limits) и перетащите пол-
зунковый регулятор, чтобы указать точное количество часов. Анало-
гичным образом вы можете ограничить время работы в выходные дни. 
Если хотите, чтобы в рабочие дни (с вечера воскресенья по вечер чет-
верга) ребенок не засиживался за компьютером, установите флажок 
Накануне учебных дней (School nights) в группе Ночное время (Bed-
time), а затем в полях ввода справа укажите период, в течение которого 
компьютер должен быть заблокирован. Чтобы ограничить работу на 
компьютере в дни перед выходными (вечер пятницы и вечер субботы), 
установите флажок Накануне выходных дней (Weekend) и укажите 
период блокировки компьютера.
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На вкладке Другие (Others) вы найдете еще несколько полезных на-
строек, которые помогут ограничить учетную запись вашего ребенка. 
Особый интерес на этой вкладке представляет флажок Отключить из-
менение пароля (Lock password change). 

Проследите, чтобы он был установлен. Не имея возможности сменить 
свой пароль, ребенок не сможет изменить настройки своей учетной 
записи, и вы всегда сможете проверить, что хранится в его домашней 
папке.

Также на этой вкладке вы можете отключить встроенную камеру и функ-
цию диктовки, скрыть нецензурную лексику из словарей, запретить из-
менять настройки принтеров и записывать CD- и DVD-диски, установив 
соответствующие флажки. Кнопка Журналы (Logs) позволяет просмо-
треть действия вашего ребенка за компьютером: посещенные и забло-
кированные веб-сайты, запускавшиеся приложения и отправленные 
сообщения.

Если вы хотите настроить параметры установки обновлений для опе-
рационной системы и приложений вашего компьютера, щелкните мы-
шью по значку  и в окне App Store установите или сбросьте соот-
ветствующие флажки. Нажмите кнопку Проверить сейчас (Check Now), 
чтобы открыть вкладку Обновления (Updates) и просмотреть, нет ли 
доступных обновлений (рис. 11.36).

Рис. 11.36. Вкладка Обновления окна программы App Store
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По умолчанию приложение App Store автоматически проверяет обнов-
ления и загружает их фоновом режиме. Это касается системных обнов-
лений и обновлений безопасности. Если вы хотите автоматически уста-
навливать и обновления приложений, отметьте флажок Устанавливать 
обновления программ (Automatically check for updates). А включение 
флажка Автоматически загружать программы, купленные на дру-
гих Mac (Installed Updates) разрешает автоматическую установку при-
ложений на данном компьютере, если те были приобретены на другом 
устройстве, авторизованном с той же учетной записью Apple ID.

Вы можете научить свой компьютер распознавать текст, который будете 
произносить в микрофон, и озвучивать набранный текст. Если данные 
возможности вас заинтересовали, обратитесь к окну Диктовка и речь 
(Dictation & Speech), щелкнув мышью по значку .

� Примечание. К сожалению, функции диктовки и преобразования 
речи в текст не поддерживают русский язык.

Благодаря функции диктовки можно начитывать текст в микрофон, 
и система будет преобразовывать его в печатный. Если же вам трудно 
читать текст с экрана компьютера, вы можете использовать настрой-
ки на вкладке Преобразование текста в речь (Text to Speech), чтобы 
компьютер произносил выделенный текст.

Важно, как ваш компьютер отображает текущие время и дату. Если 
вы не согласны с его выбором, щелкните по значку  Дата и время 
(Date & Time) и в открывшемся окне установите правильные системное 
время и дату (рис. 11.37).

Чтобы выбрать часовой пояс, перейдите на вкладку Часовой пояс 
(Time Zone) и щелкните мышью по карте в том месте, которое соответ-
ствует вашему местонахождению. Затем укажите в раскрывающемся 
списке Ближайший город (Closest City) населенный пункт, в котором 
вы проживаете.

На вкладке Часы (Clock) можно перенастроить тип часов (аналоговые 
или цифровые), задать 24-часовой формат и отображение секунд, ми-
гающего разделителя, дня недели и даты. Если вы хотите, чтобы теку-
щее время было показано в строке меню, установите флажок Показать 
дату и время в строке меню (Show date and time in menu bar). При 
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желании также можно задать параметры даты и сделать так, что си-
стема будет произносить текущее время через заданные промежутки 
времени. Это поможет не пропустить важные события и не опоздать на 
запланированные встречи.

Рис. 11.37. Окно Дата и время

Группа элементов управления Произносить время (Announce the 
time) позволяет настроить голосовое оповещение каждый час, полчаса 
или четверть часа. К сожалению, русский язык оповещениями не под-
держивается.

Когда вы работаете с несколькими операционными системами, можно 
указать среду, которая будет использоваться при следующей загрузке 
компьютера.

Чтобы выбрать ее, щелкните мышью по значку  и в открывшемся 
окне Загрузочный том (Startup Disk) выберите нужную систему.

Если вы щелкнете мышью по значку  Time Machine, запустится ути-
лита Time Machine, ее назначение — создать полную резервную копию 
информации, которая хранится на жестком диске вашего компьютера. 
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После простой настройки приложение Time Machine будет автомати-
чески делать резервную копию вашей системы и остального содер-
жимого жесткого диска: приложений, учетных записей, персональных 
настроек системы и программ, документов, музыкальных файлов, ви-
деороликов, фотографий и т. д.

� Примечание. О возможностях приложения Time Machine вы може-
те узнать из главы 10.

Значок  открывает доступ к настройкам окна Универсальный до-
ступ (Accessibility) (рис. 11.38), которые предназначены облегчить ра-
боту за компьютером людям с недостатками зрения или нарушениями 
слуха, а также тем пользователям, кто не может использовать и клавиа-
туру и мышь одновременно.

Рис. 11.38. Вид окна Универсальный доступ

В левой части окна Универсальный доступ (Internet Accounts) рас-
положены категории настроек, распределенные по разделам, соответ-
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ствующим нарушениям: Зрение (Seeing), Слух (Hearing) и Взаимодей-
ствие (Interacting).

В категории Монитор (Display) вы можете инвертировать (обратить) 
цвета, отображаемые на экране, выбрать бесцветный режим (оттенки 
серого), настроить контрастность изображения и размер указателя 
мыши.

Категория Масштабирование (Zoom) служит для настройки сочетаний 
клавиш, которые применяются для изменения размера изображения 
на экране, выбрать режим масштабирования (картинка-в-картинке или 
полный экран), а также включить сглаживание экранных шрифтов. При 
нажатии кнопки Другие параметры (More options) вы получите доступ 
к более тонким настройкам функции масштабирования.

На вкладке VoiceOver можно включить и настроить функцию VoiceOver, 
которую мы рассмотрели в главе 4.

На вкладке Звук (Audio) вы можете задать настройки, которые будут 
помогать в работе за компьютером людям с нарушениями слуха. На-
пример, когда системе понадобиться привлечь внимание пользовате-
ля, она может использовать не только звуковой сигнал, но и мигнуть 
экраном. А в случае если пользователь плохо слышит одним ухом, 
можно сделать так, чтобы правый и левый аудиоканалы звучали вместе 
в каждом из динамиков (наушников), тогда человек сможет слышать 
оба канала.

Вкладка Сопроводительный текст (Captions) позволяет выбрать 
один из трех предустановленных стилей субтитров или создать собст-
венный.

Элементы управления на вкладке Клавиатуры (Keyboard) помогут на-
строить компьютер так, чтобы пользователи с нарушениями опорно-
двигательного аппарата не испытывали дискомфорта в процессе рабо-
ты. Здесь вы можете выбрать настройки, которые помогут управлять 
компьютером, если пользователю трудно использовать клавиатуру. 
Если вы установите флажок Включить залипание клавиш (Enable 
Sticky Keys), это позволит вводить сочетания клавиш, нажимая их по-
следовательно, а не одновременно. В свою очередь установленный 
флажок Включить медленные клавиши (Enable Slow Keys) поможет 
избежать опечаток, которые возникают при непреднамеренном по-
вторном нажатии клавиши. Кроме того, вы можете активировать зву-
ковое сопровождение нажатия клавиш или сделать так, чтобы система 
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показывала их на экранной клавиатуре, воспользовавшись кнопкой 
Параметры (Options) для выбранного режима.

Если пользователю сложно работать с мышью или трекпадом, к его услу-
гам элементы управления на вкладке Мышь и трекпад (Mouse & Track-
pad). Они дают возможность управлять курсором при помощи кла-
виатуры, а не мыши. Также вы можете настроить скорость двойного 
нажатия кнопок мыши и другие параметры.

Вкладка Switch Control позволяет людям с ограниченными двигатель-
ными возможностями использовать специальные устройства для ввода 
текста, взаимодействия с объектами на экране и управления компью-
тером Mac. Дополнительные сведения по настройке данной функции 
вы найдете в справочных материалах операционной системы OS X.

Вкладка Голосовые команды (Speakable Items) позволяет настроить 
управление компьютером с помощью голоса. К сожалению, русский 
язык не поддерживается.

Настройка программы Системные настройки

Иногда бывает так, что вы знаете, что именно хотите изменить, но не 
уверены, какой параметр и в каком окне отвечает за нужное действие. 
В этих случаях воспользуйтесь функцией Spotlight. Откройте окно Си-
стемные настройки (System Preferences) и в поле, расположенное 
в правом верхнем углу окна программы, введите, о каких возможно-
стями системы вы хотите узнать. Например, вам интересно, где искать 
настройки сочетаний клавиш (рис. 11.39).

После того как начнете вводить ключевое слово, вы увидите, что не-
которые значки в окне Системные настройки (System Preferences) вы-
деляются подсветкой. Чем конкретнее будет информация, которую вы 
укажите в поле поиска, тем точнее окажутся результаты. Когда система 
найдет наиболее подходящую группу настроек, соответствующий зна-
чок выделится яркой подсветкой.

В операционной системе OS X существует возможность выбрать ото-
бражаемые значки в окне Системные настройки (System Preferences) 
и скрыть ненужные. Чтобы изменить содержимое окна, совершите сле-
дующие действия.

1. Запустите приложение Системные настройки (System Preferences) 
и выполните команду меню Вид ⇒ Настроить (View ⇒ Customize). 
В окне Системные настройки (System Preferences) возле каждого 
значка появится флажок.
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Рис. 11.39. Поиск нужных параметров в окне Системные настройки

2. Сбросьте флажки напротив тех значков, которые вам не нужны, 
в окне Системные настройки (System Preferences) и нажмите кноп-
ку Готово (Done).

Система скроет указанные значки. Если в будущем вам понадобится 
вновь отобразить скрытые значки, вы сможете вернуть их, выполнив 
команду меню Вид ⇒ Настроить (View ⇒ Customize) и установив соот-
ветствующие флажки. Также, чтобы увидеть все значки, вы можете на-
жать кнопку Показать все (Show all), которая расположена в верхней 
части окна Системные настройки (System Preferences).



Приложение 1
Решение проблем

Операционная система OS X Mavericks является более стабильной и на-
дежной, чем предыдущие версии системы, однако и она подвержена 
различным сбоям. При работе с системой OS X вы можете столкнуться 
с разного рода неполадками: настройки, которые вы задаете, не всту-
пают в силу, не открывается пункт меню, не запускается программа, 
какое-то приложение вдруг отказывается нормально работать или «за-
висает», не получается установить соединение с Интернетом и т. д.

В операционной системе OS X вы найдете набор простых функций, спо-
собных легко устранить ряд неполадок, с которыми можно столкнуться 
в процессе работы. Если какое-либо приложение работает не так, как 
вы ожидаете, не работает вообще или возникли другие сбои, исполь-
зуйте эти возможности системы для решения типичных проблем.

Хотя операционная система OS X и большинство приложений в ее со-
ставе отличаются надежностью и стабильностью, иногда программы 
могут аварийно завершить свою работу. В таком случае на экране по-
явится окно с сообщением, в котором система предложит вам отпра-
вить в компанию Apple отчет об обнаруженной неполадке . Стоит ли это 
делать — решать вам, однако отправленный отчет может принести вам 
некоторую пользу. Специалисты компании Apple обрабатывают полу-
ченные от пользователей данные, затем определяют, насколько часто 
возникают те или иные сбои в работе системы OS X или ее приложе-
ний, а потом разрабатывают обновления, которые позволяют решить 
такие проблемы окончательно. Другими словами, отправляя отчеты об 
ошибках, вы помогаете компании Apple сделать систему OS X и другое 
программное обеспечение более надежным и стабильным. И не пере-
живайте, система отправляет отчеты анонимно, поэтому разработчики 
не получат вместе с ними никакой персональной информации о вас.

Итак, прочитав это приложение, вы познакомитесь с базовыми прие-
мами, которые помогут вам быстро решить возникшие проблемы. Вы 
узнаете, как использовать простые способы устранения неполадок, 
научитесь применять функции принудительного завершения рабо-
ты приложения, перезагрузки, завершения работы системы и загруз-
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ки в безопасном режиме. Кроме того, вы поймете, как обновить файл 
предпочтительных настроек приложения, восстановить права доступа 
к файловой системе и управлять обновлениями программного обеспе-
чения, сможете создавать учетную запись для тестирования приложе-
ний, работать с отчетами об ошибках и исправлять неполадки при под-
ключении к Интернету.

Обновление системы

Главное, что можно сделать для поддержания операционной системы 
и приложений в актуальном и рабочем состоянии, — своевременная 
установка обновлений. По умолчанию операционная система OS X 
Mavericks автоматически проверяет и устанавливает обновления, но 
если вы изменили данные параметры или хотите немедленно прове-
рить наличие обновлений, надо выполнить следующие действия.

• Выполните команду меню  ⇒ Обновление ПО (  ⇒ Software 
Update), либо щелкните мышью по значку  на панели Dock и пе-
рейдите на вкладку Обновления (Updates).

� Примечание. При наличии обновлений в правом верхнем углу 
экрана появляется уведомление, а на значке App Store в панели 
Dock и на кнопке Обновления (Updates) в окне программы App 
Store указывается общее число доступных обновлений на красной 
наклейке.

Вы можете обновить все программы сразу или же выбрать, какие об-
новления устанавливать.

• Чтобы установить все обновления, нажмите кнопку Обновить все 
(Update All).

• Чтобы установить выборочные обновления, разверните список об-
новлений и нажмите кнопку Обновить (Update) около нужных.

Во время загрузки обновления вы можете приостановить процесс, что-
бы продолжить его позднее, или вовсе отменить загрузку. При установке 
системных обновлений понадобится перезагрузка компьютера, поэтому 
рекомендуется предварительно сохранить все открытые документы.
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Принудительное завершение работы 
приложения

Операционная система OS X предлагает несколько способов принуди-
тельного завершения работы любой программы, если она не реагиру-
ет на ваши команды, зависла или не позволяет корректно завершить 
работу. После того как вы принудительно закроете приложение, мож-
но запустить его повторно, и в большинстве случаев приложение будет 
работать нормально.

� Примечание. Программу Finder нельзя закрыть принудительно, но 
можно перезапустить. Эта процедура обычно устраняет большин-
ство неполадок в ее работе.

Чтобы принудительно закрыть приложение, воспользуйтесь одним из 
предложенных далее способов.

• Щелкните мышью, удерживая клавишу ⌃, по значку зависшего при-
ложения на панели Dock. Появится контекстное меню, из которого 
следует выбрать команду меню Завершить принудительно (Force 
Quit). Если она не отображается, открыв контекстное меню, нажми-
те и удерживайте клавишу ⌥ (рис. П1.1).

Рис. П1.1. Контекстное меню приложения

• Выполните команду меню  ⇒ Завершить принудительно 
(  ⇒ Force Quit) или нажмите сочетание клавиш �+⌥+�, чтобы 
открыть окно Принудительное завершение программ (Force 
Quit Applications) (рис. П1.2). В нем выберите приложение, которое 
нужно закрыть, а затем нажмите кнопку Завершить (Force Quit). Си-
стема закроет указанную вами программу. Для приложения Finder 
кнопка Завершить (Force Quit) недоступна, вместо нее появляется 
кнопка Перезапустить (Relaunch).
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Рис. П1.2. Окно Принудительное завершение программ

Некоторые процессы не отображаются в окне Принудительное за-
вершение программ (Force Quit Applications), поэтому, чтобы прину-
дительно завершить их работу, нужно запустить утилиту Мониторинг 
системы (Activity Monitor) из папки Утилиты (Utilities) каталога Про-
граммы (Applications). В открывшемся окне Мониторинг системы (Ac-
tivity Monitor) вы увидите все запущенные приложения (выполняемые 
процессы) (рис. П1.3).

Рис. П1.3. Окно приложения Мониторинг системы
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1. Выберите приложение, которое нужно закрыть в принудительном 
порядке, и нажмите кнопку  на панели инструментов окна Мо-
ниторинг системы (Activity Monitor). Появится панель с запросом 
подтвердить закрытие указанного приложения.

2. Нажмите кнопку Завершить принудительно (Force Quit). Систе-
ма закроет приложение и при этом не будет вмешиваться в работу 
других запущенных программ.

При необходимости вы можете последовательно завершить работу не-
скольких приложений, не закрывая окно Мониторинг системы (Acti-
vity Monitor).

Последний способ принудительного завершения работы приложения 
заключается в использовании программы Терминал (Terminal), в окне 
которой нужно ввести команду

top

после чего вы увидите список всех запущенных процессов. Чтобы при-
нудительно завершить один из них, введите команду

killall Название_Процесса

Если вы не успели сохранить важные изменения, которые внесли в те-
чение последнего сеанса работы в программе, и приложение не реаги-
рует на ваши попытки корректно завершить работу, попробуйте дать 
программе время «подумать». Достаточно часто, если оставить компью-
тер на некоторое время в покое, системе OS X удается самостоятельно 
справиться с возникшей неполадкой и вернуть приложение «к жизни».

Принудительная перезагрузка компьютера
Если система ведет себя не должным образом или вы не можете до-
биться реакции ни от одного запущенного приложения, следует пере-
загрузить компьютер . Такие неполадки могут произойти по разным 
причинам: системная ошибка в процессе работы, повреждение важ-
ных файлов и т. п.

Чтобы перезагрузить компьютер, выполните следующие действия.

1. Выполните команду меню  ⇒ Перезагрузить (  ⇒ Restart).

2. Если система не позволяет выполнить команду меню, нажмите 
и удерживайте кнопку питания на системном блоке или корпусе но-
утбука.
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Представленные способы перезагрузки дают возможность гарантиро-
ванно добиться результата. В исключительных случаях компьютер мо-
жет «зависнуть». Теме не менее не стоит нервничать, успокойтесь и по-
следовательно выполните перечисленные действия: один из них точно 
сработает. Не нужно стучать по клавиатуре или выдергивать вилку из 
розетки, к которой подключен компьютер. Так вы можете спровоциро-
вать его поломку.

Загрузка в безопасном режиме

Загрузка компьютера в безопасном режиме (Safe Boot ) считается наи-
более эффективным способом устранения неполадок, так как в этом 
случае система диагностирует и устраняет те проблемы, с которыми 
может справиться самостоятельно. Загрузка в таком режиме абсолют-
но безопасна и позволяет быстро и легко решить многие проблемы не-
понятного происхождения.

Безопасный режим особенно полезен в случаях, когда компьютер отка-
зывается загружаться после установки нового приложения. Использо-
вание безопасного режима позволяет отключить все функции системы 
OS X, кроме самых необходимых, и загрузить компьютер, чтобы удалить 
сбойное приложение.

Чтобы загрузить компьютер в безопасном режиме, выполните следую-
щие действия.

1. Выключите компьютер и подождите 10 секунд.

2. Нажмите кнопку включения компьютера.

3. Как только вы услышите звуковой сигнал, который сопровождает 
включение, нажмите на клавиатуре клавишу � и удерживайте ее. 
Не нажимайте ее до звукового сигнала.

4. Отпустите клавишу �, когда увидите логотип компании Apple и ин-
дикатор загрузки ниже.

5. Чтобы выйти из безопасного режима, перезагрузите компьютер без 
удерживания клавиши �.

После перезагрузки компьютер, вероятнее всего, начнет работать за-
метно лучше, так как в безопасном режиме система совершает необхо-
димые операции по самодиагностике и устранению проблем. Проис-
ходит следующее.
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• Выполняется проверка каталогов загрузочного тома. В процес-
се загрузки система сканирует их на предмет возможных проблем.

• Отключаются расширения ядра. При запуске компьютера загру-
жаются всевозможные программные компоненты. Так как иногда 
сбои в начальной загрузке системы могут быть связаны с тем, что 
какая-либо программа установки поместила на диск расширение 
ядра, не совместимое с операционной системой OS X, отключение 
расширения ядра позволяет обойти эту проблему.

• Удаляется кэш динамического загрузчика в папке /var/db/dyld/.
Ошибки в кэше могут привести к сбоям на этапе загрузки. При пе-
резагрузке этот кэш обычно создается заново.

• Отключаются несистемные шрифты. Поврежденные шрифты мо-
гут быть источником постоянных проблем, а так как диагностиро-
вать такие неполадки только по их внешнему виду нельзя, система 
отключает все шрифты, кроме разрешенных. Разрешенными опе-
рационная система считает те, которые хранятся в папке Система/
Библиотека/Fonts (System/Library/Fonts).

• Отключаются все элементы автоматического запуска при стар-
те системы.

• Удаляет кэш шрифтов. Использование кэша позволяет ускорить 
работу OS X Mavericks, так как система записывает визуальную 
информацию для каждого из шрифтов на жесткий диск. Если та-
кие файлы повреждены, в системе могут возникать сбои. Поэто-
му в безопас ном режиме она перемещает файлы с информацией 
о шрифтах в папку Корзина (Trash), что позволяет избавиться от про-
блем, провоцируемых поврежденными файлами.

В безопасном режиме не работают многие стандартные функции, по-
этому не удивляйтесь, что вы не можете запустить DVD-плейер, рабо-
тать с сетью, задавать настройки оборудования или приложений. Си-
стема делает это специально, чтобы вы могли сосредоточиться только 
на устранении неполадок. 

При следующей перезагрузке все функции вновь станут доступными. 
Хотя безопасный режим не всегда может устранить проблемы, он хо-
рош тем, что все-таки позволяет запустить систему в тех случаях, когда 
она отказывается загружаться, найти и устранить возникшие неполадки 
и тем самым избежать необходимости полной переустановки си стемы.
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Проверка и восстановление прав доступа

Значительная часть возникающих сбоев при работе с системой OS X 
связана с некорректной установкой прав доступа для какого-либо 
приложения или другого объекта. В операционной системе OS X до-
ступна специальная программа Дисковая утилита (Disk Utility), кото-
рая управляет правами доступа пользователей к файловой системе . 
Чтобы проверить и восстановить эти права, выполните следующие 
действия.

1. Запустите приложение Дисковая утилита (Disk Utility).

2. Перейдите на вкладку Первая помощь (First Aid) и в левой части 
окна выберите жесткий диск (рис. П1.4).

Рис. П1.4. Вкладка Первая помощь окна программы Дисковая утилита

3. Нажмите кнопку Проверить права доступа (Check Disk Permis-
sions). Процедура проверки может занять некоторое время. В ходе 
процедуры утилита найдет все файлы, для которых права доступа 
не соответствуют необходимым.
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4. Нажмите кнопку Восстановить права доступа (Repair Disk Permis-
sions). В ходе процедуры утилита откорректирует все соответствую-
щие права доступа.

В случае если программа Дисковая утилита (Disk Utility) столкнется 
с ошибками, с которыми она не сможет справиться, рекомендуется 
перейти к проверке жесткого диска (верификации) и его восстанов-
лению.

Устранение неполадок в работе жесткого диска

Если после того, как вы восстановили права доступа, в системе OS X 
все-таки остались неисправности, нужно перейти к следующему эта-
пу — проверке жесткого диска (верификации ).

1. Откройте приложение Дисковая утилита (Disk Utility) .

2. Чтобы проверить жесткий диск и определить наличие неисправ-
ностей файловой системы, нажмите кнопку Проверить диск (Verify 
Disk). Программа Дисковая утилита (Disk Utility) выполнит провер-
ку и сообщит вам, существуют ли неполадки и можно ли их испра-
вить.

Если приложение Дисковая утилита (Disk Utility) определит, что диск 
нуждается в обслуживании, тогда, чтобы исправить неполадки, потре-
буется загрузить систему из скрытого раздела Recovery. Это условие 
связано с тем, что программа Дисковая утилита не может исправить 
ошибки, обнаруженные на том же самом логическом диске, на котором 
она установлена.

3. Перезагрузите компьютер и во время загрузки нажмите и удержи-
вайте сочетание клавиш �+R.

4. В открывшемся окне Утилиты OS X (OS X Utilities) выберите пункт 
Дисковая утилита (Disk Utility) и нажмите кнопку Продолжить 
(Continue) (рис. П1.5).

5. В основном окне приложения Дисковая утилита (Disk Utility) нажми-
те кнопку Восстановить диск (Repair Disk) и подождите, пока при-
ложение выполнит проверку и исправит найденные ошибки.

 Если процедура прошла успешно, приложение Дисковая утилита 
(Disk Utility) сообщит, что проверенный диск в порядке.
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Рис. П1.5. Окно Утилиты OS X

6. Чтобы закончить процедуру проверки жесткого диска, закройте 
приложение Дисковая утилита (Disk Utility) и перезагрузите ком-
пьютер. Если ассистент установки предложит вам выбрать загру-
зочный диск, щелкните мышью по логическому диску, на котором 
установлена ваша система.

Если приложение Дисковая утилита (Disk Utility) не сможет исправить 
найденные ошибки, значит, возникшие проблемы действительно се-
рьезные. В этом случае вам нужно обратиться в сервисный центр Apple .

Сброс пароля администратора

Если вы вдруг обнаружите, что забыли пароль администратора, его 
можно восстановить .

Для этого выполните следующие действия.

1. Включите компьютер и во время загрузки нажмите и удерживайте 
сочетание клавиш �+R.
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2. Подождите, пока появится окно Утилиты OS X (OS X Utilities).

3. Выберите команду меню Утилиты ⇒ Терминал (Utilities ⇒ Ter-
minal).

4. В окне приложения Терминал (Terminal) введите команду

resetpassword

как показано на рис. П1.6.

Рис. П1.6. Окно приложения Терминал

5. Нажмите клавишу �. Вы увидите окно утилиты Сброс пароля (Reset 
Password) (рис. П1.7).

Рис. П1.7. Окно приложения Сброс пароля

6. Выберите жесткий диск, где установлена операционная система 
OS X. Затем в раскрывающемся списке выберите имя учетной запи-
си, пароль к которой нужно восстановить.
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� Совет. Если в окне Пользователи и группы (Users & Groups) вы 
выберете свою учетную запись и установите флажок Разрешить 
пользователю сбрасывать пароль с Apple ID (Allow user to reset 
password using Apple ID), в следующий раз, когда забудете пароль 
входа в систему, сможете сбросить его с помощью учетной записи 
Apple ID.

7. После этого в двух следующих полях ввода укажите новый пароль, 
в третье поле введите подсказку на случай, если вы снова его забу-
дете, и нажмите кнопку Сохранить (Save).

8. Завершите работу программ Терминал (Terminal) и Сброс пароля 
(Reset Password) и перезагрузите компьютер.

Вероятность потерять или забыть пароль для входа в систему может 
привести вас к мысли вообще не указывать пароль администратора 
при первичной настройке компьютера, оставив соответствующие поля 
пустыми. Но это неразумное решение, так как без пароля на вход все 
ваши данные окажутся абсолютно незащищенными от вмешательства 
других пользователей, которые, возможно и не имеют злого умысла, но 
по неосторожности могут повредить или удалить важные файлы. Поэто-
му желательно всегда указывать пароль на вход, и не только для адми-
нистратора, но и для всех остальных учетных записей в вашей системе.

Принудительное извлечение CD/DVD-дисков

Если вы столкнулись с ситуацией, когда не можете достать из привода 
CD- или DVD-диск, выполните следующие действия.

1. Сначала попробуйте извлечь диск стандартными средствами. Еще 
раз щелкните мышью по значку извлечения диска, выберите в кон-
текстном меню команду Извлечь (Eject) или, выделив диск, нажми-
те сочетание клавиш �+E.

2. Если это не помогло, попробуйте перезапустить приложение Finder, 
как было описано ранее в этом приложении.

3. Запустите приложение Терминал (Terminal), введите команду

drutil tray eject
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4. Выберите команду меню  ⇒ Завершить сеанс (  ⇒ Log Out) 
и вновь войдите в систему. Повторите попытку извлечения диска.

5. Перезагрузите компьютер и во время загрузки нажмите и удержи-
вайте кнопку мыши.

Если и этот способ не сработал, рекомендуется обратиться в сервис-
ный центр Apple. Когда это невозможно, попробуйте достать диск вруч-
ную. Найдите рядом с приводом маленькое отверстие, возьмите тон-
кий предмет (иголку, разогнутую скрепку, булавку, ключ для открытия 
крышки SIM-карт для iPhone /iPad/iPod и т. п.) и аккуратно вставьте его 
в отверстие. Когда почувствуете, что предмет уперся, слегка надави-
те — сработает встроенный механизм, и диск будет извлечен. Кстати, 
этот метод сработает и при выключенном компьютере.

Устранение неполадок при подключении 
к Интернету

С неполадками при подключении к Интернету  вы можете столкнуть-
ся прежде всего при первом включении нового компьютера. В этом 
случае проблема, скорее всего, связана с тем, что в окне параметров 
настройки сети указана неверная информация. В дальнейшем подклю-
чение к Интернету может не работать по различным причинам. Напри-
мер, вы сменили интернет-провайдера или способ подключения, но не 
внесли соответствующие изменения в настройки сети, отключены или 
повреждены кабели, возникли проблемы на стороне интернет- про-
вайдера и т. д. 

В основном большинство настроек сети система способна определить 
самостоятельно, но если для работы через нового провайдера требу-
ется установить какие-то параметры вручную, вы сможете сделать это 
в окне Сеть (Network).

Итак, чтобы создать новое соединение или устранить неполадки в ра-
боте существующего подключения, выполните следующие действия.

1. Первым делом проверьте состояние кабелей — иногда проблема 
вызвана плохим контактом или обрывом. Возможно, вы передви-
гали компьютер и отключили сетевой кабель или кто-то из домо-
чадцев случайно зацепил его. Также, если вы впервые настраиваете 
сеть и используете кабели Ethernet, убедитесь в том, что выбрали 
подходящий тип кабеля и он правильно обжат.
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2. Удостоверьтесь, что на счет абонентской платы внесены деньги 
и у вас нет задолженностей.

3. Если с кабелями все в порядке и вы уверены, что параметры вашей 
сети настроены правильно, поинтересуйтесь, есть ли связь у ваших 
соседей, которые пользуются услугами того же интернет- провай-
дера. Может быть, сбой вызван техническими проблемами само-
го провайдера, тогда у ваших соседей тоже не будет соединения. 
В этой ситуации позвоните в службу технической поддержки про-
вайдера и уточните, с чем связаны проблемы и как долго про длится 
отсутствие связи.

4. Если вы настраиваете новое соединение с Интернетом, выполните 
команду меню  ⇒ Системные настройки (  ⇒ System Prefe-
rences) и в открывшемся окне щелкните мышью по значку  Сеть 
(Network). Появится одноименное окно.

 В его левой части вы увидите список установленных сетевых интер-
фейсов. Тот, возле которого зеленый индикатор, в данный момент 
активен.

5. Выберите в этом списке тип соединения, который вам сообщили 
в службе технической поддержки провайдера или который указан 
в договоре с ним.

6. Введите необходимые данные для установки соединения.

7. Нажмите кнопку Применить (Apply), подождите несколько минут 
и проверьте, может ли веб-браузер установить соединение с Ин-
тернетом.

Если тип соединения выбран правильно и все параметры его настрой-
ки заданы верно, тогда система сможет создать соединение. Если связи 
с Интернетом по-прежнему нет, значит, необходимо скорректировать 
параметры соединения.

Чтобы установить соединение, также можно попробовать вызвать ма-
стер подключений, нажав кнопку Ассистент (Assist me), расположен-
ную в нижней части окна. Появится панель, с помощью которой вы 
сможете в полуавтоматическом режиме создать новое соединение или 
устранить проблемы с существующим подключением.

Если все же не получается установить соединение, остаются два спо-
соба решения проблемы: обратиться в службу технической поддержки 
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интернет -провайдера и попросить предоставить подробные инструк-
ции настройки или вызвать специалиста на дом.

Если у вас соединение с Интернетом осуществляется через маршрути-
затор или модем, то, чтобы восстановить связь, можно выполнить пере-
загрузку устройства. Как правило, необходимо выключить устройство, 
подождать не менее 10 секунд, а затем снова включить. 

Довольно часто это помогает решить проблемы с соединением. Будет 
не лишним после включения модема перезагрузить компьютер.

Если доступ в Интернет осуществляется через беспроводное соеди-
нение, тогда для его диагностики и наладки потребуется приложение 
AirPort-Утилита (AirPort) . Общие принципы работы с ним аналогичны 
приемам работы в окне Сеть (Network). Отменить изменения настроек 
можно с помощью кнопки Вернуть (Revert), а активировать заданные 
параметры — нажав кнопку Применить (Apply).

Если при организации беспроводных соединений у вас возникли не-
которые проблемы, попробуйте выполнить следующие действия.

1. Убедитесь, что все сетевое оборудование правильно подключено. 
Проверьте наличие питания.

2. Проверьте уровень сигнала беспроводной сети. Сделать это мож-
но, взглянув на значок  на панели индикаторов. Для нормального 
функционирования сети требуется наличие не менее четырех де-
лений. Если уровень сигнала слишком низок, попробуйте подойти 
к точке доступа поближе и избежать наличия препятствий между 
точкой доступа и вашим компьютером.

3. Если вам не удается найти сеть в списке беспроводных сетей, воз-
можно, прекращено ее вещание либо она скрыта. В последнем слу-
чае попробуйте установить соединение вручную, указав имя и па-
роль сети.

4. Попробуйте подключиться к базовой станции при помощи кабеля 
и заново настроить параметры сети — возможно, ранее вы где-то 
допустили ошибку.

Уровень сигнала беспроводных сетей может быть ухудшен, если в не-
посредственной близости от точки доступа и вашего компьютера име-
ются устройства, излучающие электромагнитные волны, такие как ра-
диотелефоны и микроволновые печи.
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Устранение проблем с получением и отправкой 
электронной почты

Проблемы с получением электронной почты  могут быть связаны с ря-
дом причин: неверно указан (либо изменился) сервер входящей или 
исходящей почты, изменились параметры аутентификации пользова-
телей, введено неверное имя пользователя, удален почтовый ящик, 
или изменился пароль у провайдера электронной почты (то есть вы 
изменили пароль к своей почте на официальном сайте провайдера, но 
забыли указать новый пароль в приложении Mail) и т. д.

Первым делом убедитесь, что соединение с Интернетом активно и ра-
ботает правильно, запустите веб-браузер и попробуйте открыть какую-
нибудь веб-страницу. Если с подключением все в порядке, проверьте 
информацию вашей почтовой учетной записи. Кроме того, попробуйте 
получить доступ к содержимому почтового ящика через веб-интерфейс. 
Почтовые службы время от времени отказывают в доступе по причине 
сбоев на сервере, технологических работ или замены оборудования.

Чтобы проверить данные учетной записи, предпримите следующие 
действия.

1. Запустите приложение Mail и выполните команду меню Mail ⇒ На-
стройки (Mail ⇒ Preferences).

2. В открывшемся окне перейдите на вкладку Учетные записи (Ac-
counts) и убедитесь, что открыта категория Свойства учетной за-
писи (Account Information) (рис. П1.8).

3. В области Учетные записи (Accounts) выберите учетную запись, 
конфигурацию которой нужно проверить.

В правой части окна вы увидите параметры выбранной записи. Поле 
Описание (Description) содержит краткое описание учетной записи, 
а поля Адрес e-mail (Email Address) и Полное имя (Full Name) отобра-
жают почтовый адрес и полное имя учетной записи. Если в поле Адрес 
e-mail (Email Address) указаны верные данные, переходите к следую-
щему этапу.

В поле Сервер входящей почты (Incoming Mail Server) вы должны 
увидеть адрес сервера входящей почты. Для каждой учетной записи 
в обязательном порядке должен быть указан адрес сервера, с которо-
го поступает электронная почта. Необходимую информацию о сервере 
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входящей почты можно уточнить в службе технической поддержки на 
официальном сайте вашего почтового провайдера.

Рис. П1.8. Категория Свойства учетной записи

В поле Сервер исход. почты (SMTP) (Outgoing Mail Server (SMTP)) дол-
жен отображаться сервер исходящей почты вашего провайдера. Если 
вы не знаете адреса сервера исходящей почты, узнайте его на офици-
альном сайте вашего почтового провайдера.

Если в поле Сервер исход. почты (SMTP) (Outgoing Mail Server (SMTP)) 
указан не тот сервер, его можно изменить, выбрав из списка или вы-
полнив команду меню Редактировать список серверов (Edit Server 
List). Появится панель, на которой вы можете изменить сервер исходя-
щей почты.

4. Выберите из списка сервер, который соответствует вашему провай-
деру электронной почты. Если подходящего в списке нет, нажмите 
кнопку  под списком серверов, перейдите на вкладку Свойства 
учетной записи (Account Information) и введите параметры на-
стройки сервера SMTP вашего провайдера.
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5. Щелкните мышью по вкладке Дополнения (Advanced), чтобы от-
крыть панель, позволяющую указать значения портов, параметры 
идентификации, имя пользователя и пароль.

6. Проверьте данные, указанные в полях Аутентификация (Authen-
tication), Имя пользователя (User Name) и Пароль (Password), — 
всю эту информацию вы получили, когда регистрировали почтовый 
ящик на сайте провайдера.

7. Нажмите кнопку OK и убедитесь, что на вкладке Свойства учетной 
записи (Account Information) в поле Сервер исход. почты (SMTP) 
(Outgoing Mail Server (SMTP)) указано имя нужного сервера.

8. Закройте окно параметров и попробуйте отправить сообщение 
электронной почты, чтобы убедиться, что неполадки с учетной за-
писью устранены.

При необходимости вы можете обратиться в службу технической под-
держки вашего почтового провайдера и получить ту информацию, ко-
торая поможет устранить неполадки с учетной записью в приложении 
Mail. Также нужно уделять особое внимание параметрам безопасности, 
так как от них зависит сохранность вашей почты. Используйте все на-
стройки безопасности, которые рекомендует ваш провайдер.

Восстановление и переустановка 
операционной системы OS X
Приложение Time Machine способно на многое, но все-таки вы може-
те столкнуться с ситуацией, когда восстановление не помогает, опе-
рационная система OS X продолжает вести себя странно: выдает по-
стоянные ошибки или неправильно выполняет вполне стандартные 
действия. В этом случае можно попробовать устранить неполадки, ис-
пользуя встроенные функции системы.

Если ничего не помогает и сбои продолжаются, имеет смысл восста-
новить или переустановить операционную систему. В OS X доступна 
возможность переустановить или восстановить систему из резервной 
копии приложения Time Machine без использования DVD-дисков с дис-
трибутивами. В восстановлении нет ничего сложного или фатального, 
по окончании процедуры вы получите работоспособную систему, из-
бавленную от нарушений (если таковые, конечно, не связаны с физиче-
ским повреждением жесткого диска и т. п.).
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Процедура переустановки/восстановления будет проходить при по-
мощи раздела Recovery HD, где хранится встроенный набор утилит, не-
обходимый для восстановления операционной системы OS X. Раздел 
восстановления Recovery HD на загрузочном диске вашего компьюте-
ра система предлагает создать при первой установке. 

Не пренебрегайте этой возможностью, иначе вы не сможете не только 
переустановить систему путем восстановления, но также использовать 
возможности функции FileVault по шифрованию и защите данных, кото-
рые хранятся на жестком диске компьютера.

Не переживайте за свои данные, стандартная установка OS X не затро-
нет ваши файлы и папки, она только исправит ошибки, которые обна-
ружит в операционной системе.

� Примечание. Восстановить систему получится, только если вы 
использовали возможности приложения Time Machine и создали 
резервную копию установленных приложений и своих пользова-
тельских настроек. В противном случае возможна только переуста-
новка.

Чтобы выполнить процедуру восстановления, предпримите следую-
щие действия.

1. Перезагрузите компьютер, как только начнется загрузка, нажмите 
и удерживайте сочетание клавиш �+R до тех пор, пока не появится 
значок Apple, который информирует о загрузке операционной си-
стемы.

2. Дождитесь, пока не появится окно программы Утилиты OS X (OS X 
Utilities).

3. Для восстановления выберите пункт Восстановить из резервной 
копии Time Machine (Restore From Time Machine Backup) и нажмите 
кнопку Продолжить (Continue).

4. Выберите диск с резервной копией и нажмите кнопку Продолжить 
(Continue).

5. Выберите дату и время резервной копии и восстановите систему, 
следуя инструкциям на экране.
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Чтобы совершить процедуру восстановления, выполните следующие 
действия.

1. Перезагрузите компьютер, как только начнется загрузка, нажмите 
и удерживайте сочетание клавиш �+R до тех пор, пока не появится 
значок Apple, который информирует о загрузке операционной си-
стемы.

2. В окне программы Утилиты OS X (OS X Utilities) выберите пункт Пе-
реустановить OS X (Reinstall OS X) и нажмите кнопку Продолжить 
(Continue).

3. Следуя инструкциям на экране, переустановите операционную си-
стему OS X (рис. П1.9).

Рис. П1.9. Переустановка операционной системы OS X

Если в процессе восстановления системы у вас возникнут вопросы, вы 
всегда можете обратиться в службу технической поддержки компании 
Apple или ознакомиться с материалами, размещенными в соответству-
ющем разделе официального сайта (www.apple.com/ru/support).
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Поиск ресурсов для устранения неполадок

В случае если перечисленные в этом приложении способы устранения 
неполадок не помогли, обратитесь к внешним источникам дополни-
тельной помощи . Главным вашим подспорьем будет раздел техниче-
ской поддержки на официальном сайте компании Apple, далее следу-
ют различные тематические форумы и, конечно же, поисковая система 
Google. С помощью Google вы сможете найти ответы на любые вопро-
сы по работе с операционной системой OS X быстрее, чем в службе 
технической поддержки, к тому же на русском языке и с подробными 
инструкциями.

Итак, следующие сайты полностью посвящены диагностике и инстру-
ментам по устранению неполадок в продуктах компании Apple.

• Справочный сайт компании Apple (www.apple.com/ru/support/
osx/) содержит разнообразные руководства, обновления для 
программ, ответы на распространенные вопросы и т. д. На стра-
ницах этого ресурса вы найдете множество статей, посвященных 
техническим и прочим вопросам эксплуатации продуктов ком-
пании Apple и операционной системы OS X. Используя возмож-
ности встроенного поиска, вы быстро найдете интересующий вас 
раздел. 

• Ресурс «AppStudio» (appstudio.org/articles/). Количество и каче-
ство вопросов и ответов, связанных с продуктами компании Apple 
и операционной системой OS X в частности, на страницах этого 
сайта превосходят все остальные бесплатные веб-ресурсы данной 
тематики. Вы даже узнаете, как установить операционную систему 
OS X на обычный персональный компьютер или ноутбук.

• Веб-проект «Просто Mac» (www.prostomac.com/category/mac-os-
tips/). Этот сайт содержит множество публикаций с советами по ра-
боте в операционной системе OS X.

� Примечание. На сайте www.apple.com/ru/support/products/ вы 
можете приобрести услугу AppleCare Protection Plan, позволяющую 
продлить срок сервисного обслуживания и технической поддерж-
ки до трех лет с момента покупки компьютера Mac. Стоимость услу-
ги от 5990 до 13 990 рублей.
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• Блог «AppleInsider.ru» (appleinsider.ru) публикует статьи обо всем, 
что связано с компьютерами Mac и устройствами под управлением 
операционной системы iOS.

• Веб-сайт «Mac Radar» (macradar.ru) следит за новостями из мира 
Apple и публикует их для вас.

• На сайте «MacDigger.ru» (www.macdigger.ru/macall/hints-macall) 
вы найдете много интересных советов и секретов, связанных с опе-
рационной системой OS X.

• На форуме «Apple Life» (applelife.ru/forums/) вы получите поддерж-
ку опытных пользователей операционной системы OS X.

Также вы можете обратиться в специализированные сервисы обслужи-
вания или в службу технической поддержки компании Apple.



Приложение 2
Хитрости и советы по работе 
в OS X Mavericks

Разработчики компании Apple основательно потрудились над новой 
версией операционной системы OS X — Mavericks. Установив ее на ком-
пьютер Mac, вы обнаружите более 200 улучшений и новых функций, ко-
торые призваны упростить работу с системой. Кроме того, в операци-
онной системе OS X «скрыто» много нюансов и особенностей, которые 
на первый взгляд незаметны, но могут оказаться весьма полезными.

В этом приложении мы рассмотрим самые интересные приемы, зная 
о которых вы сможете быстрее и эффективнее добиваться желаемо-
го результата. А также узнаете о скрытых «пасхальных яйцах1», в част-
ности заставите компьютер запеть, и научитесь запускать Windows-
программы в среде OS X.

Итак, рассмотрим, благодаря каким приемам и хитростям  вы можете 
упростить работу с операционной системой OS X Mavericks и ее при-
ложениями.

Создание загрузочного Flash-диска 
с OS X Mavericks

На момент написания книги единственный способ обновить операци-
онную систему OS X до версии Mavericks — загрузить образ дистрибу-
тива из онлайн-магазина App Store. Пользователям нескольких ком-
пьютеров Mac это может быть неудобно — необходимо загружать из 
Интернета установочный файл на каждом из компьютеров. Решить эту 
проблему можно, создав загрузочный USB-Flash-диск с дистрибутивом 
операционной системы OS X Mavericks. Для этого выполните следую-
щие действия.

1. Загрузите лицензионную копию образа с дистрибутивом операци-
онной системы OS X Mavericks из магазина App Store. Дистрибутив 
операционной системы данной версии доступен бесплатно.

1 Недокументированных возможностях.
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2. Подключите Flash-накопитель к USB-порту компьютера.

3. Запустите приложение Дисковая утилита (Disk Utility ).

4. Выберите ваш USB-накопитель в левой части окна программы и пе-
рейдите на вкладку Раздел диска (Partition).

5. В раскрывающемся списке Схема разделов (Partition Layout) выбе-
рите пункт Раздел 1 (1 Partition).

6. В раскрывающемся списке Формат (Format) выберите формат Mac 
OS Extended (журнальный) (Mac OS Extended (journaled)).

7. В поле ввода Имя (Name) укажите значение Mavericks.

8. Нажмите кнопку Параметры (Options). Установите переключатель 
в положение Схема разделов GUID (GUID Partition Table) и нажми-
те кнопку OK.

9. Нажмите кнопку Применить (Apply) в правом нижнем углу про-
граммы. Начнется форматирование Flash-накопителя.

10. Запустите приложение Терминал (Terminal).

Убедитесь, что Flash-накопитель подключен и Mavericks — единствен-
ный том с таким именем.

11. Введите в окне приложения Терминал (Terminal) следующую коман-
ду для создания загрузочного Flash-диска:

sudo '/Applications/Install OS X Mavericks.
app/Contents/Resources/createinstallmedia' 
--volume '/Volumes/Mavericks' --applicationpath 
'/Applications/Install OS X Mavericks.app' 
--nointeraction

12. Введите пароль администратора. Через 10–15 минут приложе-
ние Терминал (Terminal) завершит создание загрузочного Flash-
диска.

13. Перезагрузите компьютер с установленным Flash-диском.

14. Во время загрузки нажмите и удерживайте клавишу ⌥.

Далее вы сможете приступить к установке операционной системы OS X 
Mavericks.
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Запуск Windows-программ в среде OS X

Переход на Mac зачастую сопровождается разочарованием некото-
рых пользователей, которые обнаруживают, что их любимые Windows-
программы не имеют версий для операционной системы OS X. Далее 
вы узнаете, как устанавливать в среде OS X приложения для операцион-
ной системы Microsoft без необходимости использования виртуальной 
машины, эмулятора или загрузки нескольких операционных систем.

1. Загрузите и установите приложение Wineskin Winery с сайта source-
forge.net/projects/wineskin/. Вы увидите окно программы (рис. П2.1).

Рис. П2.1. Окно приложения Wineskin Winery

Данное приложение позволяет вам создавать «оболочки», превраща-
ющие Windows-программы в приложения для операционной систе-
мы OS X.

2. Нажмите кнопку . Вы увидите окно Add Engine (Добавить движок), 
показанное на рис. П2.2.

3. Выберите актуальную версию движка, например WS9Wine 1.7.5, 
и нажмите кнопку Download and Install (Загрузить и установить).

Если вы захотите поставить какую-нибудь очень старую программу, то 
движок может понадобиться не один и не самый новый (некоторые ста-
рые приложения не способны запускаться на более новых версиях Wine).
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Рис. П2.2. Окно Add Engine

4. После завершения установки движка нажмите кнопку Update (Об-
новить) в группе элементов управления Wrapper Version (Версия 
оболочки), чтобы загрузить актуальную версию оболочки. Теперь 
следует создать новую пустую оболочку для программы, планируе-
мой к установке.

5. Нажмите кнопку Create New Blank Wrapper (Создать новую пустую 
оболочку) и введите название оболочки, например соответствую-
щее названию Windows-программы (рис. П2.3). Через несколько 
минут оболочка будет создана.

Рис. П2.3. Окно Create a Wrapper

6. Перейдите в папку /Users/имя_вашей_учетной_записи/Applica-
tions/Wineskin.

7. Запустите созданную оболочку.

Если запуск завершается неудачей, щелкните по оболочке мышью, 
удерживая клавишу ⌃, и выберите команду Показать содержимое 



450 Приложение 2

пакета (Show Package Contents) в контекстном меню. После этого дваж-
ды щелкните мышью по приложению Wineskin. Вы увидите окно, пока-
занное на рис. П2.4.

Рис. П2.4. Интерфейс запущенной оболочки

8. Нажмите кнопку Install software (Установить программу). Вы увиди-
те окно с вариантами запуска Windows-программы (рис. П2.5).

Рис. П2.5. Выбор варианта запуска программы

Если Windows-приложение является портативным (то есть установка 
его не требуется, а возможен непосредственный запуск), достаточ-
но добавить данную папку в оболочку. Для этого предназначены два 
нижних варианта, позволяющих скопировать (Copy a Folder Inside) 
или переместить (Move a Folder Inside) папку Windows-программы 
в оболочку. В случае необходимости установки программы следует вы-
брать вариант Choose Setup Executable (Выбрать исполняемый файл 
инсталлятора). Мы рассмотрим данный вариант как наиболее распро-
страненный.
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9. Нажмите кнопку Choose Setup Executable (Выбрать исполняемый 
файл инсталлятора) и выберите файл инсталлятора.

10. Выполните установку программы. Возможно, по завершении 
потребуется выбрать исполняемый файл Windows- программы 
(рис. П2.6).

Рис. П2.6. Выбор исполняемого файла программы

Если все сделано правильно, после запуска оболочки вы увидите окно 
Windows-программы (рис. П2.7).

Рис. П2.7. Окно Windows-программы
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Режим одного приложения

Как правило, в операционной системе OS X одновременно запускается 
несколько приложений, между которыми пользователь активно пере-
ключается. Но когда окон приложений открыто слишком много, они 
перекрывают друг друга, и это не всегда удобно. Для решения данной 
проблемы в операционной системе OS X доступна скрытая функция 
под названием «режим одного приложения», которая позволяет ви-
деть лишь одно активное приложение, а остальные скрыть.

Чтобы задействовать этот режим, выполните следующие действия.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) следующую 
команду :

 defaults write com.apple.dock single-app -bool 
true;killall Dock

Теперь, чтобы переключиться между различными приложениями, вам 
нужно будет щелкать мышью по соответствующим значкам на панели 
Dock. Окно активного приложения выведется на экран, а все осталь-
ные автоматически окажутся скрыты.

Вернуть установки по умолчанию можно с помощью этой команды:

defaults write com.apple.dock single-app -bool 
false;killall Dock

Преобразование образов DMG в ISO

Иногда требуется преобразовать образ диска в формате DMG в другой 
формат — CDR или ISO.

Для решения этой задачи выполните следующие действия.

1. Дважды щелкните мышью по файлу формата DMG в окне програм-
мы Finder. После этого образ появится в левой части экрана, как 
будто вы подсоединили внешний диск.

2. Запустите приложение Дисковая утилита (Disk Utility).

3. Выберите смонтированный образ и нажмите кнопку Конвертиро-
вать (Convert) на панели инструментов программы.



Хитрости и советы по работе в OS X Mavericks 453

4. На открывшейся панели выберите формат конечного образа — для 
расширения CDR следует выбрать пункт Мастер DVD/CD (DVD/CD 
Master) (рис. П2.8).

Рис. П2.8. Настройка конвертации

5. Нажмите кнопку Сохранить (Save). Через несколько минут вы по-
лучите готовый файл формата CDR.

Чтобы изменить расширение на ISO, нужно щелкнуть по файлу формата 
CDR мышью, удерживая клавишу ⌃, и выбрать в контекстном меню ко-
манду Свойства (Get Info). В группе элементов управления Имя и рас-
ширение (Name & Extension) измените расширение CDR на ISO.

Теперь вы можете использовать данный файл на компьютере под 
управлением операционной системы Windows, хотя изначально он 
был доступен для работы только в среде OS X.

Освобождение пространства на жестком диске

В этом разделе вы узнаете, как освободить пространство на жестком 
диске. Особенно это актуально для владельцев SSD-накопителей, име-
ющих малый объем. Следующие советы ориентированы на опытных 
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пользователей. Новичкам рекомендуется быть предельно осторожны-
ми и в точности повторять изложенные действия.

Внимание! Описанные ниже действия могут привести к сбоям в ра-
боте операционной системы и компьютера при ошибочном введении 
команд.

Удаление голосовых функций

Удаление голосовых функций позволяет освободить от 500 Мб до 3 Гб, 
в зависимости от количества установленных в системе голосов.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) следующие 
команды :

 cd /System/Library/Speech/

 sudo rm -rf Voices/*

После данной манипуляции голосовые функции будут деактивиро-
ваны.

Очистка системных журналов

Позволяет освободить от 100 Мб до 2 Гб пространства.

Если вы не читаете системные журналы, выполните следующие дей-
ствия.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 sudo rm -rf /private/var/log/*

3. Введите пароль администратора. Журналы окажутся удалены.

Системные журналы все равно будут вестись, поэтому данную опера-
цию следует периодически повторять.

Удаление кэша QuickLook

Позволяет освободить от 100 до 300 Мб пространства.

Инструмент QuickLook нагружает систему, используя кэш-файлы для 
более быстрой работы, но на общую производительность это влияет 
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не лучшим образом. Чтобы удалить такие файлы, выполните следую-
щие действия.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 sudo rm -rf /private/var/folders/

Удаление Emacs

Позволяет освободить не менее 60 Мб пространства.

Если вы не пользуетесь текстовым редактором из командной строки 
Emacs, удалите его следующим образом.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 sudo rm -rf /usr/share/emacs/

Удаление tmp-файлов

Позволяет освободить от 500 Мб до 5 Гб пространства.

Каталог /private/var/tmp/ — это системный кэш, содержимое которого 
обычно удаляется после перезагрузки системы. Однако происходит 
это не всегда. Чтобы вручную очистить системный кэш (только времен-
ные файлы, а не всю директорию), выполните следующие действия.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 cd /private/var/tmp/; rm -rf TM*

Чтобы не возникало проблем с приложениями, лучшего всего закры-
вать их до выполнения команды.

Очистка кэша приложений

Позволяет освободить от 1 до 10 Гб и выше

Кэш может накапливаться от использования множества программ и их 
активности. Перед его очисткой рекомендуется закрыть все запущен-
ные приложения или перезапустить компьютер.
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1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) следующую 
команду :

 cd ~/Library/Caches/; rm -rf ~/Library/Caches/*

Настройка приложения Finder
Завершение работы приложения Finder

Приложение Finder, в отличие от других программ, закрыть невозмож-
но, только перезагрузить. Исправить эту ситуацию допустимо следую-
щим образом.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 defaults write com.apple.finder QuitMenuItem -bool 
YES; killall Finder

Теперь в меню Finder появится команда Завершить Finder (Quit Find-
er), также выполняемая сочетанием клавиш �+Q. Для отмены настрой-
ки нужно ввести в окне приложения Терминал (Terminal) следующую 
команду:

defaults write com.apple.finder QuitMenuItem -bool 
NO; killall Finder

Отображение скрытых файлов

Поскольку изначально скрытые файлы в операционной системе OS X 
недоступны для просмотра, можно включить их отображение таким 
образом.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 defaults write com.apple.finder AppleShowAllFiles 
-bool YES && killall Finder

Для отмены настройки нужно выполнить в окне приложения Терминал 
(Terminal) следующую команду:
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defaults write com.apple.finder AppleShowAllFiles 
-bool NO && killall Finder

Теперь вы можете получить доступ к скрытым системным файлам 
(рис. П2.9).

Рис. П2.9. Отображение скрытых файлов

Отображение свободного пространства на диске

В операционной системе OS X в окне приложения Finder по умолчанию 
отсутствует строка статуса, поэтому сложно быстро определить коли-
чество свободного места, оставшегося на жестком диске вашего ком-
пьютера. Для этой цели вы можете использовать два варианта: выбрать 
жесткий диск в группе Устройства (Devices) в боковой панели окна 
Finder, а затем нажать клавишу Пробел для быстрого просмотра его 
свойств или вернуть строку статуса в окно Finder. В последнем случае 
запустите приложение Finder и выполните команду меню Вид ⇒ Пока-
зать меню статуса (View ⇒ Show Status Bar).

Теперь вы можете видеть в строке статуса, расположенной в нижней 
части окна Finder, объем свободного пространства на жестком диске.

Просмотр вложенных папок всех уровней

Если вы щелкнете мышью по значку треугольника, расположенному 
слева от имени папки в окне Finder (в режиме списка), то раскроете 
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содержимое только на один уровень, исключая все подпапки. Чтобы 
просмотреть подпапки всех уровней вложенности, щелкайте мышью 
по значку треугольника, нажав и удерживая клавишу ⌥.

Сокрытие файлов и папок

Вы можете скрыть любые файлы или папки.

Для этого нужно выполнить следующие действия.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 chflags hidden /путь_к_файлу_или_папке

Указанный файл (папка) будет скрыт.

Для отмены настройки нужно выполнить в окне приложения Терминал 
(Terminal) такую команду:

chflags nohidden /путь_к_файлу_или_папке

Отображение папки Библиотеки

Папка Библиотеки (Library) на компьютерах Mac скрыта. В версиях опе-
рационной системы OS X, предшествующих Mavericks, отображение 
папки Библиотеки (Library) осуществлялось через ввод терминальных 
команд. Это неудобно и долго. 

В OS X Mavericks процедура отображения данной папки существенно 
упрощена.

1. Запустите приложение Finder и откройте свою домашнюю папку 
пользователя.

2. Выполните команду меню Вид ⇒ Показать параметры вида 
(View ⇒ Show View Options). Откроется окно с перечнем доступных 
параметров.

3. Установите флажок Показывать папку «Библиотеки» (Show Li-
brary Folder).

Теперь папка Библиотеки (Library) будет отображаться в вашей домаш-
ней папке.
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Создание папки из выделенных файлов

Допустим, на вашем рабочем столе разбросано множество файлов, 
и вы хотите переместить их в одну папку. Первое, что приходит на 
ум, — создать новую папку, затем выделить все (кроме самой папки) 
и перетащить это в нее. Однако существует более удобный способ — 
выделите необходимые файлы, затем щелкните мышью по одному из 
них, удерживая клавишу ⌃, и выберите пункт Новая папка из выде-
ленного (New Folder with Selection). 

Будет создана новая папка, в которую автоматически переместятся вы-
деленные файлы.

Объединение содержимого папок

В операционной системе OS X существует возможность автоматиче-
ского объединения содержимого двух каталогов.

Если у вас есть две папки с одинаковым именем в разных каталогах, при 
перемещении их в один появится окно с кнопкой Заменить (Replace). 
Если же при перемещении удерживать клавишу ⌥, в окне отобразится 
новая кнопка — Объединить (Merge) (рис. П2.10).

Рис. П2.10. Окно к кнопкой Объединить

Нажав ее, вы объедините содержимое обеих папок.

Сортировка приложений по категориям

В окне приложения Finder, помимо сортировки объектов по имени, 
дате добавления/открытия, размеру и тегам, вы можете распределить 
их согласно категориям приложений, выбрав в раскрывающемся спи-
ске  на панели инструментов пункт По категории программ (Ap-
plication Category) (рис. П2.11).
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Рис. П2.11. Сортировка приложений согласно категориям

Аналогичным образом вы можете сортировать и документы в других 
папках, выбрав в раскрывающемся списке  на панели инструмен-
тов пункт По программе (Application).

Закрытие всех окон приложения Finder

Если открыто множество различных окон приложения Finder, вы мо-
жете закрыть их все одновременно, нажав сочетание клавиш �+⌥+W. 
Альтернативный способ — щелкнуть мышью по кнопке , нажав и удер-
живая клавишу ⌥.

Отключение анимации окон

Операционная система OS X содержит большое количество анимаци-
онных эффектов, например, открытие окон приложений осуществля-
ется с анимацией, когда окно перемещается к центру экрана, а потом 
возвращается к своим стандартным размерам. Если вам не нравится 
анимация, можете отключить ее.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:
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defaults write NSGlobalDomain NSAutomaticWindowAni-
mationsEnabled -bool NO

Для отмены настройки нужно выполнить в окне приложения Терминал 
(Terminal) следующую команду:

defaults write NSGlobalDomain NSAutomaticWindowAni-
mationsEnabled -bool YES

Просмотр файлов с помощью 
функции Quick Look

В операционной системе OS X есть замечательная функция под назва-
нием Quick Look. С ее помощью каждый пользователь Mac может от-
крывать любые файлы в режиме предварительного просмотра. Кроме 
того, функция Quick Look позволяет осуществить слайд-шоу.

Чтобы ею воспользоваться, выполните следующие действия.

1. Выделите одно или несколько изображений в любой папке.

2. Нажмите сочетание клавиш ⌥+Пробел. Если было выбрано одно 
изображение, оно откроется на весь экран, если несколько — Mac 
запустит режим слайд-шоу.

Переход от одного изображения к другому осуществляется с помощью 
клавиш ← и →.

Настройка панели Dock
Изменение режима отображения панели Dock

В операционной системе OS X вы можете легко вернуть двухмерную 
панель Dock, если вам по каким-то причинам не нравится ее трехмер-
ный аналог. Для этого выполните следующие шаги.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

defaults write com.apple.dock no-glass -boolean YES

3. Чтобы немедленно перезагрузить панель Dock, введите команду 
меню:



462 Приложение 2

killall Dock

Теперь на вашем экране панель Dock будет отображаться в двухмер-
ном режиме. Для отмены настройки нужно выполнить в окне приложе-
ния Терминал (Terminal) следующую команду:

defaults write com.apple.dock no-glass -boolean NO

а затем команду:

killall Dock

Мониторинг системы в панели Dock

В операционной системе OS X Mavericks компания Apple значительно 
улучшила основную утилиту для наблюдения за состоянием работы 
компьютера — Мониторинг системы (Activity Monitor). 

Одним из нововведений, позволяющих проще и нагляднее получать 
информацию о процессах, стала возможность изменять значок при-
ложения на панели Dock и выводить графический монитор загрузки 
в отдельном окне. 

Чтобы ознакомиться с ним, выполните следующие действия.

1. Запустите приложение Мониторинг системы (Activity Monitor). Его 
значок находится в папке Программы/Утилиты (Applications/Utili-
ties).

2. Щелкните мышью по значку приложения Мониторинг системы 
(Activity Monitor) на панели Dock, удерживая клавишу ⌃, чтобы от-
крыть контекстное меню.

3. Выберите нужный вид значка приложения, например информи-
рующий о загрузке процессора. Для этого выберите команду меню 
Значок в Dock ⇒ Загрузка ЦП (Dock Icon ⇒ Show CPU Usage). Зна-
чок изменит свой вид (рис. П2.12).

Рис. П2.12. Монитор загрузки процессора на панели Dock



Хитрости и советы по работе в OS X Mavericks 463

Доступны следующие виды значка на панели Dock.

• Загрузка процессора.

• История загрузки процессора.

• Загрузка сети.

• Работа диска.

Некоторые мониторы можно вывести также в виде небольших видже-
тов на рабочий стол.

• Монитор загрузки процессора.

• Монитор истории загрузки процессора.

Оба они показаны на рис. П2.13.

Рис. П2.13. Мониторы загрузки процессора и истории загрузки процессора на 
рабочем столе

Размещение виджетов Dashboard 
на рабочем столе

В приложении Dashboard можно найти много разных виджетов, но 
пользоваться ими не всегда удобно. Будет комфортнее, если самые не-
обходимые виджеты вынести на рабочий стол операционной системы 
OS X. Для этого выполните следующие действия.

1. Откройте окно Системные настройки (System Preferences), выпол-
нив команду меню  ⇒ Системные настройки (  ⇒ System Pre-
fe rences).

2. Щелкните мышью по значку , чтобы открыть окно Mission Con-
trol.
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3. Сбросьте флажок Показать Dashboard как пространство (Show 
Dashboard as a Space) и закройте окно Mission Control.

4. Запустите приложение Терминал (Terminal).

5. Введите в окне приложения Терминал (Terminal) команду:

 defaults write com.apple.dashboard devmode YES; 
killall Dock

6. Запустите приложение Dashboard, нажав клавишу F12.

7. В окне программы Dashboard нажмите кнопку , выберите виджет, 
нажмите и удерживайте на нем кнопку мыши.

8. Начав перетаскивать виджет, нажмите клавишу F12.

� Совет. Если у вас не получилось разместить виджет на рабочем сто-
ле, повторите шаги 6–9.

9. Отпустите кнопку мыши, а затем вновь щелкните ею по виджету. Он 
появится на рабочем столе (рис. П2.14).

Рис. П2.14. Виджеты на рабочем столе

� Совет. Чтобы закрыть виджет, установите на него указатель мыши, 
удерживая клавишу ⌥, а затем щелкните мышью по появившейся 
кнопке .
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Для отмены настройки нужно выполнить в окне приложения Терминал 
(Terminal) следующую команду:

defaults write com.apple.dashboard devmode NO; 
killall Dock

Неочевидные приемы работы с текстом

Нестандартные выделения текста

Если в приложении TextEdit удерживать клавишу ⌥, то обычный тексто-
вый курсор (указатель мыши) заменится на значок �. После этого вы 
сможете создавать несмежные выделения (рис. П2.15).

Рис. П2.15. Несмежные выделения текста

Это довольно удобно при выделении столбцов текста.

Также вы можете, нажав и удерживая клавишу �, создать несколько 
выделений. В этом случае становится доступна возможность выделе-
ния и копирования нескольких объектов сразу.

Ввод диакритических знаков

Если вам приходится вводить диакритические знаки в текстовые доку-
менты, вы по достоинству оцените одну из возможностей функции авто-
коррекции в операционной системе OS X. Чтобы выбрать нужный знак 
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при вводе текста в окне редактора TextEdit, нажмите и удерживайте, на-
пример, клавишу с латинской буквой A, пока не появится всплывающая 
панель, где будут представлены доступные варианты (рис. П2.16).

Рис. П2.16. Ввод диакритических знаков

Чтобы выбрать необходимый вариант диакритического знака, исполь-
зуйте мышь или клавиатуру, но при этом продолжайте удерживать бук-
венную клавишу.

Функция автодополнения

Это чрезвычайно удобная функция, отлично работающая даже с рус-
ским языком. Во время набора текста в приложении TextEdit или других 
текстовых редакторах нажмите клавишу F5 или сочетание клавиш ⌥+�. 
Появится панель, где можно выбрать нужный вариант (рис. П2.17).

Рис. П2.17. Панель с вариантами автодополнения

Использование забавного шрифта Эмодзи

Операционная система OS X содержит иллюстрированные символы 
Эмодзи. Они часто используются во Всемирной паутине для выраже-
ния эмоций вместо смайликов. Персонажи из системы Эмодзи пред-
ставляют собой элементы шрифта Apple Emoji Font. Если вы хотите ис-
пользовать эти символы в тексте, выполните следующие действия.

1. Откройте приложение Finder, перейдите в папку Программы (Appli-
cations) и запустите приложение TextEdit.

2. Выполните команду меню Правка ⇒ Специальные симво-
лы (Edit ⇒ Special Characters) или используйте сочетание кла-
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виш ⌃+�+Пробел. Вы увидите список доступных символов 
(рис. П2.18).

Рис. П2.18. Выбор элементов Эмодзи

Если вы хотите перенести какой-то элемент в текстовый документ, ско-
пируйте его удобным для вас способом и вставьте в тест.

Навигация по тексту

При использовании текстовых редакторов, например Pages, можно 
перемещать курсор на целое слово, нажимая сочетания клавиш⌥+← 
и ⌥+→. Также можно перемещаться по абзацам, используя сочетания 
клавиш ⌥+↑ и⌥+↓.

Доступ ко всем форматам при сохранении 
файлов

При сохранении файла в одном из приложений в операционной систе-
ме OS X, например изображения из программы Просмотр (Preview), вам 
на выбор предоставляется несколько популярных форматов. Однако 
на самом деле количество форматов, поддерживаемых в операцион-
ной системе OS X, немного больше. Что бы увидеть их все, при сохране-
нии файла и выборе формата нажмите и удерживайте клавишу ⌥.

Поиск и удаление дубликатов композиций 
в приложении iTunes

В приложении iTunes доступна возможность поиска дубликатов пе-
сен. Для этого выберите команду меню Вид ⇒ Показать дубликаты 
(View ⇒ Show Duplicate Items), и в том же окне приложения iTunes от-
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кроется список оригинальных аудиозаписей и их копий, которые обна-
ружила программа.

Обратите внимание, что вместе с дубликатами здесь представлены 
и оригиналы. 

Сделано это для того, чтобы вы могли выбрать, какие из дубликатов 
действительно ими являются, а какие композиции удалять не стоит.

После того как удалили ненужные композиции, вы можете вернуться 
в медиатеку, выбрав команду меню точно так же из меню Вид ⇒ Пока-
зать все объекты (View ⇒ Show All Items).

Строка меню

Калькулятор в строке поиска

Как известно, в операционной системе OS X доступно два калькулято-
ра — в виде отдельного приложения и в виде виджета Dashboard. 

Пользователям, которые редко пользуются математическими вычисле-
ниями, не всегда удобно запускать эти программы. И для таких случаев 
существует куда более интересный и простой способ, о котором знают 
не все.

Чтобы им воспользоваться, нажмите кнопку  в строке меню и введите 
математический пример. В результатах поиска вы сразу увидите пра-
вильный ответ (рис. П2.19).

Рис. П2.19. Решение математического примера с помощью функции Spotlight

Сложение, вычитание, умножение и деление — все ему подвластно. 
А если щелкнуть по результату мышью, откроется окно приложения 
Калькулятор (Calculator).
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Перемещение и удаление значков в строке меню

Неизменяемые, на первый взгляд, значки в правой части строки меню 
можно перемещать и удалять. Для этого нажмите и удерживайте клави-
шу � и перемещайте элементы относительно друг друга. Данная воз-
можность недоступна для значков приложений сторонних разработ-
чиков, но системные перемещаются без проблем.

Если же перетащить значок на рабочий стол, он будет удален из строки 
меню.

Дополнительные команды значков в строке меню

Простым щелчком мыши по значку  в строке меню вы откроете регу-
лятор уровня громкости. Если же при этом нажать и удерживать клави-
шу ⌥, можно быстро переключить устройство ввода/вывода звука.

Аналогичным образом нетрудно получить доступ к дополнительным 
командам других значков. Например, при одновременном нажатии 
клавиши ⌥ и щелчке мышью по значку  в строке меню можно уви-
деть расширенную информацию об используемой сети Wi-Fi. А при 
одновременном нажатии клавиши ⌥ и щелчке мышью по значку  — 
посмотреть ранее сопряженные устройства и подключиться к ним, 
а также создать отчет диагностики службы Bluetooth.

При одновременном нажатии клавиши ⌥ и щелчке мышью по значку 
 в строке меню вы сможете пропустить информацию о компьютере 

и сразу перейти к списку оборудования.

Быстрая прокрутка в браузере Safari

Клавиша ⌥ ускоряет работу с полосой прокрутки. Например, чтобы пе-
реместиться в нижнюю часть страницы, нажав и удерживая клавишу ⌥, 
щелкните мышью в нижней части полосы прокрутки. 

Произойдет мгновенное перемещение ползунка полосы прокрутки 
в нижнюю часть страницы. 

Если же просто щелкать мышью по полосе прокрутки, то ползунок бу-
дет плавно перемещаться в сторону указателя мыши. Эта функция ра-
ботает и в любом другом окне с полосой прокрутки.
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Пасхальные яйца

«Пасхальное яйцо» (от англ. Easter Egg) — это разновидность секрета, 
оставляемого в программном обеспечении разработчиками. Пасхаль-
ные яйца играют роль своеобразных шуток для внимательных пользо-
вателей. Чаще всего для «получения» пасхального яйца следует произ-
вести сложную и/или нестандартную совокупность действий, что делает 
маловероятным либо практически исключает случайное обнаружение.

Скрытые изображения для рабочего стола

Операционная система OS X Mavericks скрывает более 40 красивых 
обоев в высоком разрешении. Изображения находятся внутри систем-
ного каталога операционной системы OS X, поэтому найти их можно 
следующим образом.

1. Откройте окно приложения Finder и нажмите сочетание клавиш 
�+�+G.

2. Укажите в поле ввода строку /Library/Screen Savers/Default Collec-
tions/ и нажмите кнопку Перейти (Go).

Рис. П2.20. Дополнительные обои для рабочего стола

3. Скопируйте четыре папки 1-National Geographic, 2-Aerial, 3-Cosmos 
и 4-Nature Patterns на рабочий стол или в любой другой каталог. Так-
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же вы можете напрямую добавить эти папки в окне Рабочий стол 
и заставка (Desktop & Screen Saver) (рис. П2.20).

4. Запустите приложение Системные настройки (System Preferences) 
и откройте окно Рабочий стол и заставка (Desktop & Screen Saver) 
щелчком мыши по значку .

5. На вкладке Рабочий стол (Desktop) нажмите кнопку  и добавьте 
скопированные папки.

Погода для города Нигде

Предустановленный виджет погоды содержит в себе пасхальное яйцо, 
и суть его заключается в том, что если запустить приложение Dash-
board, добавить на него этот виджет и щелкнуть по виджету мышью, 
нажав и удерживая сочетание клавиш �+⌥, то местоположение изме-
ниться на «Nowhere», что в переводе означает «Нигде» (рис. П2.21).

Рис. П2.21. Прогноз погоды для города «Нигде»

При этом сам значок погоды изменится на случайный, и, щелкая по нему 
мышью с нажатым сочетанием клавиш �+⌥, можно пересмотреть все-
возможные значки погодных явлений, доступных в этом виджете.

Замедленная съемка

Практически любой эффект в операционной системе OS X можно за-
медлить, удерживая клавишу �, например:

• открытие программы или сворачивание ее в панель Dock 
(рис. П2.22);

• просмотр стопки документов;

• запуск приложения Dashboard или Launchpad;

• отображение или скрытие разных панелей и прочее.
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Рис. П2.22. Эффект сворачивания окна в панель Dock

Поющий Mac

Как вы, возможно, знаете, при помощи команды say и голосового 
движка операционной системы OS X в приложении Терминал (Termi-
nal) можно произносить разные слова. Однако вам вряд ли известно, 
что операционная система OS X способна исполнять небольшие мело-
дии. Для этого достаточно ввести одну из этих команд (буква o долж-
на быть указана не менее 51 раза; чем больше число букв, тем дольше 
компьютер «поет»):

• say -v Good ooooooooooooooooooooooooooooooooooooo
oooooooooooooo

• say -v Bad oooooooooooooooooooooooooooooooooooooo
ooooooooooooo

• osascript -e 'say "Ruff neck ru les artcore scene 
artcore scene artcore scene Ruff neck ru les 
artcore scene artcore scene artcore scene and if 
you can’t live with that ruck you, ruck you, And 
if you can’t live with that ruck you all ruck you 
all" using "Cellos"'

Здесь приведен слегка измененный текст песни «Ruffneck Rules Da Art-
core Scene» группы «Juggernaut».

• osascript -e 'say "Dum dum dee dum dum dum dum 
dee Dum dum dee dum dum dum dum dee dum dee dum 
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dum dum de dum dum dum dee dum dee dum dum dee 
dummmmmmmmmmmmmmmmm" using "Pipe Organ"'

• osascript -e 'say "Dum dum dee dum dum dum dum 
dee Dum dum dee dum dum dum dum dee dum dee dum 
dum dum de dum dum dum dee dum dee dum dum dee 
dummmmmmmmmmmmmmmmm" using "Hysterical"'

Игры в приложении Терминал

В состав операционной системы OS X входит консольный текстовый ре-
дактор Emacs, который содержит несколько пасхальных яиц. Это попу-
лярные мини-игры «Тетрис», «Арканоид», «Змейка» и другие. Для начала 
вам нужно узнать версию Emacs в вашей операционной си стеме.

1. Запустите приложение Терминал (Terminal).

2. Введите в окне приложения Терминал (Terminal) команду:

 cd /usr/share/emacs/

3. Нажмите клавишу �.

4. Далее введите команду

 ls

5. Снова нажмите клавишу �. Вы увидите версию редактора Emacs на 
вашем компьютере (например, 22.1) (рис. П2.23).

Рис. П2.23. Вывод версии редактора Emacs

Теперь можно получить доступ к играм. Выполните следующие дей-
ствия.

1. Введите в окне приложения Терминал (Terminal) команду:

 ls /usr/share/emacs/версия/lisp/play
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 Замените слово версия на число, соответствующее версии редак-
тора Emacs на вашем компьютере. На экране появятся все доступ-
ные игры. Запишите их названия (рис. П2.24).

Рис. П2.24. Вывод доступных игр

2. Теперь переключитесь в редактор Emacs, введя команду

 emacs

3. Для доступа к играм нажмите клавишу �, затем клавишу X и введите 
название игры, например tetris. Нажмите клавишу � (рис. П2.25).

Рис. П2.25. Вид игры Tetris

Перейти к следующей игре можно, последовательно нажав клавиши �, 
X и введя название игры.

Для передвижения и вращения фигурок используйте клавиши ←, ↑, ↓ 
и →, а чтобы заставить фигуру упасть вниз, необходимо нажать клави-
шу Пробел.
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